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Overview 
VisualDesign™ is a 3D Structural Analysis & Design software that allows you 
to analyze and design all types of structures. It includes finite elements, floors, 
plates, and composite sections. Automatic generation of 3D mesh, trusses, ice 
and wind loads and load combinations is also available. The program can 
support an unlimited number of nodes, loads, load combinations, and 
envelopes.  

The program is user-friendly developed on a Windows interface. You will find 
it easy to use, even for the first time. It has a Multi Document Interface (MDI) 
that allows the opening of several projects simultaneously from the same 
application. You may even display different documents on the screen at the 
same time. To choose a specific document, click on its title bar or select it from 
the Window menu. 

VisualDesign™ provides a unique cyclic Steel Design using results of 
Dynamic, Spectral, Time History, Moving Loads and Non-linear Static analyses 
prior to selecting shapes and prior to starting the Foundation Design. The 
design process is iterative. Furthermore, American, Canadian, or Parametric 
standards are supported in this program. Users may easily switch from Imperial 
to Metric system of units.  

Results may be obtained graphically (forces, diagrams, and even animation of 
vibration modes) or by the way of printable spreadsheets. P-Delta effects are 
included in the static analysis, as well as inelastic and torsional effects in 
Spectral analysis. The Dynamic analysis offers an integrated database of 100 
accelerograms. Non-linear Time History analysis includes elastoplastic 
hysteretic models, hysteretic loops, friction dampers, plastic hinge, and 
displacement, support and stress time history graphs.   

The Moving Loads analysis provides a real 3D analysis including editable 
scenarios for trucks, pre-defined and/or user-defined moving loads, envelopes 
for Finite Elements, members and reactions and associated min/max values. 

The Foundation Design module includes the design of shallow and deep 
foundations. Reinforcement is supplied in the footing design results. It can be 
used with the static analysis only. However, for those owning any Design 
Module, the cyclic design will also include the foundation design results in the 
design process. 

VisualDesign 
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The Reinforced Concrete Design module and Prestressed Concrete 
module are also available. The first one designs and places rebars in beams, 
columns, shear walls and 2-way slabs. Resistance and forces diagrams for 
beams, columns and shear walls are displayed above the elevation view of a 
continuous system. This drawing shows all rebar placement details. You are 
allowed to edit (move, delete, stretch) rebars on the displayed drawing and 
check the resistance diagrams which are automatically recalculated as you edit 
rebars!  The Prestressed Concrete module designs concrete elements and 
checks the capacity of prestressed concrete beams according to the prestressing 
cables that you placed into the beam with the help of a tool called "Cable 
Layout Models". It also includes several graphical results, loss of prestress in 
cables and stresses results for each construction steps. 

VisualDesign™ is multilingual (English, Spanish, and French). You can switch 
from one language to another, simply by clicking on "Display Language" in the 
File menu. 

This program allows interfacing with AutoCAD through DXF format. The 
Reinforced Concrete Design Module and Prestressed Concrete Module 
allow you to export rebar placement details in element elevation view through 
the Export DXF function of File menu. 

When you need assistance or want more information, simply click the Help 
menu or point the arrow on one of the menu functions or buttons on the 
toolbar. You can also press the F1 key to learn more about posted dialog boxes 
or spreadsheets.  

Available Modules: 
Static Analysis (Base module)  
Dynamic Analysis Module  
Foundation Design Module  
Moving Loads Analysis Module  
Steel Design Module  
Reinforced Concrete Design Module  
Prestressed Concrete Module  
Bridge Evaluation Module  
Tower Design Module  
Generation of Culverts  
Generation of Abutments, Piers & Retaining Walls  
Timber Design Module  
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About VisualDesign™ 
Select About VisualDesign from Help menu to know the version and 
compilation number and activated modules for the license you are using. The 
expiration date of your maintenance agreement is supplied and it gives 
information about technical support. 

 

Version and Compilation 
On-line Help: Version 5.9, compilation 240.  

To know the version and compilation you are currently using, select About 
VisualDesign in the Help menu.  

See also 
About VisualDesign  
Updating VisualDesign  
About the protection key  
Technical Support 

Updating VisualDesign 
If your maintenance agreement is still active, you have the right to download 
VisualDesign latest compilation (update) through our Web site 
www.civild.com. Make sure that you have the name of your Client directory 
and password.  Ask your network administrator about it.  Should you have any 
question, please contact us at this address: installation@civild.com.  
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Maintenance Agreement 
To renew your maintenance agreement, add new licenses or modify existing 
ones, please contact us at the following address: licence@civild.com  

Minimum Equipment Required 
▪ Pentium 100MHz or higher 

▪ 32MB RAM 

▪ 100MB available disk space  

▪ SVGA screen with a minimum resolution of 800 x 600 with 65536 colours 

VisualDesign's Limitations and Capacity 
VisualDesign™ analyzes structures that induce small deflections and average 
displacements.  

There is no limitation on the size of the project. It only depends on the 
computer available memory (RAM and Hard disk).  

See also 
Analysis and Cyclic Design Limitations  
Limitations of the Reinforced Concrete Design module  
Limitations of the Foundation Design module  
Bolted Connection Design Limitations  

VisualDesign's Modules and Integrated Standards 
and Codes 
Modules Canadian Standards American Standards 

Base Module (Static Analysis) N/a N/a 

Dynamic analysis (spectrum) CNBC 1995 
CNBC 2005 
CSA/CAN S6-00 

UBC 1994 
UBC 1997 

Foundation Design CNBC 1995 
CFEM 1992 
CSA/CAN A23.3-95 
CSA/CAN S6-00 

US Army Corps of  
Engineers 1994 

Steel Design CSA/CAN S16-01 
CSA/CAN S6-00 

ASCE-7 SD 
ASCE-7 ASD 
AASHTO LRFD-98 
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Modules Canadian Standards American Standards 

Moving Load Analysis CSA/CAN S6-00 
CSA/CAN S6-88 
Customizable 

AASHTO LRFD-98 

Reinforced Concrete Design CSA/CAN A23.3-95 
CSA/CAN-A23.3-04 
CAN/CSA-S806-02 (Fibre 
reinforced polymer bars) 
CSA/CAN S6-00 

AASHTO LRFD-98 

Prestressed Concrete CSA/CAN S6-00 
CSA/CAN A23.3-95 

AASHTO LRFD-98 

Bridge Evaluation CSA/CAN S6-00  

Tower Design CSA/CAN S37-01 ASCE-10-97* 

Timber Design CSA/CAN O86-01  

 

* Refer to ASCE-10-97 tab of Project Configuration dialog box. 

** AASHTO LRFD Bridge Design Specifications (1998): For the moment, 
shrinkage and creep models are based on Code S6-00 (equivalent to CEB-78). 
Other models will be added in a later version.  

Starting VisualDesign™ 
Double-click on VisualDesign™ icon or start automatically by double-clicking 
on any VisualDesign™ application (.vd1 or .vdz extensions). 

About the Protection Key 
You may install VisualDesign™ on more than one workstation. However, in 
order to work with the software, you must also install a protection key. 

If you use the same key on more than one workstation, make sure that you 
shut down the computer before removing or installing the key. The key may be 
damaged if you transfer it from one station to another without first shutting 
them down. 

Remember that the authorization numbers of a license and its protection key 
are interdependent.  
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Using VisualDesign 
This topic includes ten essential steps that you must well understand before 
beginning a project with VisualDesign.  

1. Project Configuration 
Select this dialog box in the File menu. According to the type of analysis that 
you are planning to do, complete the appropriate tab and modify the default 
parameters, if needed.  

Always consult the Preferences tab and the Analysis tab. 

See Project Configuration  

2. Activation Modes and Properties Function 
With VisualDesign™ you may work under seven activation modes, namely, 
"Structure", "Load Case", "Load Combination", "Envelope", "Vibration 
Mode", "Design Results" and "Rebar Placement" mode. Before asking 
information about any specific element through the Properties function of the 
Edit menu, make sure that you have activated the right mode, since the 
displayed dialog box is specific to an activation mode. 

For example, if you click twice on a node while you are in the "Structure" 
activation mode, you will get the Node Characteristics dialog box. If you 
click twice on the same node while you are working with the "Load Case" 
activation mode, you will get the Loads on Node dialog box. If you proceed 
the same way in the "Load Combination" activation mode, you will get the 
Nodes Displacements dialog box. Finally, if you double click on a member 
while in the "Envelope" activation mode, you will get the envelope diagram for 
this member.  

See Activation Modes  

3a. Selection Mode 
VisualDesign™ allows one of two selection window modes: the Extended 
Window and the Restricted Window. By default, one of these modes is 
activated when the "Add" mode is not. Both windows allow you to select an 
element or group of elements. The entire element is selected whichever mode 
you used. 

The difference between the two selection windows appears when you use the 
pointer to plot a window around an element or a group of elements. 

Whichever mode you chose, you must always specify the type (member, node, 
plate etc.) of element that you want to select. The list of available elements 
appears both in the Edit Menu, under the "Elements" heading, and on the 
Elements toolbar. 

See also 
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Extended Window  
Restricted Window  
3b. Multiple Selection 
We call it a multiple selection when many elements are selected. To do a 
multiple selection of elements of the same type, press down the Ctrl key while 
you click on elements. Then, press the Properties icon. You will notice that 
some fields are blank in the dialog box. Values that will be entered in blank 
fields will be applied to all selected elements.  

To de-select elements in a multiple selection, just click on the highlighted 
element that you wish to de-select.  

3c. Mixed Selections and the Mask Function 
A mixed selection is made up of elements of different types (members, floors, 
plates…). This type of selection is very useful to isolate a part of a structure. 
You will be allowed to select a bay or a story with its selected members, plates, 
floors, etc.  

To do such a selection, activate a type of element on Elements toolbar, select 
the Restricted window and draw a window around the part of the structure 
that you want to isolate. Elements of this type will be selected. Then, activate 
another type of element on Elements toolbar and draw another window to 
select the other type of elements. Repeat this process to select other type of 
elements. Click on the Mask function.  

3d. Correspondence between Selected Elements on your Screen and 
Spreadsheet Contents 
If you select a spreadsheet and there are selected elements on your screen, the 
spreadsheet will only include the selected elements. If no elements are selected, 
the spreadsheet will include all elements in your project.  

This function applies to all activation modes except "Vibration Mode".  

4. View Options 
Use VisualDesign view options (View menu) because they are essential when 
modeling a structure and to consult results. 

See View Options 

5. 3D Modeling (By default in VisualDesign) 
For a 2D model, you must put a restraint on Mx (torsion) to at least one or two 
support nodes, depending on the type of structure. Otherwise, the model will 
be unstable and you will get a warning message that there is a null pivot in the 
stiffness matrix.  

See also 
Null Pivot in the Stiffness Matrix  
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How to model a structure  
Modeling Strategy  
Practical Example - 2D Frame  
6. Definition of Load Case Titles 
VisualDesign must know the type of loads that are going to be applied to the 
structure to accurately generate load combinations and load factors according 
to the building code.  

The spreadsheet Loads Definition is located in Loads menu at heading Load 
cases / Definition. The purpose of this spreadsheet is to define the title of 
each load case and to select the type of load because the Load Combination 
Generation Wizard needs to know which type of load applies.  

Once in the spreadsheet, you must insert the number of lines that correspond 
to the number of loads that you want to apply on the structure such as live, 
snow, wind, additional dead load, dynamic, etc. The standard dead load is 
automatically calculated and inserted in the spreadsheet. It cannot be removed.   

For each load, specify its type by double-clicking in the "Type" column. 
Choose among the drop-down list box: Dead [1] Standard, Dead [2] Wearing 
surface, Dead [3] Pouring of Concrete, Dead [4]-Backfill, Dead [5]-Hydrostatic, 
Dead [6]-Passive, Dead [7]-Guy, Live, Snow, Wind, Seismic, Interaction, 
Dynamic, Temperature, Load on roof (LRFD), Rain (LRFD), Auto ice and 
Auto wind. 

See Load Definitions Spreadsheet  

7a. Using Load Combination Generation Wizard 
Use this tool (Loads menu, heading Load Combinations) to automatically 
generate all load combinations according to the selected code. You can also 
include different envelopes such as spectral (E), moving load (Lmi), linear time 
history (Et) and non-linear time history (Etnl) envelopes. Use this tool to 
generate resistance and deflection envelopes also. 

You are allowed to disable load combinations if you do not want to generate 
them.  

When that the generation is completed, the Load Combinations spreadsheet 
is automatically open. Look at the load combinations statuses. Disable the 
option "Required" for load combinations that you do not want to analyse right 
now. Look at load factors in the Load Factors tab. 

See Load Combination Generation Wizard  

7b. Definition of Load Combinations and Load Factors 
If you do not want to use the Load Combination Generation Wizard, you 
must select and complete the Load Combinations spreadsheet. It is located in 
the Loads menu at heading Load Combinations/ Definition.  
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The purpose of the first tab is to give a title to each load combination and to 
choose its status. The load combination status is very important. The "Stage" 
column is used for prestressed concrete and composite beam that have 
construction stages. 

The second tab, titled Load Factors, is very important and is often forgotten 
by new users. Insert lines in the right part of this dialog box and select all load 
cases that are part of each load combination. To do that, you must highlight 
the load combination in the left part of the dialog box and then, in the right 
part, insert the number of lines corresponding to the number of loads that is 
part of the load combination. At each inserted line, you must double-click in 
the "Load Cases" column and choose a type of load in the drop-down list box. 
Also, enter the load factors that you want to apply to each load. Available loads 
are those defined in the Load definition spreadsheet. You must do that for 
each load combination. 

See Load Combination Definition spreadsheet and Load Factors 

8. Apply Loads on the Structure 
You must activate the Load Case mode on the Activation toolbar. Then, select 
a load title in the drop-down list box. After, go to Elements toolbar and 
activate the appropriate type of element that you want to load. Select those 
elements on the screen and click on the Properties icon. The Load dialog box 
will appear on the screen. Enter loads.  

Select another load title in the drop-down list box and repeat the process.   

If you want to modify the loads in a quick manner, select the corresponding 
load spreadsheet in the Loads/Load cases menu, select the whole column or 
a part of it and right click to call up the contextual menu. Choose one of 
available functions. Do not forget that spreadsheet content corresponds to 
selected elements on screen.   

9. Analysis 
Refer to topic Analysis Procedures (Help ? menu) to guide you through all the 
required steps. Procedures are available for all types of analyses. 

10a. Numerical Results: 
According to the type of results that you want to look at, activate the 
appropriate activation mode (Load Combination, Envelope, Vibration mode, 
or Rebar Placement) and choose a title in the drop-down list box. Then, 
double-click on an element or, if you have selected many, click on the 
Properties icon. A results spreadsheet will automatically appear on your 
screen. The "Design Results" mode gives you direct access to this spreadsheet. 

You can also select results spreadsheets through the Results menu, at headings 
Load Combinations and Envelopes.  
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10b. Graphical Results: 
Select the Results tab of View Options and select the diagram (forces, 
resistances or deflection) that you want to look at. Activate the legend for 
results.  

If you ran a dynamic and spectral analysis, activate the "Vibration mode" on 
Activation toolbar and choose a vibration mode in the drop-down list box. 
You will see the deflection of the whole structure under this mode. To animate 
this vibration mode, select the Animation function. 

See Animation 

10c. Design Results: 
If you ran a steel design, the "Design Results" activation mode will be 
automatically activated at the end of the design. Click on the Properties icon 
to call up the Design Results spreadsheet. In the lower part of the 
spreadsheet, three buttons are available to help you look at results. First, select 
a line (which corresponds to a member) in the spreadsheet and click on one of 
the button: a print preview of the member Design brief, the printing of this 
Design brief or call up the forces and deflections spreadsheet. 

See also 
Design Results Spreadsheet 
Design Brief 
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Technical Support 
Contact us if you have any question about the utilization of the program, or its 
installation procedure and upgrade, and feel free to send us your 
commentaries. 

We are open from 8h30am to 5hpm, Monday to Friday. 

Use the following e-mail address: 

Technical Support: support@civild.com  

Installation Problems: installation@civild.com 

Sales: licence@civild.com  

Using Help 
Online Help is a reference tool that gives you a systematic protocol. You can 
ask for help by using one of the following procedures: 

• By selecting the Online Help command from Help menu. 

• By selecting the Help icon  from the Standard toolbar and by clicking 
on any sub-menu included in any VisualDesign™ menus. The Online Help 
will automatically opened at the item that you selected to give you the 
information you asked for. 

• By pressing the F1 key. This function will opened the online help at the 
topic corresponding to the dialog box, spreadsheet or contextual menu you 
were in when you pressed down this key. This function is the mostly used 
by users.   

The Online Help table of contents appears at the left part of the window once 
that the Online Help dialog box is opened. It includes all online help topics 
that you may find through book chapters. Each chapter corresponds to a 
module.  

To make your search quicker, select the Index tab and enter a key word in the 
appropriate field.  

See also 
Displaying a Help Window  
Help Command of Standard Toolbar 
Online Help Command from Help menu  
Printing a Help Section  

Technical Support 
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Frequently Asked Questions (FAQ) 
Q1: "Yesterday, I applied loads on my structural model but this 
morning, when I opened VisualDesign, I could not see them." 

A. If loads were applied on floors, you will not see them unless you activate the 
floor outline in the View tab of View Options dialog box. 

Q2: "After a spectral analysis, I selected the Seismic Directions 
spreadsheet and the value of "V" is 0.00. Why?" 

A. The value of V corresponds to the chosen minimum lateral seismic force 
that is used to calibrate forces according to Vmin, if calibration is required 
(Seismic tab of Project Configuration). When calibration is not required, 
VisualDesign does not display the value of V.  

Q3: "When analyzing my structure, a warning message appears in the 
Analysis dialog box: "Warning! Load combination DL1 has not reached 
a desirable level of precision!" What does it means?" 

A. This message appears during a non-linear analysis when the last iteration 
cycle is reached and when the variation of member axial force exceeds the 
convergence criterion as specified in the Analysis tab of Project 
Configuration. If it happens, increase the number of iterations or maximum 
variation on axial force.  

Q4: "I did a multiple selection of floors and did some modifications but 
it seems that not all the selected floors have been modified. What is 
wrong? " 

Sometimes, two floors have the same number (same name) because one of 
them has been copied from another project or else. When selecting multiple 
floors for a loading, only one of these two floors will be selected because they 
have the same number. To solve this problem, call up the Floors spreadsheet 
and select the "Number" column. Re-number all floor numbers (to make sure 
they are not used twice) by right clicking and choosing the Auto numbering 
function in the spreadsheet’ contextual menu. Always verify that members, 
plates, nodes, etc. numbers are not doubled.  
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Q5: "What are the types of extension files created by VisualDesign?" 

See Type of Files generated by VisualDesign  

Q6: "I cannot print my results. Why?" 

A. Users that have printing problems with a HP-LaserJet printer must make 
sure that it is not using a PCL6 driver because it can cause a failure in the 
system. To solve this problem, go to Windows Start menu and select Settings 
and then, Printer. Right click and choose function Properties. Change the PCL6 
driver by another one.  

Q7: "The program failed at its opening." 

A. Many reasons can explain this. The first thing is to consult the xxx.log file 
located in directory C:\VisualDesign\User. xxx represents the end of  network 
card physical address, or key number, if you have one.  

This file will help to locate the problem. The most frequent causes are:  

• One of these files or directories are read only: 
VDBase.mdb in C:\VisualDesign\Sections 
Licence.mdb in C:\VisualDesign\User 
Commun.mdb in C:\VisualDesign\Commun 

• Some DLL files do not come from the right version of the software. 

• There is an error in the registers. 

Q8: " VisualDesign displays an error message following the registration 
of my workstation." 

A. Following the registration of a workstation, the licence.mdb file must be 
validated. You must e-mail us the file to this address: licence@civild.com. As 
long as this validation is not done at our office, the software will not work on 
this new workstation and will display the error message. 

Q9: " Following an upgrade of a registered installation, the program 
asked me to enter an authorization number for the Evaluation copy." 

A. The installation of a registered version is done in two steps: 

• The execution of the SetupVDxx-yyy.exe file (about 20Mo) 

• The replacement of your customized licence.mdb file by the new one 
(VDxx-yyy.exe file is smaller than 100ko). 

If you tried to open VisualDesign without having gone through the second 
step, the program will enter in the Evaluation mode, by default. 
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Q10: "At the opening of the program, a "Select Database" dialog box 
was displayed on the screen. What should I do?" 

 
A. In this case, it is very likely that the path to the file (including the name of 
file) is too long (more than 128 characters). You can do one of the operations 
describe below:   

• Move your project in a smaller path; 

• Rename your project with a shorter name; 

• Use Windows command SUBST to assign a disk letter to a particular 
directory. 

Example using the command SUBST: 

To assign the disk letter "S" to directory "C:\Projects \ Departments\ 
Structure \Completed Projects\S2001-08-24 (joists)\ Modelling 
\VisualDesignVersion52-184": 

• Go to Windows Start menu, click the Run command and enter SUBST 
S: " C:\Projects\Departments\Structure\Completed Projects\S2001-
08-24 (joists)\Modelling\VisualDesignVersion52-184" (Quotation 
marks are important in this case because of blanks.).  

• You will have access to the files included in this directory by selecting 
the disk (directory) S:FileName.vd1 

Customized Options 
CivilDesign is happy to put its programming expertise, intellectual abilities 
and innovative approach at your service by creating customized applications to 
optimize your operations and increase the reliability of results.  

We can develop an automated customized structure just for you to make your 
design quicker than ever! We can also upgrade and improve your house made 
programs into Windows environment! 

Save time and money: Contact CivilDesign today! 
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Phone:    (450) 674-0657 

Toll Free 1-800-724-5678 

E-mail: custom@civild.com 

Tips 
Null Pivot in the Stiffness Matrix 
During an analysis, this message indicates that a null pivot was detected in the 
stiffness matrix. It is a strong indication that there is an instability problem 
within the model. The node number that is given with the message is a hint to 
locate the instability source. 

Don't forget that VisualDesign™ is a 3D software by default. If 
you modeled a 2D structure, you must restraint the third direction 
and the rotation degree of 2D members to avoid the rotation 
around itself. 
A 3D structure that is stable (having analysed it without any problem) may 
become unstable if lateral forces are applied and if you ran a non-linear 
analysis. It means that instability was not detected under gravity loads. 
Consequently, we recommend that you always check the structure behaviour 
under lateral loads.  

Always check the structure deflection, if possible. An extreme displacement is 
an important indication that a mechanism is present in the structure. 
Strengthen the structure where the mechanism took place.  

If you have gone through many tries but haven't resolve the problem, here are 
a couple of suggestions to make sure that the model is stable:  

• Create a unit load case on each node of the model. Loads should be applied 
in the three orthogonal directions (x, y, z, Mx, My and Mz).  

• Create a load combination that corresponds to this load case.  

• Configure your project for a static analysis (File / Project 
Configuration / Analysis tab / "Type of analysis").  

• Run a static analysis. If you obtain the null pivot message, the model is 
still unstable.  

• Observe the model deflections to detect instabilities that could be 
present. Huge deflections are a sign of instability, inferior structural 
stiffness or excessive loads.  

• If there are some Built-Up sections in your project, change all these 
sections for symmetrical shapes or pre-defined shapes such as HSS, to 
make sure that instability is not caused by data entry.  
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Correspondence between a Graphical Selection of Elements and 
Spreadsheet's Contents 
There is a correspondence between selected elements and spreadsheets’ 
contents.  

Example: Graphically select a few members on the screen and call up the 
Members spreadsheet in the Structure menu. The members included in the 
spreadsheets are those you selected on the screen. Now, select a few lines in 
the spreadsheet and press OK. The highlighted members on your screen are 
those you selected in the spreadsheet. 

Steel Design with no Loading 
If no loading is defined and a steel design is carried on, the design results will 
be "Not evaluated" for each member.  

"Mask" Function 
When using the Mask function, only the selected elements are displayed. If 
you masked a structure after having selected floors only, members will not be 
displayed. You need to select floors AND members in the same part of the 
structure before using the Mask function. (Use the [Ctrl] key to add or 
withdraw objects in your selection).  

Mask a Part of the Structure to Have a Better Look at It 
Functions "Mask" and "Unmask" are very useful to cut off a part of the 
structure. 

Example: To look at results of a 3D frame, choose a plane view, select the 

frame members using the Restricted window  then, press down the 

"Mask" icon . Go to a perpendicular view to the frame plane. Press down 

the "Unmask" icon  to display the whole structure again. 

Selection of Elements in a 2D Model 
In a 3D structure, it is often more secure to select elements in a 3D view 
instead of a 2D view. The following example shows why. 

Figures A and B represent the same structure but in different views. The first 
one is in the XY plane and the second is the isometric view. With the mouse, 
select member m1 in a 2D view (figure A). Look at figure B: we chose bracing 
c1! The same thing can happen when selecting other elements (nodes, floors 
and plates). 
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F I G U R E  A  

 
F I G U R E  B  

 

Addition or Removal of Elements in a Selected Group of Elements on 
Screen 
Use the keyboard [Ctrl] key to add or to withdraw one or more elements from 
the selection. Ex.: Select a member, and while you press down the [Ctrl] key, 
select other members to add them to the selection. 

Applying Common Modifications to a Group of Selected Elements 
If you want to quickly apply common modifications to many elements, select 

them on the screen and press down icon Properties . 
The Characteristics dialog box (Structure mode) or Loads dialog box (Load 
Case mode) will appear. Enter common parameters in the blank fields and 
press OK. 
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Graphically Delete a Load Applied on an Element 
The [Delete] key is useful to delete a load applied on an element or on part of 
the structure. Only the load is deleted, not the element. However, the "Load 

Case" activation mode  must be activated beforehand.  

Analysis with Cable Elements (Pre-tensioned Members) 
To analyse cables (pre-tensioned members), make sure that they are properly 
split up because the non-linear calculation can create a loss in the numerical 
precision. It may cause discontinuities in the cable deflection diagram it has not 
been split up the right way. 

Eliminate Window Animation, Menus, and Lists on Win 98 
Users with Windows 98 will increase the performance of VisualDesign when 
analyzing, if they eliminate window animation, menus and lists. This animation 
option appeared with Windows 98 and it is harmful to the display of Analysis 
status in the Analysis dialog box.  

To eliminate window animation, go to Windows 98 Start menu, click on 
Settings, Control Panel, Display and Effects tab. Uncheck the box "Animate 
window, menus and lists". 
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Using Help 
Online Help is a reference tool that gives you a systematic protocol. You can 
ask for help by using one of the following procedures: 

• By selecting the Online Help command from Help menu. 

• By selecting the Help icon  from the Standard toolbar and by clicking 
on any sub-menu included in any VisualDesign™ menus. The Online Help 
will automatically opened at the item that you selected to give you the 
information you asked for. 

• By pressing the F1 key. This function will opened the online help at the 
topic corresponding to the dialog box, spreadsheet or contextual menu you 
were in when you pressed down this key. This function is the mostly used 
by users.   

The Online Help table of contents appears at the left part of the window once 
that the Online Help dialog box is opened. It includes all online help topics 
that you may find through book chapters. Each chapter corresponds to a 
module.  

To make your search quicker, select the Index tab and enter a key word in the 
appropriate field.  

See also 
Displaying a Help Window  
Help Command of Standard Toolbar 
Online Help Command from Help menu  
Printing a Help Section  

Online Help Command from Help menu 
• To access to On-line Help, select On-Line Help from Help menu. You 

will then have access to help summary. 

• To have access to one of the summary sections, click once on this section. 

• To have access to keywords, select the Index tab. 

For more information on the way to surf on On-line help, select the Using 
Help command from the Help menu. 

Using On-line Help 
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Contextual Help of Standard Toolbar 

  
The "Contextual Help" button of Standard toolbar 

 

Use the Help command to get help on any section of VisualDesign™. When 
you select the "Help" button from the Standard toolbar, the pointer appears as 
an arrow and a question mark. Click anywhere in the VisualDesign™ window, 
for example on another button of the toolbar. The help section for the element 
on which you have clicked will then appear. 

Analyses Procedures 
Analyses procedures (step by step operations) are available for all type of 
analyses that can be done with VisualDesign. Reach quickly these procedures 
by selecting the command Analyses Procedures in VisualDesign Help menu.  

Printing a Help Window 
To print a help section, select File Print. To print a help procedure, select 
"Print" from the help procedure window. 

Display a Help Window while in Working Session 
There is two types of help windows: the main window and the procedure 
window. The main window displays general information, while the procedure 
window shows the systematic procedure in order to carry out each function  

• To keep the Main help window on screen while in a working session: 

• Select "Help always Visible" from "Options" menu of Help window. 

• To keep the Procedure help window on screen while in a working session: 

• Select "Visible". 

Should the help window be in your way while in working session, click inside 
the document. The help window will go into the background. To recall the 
main help window to the foreground, push [Alt]+[Tab] keys. 
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Interface 
VisualDesign™ has Multi Document Interface (MDI) capabilities, which 
allows working on several projects simultaneously from the same application. 
Each project will have its own window. 

To work on a specific document, click on its title bar or select it from the 
Window menu. Do not click in the document window because it might lead to 
the selection or de-selection of an element.  

VisualDesign Databases 
VDBase.mdb: Shapes, Materials, Bolts, Reinforcement, Cables, Studs, Steel 
decks, and Soils data. 

Mobiles.mdb: Mobiles (Trucks) 

Seismes.mdb: Accelerograms  

See also 
Merge to current database  
Change current database 
VDBase.mdb Database  
Saving Styles and Colours  
Archiving Common Objects used in your Project within your .vd1 file  

Commum.mdb Database  
All information concerning a project configuration, except for data contained 
in Commun.mdb database, create a relational database saved in a Project.vd1 or .vdz 
file. 

The following tables are contained in the Commun.mdb file: 

• Table for physical attributes of line types (colour, style, thickness) and 
symbols (amplification factor, filling option); 

• Table of items included in list boxes (combo box); 

• Table for unit factors; 

• Table for font selection to print numbers; 

• Table including texts for messages with different identification numbers 
(ID); 

• Table for spreadsheets; 

Databases and Interface 
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• Table of menus; 

• Table of displayed language. 

ID Numbers 

ID numbers of personalized objects (Common menu) are random and superior 
to 100000. This prevents ID conflict when importing another database.  

Saving Styles and Colours 
Styles and colours are saved in Commun.mdb file. So are messages and units. 
Styles and colours can be modified using the View Options command from 
the View menu. 

You must also know that if you modify the colour of elements or certain units 
while working on a network, you will pass on this modification to all other 
users. 

Furthermore, all styles or colours modifications are automatically registered in 
the database even if you should decide not to save such modifications. 

See also 
Database Commun.mdb  

VDBase.mdb Database 
VisualDesign VDBase.mdb database includes all the objects that are 
composing the Common menu: Shapes, Materials, Bolts, Reinforcement, 
Cables, Studs, Steel decks, and Soils data.  

These pre-defined data cannot be edited but users can create their own by 
inserting lines at the end of spreadsheets.  

Users are allowed to choose another database at the opening of a VisualDesign 
project or to merge the current database with another one. Go to File menu in 
VisualDesign Start window and select either to merge the current VDBase.mdb 
database with another VDBase.mdb database or to change the current database 
by another one. 

See also 
Change or Merge the current database with another  
Database Commum.mdb  
Archiving common objects within your .vd1 or .vdz file  
Importing Common Objects to your Database  



C H A P T E R  1  B A S I C  P R I N C I P L E S  

CivilDesign inc. Engineering Software  1-23 

Archiving Common Objects within your .vd1 File 
All objects that are included in VDBase.mdb (shapes, materials and soils), 
Mobiles.mdb and Seisme.mdb databases are automatically saved, by default, 
within your project (.vd1 file).  

This option can be disabled in the Preferences tab of Project Configuration, 
at section "Archiving Common Objects".  

Importing Common Objects to your Database 
When you open a .vd1 or .vdz file that comes from another computer (from 
outside your network), it may contain "public" personalized objects that are not 
part of your VDBase.mdb file. VisualDesign will read this file and detect these 
elements.  

To inform users and to facilitate the understanding if what is going on, a 
spreadsheet will appear on your screen when the reading will be done. 
VisualDesign will let you choose a process for each detected object: either 
import the new object to your database or give a new name to the identical 
object that it found while reading the file, or cancel the importation.  

If you accept the importation of an object that has an identical name in your 
database, you can enter a new name for the imported element and 
VisualDesign will modify the input and use this name if there is no conflict.  

This table describes the columns that are part of the spreadsheet: 

Column Description Editing 

Type Type of  personalized common object that has 
been detected at the reading of  the file and 
which is not part of  the user database.   

No 

Number Number or name of  the detected common 
object. 

No 

Equivalent Object If  VisualDesign detected an object in your 
database that possesses identical parameters, the 
name of  this equivalent object will be written in 
this column.   

No 

Action VisualDesign can choose between two actions 
when the reading is completed: Import or Use 
equivalent.  

If  no equivalent object has been found, the 
Import option will be automatically selected.  
If  an equivalent object has been found, the 
option Use equivalent will be selected.  

Yes/No 
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Column Description Editing 

New Number Enter a new number/name to describe the 
imported object if  an identical name has been 
detected in your database. If  you do not enter a 
name, VisualDesign will rename this object by 
adding the term "%a" at the end of  existing 
name and will use it for this project file. 

Single click 

Change or Merge the Current Database 
Users are allowed to choose another database at the opening of a VisualDesign 
project or to merge the current database with another one. Three databases can 
be changed or merged with another similar one: VDBase.mdb, Mobiles.mdb 
and Seismes.mdb. 

Stay in VisualDesign Start window and go to File menu. You have the choice 
to either merge the current database with another one or change it by another 
one without loosing any information in the original database, including 
personalized objects. Then, select the database among the list in the File menu.  

At the next opening of the software, databases that have been specified in 
registries, at the installation of the software, will be read by default  

Type of Files Generated by VisualDesign 
Here is a description of file extensions that may be created by the software.  

vdz: File that is a renamed ZIP file and includes the VisualDesign project file 
.vd1 (input) and results file .vr1 (output) files. This zipped file is updated at the 
closing of a project and this option is available since version 5.4.  

vd1: VisualDesign project file. It is a renamed Microsoft Access (mdb) 
document. This file can be open with the Access Open command in order to 
consult its data and to generate particular reports. 

vr1: VisualDesign results file. It is also a renamed Microsoft Access (mdb) 
document and can be open with the Access Open command in order to consult 
its data and to generate particular reports.  

ldb: Temporary file created by Microsoft Access while a mdb, vd1 or vr1 file is 
open. It does not include any recoverable information about the project except 
the name of user(s) whom opened the project.  

vdk, vrk: vd1 and vr1 backup files created at the opening of a vdz file of the 
same name, in case the program fails at its opening. These files are deleted if 
the opening process is normally done. 
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vzk: vdz backup file that is created if the vdz file is open. It will be deleted if 
the closing process is normally done. 

log: Log file created at the stating of VisualDesign (present in directory 
C:\VisualDesign\User). The file name is the last eight characters of the MAC 
address network card, in hexadecimal. If a Sentinel key is used, the file name is 
the last eight characters of the key number.  

err: Renamed vd1 file when a writing error has occurred and is not recoverable.  

vpk: Temporary file created for the compaction (DAO compact database) of 
vd1 or vr1 file. This file is deleted if the compaction process is normally done.  

vbk: Backup file created when converting a project that was created with a 
previous version. This file contains the unconverted previous version of the 
document and it must be renamed .vd1 in order to be used. This file is not 
deleted.  

001, 002, 00x, etc.: Temporary file created at the saving of a project. It is 
deleted if the saving process is normally done.  

VDBase.bak, .1, .2, .x: VDBase.mdb files coming from a previous version. 
They are located in directory C:\VisualDesign\Sections. 

Mobile.bak, .1, .2, .x: Mobile.mdb file coming from a previous version. It is 
located in directory C:\VisualDesign\Sections. 
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Display Language 
VisualDesign™ is multilingual – French, English and Spanish. When you start 
the application for the first time, you must select the language you wish to 
operate the software. 

Thereafter, the application displays, by default, the language selected during the 
previous session. 

It is possible to switch from one language to another during one session by 
selecting Display Language from File menu. 

Modifying the Displayed Language 

• Select Display Language from File menu. 

• Select one of the available languages from the pull-down menu of the 
dialog box. 

• Press OK 

Display Language 
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Menus 
File Menu  
Edit Menu  
View Menu  
Common Menu  
Structure Menu  
Loads Menu  
Analysis Menu  
Results Menu  
Window Menu  
Help Menu  

File Menu 
The File menu contains all necessary commands to manage the files created 
with VisualDesign™, to print them and to choose the language of display too. 

With the File menu functions, you can create new documents, save your work, 
open existing documents or open one of the last documents used and quit the 
application. They also allow you to display your structure in graphic or 
spreadsheet form and view it before printing. 

It is also from the File menu that you will select the parameters of your project 
and switch from one language to another. 

See also 
New Project 
Open a Project 
Close the Project 
Save  
Save As 
Compact Document  
Import a DXF  
Export a DXF  
Import or Export a ProSteel File  
Import or Export a CadWork File  
Export a bitmap or screen selection as a bitmap  
Export an image as an EMF or a screen selection as an EMF  
Project Configuration 
Display Language 
Print 

VisualDesign Main Window 
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Print Preview 
Printer Configuration 
List of Latest Opened Files 
Exit  

Edit Menu 
The Edit Menu contains the functions that will allow the manipulation of the 
elements of your structure. 

You may cancel or repeat the previous entries, select elements and set their 
properties. You may also add elements, stretch, copy, paste, move, translate or 
rotate nodes, split up a member, search, quickly delete elements or their loads. 

The selected activation mode (Structure, Load Case, Load Combination, 
Envelope, Vibration Modes, and Design Results) displays a Properties dialog 
box if you click twice on an element. For example, the Properties dialog box 
displayed in active mode "Structure" for a member will allow you to set or 
modify the characteristics of this member. In active mode "Load Case", you 
may set or modify the specific loads for this member. In active mode "Load 
Combination", you will observe the internal strain and deflections diagrams. In 
activation mode "Envelope", you will get the envelope results of the selected 
member. 

See also 
Undo  
Redo  
Activate Selection Window  
Activate Elements  
Activate Mode  
Properties  
Default Spreadsheet  
Configure Copy/Paste  
Paste  
Add element  
Enlarge  
Move  
Translation  
Rotate  
Delete  
Find  
Split 
Select  
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View Menu 
View Options  
Camera  
Zoom Window  
Global Zoom  
Zoom +  
Zoom -  
Static Pan  
Dynamic Pan   
Previous Camera   
Next Camera  
Previous View  
Next View  
Animation  
Mask  
Unmask  
Perspective view  
Increase the Font size  
Reduce the Font size  
Diagrams  
Tools Toolbars  
Status Bar  

Common Menu 
The Common menu is the reflection of VisualDesign™ database called 
VDBase.mdb, which contains basic information about materials, shapes, 
reinforcement, cables, studs, bolts, steel decks, soils, and mobiles.  

This database may be customized if the user adds new shapes, materials, etc. in 
the appropriate spreadsheet. It can also be shared between users working on a 
network version of VisualDesign™. See topics Commum.mdb Databases and 
VDBase.mdb Database for important information. 

Mobile data (trucks) are saved in the Mobile.mdb database.  

These basic data cannot be edited, except the shape availability and the rebar 
bending shape’s number and aliases. However, all these spreadsheets can 
contain personalized data when a line is added at the end of the spreadsheet.  

Editing spreadsheets located in the Common menu 
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To create a new object (material, shape, rebar, cable, stud, steel deck, bolt, soil 
or mobile), add a line at the end of the spreadsheet. You will notice that the ID 
number is 5000 or more, meaning that it is a personalized object. Change the 
name and enter new parameters. (Example: copy & paste a type of stud, 
change the name and its length). 

The archiving function is activated by default (Preferences tab of Project 
Configuration). Therefore, all personalized objects are saved within your 
project file (.vd1 or .vdz).  

See also 
About Shapes spreadsheets  
Archiving Common Objects  
Importing Common Objects to your Database  
Spreadsheets included in the Common menu 
M A T E R I A L S  

Steel Materials Spreadsheet  
Concrete Materials Spreadsheet  
Timber Properties Spreadsheet 
Aluminium Materials Spreadsheet  
S H A P E S  

I Shapes Spreadsheet I  
C Shapes Spreadsheet  
HSS Shapes Spreadsheet  
L Shapes Spreadsheet  
2L Shapes Spreadsheet  
T Shapes Spreadsheet  
Z Shapes Spreadsheet  
WRF Shapes Spreadsheet 
V Shapes Spreadsheet 
Rectangular Shapes Spreadsheet  
Round Shapes Spreadsheet  
L (t, w) Sections Spreadsheet  
AASHTO Sections Spreadsheet  
NEBT Sections Spreadsheet  
Cold-Formed Sections Spreadsheet  
Built-up Sections Spreadsheet 
R E I N F O R C I N G  B A R S  

Rebar Steel Grades Spreadsheet  
Standard Reinforcing Bars Spreadsheet 
FRP Reinforcing Bars Spreadsheet  
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Meshes Spreadsheet  
Rebar Bending Shapes Spreadsheet  
C A B L E S  

Cable Steel Grades Spreadsheet  
Strands Spreadsheet  
Post-tensioning Mechanisms Spreadsheet 
S T U D S  

Studs Spreadsheet 
S T E E L  D E C K S  

Steel Decks Spreadsheet 
B O L T S  

Bolt Steel Grades Spreadsheet  
Bolts Spreadsheet 
S O I L S  

Rocks  
Cohesive Soils  
Granular Soils  
M O V I N G  L O A D S  

Trucks  

Structure menu 
T O O L S  

Axis Transformation  
Checking the Model  
Automatic Calculation of Kx, Ky, Kt and Kz  
Automatic Calculation of Rigid Extensions  
Automatic Calculation of Tributary Areas  
Foundation Transformation  
G E N E R A T O R S  

Building Generator  
Truss Generator  
The Slab & Mesh Generator  
Culvert Generator  
Abutment, Pier & Retaining Wall Generator  
Customized Options  
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S T R U C T U R A L  M O D E L I N G :  

Nodes Spreadsheet  
Supports Spreadsheet  
Spring Supports Spreadsheet  
Members Spreadsheet  
Plates Spreadsheet  
Floors Spreadsheet  
Slabs Spreadsheet  
Continuous Systems Spreadsheet 
Bolted Connections Spreadsheet  
S P E C I F I C A T I O N S :  

Sections' Groups  
The Steel Specifications Generator  
The Steel Specifications Spreadsheet  
The Concrete Specifications Spreadsheet  
The Timber Specifications Spreadsheet  
The Aluminium Specifications Spreadsheet  
Specifications for Shallow Foundations  
Specifications for Deep Foundations  
G R O U P S :  

The Steel Design Groups  
The Timber Design Groups  
Grouping Members  
Automatic Grouping (tool)  
Group of Plates - Shear Walls  
Group of Plates - Surfaces  
F O U N D A T I O N :  

Stratigraphical Profiles Spreadsheet  
Automatic Generation of Foundation Models  
Deep Foundation Models Spreadsheet  
Shallow Foundation Models Spreadsheet  
Foundation Modeling Wizard  
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Loads Menu 
T H E  L O A D  D E F I N I T I O N  S P R E A D S H E E T :  

Load Definition  
G E N E R A T I O N  T O O L S :  

Automatic Generation of Ice Loads  
Automatic Generation of Wind Loads  
Load Combination Generation Wizard  
Moving Load Case Generation Wizard  
L O A D S  S P R E A D S H E E T S :  

Forces on Nodes  
Support Settlements  
Concentrated Loads on Members  
Distributed Loads on Members  
Torsional Loads on Members  
Temperature Variations on Members  
Pressure on Plates  
Temperature Variation on Plates  
Concentrated Loads on Floors  
Distributed Loads on Floors  
L O A D  C O M B I N A T I O N S  S P R E A D S H E E T :  

Load Combinations Definitions  
E N V E L O P E S  S P R E A D S H E E T :  

Definition of Envelopes 
M O V I N G  L O A D S  S P R E A D S H E E T S :  

Moving Load Cases  
2D Axle Factors  
Moving Load Envelopes  
S E I S M I C  D I R E C T I O N S  S P R E A D S H E E T S :  

Seismic Directions (Linear)  
Seismic Directions (Non-linear)  
G E N E R A L  D Y N A M I C  L O A D I N G S  S P R E A D S H E E T :  

General Dynamic Loading Diagrams  
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Analysis Menu 
Modal Analysis  
Spectral Analysis  
Time History Analysis  
Non-linear Time History Analysis  
Moving Loads Analysis  
Static Analysis  
Analysis and Design  

Results Menu 
L O A D  C O M B I N A T I O N S  R E S U L T S :  

Summary  
Node Displacements  
Reactions at Supports  
Internal Forces in Members  
Internal Forces in Members (min./max.)  
Internal Stresses in Members  
Internal Stresses in Members (min./max.)  
Internal Forces in Triangular Plates  
Internal Forces in Rectangular Plates  
Tower Load Combination Results  
Stresses in Composite Beams  
E N V E L O P E S  R E S U L T S :  

Node Displacements  
Reactions at supports (min/max)  
Reactions at supports (min/max) and Critical Load Combinations  
Diagram of Internal Forces and Deflections  
Diagram of Internal Forces and Deflections (min./max)  
Min./Max Internal Forces and Deflections for Design Groups  
Stress Variations in Member   
Internal Forces in Triangular Plates  
Internal Forces in Rectangular Plates   
Tower Envelopes Results  
M O D A L / S P E C T R A L  A N A L Y S I S  R E S U L T S :  

Frequencies  
Information on Levels according to Seismic Directions  
Node Displacements (Vibration mode)  
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T I M E  H I S T O R Y  A N A L Y S I S  R E S U L T S :  

Displacement at Nodes vs. Time  
Reactions vs. Time  
Forces vs. Time  
Forces vs. Displacement  
D E S I G N  R E S U L T S :  

Steel Design Results  
Bolted Connection Design Results  
Concrete Design Results  
Timber Design Results  
F O U N D A T I O N  R E S U L T S :  

Footing Results  
Reinforcement in Footings  
Pile Results  
Pile Reactions  
B I L L  O F  M A T E R I A L S :  

Bill of Materials (Members)  
Bill of Materials (Plates)  
Bar List (2-way slabs) 
Bar List (Continuous Systems) 

Window Menu 
VisualDesign™ allows you to visualize parts of your project from different 
angles simultaneously by using different zoom options. Open the additional 
windows from within the main window.  

You will also learn how to rearrange windows shrunk into icons and how to 
switch from one window to another when they are covering the whole page or 
they overlaid each other. 

See also 
New Window  
Cascade  
Tile Horizontally  
Tile Vertically  
Rearrange Icons  
Refresh  
List of Open Windows  
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Help menu 
Using VisualDesign On-Line Help  
Contents  
How to Use VisualDesign  
Toolbars and Icons Definition  
Using Spreadsheets' Contextual Menu  
Keys to Control the View on your Screen  
Print Functions  
Structural Modeling  
Analysis Procedures  
Technical Support  
A Few Tricks  
FAQ  
Disclaimer  
About VisualDesign  
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Shortcut Keys - Main Window 
Menu Command Shortcut Key 

File New 
Open 
Save 
Graphic Printing 

Ctrl+N 
Ctrl+O 
Ctrl+S 
Ctrl+P 

Edit Undo 
Redo 
Properties 
Default Spreadsheet 
Copy 
Paste 
Translation 
Delete 
Create a Selection 
Choose a Selection 
Invert Selection 
Cancel Selection 
Multiple Split 
Pin Connection 
Rigid Connection 
Split at Exact Position 
Split according to Node 

Ctrl+Z 
Ctrl+A 
Ctrl+T 
Ctrl+H 
Ctrl+C 
Ctrl+V 
Ctrl+B 
[Delete] 
Ctrl+L 
Ctrl+K 
Ctrl+I 
[Escape] 
Ctrl+M 
Ctrl+X 
Ctrl+R 
Ctrl+E 
Ctrl+Y 

Edit / Activate 
Element 

Node 
Support 
Member 
Continuous System 
Triangular Plate 
Rectangular Plate 
Floor 

Ctrl+1 
Ctrl+2 
Ctrl+3 
Ctrl+4 
Ctrl+5 
Ctrl+6 
Ctrl+7 

View View Options 
Camera 
Zoom window 
Global Zoom 
Zoom + 
Zoom – 
Dynamic Pan 
Previous View 
Mask 
Unmask 
Perspective View 

O 
C 
Z 
G 
+ 
- 
P 
V 
M 
D 
S 

Structure Grouping Members Ctrl+G 

Window Refresh F5 

Help Online Help F1 
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Toolbars give access to the most frequently used commands. When you open 
VisualDesign™, all toolbars selected during the previous work session will be 
posted by default. 

See also 
Description of Toolbars and Icons  
Displaying or Hiding Toolbars and Tool tips 
Moving and Sizing Toolbars  

Description of Toolbars and Icons 
VisualDesign™ Toolbars and Icons: 

Toolbars Icons 

Standard 

  

 

New– Open– Save– Copy– Paste– Undo– 
Redo– Print – Print Preview– Help 

Cursor 

  

 

Extended Window– Restricted Window– Add 

Elements 

  

 

Node – Support – Member – Continuous 
System - Plate – Floor  

Edit 

  

 

Properties– Move– Translate Rotate– Find– 
Delete –Create a Selection  

Toolbars 



C H A P T E R  1  B A S I C  P R I N C I P L E S  

CivilDesign inc. Engineering Software  1-39 

Toolbars Icons 

View 

  

 

Camera– Previous Camera– Next Camera– 
Previous View– Next View– Zoom Window– 
Global Zoom- Zoom +–  Zoom -  – Static 
Pan– Dynamic Pan– View Options– Increase 
font size– Decrease font size– Animation– 
Mask– Unmask 

Diagrams 

  

 

Automatic Scaling – Increase Amplitude – 
Reduce Amplitude – Display Numerical Values  

Tools 

  

 

Building Generator– Arc Generator – Truss 
Generator– Modal Analysis – Spectral Analysis 
– Time History Analysis – Non-linear Time 
History Analysis – Moving Load Analysis – 
Static Analysis – Analysis and Design 

Split/Join 

  

 

Split – Multiple Split – Split with pin connection 
– Split with rigid connection – Split at exact 
position – Split according to node– Join - 
Connect  

Activation 

  

 

Title Selection – Structure mode – Load Case 
mode – Load Combination mode – Envelope 
mode – Frequency mode Shapes – Design 
Results mode – Rebar Placement mode  

View Options Selection tree This toolbar is a selection tree that includes the 
view options as you can find them in the View 
Options dialog box. Options are grouped per 
element. 
To activate this toolbar, go to View menu / 
Toolbars and check the "View Options" box.  

See also 
View Options Selection tree  
View Options dialog box  
Displaying or Hiding Toolbars and Tool tips 
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Moving and Sizing Toolbars  
Toolbars  

Displaying or Hiding Toolbars and Tool tips 
Toolbars and tool tips may be displayed or hidden during a work session.  
P R O C E D U R E :  

• Select Toolbars from the View menu. 

• In the dialog box, tick off the toolbars that you wish to display. 

• If you wish to display the toolbar icons’ on-line description, activate the 
"View" radio button under Tool Tips.   

• If you do not wish to display the description, activate the "Hide" radio 
button. 

• Press "OK" to validate your choice or "Cancel" to annul the modifications. 

Moving and Sizing Toolbars 
You may move your toolbar by clicking on the title bar and dragging it to the 
new location.  

Your toolbars can be positioned beneath the Menu bar, above the Status bar, 
or vertically on the left or right side of the screen. 

Twinning Toolbars Functions 
Activation modes, Elements toolbar and Properties function: 

In the Structure activation mode, activate an element on the Elements toolbar 
and click on the function Properties . It will allow you to display and edit 
activated element characteristics or common characteristics of this type of 
element if you selected many of them.  

In the Load Case activation mode, the Properties function will display Loads 
dialog boxes so that you can enter loading data for the selected elements, and 
for the load case that you chose in the "Title Selection" drop-down list box.  

In the Load Combination activation mode, the Properties function will supply 
the results for the chosen load combination (Title Selection drop-down list box 
of Activate toolbar) and for the selected elements (nodes, supports, members, 
etc.). 

In the Envelope activation mode, the Properties function will supply the 
results for the chosen envelope (Title Selection drop-down list box of Activate 
toolbar) and for the selected elements (nodes, supports, members, etc.). 
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In the Design Results activation mode, the Properties function will supply the 
steel design or timber design results for the selected elements (nodes, supports, 
members, etc.). 

Activation modes, Elements toolbar and Edit toolbar: 

  
Activate the Structure mode and activate a type of element on the Elements 
toolbar to add an element of this type or to delete this element.  

Also, in the Structure mode, use one of the functions of Edit toolbar (Move, 
Rotate, Search and Delete) after having activated a type of element on the 
Elements toolbar.  Only nodes can be rotated or moved. (Members that are 
attached to these nodes will also be moved). 

The Delete function twinned to the Load Case activation mode will delete the 
loads that were applied to the selected element. 

See also 
Displaying or Hiding Toolbars and Tool tips 
Moving and Sizing Toolbars  
Description of Toolbars and Icons  
Toolbars   

Status bar 
Status bar is located in the lower part of VisualDesign™ program window and 
provides information about current document or current operation. In 
addition, when elements are selected on the screen, the status bar displays the 
type and number of selected objects.  

See also 
Displaying or Hiding the Status bar 
Reading the Status bar 
Reading the Status Bar 
The status bar offers a brief description of the command or toolbar button 
chosen. In the case of a command with longer execution time, the status bar 
will give you a message explaining that the operation you chose is in-progress. 

Displaying or Hiding the Status Bar 
By default, the status bar will be displayed on the screen. To hide it, choose 
Status Bar from the View menu. 

The Status Bar option from the View menu is activated when you tick it off. 
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The Diagrams Toolbar 

   
The "Diagrams" toolbar of VisualDesign main window 
 
Use the Diagrams toolbar functions to size displayed objects, forces or 
diagrams that are shown on the screen. These functions are available in 
"Structure", "Load Case", "Load Combination", "Envelope" or "Results" 
modes. Display diagram numerical values by selecting the function "Numerical 
Values". 

This toolbar includes the following functions: 

Automatic Diagram Scaling  
Increase Diagram Amplitude  
Reduce Diagram Amplitude  
Numerical Values  
G R A P H I C  R E S U L T S  F O R  F I N I T E  E L E M E N T S  R E S U L T S :  

When stress/force contours are displayed, press an icon on Diagrams toolbar 
to open the tool Scaling for Intervals.  

Automatic Diagram Scaling 

   
The "Automatic diagrams scaling" icon of Diagrams toolbar 
 
With "Structure" in activated mode, automatically adjust the size of the 
displayed objects (nodes, supports, etc) using the automatic diagrams scaling 
button. 

With "Load Case" in activated mode, automatically adjust the size of the 
displayed load case. 

With "Results" in activated mode, automatically adjust the size of the displayed 
diagrams. 

Increase Diagram Amplitude 

   
The "Increase diagram amplitude" icon of Diagrams toolbar 

 

Use this button to increase the size of the objects, applied loads or displayed 
diagrams, according to the selected activation mode. 
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Reduce Diagram Amplitude 

   
The "Reduce diagram amplitude" icon of Diagrams toolbar 

 

Use this button to decrease the size of the objects, applied loads or displayed 
diagrams, according to the selected activation mode. 

Numerical Values 

   
The "Numerical Values" icon of Diagrams toolbar 

 

Use this button to display numerical values associated to applied loads or 
displayed diagrams, according to the selected activation mode.  

Scaling for Intervals 
When coloured stress/force contours are displayed for consulting finite 
elements results, press an icon on Diagrams toolbar to open the Scaling for 
Intervals dialog box.  

This tool allows modifying intervals (values and number of colours) for the 
displayed legend. 

  
Select a number of colours for the display (9, 25, 45, 105, 225, 525 or 1021).   

The dialog box is composed of two scroll bar sliders that allow the scaling of 
intervals from maximum or minimum values when displaying stress/force 
contours (legend). Each scroll bar is subdivided into 100 units. Marks indicate a 
subdivision of 25 units. To move the indicator, click on it and slide the mouse 
at the right or left on the scroll bar. Displayed intervals will be increased or 
reduced as a result. 

The Manual Mode: 
When the Manual mode is activated, the absolute minimum and maximum 
values will still be displayed in the coloured legend but the specified value (min 
and max) will be used as upper and lower limits for the critical zone. If scroll 
bar sliders are used to modify the displayed values for intervals, the min and 
max specified values would be used for the modification instead of absolute 
values.  
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Therefore, critical zones (red or blue) are always delimited by the absolute 
value and specified value if the Manual mode is activated. If sliders are used, the 
modification will be done according to specified values.  

The legend displays the lower and upper limits for the two critical zones and 
intermediate zones (colours) display the middle value of the interval.  

Shortcut Keys: 

Use keyboard shortcut keys to adjust intervals when your cursor is located in 
the Max or Min scroll bar.  

Shortcut key Action 

[Home] The [Home] key moves the indicator at the 
beginning of  the scroll bar slider. 

[End]  The [End] key moves the indicator at the end 
of  the scroll bar slider. 

→  This arrow moves the indicator one unit right. 

←  This arrow moves the indicator one unit left. 

See also 
Grouping plates  
The Results FE tab  
Interpreting Plates Analysis Results  

View Options Toolbar 
Display the View Options toolbar to quickly verify the structural model and 
results. This toolbar, which is a selection tree, include the same options as the 
View Options dialog box and will be posted at the right of the screen.  

To activate or hide this toolbar, go to View menu and select Toolbars. Check 
or uncheck the "View options" toolbar.  

The View Options selection tree is divided into many roots, which correspond 
to element (Members, Nodes, Floors, and Plates) in such a way that options are 
grouped together and can be selected quickly. Display options for results are 
also available for each element. You will also find the Foundations root and 
General root.   

See also 
View Options Dialog Box  
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Units and Decimals 
Units and decimals can be modified through dialog boxes by right clicking in a 
field that contains units. A contextual menu appears, which displays the 
command Units and Decimals, as shown below. Place the cursor on the 
command and a list box will display available units and decimals. Click on a 
listed unit or decimal.  

Contextual menu 

 
Units and decimals are also editable in spreadsheet cells through the 
spreadsheet contextual menu. Refer to topic Change Units (Spreadsheet 
contextual menu).  

 

Units 
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Global Axis System 
Set the global axis system through the Preferences tab of Project Configuration 
dialog box (File menu). 

Displaying or Hiding the Global Axes 

• To hide the global axis system, go to the Attributes tab of View Options 
dialog box and disable the display option. 

• You may modify the colour of global axis system through the Colours tab.  

See also 
The Member Element  
The Colours Tab  
The Attributes Tab 

Local Axis System 
Displaying Member Local Axis System 

• Select the Attributes tab of View Options dialog box. In the Member 
zone, activate the Local Axis System option. 

The local y-axis, which is the weak axis, is the longest of x and y local axes. The 
local z-axis always points towards node j to facilitate the localization of 
member’s incidence nodes.  

  

• To modify the colour of local axes, select the Colours tab and expand the 
General title until you reach Member.  

See also 

Axis System 
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Convention- Forces in Members  
The Member   
The Attributes Tab 
The Colours Tab  
Display Member Characteristics  
Displaying the Floor Local Axis System 

• Go to the Attributes tab of View Options dialog box and activate the 
Local Axis System option in the "Floors" section.   

By default, point (0,0,0) corresponds to the floor’s node i. Local y-axis always 
points towards node j.  

 
See also 
Floor Characteristics  
The Attributes Tab  
Display Floor characteristics 
Displaying the Plate Local Axis System 

• Go to the Attributes tab of View Options dialog box and activate the 
option Local Axis system in the Plates section. 

When the local axis system of a plate is displayed, point (0,0,0) corresponds to 
the plate’s Node i. 
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VisualDesign Dialog Boxes 
VisualDesign dialog boxes are used for entering and modifying data for a single 
element or many of them. We recommend using dialog boxes for inputs 
because they are more explicit than spreadsheets.  

Bi-directional Data Exchange 
Generally, data entered in dialog boxes are transferred into corresponding 
spreadsheets, and vice-versa, for elements characteristics and loads. 
Spreadsheets are useful for consulting and sorting data or to modify data in a 
quick way, using spreadsheets' contextual menu.  

Calling up a Dialog Box 
A dialog box is called up when double clicking on an element with any 
Activation mode.  

It can also be called up by clicking once on an element (or many of them) and 

by selecting the Properties icon  on Edit toolbar or in Edit menu.  

The dialog box that will appear on screen depends on the Activation mode and 
activated element (Node, Member, Floor, or Plate): 

• The Structure  activation mode calls up Element Characteristics dialog 
boxes. 

• The Load Case  activation mode calls up Loads dialog boxes.  

Edit Functions 
A dialog box is also used when some functions or tools are called up such as 
Copy/Paste, Translation, Rotate, and Automatic Generation of a 
Building, among others.   

Dialog Box's Contextual Menu 
Numerical values included in VisualDesign dialog boxes can be edited through 
a contextual menu (right click). This menu is composed of the following 
functions: Undo, Cut, Copy, Paste, Delete, Select all, Units and Decimals. 
These functions cannot be applied to list box.  

Modify Units in a Dialog Box 
Please refer to Units and Decimals  

Dialog Boxes 
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Spreadsheet Functionalities 
VisualDesign™ spreadsheets let you copy and paste data to and from a 
commercial spreadsheet.   

The spreadsheets may be printed out directly without using the Print 
Spreadsheet command on the File menu. You can choose to display or hide 
columns, this way formatting your spreadsheet print output. In the contextual 
menu of the spreadsheets, you will find different options allowing you to 
change measuring units, launch search operations, replace data, apply 
arithmetic operations, and quickly modify alphanumerical numbers using auto-
numbering.  

You may insert, delete, or sort spreadsheet lines.  

See also 
Shortcut keys  
Left mouse button 
Spreadsheet's Contextual Menu 
Selected Elements and Spreadsheet Contents 
Short cut Keys  
Inserting a Line in a Spreadsheet  
Print spreadsheets (File Menu)  

Shortcut Keys (Spreadsheets) 
VisualDesign™ lets you perform certain operations with the keyboard control 
keys. 

Activate shortcut key To 

ENTER Exit the active cell while validating the new input 
value. The cursor will move to the next right-hand 
cell. 

ESC Stop editing an active cell and replace its content by 
the previous value. 

INS Insert a line above the cursor. 

Arrow keys Move the cursor one cell at a time (right, left, up, 
down) 

CTRL +↑ 
CTRL + ↓ 

Move the spreadsheet up or down while keeping the 
initial cell selected. 

Spreadsheets 
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Activate shortcut key To 

Mouse scroll wheel Move the spreadsheet up or down while keeping the 
initial cell selected. 

CTRL + → 
CTRL + ← 

Move the spreadsheet right or left while keeping the 
initial cell selected. 

PgUP 

PgDN 

Move a spreadsheet forward or backward by as many 
lines as indicated on screen. 

CTRL + Scroll wheel Move a spreadsheet forward or backward by as many 
lines as indicated on screen. 

HOME 

END 

The HOME key moves the cursor to the top of  the 
screen; the END key moves it down to the bottom of  
the screen. 

CTRL + HOME 

CTRL + END 

Press CTRL HOME to display the beginning of  a 
spreadsheet from Line 1. Press CTRL+ END keys to 
display the last line of  the spreadsheet. 

Left Mouse Button 
The left mouse button is a selection button. 

To Do the following 

Select a cell Click the cell with the left mouse button. 

Select more cells 
consecutively 

Click the first cell with the left mouse button, keep the 
button pressed and drag the mouse diagonally across to the 
last cell. 

Select an entire 
column 

Click the column header with the left mouse button. 

Select an entire line Click the line header with the left mouse button. 

Select the entire 
spreadsheet 

Click the "Select All" button in the upper left corner of  the 
spreadsheet. 

Edit the cell content Click the cell and enter the new data. 
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Selected Elements and Spreadsheet Contents  
When elements of the same type are selected on screen, the spreadsheet will 
include selected elements only. However, if no element is selected, the 
spreadsheet will include all elements when the spreadsheet will be called up.  

Elements that are selected in a spreadsheet will be selected on screen when the 
spreadsheet will be closed. This functionality applies for Structure, Load case, 
Load combination, Envelope, Vibration mode, and Design Results Activation 
modes.  

Default Spreadsheet 
Use the function Default Spreadsheet function of Edit menu or use the 
short-cut key [Ctrl]+H to quickly call up a default spreadsheet instead of 
doing it through VisualDesign™ different menus (Structure, Loads or Load 
Combinations). The "default " spreadsheet that will be displayed depends on 
the activation mode you are working in.  

If elements were selected on your screen, the default spreadsheet will include 
these elements only. However, if none were selected, all elements will be 
included. 

Structure activation mode:  

• Select a type of element on the Element toolbar and use this function to 
call up the corresponding spreadsheet that includes data and coordinates. 

E X A M P L E :  

• Activate the "Node" icon on the Element toolbar. 

• Select all nodes or few of them. 

• Select the Default spreadsheet function under Edit menu or use the short-
cut keys [Ctrl]+H. 

In the "Load Case" activation mode:  

• If you choose a load case in the Title bar of Activation toolbar: the default 
spreadsheet corresponds to loads applied on the type of element that you 
activated and selected on your screen. 

• If you have not chosen any load case in the Title bar: the default 
spreadsheet will correspond to the Loads Definitions spreadsheet. Add 
new type of load cases. 
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In the "Load Combinations" activation mode:  

• If you activated a load combination on Activation toolbar, the default 
spreadsheet corresponds to Internal Forces - Members if you selected a 
member. If another element is selected, the corresponding results 
spreadsheet will be open. 

• If you have not chosen any load combination in the Title bar: the default 
spreadsheet will correspond to the Load Combination Definitions 
spreadsheet. Add new load combination, if desired. 

In the "Design Results" activation mode:  

• Selected members and the default spreadsheet will correspond to the 
Design Results spreadsheet (Steel, Concrete, or Timber). 

Spreadsheet's Contextual Menu 
A contextual menu is accessible from all VisualDesign spreadsheets, through a 
right click. It includes the following functions: Details, Change Units, Find, 
Auto-numbering, Modify, Replace, Sort, Sort Up, Sort Down, Selection of 
Contiguous Items, Insert, Delete, Copy, Copy with Titles, Paste, Paste with 
MSAccess, Duplicate, Mask, Display, Column Width, Page Layout, Print and 
Print All Tabs.  

If functions are shaded, it means that they are not available. It depends on the 
selected objects (a line, a column, etc.) 

Details 
Select this command to access details related to the selected elements. If the 
command is shaded, it means that there is no detail available for this particular 
element. 

Change Units 
Units can be changed within dialog box or spreadsheet.  A change of units in a 
spreadsheet column will affect the same type of data included in another 
spreadsheet. This exchange is defined as a bi-directional: Spreadsheet <–> 
Dialog box. 
P R O C E D U R E :  

• Select the column by clicking in its title and right click to open the 
contextual menu. 

• Choose Change Units.  

• In the Change Units dialog box, select one unit in the scroll list. 
Indicate the number of decimals to be used with real numbers.  
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• Press OK to validate your choice.  

R E S T R I C T I O N :  

Applicable to columns having units.  

Find 
This function only applies to alphanumeric numbers and text items.  
P R O C E D U R E :  

• Use the left mouse button to select a cell in the column where you want 
to locate an element or a value. Press the right mouse button to open 
the contextual menu.  

• Choose Find.  

  
• In the Find dialog box, enter the word or alphanumeric number you 

are looking for. Activate the Whole word only option if you want 
VisualDesign™ to find the specified value as a "whole" rather than as a 
"part". Activate the Match Case option to include upper- and lower- 
cases as search criteria. In the "Direction" section, select the Up or 
Down radio button to direct the search upwards or downwards from the 
insertion point. 

• When there is more than one value or element found with the search 
criteria, VisualDesign™ will activate the "Next" button allowing you to 
look at other data. 

R E S T R I C T I O N :  

Not applicable to columns with integral or real numbers. 
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Autonumbering 
P R O C E D U R E :  

• Select the column title to select the whole column or select a group of 
cells that you want to be numbered.  

• Right click to open the contextual menu. 

• Choose Auto numbering. 

   
• To create a list of alphanumeric numbers, enter the starting number 

and increment. Prefix and suffix are optional.  

• To create a sequential list of real and integral numbers, enter the 
starting number and the increment and press OK. 

Option "Padding of numerical characters" 

This option avoids producing identical numbers for copied/pasted elements, 
by replacing the identical part by its ID number, which is specific to each new 
element.  
R E S T R I C T I O N :  

Not applicable to a range of cells belonging to different columns. 

Modify 
P R O C E D U R E :  

• Select a cell, a group of cells, or a column in which you want to apply 
an arithmetic operation.  

• Right click to open the contextual menu. 

• Choose Modify. 



C H A P T E R  1  B A S I C  P R I N C I P L E S  

CivilDesign inc. Engineering Software  1-55 

   
• In the dialog box, activate the radio button corresponding to the 

arithmetic operation you want to apply. Type in the number that will 
affect the selected cells. 

• Click OK. 
R E S T R I C T I O N S :  

Applicable to real numbers only. Not applicable to a range of cells belonging to 
two different columns. 

Replace 
P R O C E D U R E :  

• Select a cell, a group of cells, or a column in which you want to replace 
values by another one.  

• Right click to open the contextual menu. 

• Choose Replace. 

   
• Enter a new value in the Replace Values dialog box. 

• Click OK. 
R E S T R I C T I O N S :  

Not applicable with ID numbers or alphanumerical numbers. 

Not applicable to a range of cells belonging to two different columns. 
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Sort  
P R O C E D U R E :  

You may sort the whole spreadsheet or selected lines. 

• To sort a whole spreadsheet, use the left mouse button to select a cell.  

• To sort a restricted number of lines, choose a range of cells or line 
headers targeted by the sort operation.  

• Right click to open the contextual menu. 

• Choose Sort. 

   
• In the Column dialog box, select columns (up to 5 columns can be 

added in a sorting) according to the priority you want to get, and specify 
an ascending or descending order. 

• Click OK. 

Sort Up & Sort Down 
You may sort values in a column, up or down, numerically or alphabetically. 
P R O C E D U R E :  

• Click a cell located in the column that you wish to sort or select the 
whole column by clicking on its title.  

• Right click to open the contextual menu. 

• Choose Sort Up or Sort Down. 
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Selection of Contiguous Items 
To select identical items, they must be contiguous in the spreadsheet. When 
there is no selection in the spreadsheet, this function allows finding and 
highlighting identical items. It can be useful for consulting modeling data or 
results.  
P R O C E D U R E :  

• Click in a cell and right click to open contextual menu. 

• Choose Selection of Contiguous Items. The search begins at the 
pointed cell and ends at the last identical item.  

Select Identical Items in a Spreadsheet 
Use the contextual menu function Selection of Contiguous Identical Items 
to group elements in the spreadsheet. Select these lines and click OK to exit 
the spreadsheet.  

Example:  

Open the Steel Design Results spreadsheet and sort member shape W310x39. 
Then, use function Selection of contiguous identical items to select all 
W310x39. Click OK. These members will be highlighted on the screen. Go to 

Edit menu and select Select/Create a Selection or press icon . Give a 
name to this selection. You can call back this selection any time. 

See also 
Create a selection (Personalized Selections of Elements)  
Insert 
P R O C E D U R E :  

• Select the same number of lines you want to insert.  

• Right click to open the contextual menu. 

• Choose Insert. 

• New lines will be inserted above the group of selected lines. 
N O T E :  I N S E R T I N G  A  L I N E  I N  A N  E M P T Y  S P R E A D S H E E T  

• Use the left mouse button to select the first line header of the empty 
spreadsheet. 

• Press the [Insert] key or right click to open the contextual menu and 
choose "Insert". 

• To insert more lines, position the cursor in the end cell of first line, 
then press [Enter]. 
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Delete 
P R O C E D U R E :  

• Select the line(s) to be deleted.  

• Right click to open the contextual menu. 

• Choose Delete. 

Copy 
P R O C E D U R E :  

• Select the line(s) that you want to copy. 

• Right click to open the contextual menu. 

• Choose Copy. 

Copy with Titles 
VisualDesign allows to copy cells along with corresponding units to another 
spreadsheet that does not belong to VisualDesign™. 
P R O C E D U R E :  

• Select the line(s) that you want to copy. 

• Right click to open the contextual menu. 

• Choose Copy with titles. 

• Open the other spreadsheet and paste data. 

Paste 
P R O C E D U R E :  

• Move the cursor up to the cell where data will be pasted. 

• Right click to open the contextual menu. 

• Choose Paste. 

Paste with MSAccess 
The software allows pasting data from an MS Access spreadsheet to any 
VisualDesign spreadsheet. 
P R O C E D U R E :  

• Select the line(s) in the MS Access spreadsheet. 

• Back in VisualDesign spreadsheet, move the cursor to the appropriate 
place. Right click to open the contextual menu. 

• Choose Paste from MS Access. 
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Duplicate 
This function is available in spreadsheets that are composed of tabs. These tabs 
include related parameters that belong to the master spreadsheet. This function 
allows you to copy a line along with the data included in all the other tabs.  

Example: This function will copy a load combination along with its load 
factors. 
P R O C E D U R E :  

• Open a spreadsheet that is composed of many tabs. 

• In the master spreadsheet, usually the first one, select the line that you 
want to copy along with data included in other tabs. 

• Right click to open the contextual menu. 

• Choose Duplicate. 

• The copied line will be added at the bottom of the spreadsheet. Edit 
the name or number to avoid identical data. 

Mask 
You are allowed to hide one or more columns to get an uncluttered 
spreadsheet or to select columns for printing. 
P R O C E D U R E :  

• Click the column’s header with the left mouse button to select the 
whole column. 

• Right click to open the contextual menu. 

• Choose Mask. 

• To display the column(s) again, choose function Display in contextual 
menu. 

Display 
P R O C E D U R E :  

• To display the hidden columns, click the right mouse button to access 
the contextual menu and choose Display.  

• Click on column titles that you want to display in the spreadsheet, while 
keeping down the [Ctrl] key. If you want the whole column to be 
displayed, push down the left mouse button while you move down the 
cursor. 
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Column Width 
You can define column widths to format your spreadsheet. 
P R O C E D U R E :  

• Click the column header with the left mouse button to select the whole 
column.  

• Right click to open the contextual menu. 

• Choose Column Width. 

   
• In the dialog box, enter the desired width (between 1 and 255 

characters) and press OK or choose a default value by clicking the 
"Default width" button.  

• Use the same procedure for other columns. 

Note that the modifications done to column widths will be saved for the next 
sessions until you change them. 
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Page Setup 
Before printing a spreadsheet, select this function to fix printing attributes. 
P R O C E D U R E :  

• Click a cell and right click to open the contextual menu. 

• Choose Page Setup. 

   
• In the Page Setup dialog box, enter the layout options such as 

numbering, margins, and font in the dialog box. 

Note that the modifications will only be visible at the printing. 

Print 
You may print the whole spreadsheet or only a part of it. If you want to print 
only a part, you must first select the cells or the lines to be printed. 
P R O C E D U R E :  

• Select the whole spreadsheet or a part of it. 

• Right click to open the contextual menu. 

• Choose Print. 

Print All Tabs 
This function allows you to print all the tabs that are composing a spreadsheet, 
as the command Print / Spreadsheets in the File menu would do.  
P R O C E D U R E :  

• Click in any cell in the first spreadsheet. 

• Right click to open the contextual menu. 

• Choose Print All Tabs. 
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New Project 

  
The "New Project" icon of Standard toolbar 
 
When activated, the New Project function opens a blank document, 
temporarily named Projet1. It is then recommended to select the Project 
Configuration command from the File menu to register identification data 
for this new project (project name and number, selected units, type of analysis, 
selection of the gravitational axis, etc.). 

You can create a new project at any stage of your work session. Select the New 
function from the File menu or click on the "New Project" icon from the 
Standard toolbar. 

See also 
Project Configuration  
Creating a New Project 
Create a new project by doing one of the following: 

• Select the New function from File menu. 

• Click the icon  on Standard toolbar. 

Open a Project 

  
The "Open Project" icon of Standard toolbar 
 
To open an existing document on which you have worked recently, select it 
from the latest opened files that appear at the bottom of the File menu. 

You can also access an existing document by selecting the Open function of 
File menu or by clicking on the "Open Project" icon of the Standard toolbar. 

When the Open dialog box is displayed on the screen, select the name of a 
document from the "Name" list, another disk drive, another directory, or 
another "type" of file. 

If some shapes or materials are missing at the opening of a project, the user has 
the choice to cancel the reading or to continue and lose results. However, this 
will not happen if a user saved all common and personalized objects used in his 
project with option Archiving common objects of Preferences tab (Project 
Configuration). This option saved all objects within the .vd1 or .vdz file.  

 

Managing your Project 
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See also 
Preferences Tab  
Opening an Existing File 

• Do one of the following: 

• Click the icon  of Standard toolbar 

• Select File/Open 

• In the "File Name" zone, type or select the name of the document to open. 

If the document you want to open is not on the list, select a different disk 
drive, directory or file, or select another type of file in the "Types of Files" 
zone. 

• Select "OK". 

Save 

  
The "Save" icon of Standard toolbar 
 
From time to time, during your project at hand, the program will ask you to 
save your project. 

It will happen when: 

• You have modified some elements of the structure, load cases, load 
combinations or envelopes and you launched an analysis. 

• You changed a parameter in the Preferences tab or Analysis tab (Project 
Configuration dialog box). If the number of member subdivisions have 
changed, VisualDesign™ will ask you to confirm the load combination. 

• You changed one of the parameters for the design of footings in the 
Foundations tab (Project Configuration dialog box). 

However, we recommend that you regularly save your project during a working 
session. 

Saving Current File 

• Use one of the following procedure: 

• Click the icon  of Standard toolbar. 

• Go to File/Save. 
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Save As 

  
The "Save" icon of Standard toolbar also gives access to the "Save as" function 
 
VisualDesign™ uses the features of the operating systems Windows NT™ and 
Windows 95+™: 

Select File/Save As or click on the "Save" icon in the Standard toolbar to save 
a new document. The File/Save As function is often used to save the results 
of one structure under one name and create a copy of the same structure under 
another name which can then be modified and re-analyzed. 

Note that the "Save" icon gives access to the File/Save As dialog box when it 
is the first time you save a new document. 

File and directory names may have up to 256 characters, including extensions. 
File names may contain capital or small characters, except for the following 
symbols: *  "       \  /  < >. Extensions must be .vd1 or .vdz. Extension .vdz is 
a compressed file that includes .vd1 and .vr1 files and is created at the closing 
of a project if the Compression of VD files option has been activated in the 
Preferences tab of Project Configuration.  

For more information concerning types of files, refer to the documentation 
about operating systems Windows NT™ and Windows 95+™. 

Saving a File As or Copying a File 

• Go to File menu and select Save As. 

• From the "Disk Drive" section, select the disk drive where you wish to 
save your document. 

• Select the directory in which you want to file this new document. 

• In the "File Name" section, type the new name of the document. 

• Push down the "OK" button to save the document or on the "Cancel" 
button to stop the operation. 

Compact document 
By default, your .vd1 and .vr1 files are automatically compressed (zipped) when 
exiting a project. This function compacts unused spaces of files .vd1 and .vr1 
in order to reduce the space occupied by these files on the hard disk. It could 
be useful if you deleted many objects. 

If you do not want the files to be zipped, uncheck the appropriate box in the 
Preferences tab of Project Configuration.  
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Note. This type of compression is not a ZIP. Only empty spaces are deleted. 

Compression of VD Files 
By default, .vd1 and .vr1 files will be compressed (zip) at the closing of a 
project. This option can de deactivated in the Preferences tab of Project 
Configuration, at section "Compression of Files". 

Import a DXF File from AutoCAD 
You can import a DXF file from AutoCAD to VisualDesign. To do so, go to 
File / DXF In. Elements from the DXF file will be converted into members 
that can be modified afterwards in VisualDesign.  

• Make a copy of the drawing file (*.DWG). 

• Use the AutoCAD Explode command to breakdown the drawing into 
blocks. 

• Use the AutoCAD Purge All command to purge unused blocks. 

• Remove irrelevant parts of the drawing for VisualDesign, such as texts, 
cartridge, etc. 

• Save the *.DXF file. 

• Go to VisualDesign File/Import menu and select Import a DXF. 

• A dialog box will appear on screen while importing the file. Specify the 
units for the imported drawing (in, ft, m or mm) and VisualDesign will 
convert them, if applicable.  

 

VisualDesign reads the Line, Pline and 3D Face AutoCAD objects. VisualDesign 
transforms the Line and Pline objects for members when it reads the DXF file.  
3D Face objects are transformed into rectangular and triangular plates. 

Export a DXF File to AutoCAD 
You can export a DXF file of your structure to AutoCAD. Elements (floors, 
members and plates) are saved on different layers. Members imported to 
AutoCAD can be seen the same way as in VisualDesign™ (lines) or with relief 
(3D-Face).  

Rebar placement drawings coming from the Rebar placement window 
(Concrete Design module) can be exported too. 

Getting the drawing ready before importation: Importing the DXF File 
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Procedure 
• Select the function Export a DXF from File / Export menu in VisualDesign 

main window or Rebar Placement window.  

• The Save as dialog box will appear on screen and the file name will have the 
extension .dxf. Choose the directory where the file will be stored. Press the OK 
button.  

• Open AutoCAD and open the dxf file. 

Close a Project 
Closing a project without saving it will erase the memory of that project. 

To close a project, select File /Close. If your last modifications have not been 
saved, the Save dialog box will appear on the screen. 

You can also double-click on the control box of the document located in the 
upper left corner to close your window. All other active projects will remain 
open. 

See also 
Compression of VD files  
Compact Document  

Latest Opened Files 
In the File menu, VisualDesign™ lists the four (4) latest files that you have 
been working with. To reopen any one of these projects, simply click on it 
from the list. 

Note.  If you erased a file on the Latest -Opened -Files list before or during a 
VisualDesign™ session, the name of that file will still appear on the list. However, 
VisualDesign™ will give an error message if you try to reopen the file. 

Exit 
To exit VisualDesign™, choose Exit from the File menu. 

VisualDesign™ will close all the open records simultaneously. If you have 
forgotten to save the changes made to one or more documents, a dialog box 
will appear and allow you to save these modifications. 
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Export a screen image or a screen selection as a 
bitmap 
Functions Export as a BMP and Export a selection as a BMP are located in 
File / Export submenu. 

Export as a BMP 
Users can export the visible image on screen as a bitmap. It can be saved in a 
file or in the clipboard. This new tool is useful to extract images for reports 
and can help users to find a particular project among many.  

Export a selection as a BMP 
Select this function to make a selection of image on your screen and export this 
partial view as a BMP. When this function is selected, the cursor will change 
into a cross. Draw a window around the image that you want to export.  

Export as a Bitmap Dialog box 

The selection of either functions calls up the Export as a Bitmap dialog box 
in which you will define the image parameters. The dialog box is composed of 
the following sections: 

Section Description 

Current size Current image width and height. 

Sizing Select an option among the following: 
320x240 pixels 
640x480 pixels 
800x600 pixels 
1024x768 pixels 
Scale factor (Enter a factor) 
Resolution (Define o resolution in dpi) 

Final size According to the selected option, the image will have 
these width and height. You can also enter dimensions 
directly in these fields.  

Save Choose an export option:  
Export to clipboard 
Export to file (Choose a path in the drop-down list box).  

 

Export Bitmaps and EMF Files 
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Export an image or a screen selection as an EMF 
File 
An image in EMF format ((Enhanced MetaFile) can be reduced or magnified 
without loosing its resolution and quality. This type of file as an .emf extension. 
A metafile can include a file of vectorial images, point images, and another file 
that contains text, and it can be included as an image in a document that 
supports EMF image format.  

Functions Export as an EMF File and Export a selection as an EMF File 
are located in File / Export submenu. 

Export as a EMF File 
Users can export the visible image on screen as a EMF image file. It can be 
saved in a file or in the clipboard. This new tool is useful to extract images for 
reports and can help users to find a particular project among many.  

Export a selection as a EMF File 
Select this function to make a selection of what is displayed on screen and 
export this partial view as a EMF image file. When this function is selected, the 
cursor will change into a cross. Draw a window around the image that you 
want to export.  

Export as an EMF File Dialog box 

The selection of either functions calls up the Export as a EMF File dialog 
box in which you will define the image parameters. The dialog box is 
composed of the following sections: 
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CadWork Files 
VisualDesign is now partially compatible with CadWork applications 
concerning the reading of the file. The importation of a CadWork file can be 
done through the function Import a CadWork File in VisualDesign 
File/Import menu. Bi-directional exchanges will be possible in a future 
compilation.  

CadWork Applications 
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ProSteel Files 
VisualDesign is now partially compatible with ProSteel applications 
concerning the reading of the file. The importation of a ProSteel file can be 
done through the function Import a ProSteel File in VisualDesign 
File/Import menu. Bi-directional exchanges will be possible in a future 
compilation.  

 

ProSteel Applications 
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The Project Configuration dialog box is available in File menu and contains 
specific tabs allowing you to define basic parameters that need to be 
considered for the specific analysis that you are planning to run with 
VisualDesign. The number of tabs depends upon the number of modules that 
you own. The complete list is: General, Preferences, Analysis, Seismic, 
Foundation, Steel, Composite Beam, ASCE-10-97, Concrete Design and 
Prestressing. 

Print the project configuration data by using function Print / Spreadsheets in 
the File menu. Choose information that you want to print in the selection tree. 
See topic Printing spreadsheet.  

Units 

Units are specified in the Preferences tab along with the shape designation 
(metric or imperial) 

General Tab 
The General tab may include information about the project such as name and 
number, person in charge, a description of the project and location, and 
information about the client. 

  

Project Configuration 
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Preferences Tab  
Specify your preferences for the gravity axis, minimum distance between two 
nodes, metric or imperial designation of shapes & system of units and the 
display of characteristics dialog boxes when adding elements. 

Specify an automatic compression of your .vd1 and .vr1 files and the check in 
of all personalized objects within your project (.vd1 or .vdz) when exiting the 
project. 

  

Heading Description 

Selection of  gravity axis By default, the selected gravity axis is Y. It is 
recommended to select the gravity axis before beginning 
a project. 

Tolerance for merging two 
nodes 

Minimum distance between two nodes. If  the distance is 
less than this value, nodes will be merged. 
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Heading Description 

Shape Designation Select the Metric or Imperial system of  units from the 
shapes designation and also the country to know the 
shape availability 

System of  Units Select a Metric or Imperial system of  units by clicking 
the appropriate button. 

Dialog Boxes Display If  you want the dialog boxes for node, member, floor 
and plate characteristics to be displayed each time you 
add an element, select the respective check box. 

Note.  It is usually faster to create all the elements first 
without the dialog boxes- then to proceed to defining 
their properties in groups using the Properties 
function. 

Check in common objects in 
the project 

By default, VisualDesign saves all objects (common and 
personalized) within your .vd1 file. To deactivate this 
option, uncheck box "Automatic at the saving". 

Compressing files By default, option "Automatic at closing" is activated 
allowing the compression of  files .vd1 and .vr1. 

3D Display for shapes Fraction of  L not drawn: The default value of  0.1 
means that 10% of  the member length will not be 
displayed in 3D, at nodes. 

Displaying loaded surfaces Fraction displayed: The default value of  0.9 means that 
loads applied on surfaces will be display on 90% of  the 
surface of  a floor or plate. This help to visualize 
alternated loaded floors. This value shall be greater than 
0.5 and less than 1.0.  

See also 
Properties  
Compression of VD files  
Archiving common objects within your .vd1 file  

Analysis Tab  
Specify the type of static analysis to be run (linear, non-linear, or with release), 
parameters for non-linear analysis, subdivision of members for the display of 
internal forces, reduction factor for tributary area, and parameters for a general 
dynamic (transient) analysis. 
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This table describes the fields in this dialog box:  

Heading Description 

Type of analysis Activate a linear or non-linear static analysis or a static 
analysis with release if  supports or members need to be 
released during analysis.  Refer to topics: Types of  Static 
Analysis and Tension-only Members  

Tributary Area Specify the type of  reduction factor that will be applied to 
tributary areas: Compression or Bending. 

With the drop-down list box, select the code that will be apply to reduce 
overload. 

Parameters for Non-linear 
Analysis 

Parameters are shaded if  you activated a linear analysis. 

If  you activated an analysis "with release", only the 
number of  iterations can be specified for said analysis. 

Max. Variation for axial P The non-linear analysis terminates when the variation over 
P axial falls below this value. This is a convergence 
criterion. 
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Heading Description 

Max. Variation on 
Displacements 

This tolerance is applied to the displacements of  axially 
released supports only. 

Number of  iterations The non-linear analysis or the one considering release will 
end when the specified maximum number of  iterations 
will be reached. 

Rigidity factor (axial release) Specify a rigidity factor for axially released members. 

Parameters for Cyclic Design 

Number of  cycles 
(optimization) 

Number of  cycles for optimization when designing 
members. 

Number of  cycles 
(corrections) 

When the optimized number of  cycles is reached, 
members that have not been optimized will be evaluated 
with the correction mode.  

Number of subdivisions for the 
diagrams 

Number of  subdivisions applied to all members no matter 
the load condition. It can be specified for loaded beams, 
unloaded beams, unloaded pinned beams, concrete 
members and for rectangular plates. 

General Dynamic Loadings  

Duration Allows fixing a maximum time for the application of  this 
type of  dynamic loading on a structure 

Time pitch Specify the time pitch. Make sure that dti is larger than the 
time pitch otherwise there will be a warning. See the topic 
"General Dynamic Analysis" for more details. 

Save Node Displacements Save the time responses of  node displacements in the 
database (Project_Name.vr1). See the note below. 

Save Node Displacements 

If you prefer, you can save only a few nodes to shorten the time of analysis. 
Select the desired nodes and create a personalized selection before launching 
the analysis. From menu Results/ Time History/ Nodes displacements, 
observe the graph of nodes displacement in time. 

See also 
Released Supports  
Released Members  
General Dynamic Analysis  
Automatic calculation of Kx, Ky, Kt and Kz  
Load reduction due to tributary areas  
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Seismic Tab (General) 
When the engineer specifies the R factor that represents the ductility of a 
structure, this allows a certain deflection of the structure during an earthquake.  
These deflections, caused by additional forces in the structure, can be evaluated 
in two ways: an elastoplastic analysis or an approximate method as defined in 
the Canadian National Building Code (1995 or 2005). 

VisualDesign™ does elastoplastic analysis or the approximate method for each 
seismic direction that the user wishes to study. VisualDesign™ corrects the 
spectral analysis (or time history) by including inelastic effects.  The engineer 
will find in the Levels spreadsheet all parameters used by VisualDesign™ to 
compute the stability coefficient Θx used to amplify the forces. 

Furthermore, VisualDesign™ adjusts the spectral analysis (or time history 
analysis) by including these inelastic effects.  The user may select the 
"Information on Levels" spreadsheet to have a look at the parameters that 
have been used to compute the qx coefficient that is needed for the calculation 
of the amplified forces in the structure.  

The Seismic tab includes general parameters required to run a spectral and 
time history analysis. Specific parameters will appear in this tab according to 
the code that will be selected in the "Construction Code" box. Available codes 
are: CNBC-05, CNBC 95, UBC 94, UBC 97, and CAN-S6-00.  

Seismic tab - NBC-95 Code 
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This table describes the fields included in this tab when the Canadian National 
Building Code 95 has been selected in the "Building Code" list box.   

Heading Definition 

Equivalent Static Force  

Building Code Each building code uses a normalized spectrum according 
to the occurrence probability of  each country. The selection 
of  a building code automatically fixes the spectrum to be 
used.  

Zv   Velocity-related seismic zone 

Za   Acceleration-related seismic zone 

Zonal velocity ratio, v Horizontal velocity at ground level for this zone, expressed 
in m/s units. 

Calibration factor, U Factor representing level of  protection based on experience, 
as described at paragraph 4.1.9.1 4). 

Importance factor, I  Seismic importance factor of  the structure, as described at 
paragraph 4.1.9.1 10): 
Essential public services: 1,5 
School buildings: 1,3 
Other buildings: 1,0 

Foundation factor, F  Foundation factor, as specified at paragraph 4.1.9.1 11).  
Refer to topic: "Foundation Factor, F" 

Total height, hn Total height of  the structure from the base, where the base 
of  the structure is corresponding to the level at which 
horizontal earthquake motions are considered to be 
imparted to the structure. 

Number of  stories, N  Total number of  stories above the mean exterior grade up 
to the total height hn. 

Spectral Analysis 

Accidental Torsion Proportion of  "V" to apply as accidental torsional effects 
during spectral and time history analyses. 

Modal Combination Method of  calculation used to evaluate likely internal 
stresses in elements. Choose the SRSS or CQC method. 
(SRSS: Square Root of  Sum of  Squares. 
CQC: Complete Quadratic Combination.) Refer to topic 
The CQC Method. 

Rounding for levels Tolerance that is used to distinguish a dynamic level from 
another. If  the distance between two levels is within this 
tolerance, seismic loads will be merged. 
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Heading Definition 

Levels c/c of  floors Seismic levels will be considered c/c of  floors. 

Add inelastic effects Activate this option to add inelastic effects in analyses (P-
Delta), as specified at paragraph 4.1.9.1.28). 

Add ductility effects [/¯\] Activate this box to consider ductile frames for a seismic 
steel design according to section 27 of  S16-01 standard. 

Time History Analysis 

Accelerogram Click on the button to open a selection tree that allows you 
to select an accelerogram. The accelerogram is graphically 
shown and can be printed with the toolbar on top of  the 
graphic.  

Duration Fix a maximum time in seconds for applying the 
accelerogram (This time shall be less than or equal to 200 
sec.). Be careful with this parameter because the time 
history analysis calculation can go on for a very long time. 

Time pitch Time pitch of  the selected accelerogram. If  you type in 
another value, VisualDesign will use this time. If  you select 
another accelerogram and want to use its time pitch, enter a 
value of  zero.  

Save node displacements Activate this option to save the time responses for node 
displacements in VisualDesign results file ".vr1". Look at 
note 1 below. 

Maximum Accelerations (g) 

Horizontal Maximum horizontal acceleration that will be considered for 
linear and non-linear time history analysis. It can also be 
required for a spectral analysis if  some vibration mode(s) 
act towards the gravity axis.  

Vertical Maximum vertical acceleration that will be considered for 
linear and non-linear time history analysis. It can also be 
required for a spectral analysis if  some vibration mode(s) 
act towards the gravity axis. 

Non-linear Time History Analysis 

Tolerance Tolerance that applies to the tension and compression force 
in elastoplastic members and compared to the maximum 
values that a Pall system (friction dampers) can absorb. 

Add vertical effects Activate this box to statically add the contribution of  
vertical effects to the structure for the non-linear analysis. 
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Note 1: Save Node Displacements 

If you prefer to save only a few nodes to shorten the time of analysis, select the 
desired nodes before launching the analysis. Then, from menu Results/ Time 
History/ Nodes Displacements, observe Node displacements in time. 

Foundation Tab 
Parameters used for the design of shallow foundations (soil pressure, friction 
angle, cohesion and dimension of foundation footings), as well as those applied 
to the verification of pile foundations are listed in the Foundation tab of 
Project Configuration. 

  

Heading Definition 

General Information  

Round-off  Dimensions to: Allow you to round off  dimensions of  the 
foundation according to a specified value. 
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Heading Definition 

Load Factor Alpha D Max: If  the load factor for dead load is greater 
than 1.0 for ULS, VisualDesign™ will used this 
load factor. 

Min: If  the load factor for dead load is smaller 
than 1.0 for ULS, VisualDesign™ will used this 
load factor. 

Friction Wall/Soil - Delta/Phi Specify the reduction (in decimals) to apply to the 
angle of  friction, delta (δ), of  a granular soil 
against a concrete wall.  According to Bowles, this 
angle can be considered as the angle of  internal 
friction of  the soil, phi (Φ), for concrete materials. 
The delta angle is used to calculate the active (Pa) 
and passive (Pp) earth pressure. Some standards 
reduce this angle by a factor of  2/3 or 50%. 

Shallow Foundations  

Global Resistance Factor USD global resistance factors replace the safety 
factor used in the allowable stress method. For a 
shallow foundation, a global resistance factor of  
0.50 equals to a safety factor of  3 when the ASD 
method is used. 

Default values are: 
φ capacity = 0.5 
φ passive = 0.5 
φ horizontal = 0.8 

Calculation Method for Max 
Eccentricity 

Choose a model for calculating the maximum 
allowable eccentricity. Three models are proposed:  
1. Model OHDBC: e < 0,3B 
2. Model ACI 318: B > 4e + w 
3. Custom model:  B > FE(e) + FC(w) 
where "w" is the column width. 

Column Factor (FC) and  If  you chose a custom model, enter FC value 
needed to compute B. 

Eccentricity Factor (EF) If  you chose a custom model, enter FE value 
needed to compute B. 

Allowable Settlement Allowable settlement of  spread footings for the 
analysis of  limit conditions during service. 
(Usually, 25mm) 
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Heading Definition 

Pile Foundations  

Global Resistance Factor USD global resistance factors replace the safety 
factor used in the allowable stress method. For a 
pile foundation, a global resistance factor of  0.40 
equals a safety factor of  3 when the ASD method 
is used. 

Default values are: 
φcs compression/friction = 0.4 
φcb compression/point = 0.4 
φts tension = 0.3 
φ passive horizontal = 0.5 

Number of  subdivisions per pile Specify pile number of  subdivisions for the display 
of  internal stress diagrams.  

Allowable Lateral Deflection Specify allowable pile lateral deflection. Generally 
equal to 25 mm 

See also 
Project Configuration 
The Foundation Design Module  
The Foundation Factor F  

Steel tab  
This tab will be part of the Project Configuration dialog box if you own the 
Steel Design Module.  

This tab includes parameters that have to be specified before launching a steel 
design. If you own the Tower Design Module, you have to select a 
calculation method for wind loads before defining an "Auto-wind" type of 
loads in the Loads Definition dialog box. If you want to design bolted 
connections, consult the default values in section "Design of Bolted 
Connections".  
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Heading Definition 

Effective Compression Length Factor 

Automatic Calculation of  Kt  Among the list box, choose the value that will be 
considered for the automatic calculation of  buckling 
length factor due to torsion, Kt: 0.0, Kx, Ky, max. 
(Kx, Ky) ou min. (Kx, Ky). 

Automatic Calculation of  Kz Among the list box, choose the value that will be 
considered for the automatic calculation of  effective 
compression length factor on major axis, Kz: 0.0, 
Kx, Ky, max. (Kx, Ky) ou min. (Kx, Ky). 

Wind Load on Towers  

Type of  structure Select the type of  tower: Square tower or Triangular 
tower for the calculation of  drag factor Cd (Clause 4.9 
of  CAN/CSA-S37-01). 



C H A P T E R  1  B A S I C  P R I N C I P L E S  

CivilDesign inc. Engineering Software  1-83 

Heading Definition 

Calculation Method Choose CAN/CSA-S37-01 standard method for 
calculation of  wind load or Environment Canada. A 
method must be selected before using the generator 
of  wind loads. By default, it is set to Not applicable  

Reference Level Select the reference level (base of  structure) from 
which the wind load will be applied. 

Design of Bolted Connections   

Max. number of  bolts in a line When this number of  bolts in line is exceeded when 
designing connections, VisualDesign will change the 
bolts layout that is in line to a staggered layout.  

Round up the plate thickness to: Specify a rounding for the design of  plate thickness. 

Round up edge distance "e" to: Specify a rounding for the transverse edge distance 
measured from free edge of  member to nearest bolt 
hole. 

Round up "ep" and "em" distances 
to: 

Specify a rounding for these distances for the design 
of  bolted connections. 

Round up "p" distance to: Specify a rounding for this distance for the design of  
bolted connections. 

Round up "g1" and "g2" distances 
to: 

Specify a rounding for these distances for the design 
of  bolted connections. 

See also 
Tower Design Module  
Wind Loads Definition  
Generating Wind Loads  
Automatic Calculation of Kx, Ky, Kt and Kz  
Steel Design Module  
Bolted Connections Spreadsheet  
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Composite Beam tab 
This tab is available for users owning the Steel Design module. 

Activate the " Project with Steel/Concrete Composite Beams" box that is 
located in the upper part of the dialog box to activate construction stages.  

  

You need to define construction stages if you need to: 

• Design or verify composite beams that are not shored; 

• Consider the casting sequences for concrete slabs (rectangular and 
triangular plates) 

• Obtain an accurate calculation of deflections considering the ratio "n" for 
long-term deformations.  

Results will depend on these construction stages.  
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E steel/E concrete Modulus ratio "n": 
Long Term: Ratio n is equal to 3.0 for the calculation of long-term deflection 
under permanent loads, and inflexion points. 

Short Term: Ratio n is equal to 1.0 for the calculation of forces due to live 
loads considered for a short-term period. 

Ratio of modulus E and G 
Non effective stiffness / E original stiffness: enter this ratio to consider the 
difference between the stiffness of liquid concrete and solid concrete for the 
analysis of construction stages.  

Studs for Bridge Design – Fatigue 
This topic is based on Code S6-00, clause 10.17.2, titled Live Load-induced 
Fatigue.  

Here is a description of each field: 

Field  Description 

Design life (y) Design life equal to 75 years unless otherwise specified.  

Nd (0.1L support) 

Nd (elsewhere) 

Refer to Table 10.17.2.3b) Values of  Nd - Code S6-00. 

Lane factor (p) p is 1.0,  0.85 or 0.8 for the cases of  1, 2, or 3 or more lanes 
available to trucks, respectively, and ADTT is as given in Table 
10.17.2.3 c) – Code S6-00. 

ADTT Average Daily Truck Traffic. 
Refer to table 10.17.2.3 c) Code S6-00. 

Studs in the zone of  
M- 

Activate this box if  you wish to consider studs in the negative 
bending zone. 
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Table 10.17.2.3b) Values of Nd  - Code S6-00 

Longitudinal  
Members 

Span Length, L 
 = 12 m 

Span Length, L 
 < 12 m 

Simple-Span Girders 1.0 2.0 

Continuous Girders 

1. Near interior support 
(within 0.1L on either side) 

2. All other locations 

 

1.5 
 

1.0 

 

2.0 
 

2.0 

Cantilever Girders 5.0 5.0 

Trusses 1.0 1.0 

Transverse Members Spacing = 6 m Spacing < 6 m 

All Cases 1.0 2.0 

 

Table 10.17.2.3 c) Average Daily Truck Traffic (ADTT) – Code S6-00 
 

Class of  highway ADTT 

A 4000 

B 1000 

C 250 

D 50 

See also 
Steel Design Module  
Composite Beams  
Thermal Gradient  
Construction Stages  
Calculation Method for Composite Beams  
Defining a Member as Composite  
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ASCE-10-97 Tab  
This tab allows the user to define a parametric code for the verification or 
design of members. The specified Phi (resistance factor) coefficients are used 
to calculate member resistance. The base code for the calculation is according 
to CAN/CSA-S16-01 code.  

To launch a design or verification according to this standard, select ASCE 
specification in the Steel Design tab (Specification field)  

  
The following table gives a definition of the headings included in this tab: 

Heading Description 

Standard Load Combination  (Phi factor to apply to standard load combinations) 

Phi (compression) Resistance factor applied to compression 

Phi (tension) Resistance factor applied to tension 

Phi (bending) Resistance factor applied to bending 
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Heading Description 

Phi (shear) Resistance factor applied to shear 

Phi (global) Global resistance applied to the equation 

Verification of Interaction  

Standard Interaction Check this radio button for standard interaction verification. 

Compression and Tension 
Verification Only 

Check this radio button for compression and tension 
verification only. 

Apply a Global Phi on the 
Interaction 

Check this radio button to apply a global phi on the 
interaction. 

Resistance Interaction 
Only 

Check this radio button to verify resistance interaction only. 

Buckling Curve Select the code from which the buckling curve will be 
calculated. 

Damaged Load Combination (Phi factor to apply to damaged load combinations) 

Phi (compression) Resistance factor applied to compression 

Phi (tension) Resistance factor applied to tension 

Phi (bending) Resistance factor applied to bending 

Phi (shear) Resistance factor applied to shear 

Phi (global) Global resistance applied to equation 

Verification of Interaction  

Standard Interaction Check this radio button for standard interaction verification. 

Compression and Tension 
Verification Only 

Check this radio button for compression and tension 
verification only. 

Apply a Global Phi on the 
Interaction 

Check this radio button to apply a global phi on the 
interaction. 

Resistance Interaction 
Only 

Check this radio button to verify resistance interaction only 

Buckling Curve Select the code from which the buckling curve will be 
calculated. 
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Concrete Design Tab 
Select this tab in the Project Configuration dialog box and specify default 
values to be used for a reinforced concrete design of your structure. 

  

See the table below to know the definition of headings included in this tab. 

Heading Description 

Rounding of Dimensions  

Stirrup spacing Specify a rounding for the calculation of  stirrup 
spacing. 

Rebar lengths Specify a rounding for the calculation of  bar lengths. 

Rebar spacing in slabs Specify a rounding for the spacing of  rebars in slabs. 
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Heading Description 

Optimization of Longitudinal 
Rebars 

Specify the amount of  extra steel that would be 
tolerated until the program changes rebars in the 
design of  reinforcement. 

Shear – Maximum Number of Stirrup Sequences 

Standard Beam  Fix the maximum number of  stirrup sequences that 
you wish to have for a beam located between two 
supports. 

Cantilever  Fix the maximum number of  stirrup sequences that 
you wish to have for a cantilever beam. 

Rebars – Default Bend Shape  

Rectangular Beam In the drop-down list box, choose the default bend 
shape that will be used for the design of  rectangular 
beam.  

T Beam In the drop-down list box, choose the default bend 
shape that will be used for the design of  T beam. 

L Beam In the drop-down list box, choose the default bend 
shape that will be used for the design of  L beam. 

See also 
Effective Stiffness  
Member tab  
Reinforced Concrete Design module  
Bending Shapes 
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Prestressing tab 
You must complete this dialog box if your structure has prestressed concrete 
elements (semi-continuous pre-tensioned and/or post-tensioned elements). 
Call this dialog box by selecting Project Configuration under File menu.  

You must check the box "Prestressed Concrete Project" in the upper part of 
the dialog box in order to activate the construction stages below. Otherwise, 
you will not be allowed to define cable groups.  

  

Then, define the construction stages by ticking off the appropriate boxes. 
Below the field "Day", enter the number of days (which is cumulative) where 
each stage will be applied. Superposition of results will be automatically done 
according to construction stages. The information will be used to calculate 
prestress losses in cables due to creep and shrinkage.  
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Stages 4, 7 and 10 correspond to post-tensioning stages. Post-tensioning can be 
sequential or not. If sequential, cables are not jacked at the same time. 
Example: a cable is made of three sheaths. The first sheath is jacked. It will not 
create any loss of prestress in the remaining cables. When the second sheath is 
jacked, the concrete will shrink and will cause losses of prestress in the already 
jacked cables. The same thing will happen at the jacking of the third sheath.  

Note  For each construction stage, you must create a corresponding load 
combination. Each stage load combination must have a "Construction Stage" status. If 
stage load combinations are not compatible with those defined in the Prestressing tab 
(Project Configuration), warning messages will appear on your screen.. 

Shrinkage and Creep Effects 

• Choose a shrinkage/creep model in the drop-down list box: CEB-FIP 
1978/S6-00, ACI 203, or AFNOR 1999. 

• Enter percentage of relative humidity at this location. 

• Choose a type of cure for the section and slab. 

• Specify the integration constant (Default value is 4.0).  If you want more 
precision in the calculation of shrinkage and creep effects, reduce this 
value. The value may range from 1.0 to 10.0. However, the more the value 
is small and the more time it will take for the calculation. 

• In "Exposed Surfaces" section, tick off boxes that represent surfaces that 
are exposed to air. This information will be use for the calculation of 
shrinkage and creep effects.   

See also 
Prestressed Concrete Module  
Load Cases  
Construction Stage Load Combinations  
Other Load Combinations  
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View Menu and Toolbars 
VisualDesign View menu includes the following functions and toolbars:  

   
  
First Row: Camera, Previous Camera, Next Camera, Previous View and Next View; 
Second row: Global Zoom, Zoom Window, Zoom +, Zoom –, Static Pan and 
Dynamic Pan; 
Third row: View Options, Increase Font size, Reduce Font size, Animation, Mask 
and Unmask. 

 

Diagrams Toolbar: Automatic scaling, Increase amplitude, Reduce amplitude, 
Numerical values. 

Perspective view, Tools Toolbars and Status Bar are functions included in the View 
menu (no corresponding icons) and will be explain further in this section. 

Camera 

  
The "Camera" icon of View toolbar 
 
VisualDesign™ allows visualizing the structure from a variety of angles. Select 
the Dynamic option to get a real-time display.  

You may rotate the camera using the two scroll bars in the dialog box. The 
horizontal scroll bar corresponds to θ and allows for a 0º to 360º rotation, 
whereas the vertical scroll bar corresponds to φ and allows for a 0º to 180º 
rotation.   

The camera angle moves one unit at a time when you click one of the arrows 
of the scroll bar, and 15 units every time you click above the elevator. You may 
also scroll the angle quickly by gliding the selection cursor along the scroll-bar 
slider.  

View Functionalities 
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You may also choose standard work planes such as XY, YZ or XZ.  Activate 
one of the radio buttons to obtain respectively, coordinates: (0,0,1000), 
(1000,0,0) and (0,1000,0).  

The displayed cube shows the selected camera angle. The red point indicates 
the closest point from you and helps you orient the structure.  

When you select  You get 

XY Plane (0,0,1000) A z-axis perpendicular to the screen plane 
and pointing in your direction. 

YZ Plane  (1000,0,0) An x-axis perpendicular to the screen plane 
and pointing in your direction. 

XZ Plane (0,1000,0) A y-axis perpendicular to the screen plane 
and pointing in your direction. 

Note that whenever you modify the camera angle, you will automatically return 
to Global Zoom, no matter what zoom mode you were in to begin with. 

See also 
Previous Camera   
Next Camera   
Modifying Camera Angle 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Choose Camera from the View menu. 

• Work in XY, YZ, or XZ plane by activating the appropriate radio button.  

You are allowed to modify default coordinates. 
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• Use the horizontal and vertical scroll bar to rotate the camera in 3D 
spherical coordinates system. The horizontal scroll bar corresponds to θ 
and allows for a 0º to 360º rotation, whereas the vertical scroll bar 
corresponds to φ and allows for a 0º to 180º rotation. 

• Select the "Apply" radio button to view the effects of the new camera angle 
on-screen.  

• Press "OK" to validate your choices or "Cancel" to annul the operation.  

Note: If you have already activated the Apply option, you will not return to the 
previous coordinates if you press Cancel. 

• Return to the first viewpoint by selecting Previous View from View menu 

or clicking the icon . 

Previous Camera 

  
The "Previous Camera" icon of View toolbar 

 

The Previous Camera function allows you going back to the previous camera 
angle. VisualDesign™ will then display the entire structure (Global Zoom) 
with the parameters applicable when the camera angle was chosen. 

See also 
Camera 
Next Camera  
Going Back to Previous View  
Going Back to Previous Camera Angle 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Select Previous Camera from View menu. 

Next Camera  

  
The "Next Camera " icon of View toolbar 

 

The Next Camera function is available only if the Previous Camera function 
has been activated before. The structure will be viewed from the same angle as 
it was when selecting Previous Camera. 
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Like the Previous Camera function, it allows viewing the structure in Global 
Zoom mode. Parameters are the same as those applicable at the time of the 
camera configuration. 

See also 
Camera 
Previous Camera 
Going to Next Camera 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Select Next Camera from View menu. 

Zoom Window 

  
The "Zoom Window" icon of View toolbar 
 
The Zoom Window function allows viewing in full-screen any part of the 
structure that you have selected by way of the Zoom Window cursor. The 
selected part of the structure will be magnified to scale and centred on the 
screen. 

The cursor will appear as a cross when activating Zoom Window.  

See also 
Zoom + 
Zoom - 
Global Zoom 
Viewing a Part of a Structure in Full-Screen 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Select Zoom Window from View menu. 

• Use the cursor and draw a window around the part that you want to 
magnify.  

To draw a window, press the left mouse button and keep it down while you 
move the mouse diagonally. The elements that are contained within the 
window will be magnified and centred on the screen. 

When the chosen part is magnified, VisualDesign™ will return by default to 
Extended-Window mode.  
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Note. To go back to previous view, click the icon . 

Global Zoom 

  
The "Global Zoom" icon of View toolbar 

 

The Global Zoom function reduces the structure to scale, letting you view the 
whole structure on the screen. 

Global Zoom Margins 

By default, VisualDesign puts margins that equal to 25% of the size of the 
structure, all around the screen image. It is possible to modify these margins. 
Use the following shortcut keys to increase or reduce margins: 

Shift+ Global Zoom: Reduces margins so image will be bigger. 
Ctrl+ Global Zoom: Increases margins so image will be smaller.   

Viewing the Structure in Full-screen 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Select Global Zoom from the View menu. 

When the part that you have selected has been magnified, VisualDesign™ will 
return by default to Extended-Window mode. 

Note. To go back to previous view, click the icon . 

Zoom + 

  
The "Zoom+" icon of View toolbar 
 
The Zoom + function allows you stretching the content of the current 
window by 200%. The content of the window is stretched to scale and centred 
on screen. 

Magnifying the Content of Current Window to 200% 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Select Zoom + from the View menu. 
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• Mouse scroll wheel: Place the mouse cursor on the spot you want to 
magnify and scroll the wheel up.  

When the content of the current window has been magnified by 200%, 
VisualDesign™ returns by default to the Extended-Window selection mode. 

Note. To go back to previous view, click the icon  or the icon . 

Zoom - 

  
The "Zoom –" icon of View toolbar 
 
The Zoom - function allows you reducing the content of the current window 
by 50%. The content is reduced to scale and centred on the screen. 

Reducing the Content of Current Window by Half 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Select Zoom - from the View menu. 

• Mouse scroll wheel: Place the mouse cursor on the spot you want to 
magnify and scroll the wheel down.  

When the content of the current window has been reduced by 50%, 
VisualDesign™ returns by default to the Extended-Selection mode. 

Note. To go back to previous view, click the icon  or the icon . 

Static Pan  

  
The "Static Pan" icon of View toolbar 
 
The Static Pan command allows you moving what you see on screen while 
letting you monitor the displacement vector. 

When you work in Static Pan mode, the pointer looks like four arrows. 

Click anywhere on the structure. The point will become the displacement 
vector’s starting point. Slide the cursor to the target position. When you let go 
the left mouse button, the starting point will move onto the target point, taking 
the whole structure with it. 

See also 
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Dynamic Pan  
Using the Static Pan 
Using the Static Pan 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Select Static Pan from View menu. 

• Use the hand pointer to click on the structure. 

• Keep the left mouse button pressed and slide the pointer to where you 
want to move the structure. 

• Release the left mouse button. Your selection’s starting point will move 
onto the target point, taking the whole structure with it.  

When the move has been completed, VisualDesign™ returns by default to the 
Extended-Window selection mode. 

Dynamic Pan 

  
The "Dynamic Pan" icon of View toolbar 
 
The Dynamic Pan function allows you moving in "real time" what you see on 
screen, with reference to the pointer movement. 

When you activate the Dynamic Pan function, the pointer will look like a 
pointing hand.  

Click anywhere on the structure. Press the left mouse button and slide the 
hand to move the structure to the destination point. Then, release the left 
mouse button. 

See also 
Static Pan 
Using the Dynamic Pan 

• Do one of the following: 

• Click the icon  on View toolbar.  

• Select Dynamic Pan from View menu. 

• Use the hand pointer to click a point on the structure and slide it to its new 
position. 

• Release the left mouse button to fix the structure new location.  
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Once the move has been completed, VisualDesign™ returns by default to the 
Extended-Selection mode. 

Previous View 

  
The "Previous View" icon of View toolbar 

 

The Previous View command allows you going back to the last displayed 
screen: the camera angle, the zoom and the pan will be the same.  

Please note that if you use the static or dynamic pan with the same zoom and 
camera angle more than once during the same session, VisualDesign™ will 
only take account of the last pan when it takes you back to the previous view. 
VisualDesign™ will only memorize the last pan of a series of consecutive pans. 

See also 
Next view  
Going Back to Previous View 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Select Previous View from View menu. 

Next View 

  
The "Next View" icon of View toolbar 

 

The Next View command is only available if you have already activated the 
Previous View option. It allows you going back to the last screen. The camera 
angle, the zoom, and the pan will be the same as the ones used before 
activating the Previous View. 

See also 
Previous view  
Going to the Next View 

• Do one of the following: 

• Click the icon  on View toolbar. 

• Select Next View from View menu. 
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Animation 

  
The "Animation" icon of View toolbar 

 

Press this icon to animate the structure. The animation you will see on screen 
depends on the display options you entered (stresses, deflection, etc…) and the 
activation mode you are in: 

• Structure and Load Case Modes: the animation function rotates the 
model according to the gravity axis. 

• Load Combination and Envelopes Modes: the deflections and stresses 
are animated by multiplying them by factors varying from –1.0 to 1.0. 

• Vibration Mode: the vibration mode is animated. 

Mask 

  
The "Mask" icon of View toolbar 

 

This function, available in View menu, retains only the selected elements on 
the screen. It is not necessary to select contiguous elements. 

To display the entire structure, select the Unmask function from Edit menu. 

Note. This function is very useful when personalized selections of elements 
have been defined. These selections can be called back anytime and the Mask 
function will help you to check the model or consult diagrams results.  

See also 
Unmask 
Personalized Selections of Elements 

Unmask 

  
The "Unmask" icon of View toolbar 

 

This function, available in View menu, displays the whole structure after part 
of it has been masked. 



C H A P T E R  1  B A S I C  P R I N C I P L E S  

1-102  CivilDesign inc. Engineering Software 

Perspective View 
Use function Perspective available in View menu to get a perspective view of 
the structure or use the shortcut key "S".  

Mouse scroll wheel: 

Press simultaneously the control keys [Shift] + [Ctrl] and use the scroll wheel 
to adjust the perspective view for very tall structures.  

Increase Font Size 

   
The "Increase font size" icon of View toolbar 

 

Press this icon to magnify the font size for characters linked to elements such 
as numbers, length, materials, sections, areas, etc. The modified characters are 
those associated with the activated element (node, member, plate or floor).  

For example, if you wish to increase the displayed node numbers: 

• Make sure that the node numbers are displayed. 

• Make sure the node  button is down. 

• Press the Increase Font Size  button. 

Reduce Font Size 

   
The  "Reduce font size" icon of View toolbar 

 

Press this icon to reduce the font size for characters linked to elements such as 
numbers, length, materials, sections, areas, etc. The modified characters are 
those associated with the activated element (node, member, plate or floor).  

For example, if you wish to reduce the displayed number for members: 

• Make sure that the member numbers are displayed. 

• Make sure the Member icon is activated. 

• Press the Reduce Font Size  button. 
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Control Over the Image on Your Screen 
In this table, you will find short cut keys to help you managing the screen 
image. 

Short-cut key Mouse scroll wheel Action 

PgDn N/A To obtain a XY plan view of  the 
structure. 

End N/A To obtain a XZ plan view of  the 
structure. 

Home N/A To obtain an YZ plan view of  the 
structure. 

PgUp N/A To obtain a 45 degree isometric view of  
the structure. 

Vertical arrow N/A 1-degree rotation of  the XZ plane of  the 
structure (if  Y is gravity axis). 

Horizontal arrow N/A 1-degree rotation about gravity axis. 

[Ctrl] + Vertical 
arrow 

Press down the [Shift] 
key and use the scroll 
wheel. 

15 degrees rotation of  the XZ plane of  
the structure (if  Y is gravity axis). 

[Ctrl] + Horizontal 
arrow 

Press down the [Ctrl] key 
and use the scroll wheel. 

15 degrees rotation about gravity axis. 

[Shift] + Horizontal 
arrow 

[Shift] + Vertical 
arrow 

N/A Dynamic Pan in the direction of  arrow. 

[Shift] + [Ctrl] + 
Horizontal arrow 

[Shift] + [Ctrl] + 
Vertical arrow 

N/A  Bigger Dynamic Pan in the direction of  
arrow. 

+ or - Scroll the wheel in both 
directions to zoom in or 
out 

Zoom + or Zoom - 

[Shift] + Global 
Zoom  

N/A Reduce margins around displayed image 
on the screen. Therefore, the image will 
be bigger. 
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Short-cut key Mouse scroll wheel Action 

[Ctrl] + Global 
Zoom 

N/A Increase margins around displayed image 
on the screen. So, the image will be 
smaller 

N/A Press down the [Shift] + 
[Ctrl] keys and roll the 
mouse wheel 

Adjust the perspective view for very tall 
structures 

See also 
Camera  
Perspective View  

View Options Dialog Box 

   
The "View Options" icon of View toolbar 

 

The View Options command enables you to select for the types of objects 
you wish to see displayed on the screen. It also gives you full control on their 
graphic attributes presentation (colour, pen thickness, filling) and text 
(numbers, results values). 

The View Options dialog box is composed of many tabs, namely the View 
tab, Attributes, Limits, Loads, Results, FE Results and Colour tabs.  

See also 
Displaying Legends on Screen  
The View Options Toolbar  
The View Tab 
The View tab enables you to select for the display elements and their 
characteristics. 

 

In activating or deactivating the check-off boxes corresponding to the types of 
elements, you will mask or display nodes, supports, members, floors, plates, 
and footing dimensions, model name, pile numbers and sections, and 
continuous system numbers. You may also choose to temporarily mask some 
floors components (outline, surface, joists) or plates (outline, surface) to 
facilitate the viewing of other characteristics. 

The "Font" button allows you to set the font for the display of numbers. 
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Please note that some fields may be shaded if you do not possess some 
modules. 

Note.  The display of elements overrides the content of all other headings of this tab. 
For example, if you do not activate the "Member" box, you will not be allowed to 
display member characteristics included in the Attributes tab or Results tab. 

See also 
The Attributes tab  
The Results tab  
Font Dialog Box 
Modify the font and style using drop-down list boxes. Adjust text height by 
activating one of the following radio buttons:  

• The Absolute button allows fixing a height that will follow the zoom in and 
out of the structure. 

• The Relative to window radio button allows adjusting the text height relatively 
to the size of window (text height stays the same no matter the zoom you 
are in). 
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N.B. The radio button Relative to window is not activated when modifying node, 
member, plate, floor and dimension fonts. 

The Attributes Tab 
The Attributes tab enables you to identify elements that might cause a 
problem at the time of analysis. 
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Members: 

Members characteristics can be displayed, such as end conditions, local axes, 
shape outline or 3D member shape, members having no specified sections or 
material, elastoplastic members, axially released members, pre-tensioned 
members, members with lateral support, design group, member materials and 
their corresponding legend. If you checked several boxes, some have 
precedence over others, namely:   

1. The selected object (member); 

2. Members design groups; 

3. Members part of the moving load axis; 

4. Members with unspecified shape; 

5. Material colour; 

6. Members with unspecified material; 

7. Members with pre-tension (in the "Structure" activation mode only); 

8. Released members:  

▪ In the Structure activation mode: all members with axial release. 

▪ In the Load Combinations activation mode: members that have been 
released during analysis. 

9. The member colour. 

Floors: 

For floors, you can display geometrically invalid floors, floors having no dead 
load, the local axes system, the tributary surfaces (two-way slabs), and symbols 
for two-way or one-way slabs.  

Plates: 

For plates, you can display geometrically invalid plates, plates having no 
thickness, plates having no specified material, and the plates local axes system. 
Use the 3D Display option to display plates with volume.  

Moving Loads: 

Display all moving load axes or display one moving load axis (1, 2 or 3) at a 
time. When all axes are displayed, no moving load case will be available in the 
list box. However, when one axis is selected, moving load cases will be 
available but only those corresponding to this axis.   

General: 

In this section, choose to mask or unmask the orientation cube, the global axes 
system or the identification of the project 
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See also 
Displaying Legends on Screen  
Display Member Characteristics  
Display Plate Characteristics  
Display Floor Characteristics  
Display Global Axis System  
The Limits Tab 
Use this tab and define eight colour ranges representing intervals for the 
display of members design load. You can change the associated colour of a 
range by clicking on the colour square and by choosing a new colour. The 
associated limits can be modified also. Enter ranges of your interest in each 
field. 

You can also use eight colours to represent each material present in your 
project.  

  
See also 
Displaying Legends on Screen  
Displaying Members' Design Load  
Displaying Materials  
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Displaying the Legend for Materials 

• Activate the Structure mode and open the View Options. 

• Go to the Attributes tab and activate the Material option.  

• Go to the Limits tab. Select materials and choose a colour for each 
material. Activate the "Legend" box. To modify the font size and style, 
press the "Font" button. 

See also 
The Limits Tab 
Results tab  
Displaying Legends on Screen  
The Loads Tab 
The Loads tab enables you to display loads on the screen. 

Use this tab to display support settlements and loads applied on nodes, 
members, plates or floors. Tick off the Numerical box to display the numerical 
values of loads. 

 
See also 
Loads  
Coloured Display for Loads on Supports  
Coloured Display for Loads on Nodes  
The Results Tab 
Select the Results tab to graphically or numerically view static analysis results. 
You can display support reactions and bending moments for members. You 
can also display the members design load and its legend, shear stress, axial 
force, torsion and deflection.  
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Vibration Mode:  

The Deflection box is automatically checked when the Vibration mode is 
activated. Consequently, if you select a mode and wish to animate it (using 
function Animation), deflections will be displayed.  

Foundation: 

Display the geotechnical and structural design loads. 

Description of View Options' Results tab  
 

Option Description Comment 

Supports  Display numerical values by ticking 
off  the appropriate box located 
below the "Numerical" title. 

Rx, Ry, Rz Display the support reaction according to 
global axis system.  

 

Mx, My, Mz Display the bending moment at support, 
according to global axis system  
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Option Description Comment 

Pressure and 
Capacity 

Display the pressure on spring support and 
its capacity. A coloured legend is also 
displayed to differentiate pressure from 
capacity. 

Ex.: Spring supports located along 
a pile foundation. 

Members  Display numerical values by ticking 
off  the appropriate box located 
below the "Numerical" title. 

Mx, My Display the bending moment in members, 
for strong or weak axis, according to 
member local axis system.  

 

Vy, Vx Display the shear forces in members, for 
strong or weak axis, according to member 
local axis system.  

 

Nz Display the axial forces in members.  

Tz Display the torsional moment in members.  

Deflection Display the member deflections Check the "u" and/or "v" box to 
display deflection numerical values 
for strong or weak axis. 

Stresses Display stresses in members.  

Design Load Display the coloured design load for 
members and foundations. 

Activate the "Legend" box in the 
Limits tab and modify the colours 
and values for each interval. 

General   

Legend for 
Results 

Check this box and press the "Font" button 
to modify the text height and font that are 
used in legends.  

 

Foundations  Display one type of  result at a 
time. 

Geotechnical 
Design Load 

Display the coloured geotechnical design 
load for shallow or deep foundations. 

Activate the "Legend" box in the 
Limits tab and modify the colours 
and values for each interval. 

Structural 
Design Load 

Display the coloured structural design load 
for shallow or deep foundations. 

Activate the "Legend" box in the 
Limits tab and modify the colours 
and values for each interval. 

See also 
Animation  
View Options Dialog Box 
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View Options Toolbar  
Displaying Results for Members   
Displaying Legends on Screen  
Displaying the Pressure and Capacity of Spring Supports  
Displaying Legends on Screen 
M A T E R I A L S  

Use the Structure activation mode. Open the View Option dialog box. 

Display the coloured legend of materials by checking the option "Material" in 
the Attributes tab and activate the "Legend" box in the Limits tab. To modify 
the font style and text height, press the Font button.  
M E M B E R  D E S I G N  L O A D :   

Use the Design Results activation mode. Open the View Option dialog box. 

Display the coloured legend of member design load (according to the chosen 
colours and intervals in the Limits tab) by checking option "Design load" in 
the Results tab.  

To modify the font style and text height, go back to the Limits tab and press 
the "Font" button. 
L E G E N D  F O R  F O U N D A T I O N S  G E O T E C H N I C A L  A N D  S T R U C T U R A L  
D E S I G N  L O A D :  

Use the Design Results activation mode. Open the View Option dialog box. 

Display the coloured legends of geotechnical or structural design load of 
foundations (according to the chosen colours and intervals of Limits tab) by 
checking option "Structural Design load" or "Geotechnical Design load".  

To modify the font style and text height, press the "Font" button in the Limits 
tab and check the "Legend" box.  

The Finite Elements Results Tab 
The Results FE tab is useful to graphically or numerically display stresses and 
forces such as, bending moments, shear forces, axial forces, and deflections for 
rectangular and triangular plates. 

Following a static analysis, select a load combination on Activation toolbar and 
open the View Options dialog box. Select the Results FE tab. 

Select a diagram among the list box. Activate a type of display (stress/force 
contour or mesh, with or without deflection). Click OK. 

N. B. Finite Element Analysis and results are detailed further on in this 
chapter. 
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Force/Stress Contours 
Activate a load combination on Activation toolbar. 

The left radio button displays graphic results in the form of stress/force 
contours if a graph is selected in the list box. Click any icon on Diagrams 
toolbar to open the Scaling of Intervals dialog box. This tool allows 
modifying the scale (upper and lower limits) for the displayed values (intervals) 
and colours. Refer to the topic Scaling for Intervals to learn more about this 
tool.  

Mesh and Deflection 
Activate a load combination on Activation toolbar. 

The right radio button displays the mesh and allows consulting numerical 
results. Double click on a plate to open the Internal forces and stresses 
spreadsheet or select many plates and press the Properties icon to open the 
spreadsheet.  

The check box "Deflection u, v w" displays the deflection of plates for the 
selected load combination. The deflection can be displayed along with the 
mesh or coloured stress/force contours. 

Rebar Placement for 2-Way Slabs 
The Reinforced Concrete Design is required.  
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This section applies to the display of calculated rebars for 2-way slabs. Four 
layers of bars can be displayed. The colour of rebars can be modified through 
respective reinforcement spreadsheets.  

See also 
Grouping Plates  
Scaling for Intervals  
View Options 
Interpreting Plates Analysis Results  
Concrete Design of 2-Way Slabs  
Scaling for Intervals 
When coloured stress/force contours are displayed for consulting finite 
elements results, press an icon on Diagrams toolbar to open the Scaling for 
Intervals dialog box.  

This tool allows modifying the intervals (values and number of colours) for the 
displayed legend. 

   
Select a number of colours for the display (9, 25, 45, 105, 225, 525 or 1021).   

The dialog box is composed of two scroll bar sliders that allow the scaling of 
intervals from maximum or minimum values when displaying stress/force 
contours (legend). Each scroll bar is subdivided into 100 units. Marks indicate a 
subdivision of 25 units. To move the indicator, click on it and slide the mouse 
at the right or left on the scroll bar. Displayed intervals will be increased or 
reduced as a result. 

The Manual Mode: 

When the Manual mode is activated, the absolute minimum and maximum 
values will still be displayed in the coloured legend but the specified value (min 
and max) will be used as upper and lower limits for the critical zone. If scroll 
bar sliders are used to modify the displayed values for intervals, the min and 
max specified values would be used for the modification instead of absolute 
values.  

Therefore, critical zones (red or blue) are always delimited by the absolute 
value and specified value if the Manual mode is activated. If sliders are used, the 
modification will be done according to specified values.  
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The legend displays the lower and upper limits for the two critical zones and 
intermediate zones (colours) display the middle value of the interval.  

Shortcut Keys: 

Use keyboard shortcut keys to adjust intervals when your cursor is located in 
the Max or Min scroll bar.  

Shortcut key Action 

[Home] The [Home] key moves the indicator at the 
beginning of  the scroll bar slider. 

[End]  The [End] key moves the indicator at the end 
of  the scroll bar slider. 

→  This arrow moves the indicator one unit right. 

←  This arrow moves the indicator one unit left. 

See also 
Grouping plates  
The Results FE tab  
Interpreting Plates Analysis Results  
The Colours Tab 
The Colours tab allows you to change the colour and the graphic attributes of 
structural elements, loads, results, foundations and moving loads. 

 

The tab is divided into six selection trees:  

▪ General:  Colours for axes, text, print margins, background colour, selected 
elements, mesh, and axes systems;  

▪ Structure: Colours for nodes, supports, members, plates, and floors;  

▪ Loads: Colours for arrow (load symbol) that represents loads applied to 
nodes, members, plates, and floors; 

▪ Results: Colours of results for members, supports, and plates;  

▪ Foundation: Colours for the display of Design mode or Verification mode;  

▪ Moving Loads: Colours for moving loads axis and position. 

For each element in these sections, you can change the colour, the line 
thickness, and the symbol. Activate the Black-and-White option before printing 
using a black-and-white printer otherwise the background to the structure will 
be black. 
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See also 
Graphical and Numerical Results  
Coloured Results  
Defining Graphic Attributes  
View Options   
Defining Graphic Attributes 

• Select View Options from the View menu. 

• Select the Colours tab. 

• Click the expansion button for one of the trees to access the element for 
which you wish to modify the graphic attributes.  

• To assign a colour, click one of the colours available in the "Colours" 
section. 

• To modify the line style, choose from the options in the "Style" scroll list. 

• To modify the line thickness, select a value in the Width box. The 
measuring unit for line thickness is the same as the one you selected for the 
coordinates. (See Project Configuration in the File menu. By default, "0" 
is equivalent to one pixel.) 



C H A P T E R  1  B A S I C  P R I N C I P L E S  

CivilDesign inc. Engineering Software  1-117 

• To modify the scale factor of an element’s symbol, enter one of the values 
in the Scale Factor box. 

• To fill in certain symbols with colour, activate the Fill In box.  

• Press [OK] to validate your choice, click [Apply] to view the modifications 
without exiting the dialog box, or [Help] for a description of the different 
options in this dialog box. 

Note.  The Preview option lets you see how the line colour matches the background 
colour. You may also view the line style to see whether the form is filled with colour 
or not. However, the graphic representation does not take into account the thickness 
of the line nor the scale factor applied to the selected element. 

View Options Selection Toolbar 
Display the View Options toolbar to quickly verify the structural model and 
results. This toolbar, which is a selection tree, include the same options as the 
View Options dialog box and will be posted at the right of the screen.  

To activate or hide this toolbar, go to View menu and select Toolbars. Check 
or uncheck the "View options" toolbar.  

The View Options selection tree is divided into many roots, which correspond 
to element (Members, Nodes, Floors, and Plates) in such a way that options are 
grouped together and can be selected quickly. Display options for results are 
also available for each element. You will also find the Foundations root and 
General root.   
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The Activation Toolbar 

  
The Activation toolbar of VisualDesign main window 

 

With VisualDesign™ you can work under seven activation modes, namely, 
"Structure", "Load Case", "Load Combination", "Envelope", "Vibration 
Mode", "Design Results" and "Rebar Placement" mode. Before asking 
information about any specific element through the Properties function of the 
Edit menu, make sure that you have activated the right mode, since the 
displayed dialog box is specific to a selected mode. 

For example, if you click twice on a node while you are in the "Structure" 
activation mode, you will get the Node Characteristics dialog box. If you 
click twice on the same node while you are working with the "Load Case" 
activation mode, you will get the Loads on Node dialog box. If you proceed 
the same way in the "Load Combination" activation mode, you will get the 
Nodes Displacements dialog box. Finally, if you double click on a member in 
the "Envelope" activation mode, you will get the envelope diagram for this 
member.  

To visualize the structure motion under a particular vibration mode, activate 
the "Vibration mode", choose a mode in the "Title Selection" list box and 
press the "Animation" icon.  

Once you have executed a steel design, the "Design Results" mode will be 
automatically activated. Double-clicking on a member gives you access to the 
Design Results Spreadsheet. 

For those owning the Reinforced Concrete Design module and Prestressed 
Concrete module, activate the "Rebar Placement" activation mode to access 
the Rebar Placement window by double-clicking on any continuous system even 
if you had not run any analysis or design. The purpose of this is to allow you to 
look and modify longitudinal and transverse rebars calculated by the program 
or to create your own design and checking it by looking at the displayed 
diagrams. 

See also 
Description of Icons and Toolbars  
Structure Activation Mode  
Load Case Activation Mode  
Load Combination Activation Mode 

Activation Modes 



C H A P T E R  1  B A S I C  P R I N C I P L E S  

CivilDesign inc. Engineering Software  1-119 

Envelope Activation Mode  
Vibration mode Activation Mode  
Design Results Activation Mode  
Rebar Placement Activation Mode  
Display Default Spreadsheet  

Title Selection 

   
The "Title selection" box of Activation toolbar 

 

Press this button and select a load case title, a load combination or envelope 
title, or vibration mode while being in the "Load Case", "Load Combination", 
and "Envelope" or "Vibration" activation mode. 

When one of these modes is activated, the drop-down list box automatically 
opens to let you choose a title.  

Structure Activation Mode 

  
The "Structure" icon of Activation toolbar 

 

By activating the "Structure" mode, observe or modify element characteristics 
such as a normal node, a support node, a continuous system, a member, a plate 
or a floor. 

The "Structure" mode must be activated to modify element characteristics 
through a specific dialog box using the Properties function of Edit menu. 

See also 
Activation  
Node Characteristics  
Support Characteristics  
Member Characteristics  
Rectangular Plate Characteristics  
Triangular Plate Characteristics  
Floor Characteristics  
Properties  
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Load Case Activation Mode 

  
The "Load Case" icon of Activation toolbar 
 
The "Load Case" activation mode is useful when you wish to enter or modify 
loads that are applied on different elements of your structure. For example, it 
allows setting forces and moments on nodes, support settlements 
(displacement / rotation), loads on member (distributed / concentrated / 
temperature / torsion / shrinkage), plate (pressure / temperature) and floor 
loads (concentrated / distributed). 

Before applying loads on elements, you must first create a load case title. To do 
so, select Loads/Definition. 

Press down the "Load Case" activation mode, and then select the load case title 
in the "Selection Title" box of the Activation toolbar. 

You are now able to set or modify the loads that will be applied on each 
element of your structure for the selected load case. 

Select an item or double click it, then select the Properties icon of the Edit 
toolbar. You will then have access to the loads dialog box that is specific to this 
element. 

You may also set or modify loads through the spreadsheets under the Loads 
menu. 

See also 
Loads  
Applying or modifying loads  
Loads on Nodes  
Loads on Supports  
Loads on Members  
Loads on Floors  
Pressure on Plates  
Activation  
Properties  
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Load Combination Activation Mode 

  
The "Load Combination" icon of Activation toolbar 
The Edit/Activate Mode/Load Combination function is activated by 
default as soon as an analysis has been carried out. However, no load 
combination title has been selected and you must select one from the pull-
down menu of the Activation toolbar in order to view the results. 

When the "Load Combination" active mode is selected, you may observe the 
results using one of the following procedures: 

Through Proceed as follows: 

Dialog boxes Click twice on an element, or first select an element and press 
down the "Properties" icon of  the Edit toolbar. Load combination 
results for this element will be displayed. 

Coloured Display Select the Results tab of  the View Option dialog box (View 
menu) and tick off  the boxes corresponding to the results that you 
wish to have displayed. 

To modify graphic attributes (colour, line thickness) of  different 
types of  results, select the Colours tab. 

Spreadsheets Select Load Combinations under Results menu. Select the 
heading corresponding to the desired type of  results (nodes 
displacements, members internal forces, plate internal forces, 
support reactions, etc.). 

Only the results for the elements selected on screen will be 
displayed in the spreadsheet. If  no selection is made, all the 
element results will be displayed. 

See also 
Consulting Load Combination Results  
Displacements at Nodes  
Reactions at Supports  
Internal Forces in Members  
Internal Forces in Members (min/max)  
Internal Stresses in Members  
Internal Stresses in Members (min/max)  
Internal Forces in Rectangular Plates  
Internal Forces in Triangular Plates  
Activate Mode  
Properties  
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Envelope Activation Mode 
  

The "Envelope" icon of Activation toolbar 
Press the Envelope icon of Activation toolbar or select Edit/Activate 
Mode/Envelope function. Then, select an envelope title from the pull-down 
list of Activation toolbar. 

When the Envelope mode is selected, you may observe results using one of the 
following procedures: 

Through Proceed as follows: 

Dialog boxes Click twice on a member, or first select a member and press 
down the "Properties" icon of  the Edit menu. The dialog 
box of  the envelope results for this element will then be 
displayed. 

Coloured Display Select the Results tab of  the View Option dialog box 
(View menu) and check-off  the boxes corresponding to the 
results you wish to have displayed. 

To modify graphic attributes (colour, line thickness) of  
different types of  results, select the Colours tab. 

Spreadsheets Select the Results/Envelopes menu, then one of  the 
required results spreadsheet. 

Only the results for the elements selected on screen will be 
displayed in the spreadsheet. If  no selection is made, results 
for all elements will be displayed. 

See also 
Consulting Envelope Results  
Reactions at Supports (min/max)  
Diagram of Internal Stresses and Deflections  
Diagram of Internal Stresses and Deflections (min/max)  
Variation of Stresses in Members  
Internal Forces in Rectangular Plates  
Internal Forces in Triangular Plates  
Activate Mode  
Properties  
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Vibration mode Activation Mode 

  
The "Vibration mode" icon of Activation toolbar 
The "Vibration mode" activation mode is useful to look at the structure 
deflection under a vibration mode selected in the Title Selection box. The 
structure deflection will automatically be displayed on your screen.  The 
displayed deflections represent the shape of a vibration mode, not the real 
displacements of the model under loads. 

The displacements of nodes under a selected vibration mode are available in 
Results / Modal/Spectral. 

Have a look at the whole structure behaviour under a selected vibration mode 
by clicking on the "Animation" icon. 

See also 
Modal analysis 
Nodes Displacements Spreadsheet  
Animation  
View Options 
Title Selection 

Design Results Activation Mode 

   
The "Design Results" icon of Activation toolbar 

 

The "Design Results" activation mode allows accessing steel and timber design 
results, design loads for concrete continuous systems and foundations design 
loads.  

Steel, timber, and concrete design: 

Go to Results / Structure Design / Steel, Timber, or Concrete. 

Foundation Design Loads: 

Go to the Results tab of View Options and activate the structural or 
geotechnical design loads. 

See also 
Steel Design Results Spreadsheet  
Timber Design Results Spreadsheet  
Concrete Design Results Spreadsheet  
Display Foundation Design Loads and Legend  
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Rebar Placement Activation Mode 

   
The "Rebar Placement" icon of Activation toolbar 

 

To open the Rebar Placement window: 

• Activate the Rebar placement mode and do one of the following: 

• Double-click on any continuous system 

• Click once and press the Properties icon. 

See also 
Rebar Placement Window  
Reinforced Concrete Design 
Prestressed Concrete Analysis 
Design of 2-way-Slabs  
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Print 

  
The "Print" icon of Standard toolbar 

 

You can print a project under its graphic form or choose to print spreadsheets. 

VisualDesign™ runs with printers and plotters supported by Windows NT and 
Windows 95+. 

See also 
Print Graphic (File Menu) 
Print Spreadsheets (File Menu) 
Print the Project Configuration  
Export a screen image as a bitmap  

Printer Configuration 
Choose printer, format, and paper orientation by selecting Printer 
Configuration from the File menu. Note that this dialog box will 
automatically be called to the screen when you exit the Print dialog box. 

Configuring your Printer 
• Choose Printer Configuration from File menu. 

• When the dialog box appears, select the paper feed source. Note that you 
may use a tracer to print the graphic presentation of a project, and a printer 
to print out the spreadsheets.  

• Press "Configuration" and indicate how many copies you want and define 
the print options in accordance with the printer used. 

• Select paper size from available options. 

• Specify the paper source. 

• Choose paper orientation. Pages can be oriented either vertically (portrait) 
or horizontally (landscape). 

• To connect to another network user, specify the drive letter, and then press 
Network. 

• To connect to another printer in a network, press the "Network" button. 

Print Functions 
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• For more information about the Printer Configuration dialog box, choose 
Help. 

• Press "OK" to validate your choices, or "Cancel" to annul the operation. 

Print Preview 

  
The "Print Preview" icon of Standard toolbar 
The "Print Preview" icon of the Standard toolbar enables you to view the 
graphic display of your project such as it will appear when printed. Note that 
this function is not used to view a spreadsheet. 

See also 
Toolbar of "Print Preview" Window 
Print 
Previewing a Graphic before Printing  

Previewing the Graphic before Printing 
• Do one of the following: 

• Click the icon  on Standard toolbar. 

• Choose Print Preview from the File menu. 

• In the Trace Graphic dialog box, indicate the tracing scale: either full-page 
or according to a scale factor. 

• Select a WYSIWYG print (What You See Is What You Get) or print the 
whole structure. Indicate how much space the graphic shall cover on the 
page by entering the percentage in the Space-on-Page box. 

• Select the width of the margins (mm or inches) by activating the 
appropriate option button. 

• Enter the top, bottom, left, and right margins in the appropriate command 
boxes. 

• Press OK to validate your choices and to preview the structure with the 
required specifications before printing. 
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Print Graphic from File Menu 
The Print/Graphics command from File menu allows selecting a graphic 
printing of either the whole structure or what is displayed on screen 
(WYSIWYG). 

Printing your Document in its Graphic Form 

• Click the icon  of Standard toolbar or go to File / Print / Graphics. 

The first dialog box displayed is Plotting the Graphic box. 

• Adjust the plotting scale to the whole page or enter a scale factor to plot 
the structure. 

• Set the printing zone. Activate the "Entire Structure" radio button to print 
the whole structure. Enter the percentage of the structure that should be 
displayed on the page. To only print what is displayed on screen, activate 
the "Screen (WYSIWYG)" radio button. 

• Select margin dimensions (top, bottom, left and right) in the appropriate 
boxes. Specify units. 

• Press the "OK" button to validate your input data and have access to the 
Print dialog box. 

Toolbar from the "Print Preview" Window 

Action Do the following 

View the next page Press the Next button 

View the previous page Press the Previous button 

View 2 pages at a time Press the Two-Page button 

Zoom in 150% Press Zoom + 

Zoom in 200% Press Zoom + again 

Return to the general work 
screen 

Press Zoom - 

Print Press the Print button 

Exit the Print Preview mode 
and return to the previous view 
mode 

Press Close 
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Print Spreadsheets (File Menu) 
All VisualDesign spreadsheets can be printed using the Print Spreadsheets 
function from the File/Print menu except for users working with a Trial 
Version of VisualDesign™. 

The advantage of using this command, instead of the Print function included 
in spreadsheets' contextual menu, is that you can simultaneously print many 
spreadsheets for a continuous and optimized printing.  

Create a PDF file with Adobe Acrobat. All spreadsheets will 
automatically be printed in a single file.  

The list of available spreadsheets is shown in the form of an expanding tree. 
The roots are Project Configuration, Common, Structure, Loads and Results. 
Expand the roots by clicking the plus sign (+) box until reaching the category 
button.   

The category button is green when all the spreadsheets are selected. It is grey 
when a partial selection has been made. It remains white when no spreadsheet 
has been selected. 

To select a spreadsheet, click the category button next to it. To quickly select 
all spreadsheets included in a category, simply push down the root category 
button. 

It is possible to print a spreadsheet with no grid, title zone, nor number zone. 

Optimization of the Number of Printed Pages 

To decrease the number of printed pages, two options are available: The 
option "Optimize with Portrait or Landscape" evaluates the number of pages 
according to a portrait or landscape printing, for each spreadsheet, and the 
second option is "Do not print ID columns". 

N.B. If you have checked-off the "Print Empty Spreadsheets" option and 
asked to print spreadsheets of results before having analyzed, you will get 
empty spreadsheets. However, if you have not checked-off this option, you will 
get no output from the printer. 

See also 
Specification Sheet (Spreadsheet)  
Printing Spreadsheets in Series  
Managing Spreadsheets  
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Printing Spreadsheets in Series 

• Select the "Spreadsheets" heading of File/Print. (The "Print" button of 
the Standard toolbar has not been designed to print spreadsheet). 

• In the Printing Spreadsheet dialog box, select the specific radio buttons 
for the spreadsheets to be printed. To view the list of each category 
spreadsheet (Project Configuration, Structure, Loads and Results, click 
on their respective expansion button [+]. To select all spreadsheets of the 
same category, activate the radio button of this family. 

Note:  Selection of items listed in an expanding tree: When a family radio button is 
green, all spreadsheets are selected. When a family radio button is white, no 
spreadsheet has been selected. If the radio button is grey, it means that a partial 
selection has been made in this family. 

• To reduce the number of printed pages, use option "Optimize the printing 
with portrait or landscape". Check also the box "Don’t print ID columns".   

• To print empty spreadsheets, tick the "Printing Empty Spreadsheets" box. 

Warning! If you have not clicked this box and are asking for the printing of a 
results spreadsheet before analyzing, no spreadsheet will be printed. 

• Press down the "Page Set-up" button to reach the dialog box that includes 
the paper settings and the margins. 

• Press down the "Printer" button to set the size and orientation of paper 
sheet and select the printer. 

• Press the "OK" button to print your document or the "Cancel" button to 
stop the operation. 

Print the Project Configuration 
• Go to File / Print / Spreadsheets and expand the Project Configuration 

root in the selection tree that is displayed in the Printing Spreadsheet 
dialog box.  

All branches correspond to the Project Configuration dialog box (File 
menu), except Statistics, Moving Loads and Bridge Evaluation.  

The Statistics branch includes the number of elements in your model, the 
number of load cases, load combinations, and envelopes.  

The Moving Loads branch includes information you may find in the Moving 
Load Analysis dialog box.  

The Bridge Evaluation branch includes user's input for bridge evaluation.  
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Printing the Project Configuration 

• Select File / Print /Spreadsheets. (The "Print" button of Standard 
toolbar has not been designed to print spreadsheets). 

• In the Printing Spreadsheet dialog box, expand the "Project 
Configuration" root and check appropriate boxes. 

• Press the "Printer" button to choose a printer. 

• Press the "OK" button to start the printing. 

• Press the "Cancel" button to exit the dialog box or to cancel the operation. 
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New Window 
Choose New Window from the Window menu to open one or more versions 
of your main project window. 

The secondary window lets you display different parts of the structure. When 
you modify the structure in one window, the changes you make will be carried 
over to all the other windows. (Only the zoom functions will not be carried 
over.) 

A secondary window displays the name of the original window, followed by a 
colon and the new window’s number. For instance, if the original window is 
called BridgeA.vd1:1, the next window will be called BridgeA.vd1:2. 

Creating a Secondary Window from Active File 

• Choose New Window from Window menu. 

Cascade 
The Cascade option lets you to view the opened windows in a cascade. Only 
the title bars will be visible. 

Tile Horizontally 
Choose Tile Horizontally from the Window menu to view horizontally 
opened windows simultaneously. The windows will all be visible on the screen, 
not overlaid. Open windows are organized from the top towards the bottom of 
the screen. 

Tile Vertically 
Choose Tile vertically to view, up to four vertically opened windows 
simultaneously. The windows will all be visible on the screen, not overlaid. 
Open windows are organized from left towards right of the screen. 

Rearrange 
You may rearrange windows converted into icons.  

To shrink a window and convert it to an icon, press the Minimize arrow on the 
title bar. 

To rearrange windows converted to icons, choose Rearranging Icons from 
the Window menu. The icons will be rearranged horizontally, from the left to 
the right, at the bottom of the screen. 

Windows Management 
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Refresh 
When you move elements on the screen, some pixels may remain residual. In 
order to remove these parasite signals from the screen, activate the Refresh 
function or press the F5 key. 

List of Open Windows 
VisualDesign™ displays a list of opened windows pertaining to the same 
document. To switch from one window to another, select another window 
from the list in the Window menu. 
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About Common Objects 
Chapter 2 describes some spreadsheets that are composing the Common 
menu such as Materials, Shapes, Reinforcement, Cables, Studs, Steel Decks, 
and Bolts. These are called common objects because they are part of VisualDesign 
database VDBase.mdb and they can be shared among users (network version).  

Editing spreadsheets located in the Common menu 
These basic data cannot be edited, except the rebar bending shape’s number 
and aliases. However, all these spreadsheets can contain personalized data 
when a line is added at the end of the spreadsheet.  

To create a new object (material, shape, reinforcement, cable, stud, steel deck, 
bolt, soil or mobile), add a line at the end of the spreadsheet. You will notice 
that the ID number is 5000 or more, meaning that it is a personalized object. 
Change the name and enter new parameters. (Example: copy & paste a type of 
stud, change the name and its length). 

The archiving function is activated by default (Preferences tab of Project 
Configuration). Therefore, all personalized objects will be saved within your 
project file (.vd1 or .vdz).  

See also 
Common menu  
Archiving common objects within your file  
Preferences tab (Project Configuration)  
VDBase.mdb file  

Importing Common Objects to your Database 
When you open a .vd1 or .vdz file that comes from another computer (from 
outside your network), it may contain personalized common objects that are 
not part of your VDBase.mdb file. VisualDesign will read this file and detect 
these elements.  

To inform users and to facilitate the understanding if what is going on, a 
spreadsheet will appear on your screen at the end of the reading of the file. 
VisualDesign will let you choose the action that you want to do for each 
detected object: either import the new object to your database or give a new 
name to the identical object that it found at the reading, or cancel the 
importation.  

General 
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If you accept the importation of an object that has an identical name in your 
database, you can enter a new name for the imported element and 
VisualDesign will modify the input and use this name if there is no conflict.  

This table describes the columns that are part of the spreadsheet: 

Column Description Editing 

Type Type of  personalized common object that has 
been detected at the reading of  the file and 
which is not part of  the user database.   

No 

Number Number or name of  the detected common 
object. 

No 

Equivalent Object If  VisualDesign detected an object in your 
database that possesses identical parameters, the 
name of  this equivalent object will be written in 
this column.   

No 

Action VisualDesign can choose two actions when the 
reading is completed: Import or Use equivalent.  

If  no equivalent object has been found, the 
Import option will be automatically selected.  
If  an equivalent object has been found, the 
option Use equivalent will be selected.  

Yes/No 

New Number Enter a new number/name to describe the 
imported object if  an identical name has been 
detected in your database. If  you do not enter a 
name, VisualDesign will rename this object by 
adding the term "%a" at the end of  existing 
name and will use it for this project file. 

Single click 

See also 
The Commun.mdb database  
Archiving common objects within your .vd1 or .vdz file  
The VDBase.mdb database  
Saving styles and colours  
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Material Properties 
Steel Materials 
Properties of steel materials have been extracted from the following standards: 

CAN/CSA-G40.21-M92: Handbook of Steel Construction (1995), Canadian 
Institute of Steel Construction, Sixth Edition, Table 6-3. 

ASTM: Manual of Steel Construction (1995), American Institute of Steel 
Construction, Second edition, Table 1-1.  

S136 Standard for Cold-Formed Sections. 

ASTM A500 Grade C for American HSS. 

Concrete Material 
Properties of concrete materials have been extracted from the following 
standard: 

CAN/CSA-A23.1-94: Concrete Materials and Methods of Concrete 
Construction; 

Timber 
Wood Design Manual (2001), Canadian Wood Council. 

See also 
Steel Materials spreadsheet  
Concrete Materials spreadsheet  
Timber Properties spreadsheet  
Aluminium Materials spreadsheet  

Materials 
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Steel Materials Spreadsheet 
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumerical characters describing the type 
of  steel. 

Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

Category Select a category among the drop down list box: 
G40, ASTM, Strand, or Others. 

Double click 

E Young's elastic modulus Single click 

G Shear modulus Single click 

µ Poisson’s ratio Single click 

Density Density of  steel Single click 

Thermal Coeff. Coefficient of  thermal expansion Single click 

fy Yield strength of  steel Single click 

Fu Tensile strength of  steel Single click 

Ry Factor applied to fy for estimating the probable 
elastic limit (refer to section 27 of  CAN/CSA-
S16-01 Standard.)  

Single click 

Rt 
(Not yet 
activated) 

Ratio of  probable tensile strength and minimum 
tensile strength, Fu, relatively to the probable 
elastic limit, Ry. (Refer to AISC-I-6- Seismic 
Provisions for Structural Buildings, March 2005)  

Single click 

See also 
Steel Specifications  
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Concrete Materials Spreadsheet 
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

E Modulus of  elasticity of  concrete  Single click 

G Shear modulus Single click  

µ Poisson’s ratio Single click 

Density Material density Single click 

Density (E, f'c) Density of  material that is considered for 
calculating f'c. 

Single click 

Thermal Coeff. Coefficient of  thermal expansion Single click 

f'c Specified compressive strength of  concrete Single click 

fct Tensile strength of  concrete Single click 

λ Modification factor taking into account the effects 
of  concrete density on its tensile strength 

λ=1,00 for normal density 
λ=0,85 for structural semi-low-density concrete in 
which all of  the fine aggregate is natural sand. 
λ=0,75 for structural low-density concrete in 
which none of  the fine aggregate is natural sand. 

Single click 

a max Maximum diameter of  aggregates present in the 
mixture 

Single click 

εf Stress of  concrete due to shrinkage Single click 

Ect Effective modulus of  concrete in tension Single click 

Elt Concrete modulus of  elasticity (long term) Single click 
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Column Description Editing 

α Factor depending on type of  cement and curing 
conditions and is used in the calculation of  f ’ci 
for prestressed concrete beams. See topic 
Calculation of  factor alpha… 

Single click 

Type of  cement Specify the hardening for this type of  concrete: 
Slow, Normal, Quick or Quick and High Resistance 
hardening.  

Double click 

 

Note.  For the λ modification factor: Linear interpolation may be applied based on 
the fraction of natural sand in the mix. 

See also 
Concrete Specifications  
Factor alpha for Prestressed Concrete  

Timber Materials Spreadsheet 
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Number Name (12 alphanumeric characters) describing the 
wood species and structural quality. Refer to 
Timber Nomenclature.  

Double-click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

Classification Choose the classification of  this material among 
the drop-down list box: Visual, MSR (Machine 
Stress-Rated), MEL (Machine Evaluated Lumber) 
or GLT (Glue Laminated Timber). Refer to 
Classification  

Double-click 

Grade  Select the grade among the list box: Select 
structural, No.1, No.2, No.3, Construction or 
Standard. 

Double-click 

Species Select a species among the list box: S-P-F, D Fir-
L, Hem-Fir or North Species. 

Double-click 
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Column Description Editing 

Available Cuts This column shows the available cuts according to 
the classification, grade and species of  this 
element.  
N.B. While designing timber elements, 
VisualDesign cannot change the classification 
of  this material. 

Double-click 

E Specified Elastic modulus. Single click 

E05 Modulus of  elastic for design of  compression 
members. 

Single click 

G Shear modulus Single click 

µ Poisson’s ratio Single click 

Density Density of  this material. Single click 

Thermal coeff. Coefficient of  thermal expansion Single click 

fb|M+ Specified positive bending strength at extreme 
fibre.  

Single click 

fb|M- Specified negative bending strength at extreme 
fibre.  

Single click 

fv Specified shear strength. Single click 

fc Specified compressive strength parallel to grain. Single click 

fcp|c Specified compressive strength perpendicular to 
grain, compression face bearing. 

Single click 

fcp|t Specified compressive strength perpendicular to 
grain, tension face bearing. 

Single click 

ftn Specified tensile strength parallel to grain at net 
section. 

Single click 

ftg Specified tensile strength parallel to grain at gross 
section of  glued-laminated timber. 

Single click 

ftp Specified tensile strength perpendicular to grain. Single click 

See also 
Timber Specification  
Timber Species and Properties  
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Aluminium Materials Spreadsheet 
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters describing the type of  
aluminium. 

Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

E Young's elastic modulus Single click 

G Shear modulus Single click 

µ Poisson’s ratio Single click 

Density Density of  aluminium Single click 

Thermal Coeff. Coefficient of  thermal expansion Single click 

Fy Yield strength of  aluminium Single click 

Fu Tensile strength of  aluminium Single click 

See also 
Aluminium Specifications  
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About Shapes Spreadsheets 
Metric and Imperial Designation 
The Metric or Imperial designation for shapes is activated in the Preferences 
tab of Project Configuration dialog box (File menu).   

Personalized Standard Shapes: 
Insert a line in any standard shape spreadsheet to create your own standard 
shape. Enter general parameters such as b, d, t, and w. VisualDesign 
automatically calculates the new shape properties.  

Use the shape nomenclature (name) that you may find in the shape selection 
tree to find the new standard shape in a particular branch. Ex.: W460x67, 
HS305x305x11. 

Shape Availability 
Symbol [cue] appears in the tree sections before the name of the shape. c = 
Canada, u = USA, e = Europe. When a shape is not available in a country, the 
symbol "_" is displayed. Suppose a shape is only available in the US, the 
following symbol is then displayed [_u_]. 

Distribution 
Assign a "Private" distribution to your personalized shape if you don't want it 
to be imported to another user's database at the opening of your file. N. B. A 
private distribution can only be assigned to personalized shapes. All 
VisualDesign shapes have a "Public" distribution. 

The Shape Properties Dialog Box 
This dialog box is accessible from shapes spreadsheets: Click in any cell, right 
click to open the contextual menu and select the function Detail.  

Shapes & Sections 
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Section Strong and Weak Axis 
In VisualDesign, the member strong and weak axes are as follows: 
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I Shapes Spreadsheet 

  
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 
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Column Description Editing 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

Type Shape: HP, M, S, W, WWF, or SLB Double-click 

d Depth Single click 

d nominal Nominal depth Single click 

b Flange width Single click 

w Web thickness Single click 

t Flange thickness Single click 

k Distance from outer face of  flange to web toe of  
fillet. 

Single click 

k1 Distance from centreline of  section to flange toe 
of  fillet. 

Single click 

Area Section area Single click 

Ix Moment of  inertia – strong axis Single click 

Sx Elastic section modulus on strong axis No 

rx Radius of  gyration on strong axis No 

Zx Plastic section moment on strong axis Single click 

Iy Moment of  inertia on weak axis Single click 

Sy Elastic section modulus on weak axis No 

ry Radius of  gyration on weak axis No 

Zy Plastic section moment on weak axis Single click 

J Torsional constant Single click 

Cw Warping constant Single click 
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Column Description Editing 

Perimeter Perimeter of  the section. Single click 

C Shapes Spreadsheet 

  
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 
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Column Description Editing 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

Type Shape: C or MC Double-click 

d Depth of  the section Single click 

d nominal Nominal depth of  the section Single click 

b Flange width Single click 

t Flange mean thickness Single click 

w Web thickness Single click 

Area Section area Single click 

Ix Moment of  inertia – strong axis Single click  

Sx Elastic section modulus around strong axis No 

rx Radius of  gyration – strong axis No 

Iy Moment of  inertia – weak axis Single click 

Sy Elastic section modulus around weak axis No 

ry Gyration radius – weak axis No 

x Position of  gravity axis Single click 

Xo Shear centre Single click  

J Torsional constant Single click 

Cw Warping constant Single click  

Perimeter Perimeter of  the section. Single click 
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HSS Shapes Spreadsheet 

  
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 



C H A P T E R  2  M A T E R I A L S  &  S E C T I O N S  

2-16  CivilDesign Inc. Engineering Software 

Column Description Editing 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

Type Shape: Square, Rectangular, Circular or Pipe. Double-click 

d Depth Single click 

d nominal Nominal depth Single click 

b Section width Single click 

t Wall thickness Single click 

Ext. radius Bend radius measured from outer face. Single click 

Area Section area Single click 

Ix Moment of  inertia – strong axis Single click 

Sx Elastic section modulus around strong axis No 

rx Radius of  gyration – strong axis No 

Zx Plastic section moment around strong axis Single click 

Iy Moment of  inertia – weak axis Single click 

Sy Elastic section modulus around weak axis No 

ry Radius of  gyration – weak axis No 

Zy Plastic section moment around weak axis Single click 

J Torsional constant Single click 

Crt Shear constant Single click 

Perimeter Perimeter of  the section. Single click 

HSS Design wall thickness 
The design wall thickness of a selected HSS must be specified in the Member 
tab (Member Characteristics dialog box). HSS properties are adjusted with 
respect to this wall thickness.  

The display of such shapes on screen and its nomenclature in the design brief 
is as follows: HS305x254x9.5 (0.9t). 
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Note  Dead load is calculated without considering the thickness reduction. 
Consequently, dead load applied on the structure and bill of materials are adjusted to 
usual HSS (full wall thickness). 

L Shapes Spreadsheet 

  
 

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 
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Column Description Editing 

Material Choose the shape material among the list box. Double-click 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

Type Type of  section: L (d=b) or L (d>b) Double-click 

d Depth Single click 

b Section width Single click 

t Flange thickness Single click 

Bend radius Bend radius used in the calculation of  
width/thickness ratio of  compression elements 
(standard S37-01) 

Single click 

Area Section area Single click 

Ix Moment of  inertia – strong axis Single click 

Sx Elastic section modulus around strong axis No 

rx Radius of  gyration – strong axis No 

y Position of  gravity axis Single click 

Iy Moment of  inertia – weak axis Single click 

Sy Elastic section modulus around weak axis No 

ry Radius of  gyration – weak axis No 

x Position of  gravity axis Single click 

rz Lowest radius of  gyration Single click 

Tan α Angle between orthogonal and major/minor axis 
system and used to calculate rz. 

Single click 

J Torsional constant No 
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Column Description Editing 

Perimeter Perimeter of  the section used to calculate the 
surface to paint and/or ice coating. 

Single click 

2L Shapes Spreadsheet 

  

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 
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Column Description Editing 

Material Choose the shape material among the list box. Double-click 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

Type Layout of  double steel angles: 2EL, 2SL, 2LL Double-click 

d Depth Single click 

b Section width Single click 

t Thickness Single click 

Bend radius Bend radius used in the calculation of  
width/thickness ratio of  compression elements 
(standard S37-01) 

Single click 

Area Section area of  2 angles Single click 

Ix Moment of  inertia – strong axis Single click 

Sx Elastic section modulus around strong axis No 

rx Radius of  gyration - strong axis No 

y Position of  gravity axis Single click 

Iy angle Moment of  inertia – weak axis Single click 

rz angle Radius of  gyration – major/minor axis system for 
a single angle 

Single click 

x angle Position of  gravity axis Single click 

ry Radius of  gyration – weak axis No 

J Torsional constant No 

Perimeter Perimeter of  the section used to calculate the 
surface to paint and/or ice coating. 

Single click 
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T Shapes Spreadsheet 

  
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 
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Column Description Editing 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

Type Type of  steel shape: WT, WWT 
Concrete section: T 

Double-click 

d Depth of  section Single click 

d nominal Nominal depth of  section Single click 

b Flange width Single click 

t Flange thickness Single click 

w Web thickness Single click 

Area Section area Single click 

Ix Moment of  inertia – strong axis Single click 

Sx Elastic section modulus around strong axis No 

rx Radius of  gyration – strong axis No 

y Position of  centre of  gravity, parallel to local y-
axis. 

Single click 

Iy  Moment of  inertia – weak axis Single click 

Sy Elastic section modulus around weak axis No 

ry Radius of  gyration – weak axis No 

J Torsional constant No 

Cw Warping torsional constant No 

Perimeter Perimeter of  the section. Single click 
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Z Shapes Spreadsheet 
VisualDesign does not design such shapes. Only compression strength is 
verified. You must calculate the bending capacity Mr yourself.  

If you choose a major/minor axis system in the Member tab (Member 
Characteristics dialog box) VisualDesign, will not consider it. (A value of 1.0 
kN will be displayed in the Results spreadsheet.)  

  
Group: Shared Data: VDBase.mdb 

 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 
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Column Description Editing 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

d Depth of  section Single click 

d nominal Nominal depth of  section Single click 

b Flange width Single click 

t Web thickness Single click 

Area Section area Single click 

Ix Moment of  inertia – strong axis Single click 

Sx Elastic section modulus around strong axis No 

rx Radius of  gyration – strong axis No 

Iy Moment of  inertia – weak axis Single click 

Sy Elastic section modulus around weak axis No 

ry Gyration radius – weak axis No 

J Torsional constant Single click 

Cw Warping constant Single click 

Perimeter Perimeter of  the section. Single click 
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WRF Shapes Spreadsheet 

  
Group: Shared Data: VDBase.mdb 

 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 
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Column Description Editing 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

d Depth of  section Single click 

d nominal Nominal depth of  section Single click 

b1 Width of  top flange Single click 

t1 Thickness of  top flange Single click 

b2 Width of  bottom flange Single click 

t2 Thickness of  bottom flange Single click 

w Web thickness Single click 

yt Distance from top to centre of  gravity. Single click 

Area Section area Single click 

Ix Moment of  inertia – strong axis Single click 

rx Radius of  gyration – strong axis No 

Sxt Elastic modulus of  section at the top, on strong 
axis. 

No 

Sxb Elastic modulus of  section at the bottom, on 
strong axis. 

No 

Iy Moment of  inertia – weak axis Single click 

ry Radius of  gyration – weak axis No 

Sy Elastic modulus of  section around weak axis No 

J Torsional constant Single click 

Cw Warping constant Single click 

Perimeter Perimeter of  the section. Single click 
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V Shapes Spreadsheet 

  
Group: Shared Data: VDBase.mdb 

 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 
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Column Description Editing 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

d Depth of  the section Single click 

d nominal Nominal depth of  the section Single click 

b1 Width of  the section Single click 

t Thickness Single click 

x Look at the image above. Single click 

xr Look at the image above. Single click 

y max Look at the image above. Single click 

Bend radius Bend radius used in the calculation of  
width/thickness ratio of  compression elements 
(standard S37-01) 

Single click 

Area Section area Single click 

Ix Moment of  inertia – strong axis Single click 

rx Radius of  gyration – strong axis No 

Sx Elastic modulus of  the section around the strong 
axis 

No 

Qx The shear stress by units of  width, in the direction 
of  the z axis, at the x face of  the local system  

No 

Iy angle Moment of  inertia of  original angle– weak axis Single click 

ry Radius of  gyration – weak axis No 

Sy Elastic modulus of  the section around the weak 
axis 

No 

Qy The shear stress by units of  width, in the direction 
of  the z-axis, at the y face of  the local system. 

No 

J Torsional constant Single click 

Cw Warping constant No 
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Column Description Editing 

Perimeter Perimeter of  section. Single click 

Rectangular Shapes Spreadsheet 

  
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 
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Column Description Editing 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

d Depth of  the section Single click 

b Width of  the section Single click 

Area Section area No 

Ix Moment of  inertia – strong axis No 

Sx Elastic section modulus around strong axis No 

rx Radius of  gyration – strong axis No 

Zx Plastic section moment around strong axis No 

Iy Moment of  inertia – weak axis No 

Sy Elastic section modulus around weak axis No 

ry Radius of  gyration – weak axis No 

Zy Plastic section moment around weak axis No 

J Torsional constant No 

Composition Timber design: Select the composition of  the 
member: Sawn Timber, Glulam, or Composite 

Double-click 

Number of 
pieces in local 
x-direction 

Timber design: If  composition is glulam, indicate 
the number of  laminations in the local x-
direction. 

Single click 

Number of 
pieces in local 
y-direction 

Timber design: If  composition is glulam, indicate 
the number of  laminations in the local y-direction. 

Single click 

Perimeter Perimeter of  the section. No 
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Laminations in Glulam Sections 

 

Round Shapes Spreadsheet 
VisualDesign calculates the round section area in an automatic way using the 
diameter defined in this spreadsheet. To modify the area, double-click in the 
"Area" cell. 

Shape Designation: 
BS: Bridge Strand 

GS: Guy Strand (for guyed tower) 

RB: Round Bar 
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Stress Relaxation: 
If you own the Steel Design module, you can consider stress relaxation by 
activating the appropriate box in the Steel Design tab of Member 
Characteristics dialog box. 

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

d Depth Single click 

Area Section area Single click 

Ix Moment of  inertia – strong axis No 

Sx Elastic section modulus around strong axis No 

rx Radius of  gyration – strong axis No 

Zx Plastic section moment around strong axis No 

J Torsional constant No 

Perimeter The perimeter is used to calculate the surface to 
paint and/or ice coating. 

No 
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L (t, w) Sections Spreadsheet 

  
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [  x  ] by double-
clicking. 

Double-click 
or Space bar 
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Column Description Editing 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

d Height of  section Single click 

d nominal Nominal height of  section Single click 

b Width of  leg Single click 

t Leg thickness Single click 

w Web thickness Single click 

Area Section area No 

Ix Moment of  inertia – strong axis No 

Sx Elastic section modulus around strong axis No 

rx Radius of  gyration – strong axis No 

y Distance from top fibre to section centre of  
gravity. 

No 

Iy Moment of  inertia – weak axis No 

Sy Elastic section modulus around weak axis No 

ry Gyration radius – weak axis No 

x Distance from left fibre to section centre of  
gravity 

No 

J Torsional constant No 

Perimeter Perimeter of  the section. No 

AASHTO Sections spreadsheet 
This spreadsheet is located in the Common/Shapes menu. It is mostly used 
for prestressed concrete structure (composite or not) with pre-tensioning 
cables.  

T-sections can be modeled from AASHTO sections, using appropriate 
dimensions. To learn more, refer to the topic: Prestressed Concrete T-Section  
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Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated  No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

d Total height of  the section Single click 
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Column Description Editing 

w Thickness of  the web Double-click 

bt Total width of  top flange Single click 

tt Thickness of  top flange Single click 

bf1 See the figure above. Single click 

h1 See the figure above. Single click 

h2 See the figure above. Single click 

h3 See the figure above. Single click 

bb Total width of  bottom flange Single click 

tb Thickness of  bottom flange Single click 

hw Height of  the web having a thickness w. No 

Area Area of  the section  No 

yt Distance from bottom to centre of  gravity No 

Ix Section inertia – strong axis No 

Iy Section inertia – weak axis No 

J Torsional constant No 

Perimeter Perimeter of  the section. No 

See also 
Prestressed Concrete Composite Beams  
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NEBT Sections spreadsheet 
This spreadsheet is located in the Common/Shapes menu. It is mostly used 
for prestressed concrete structure (composite or not) with pre-tensioning 
cables. 

  
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated  No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 
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Column Description Editing 

Material Choose the shape material among the list box. Double-click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

d Total height of  section Single click 

bb Total width of  bottom flange Single click 

bc Width of  truncated part (45 deg.) of  bottom 
flange. 

Single click 

tb See the figure above. Single click 

R1 Radius of  curvature of  bottom flange. (See the 
figure above) 

Single click 

R2 Radius of  curvature of  bottom flange. (See the 
figure above) 

Single click 

h1 See the figure above. Single click 

w Web thickness of  the section Single click 

hw Height of  web having a thickness w. Single click 

R3 Radius of  curvature of  top flange. (See the figure 
above) 

Single click 

R4 Radius of  curvature of  top flange. (See the figure 
above) 

Single click 

h2 See the figure above. Single click 

bt Total width of  top flange. Single click 

tt See the figure above. Single click 

Area Area of  the section  No 

yt Distance from bottom fibre to centre of  gravity No 

Ix Section inertia – strong axis No 

Iy Section inertia – weak axis No 

J Torsional constant No 
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Column Description Editing 

Perimeter Perimeter of  the section. No 

See also 
About Shapes  
Prestressed Concrete Module  
Prestressed Concrete Composite Beams  

Cold-Formed Sections Spreadsheet 
Cold formed sections are available for the following shapes: en C, Z, I, 
cylindrical, caisson and combined.  

Refer to the S136 Standard for more details. 
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Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material among the list box. Double-click 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. These 
fields cannot be edited except for personalized shapes. 
If  available in one of  these countries, activate the cell 
[  x  ] by double-clicking. 

Double-click 
or Space bar 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  the 
file.  The distribution of  pre-defined shapes is not 
editable. 

Double-click 

Category Enter up to 20 alphanumerical characters to define the 
category: Useful to subdivide the type of  thin wall 
section into several subgroups.  

Single click 

Type of  
section 

Choose a type of  cold-formed section: C, I, Z, 
Caisson, Cylindrical or Combined. 

Double-click 

Symmetry Specify the type of  symmetry of  the section: Double 
symmetry, Axis X symmetry or Axis Y symmetry. 

Double-click 

d sup Distance from centre to top fibre Single click 

d inf Distance from centre to bottom fibre Single click 

b2  Distance from centre to right fibre Single click 

b1 Distance from centre to left fibre Single click 

d(τ|Tz) Distance used for the calculation of  shear stress 
d(Tau|Tz) * Tz / J. See the note below. 

Single click 

Area Gross area of  the section, used for the calculation of  
mass and EA/L. 

Single click 

Area not 
reduced 

Gross area minus bolt holes. Used for the calculation 
of  torsion buckling max stress (Cl. 6.6.3.1) 

Single click 
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Column Description Editing 

Effective 
Area 

Section effective area for the calculation of  Cr (Cl. 
6.6.1.3)  

Single click 

Ix Moment of  inertia according to strong axis. Normally 
used with the unreduced section area. 

Single click 

Iy Moment of  inertia according to weak axis. Normally 
used with the unreduced section area. 

Single click 

IycMxp Moment of  inertia of  the compressed zone of  the 
unreduced area of  the section relative to the neutral 
axis of  the whole section parallel to the web(s), for 
Mrx positive. 

Single click 

IycMxn Moment of  inertia of  the compressed zone of  the 
unreduced area of  the section relative to the neutral 
axis of  the whole section parallel to the web(s), for 
Mrx negative. 

Single click 

rx Radius of  gyration according to strong axis. Normally 
used with the unreduced section area and for the 
calculation of  compression and lateral buckling (Cl. 
6.4.3 and Cl. 6.6.3) 

Single click 

ry Radius of  gyration according to weak axis. Normally 
used with the unreduced section area and for the 
calculation of  compression and lateral buckling (Cl. 
6.4.3 and Cl. 6.6.3) 

Single click 

Xo Distance from shear centre to centre of  gravity, in the 
x-axis direction. 

Single click 

t Thickness of  the thin wall Single click 

j Lateral buckling constant. See the equation below. Single click 

J Torsional constant. See the examples below. Single click 

Cw Warping constant Single click 

Sc (Mx+) Elastic section modulus in compression taken from 
the moment of  inertia of  effective area divided by the 
distance between neutral axis and the end fibre in 
compression (y+).  

Single click 

Sc (Mx-) Elastic section modulus in compression taken from 
the moment of  inertia of  effective area divided by the 
distance between neutral axis and the end fibre in 
compression (y-). 

Single click 
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Column Description Editing 

Sc (My+) Elastic section modulus in compression taken from 
the moment of  inertia of  effective area divided by the 
distance between neutral axis and the end fibre in 
compression (x+). 

Single click 

Sc (My-) Elastic section modulus in compression taken from 
the moment of  inertia of  effective area, divided by the 
distance between neutral axis and the end fibre in 
compression (x-). 

Single click 

St (Mx+) Elastic section modulus in tension taken from the 
moment of  inertia of  the section effective gross area 
divided by the distance between neutral axis and the 
end fibre in tension (y-). 

Single click 

St (Mx-) Elastic section modulus in tension taken from the 
moment of  inertia of  the section effective gross area 
divided by the distance between neutral axis and the 
end fibre in tension (y+). 

Single click 

St (My+) Elastic section modulus in tension taken from the 
moment of  inertia of  the section effective gross area 
divided by the distance between neutral axis and the 
end fibre in tension (x-). 

Single click 

St (My-) Elastic section modulus in tension taken from the 
moment of  inertia of  the section effective gross area 
divided by the distance between neutral axis and the 
end fibre in tension (x+). 

Single click 

Stn Mx+) Elastic section modulus in tension taken from the 
moment of  inertia of  the section effective net area 
divided by the distance between neutral axis and the 
end fibre in tension (y-).  

Single click 

Stn (Mx-) Elastic section modulus in tension taken from the 
moment of  inertia of  the section effective net area 
divided by the distance between neutral axis and the 
end fibre in tension (y+). 

Single click 

Stn (My+) Elastic section modulus in tension taken from the 
moment of  inertia of  the section effective net area 
divided by the distance between neutral axis and the 
end fibre in tension (x-). 

Single click 

Stn (My-) Elastic section modulus in tension taken from the 
moment of  inertia of  the section effective net area 
divided by the distance between neutral axis and the 
end fibre in tension (x+). 

Single click 

Sxc (Mx+) Elastic section modulus in compression of  unreduced 
section area relative to X-X neutral axis perpendicular 
to web. (Ix is divided by the distance between neutral 
axis and end fibre in compression.)  

Single click 

Sxc (Mx-) Elastic section modulus in compression of  unreduced 
section area relative to X-X neutral axis perpendicular 
to web. (Ix is divided by the distance between neutral 
axis and end fibre in compression.) 

Single click 
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Column Description Editing 

Syc (My+) Elastic section modulus in compression of  unreduced 
section area relative to Y-Y neutral axis parallel to web. 
(Iy is divided by the distance from neutral axis to the 
end fibre in compression.) 

Single click 

Syc (My-) Elastic section modulus in compression of  unreduced 
section area relative to Y-Y neutral axis parallel to web. 
(Iy is divided by the distance from neutral axis to the 
end fibre in compression.) 

Single click 

Awx  Web net area – weak axis Single click 

Awy Web net area – strong axis Single click 

hx  Web height in the direction of  weak axis (longest 
component) 

Single click 

hy Web height in the direction of  strong axis (longest 
component) 

Single click 

wxp Length used for the calculation of  W, clause 6.4.4, for 
Mrx positive. 

Single click 

wxn Length used for the calculation of  W, clause 6.4.4, for 
Mrx negative. 

Single click 

wyp Length used for the calculation of  W, clause 6.4.4, for 
Mry positive. 

Single click 

wyn Length used for the calculation of  W, clause 6.4.4, for 
Mry negative. 

Single click 

a Distance between transverse stiffeners; distance c/c 
between webs of  caisson sections. 

Single click 

r1 Radius of  gyration of  non-reduced area of  a particular 
section included in a combined section. 

Single click 

qsx  Single click 

qsy  Single click 

Q For a class 4 section: This ratio is equal to f'y/fy, 
where f'y is corresponding to the equivalent yield 
stress of  a class 3 section. 

Single click 

Perimeter Perimeter of  the section. Single click 
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Calculation of Saint-Venant torsional constant 
Open Sections 

( )3
n

1i
i tiI3

1J ∗∗= ∑
=     

Where 

I=median length of element sections 

t= thickness of the element steel sections 

Caisson Beams 
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Where 

a = distance between web axes 

b = distance between flanges axes 

t1 = flanges thickness 

t2 = webs thickness 

Calculation of Lateral Buckling Constant: 
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Built-up Shapes Spreadsheet 

   
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Calculated automatically No 

Metric 
Designation  

The metric designation for this section (12 
alphanumeric characters) 

Single click 

Imperial 
Designation  

The imperial designation for this section (12 
alphanumeric characters) 

Single click 

Material Choose the shape material in the Material 
selection tree. 

Double-click 
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Column Description Editing 

Canada 
USA 
Europe 

Shape availability in Canada, USA or Europe. 
These fields cannot be edited except for 
personalized shapes. If  available in one of  these 
countries, activate the cell [ x ] by double-clicking. 

Double-click 
or Space bar 

Distribution Assign a "Public" or "Private" distribution to your 
personalized shape.  A private shape will not be 
merged into another database at the opening of  
the file.  The distribution of  pre-defined shapes is 
not editable. 

Double-click 

Class Class of  the Built-Up section. Double-click 

d sup Distance between the centre and top fibre Single click 

d inf Distance between the centre and bottom fibre Single click 

b2 (right) Distance between centre and right end of  fibre Single click 

b1 (right) Distance between centre and left end of  fibre Single click 

d(τ|Tz) Distance to be used for calculating the shear stress 
in torsion: d(Tau|Tz) * Tz / J.  

See the examples below. 

Single click 

Area Section area Single click 

Shear area 
dir.x 

Shear area of  the section on local x-axis, used to 
calculate the shear resistance. 

Single click 

Shear area 
dir.y 

Shear area of  the section on local y-axis, used to 
calculate the shear resistance. 

Single click 

Ix Moment of  inertia – strong axis Single click 

Iy Moment of  inertia – weak axis Single click 

Zx Plastic section modulus – strong axis. Single click 

Zy Plastic section modulus – weak axis. Single click 

J Torsional constant Single click 

Cw Warping torsional constant Single click 

Crt 
dir. x 

Shear constant in the local x-direction. Single click 

Crt 
dir. y 

Shear constant in the local y-direction. Single click 
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Column Description Editing 

βx Mxp Coefficient of  mono-symmetry used for 
calculating the positive bending strength on strong 
axis. Refer to T. Galambos, 5e éd., page 201. 

Single click 

βx Mxn Coefficient of  mono-symmetry used for 
calculating the negative bending strength on 
strong axis. Refer to T. Galambos, 5e éd., page 
201. 

Single click 

xo Distance between centre of  gravity and shear 
centre, in the local x-direction, for mono-
symmetric sections. 

Single click 

yo Distance between centre of  gravity and shear 
centre, in the local y-direction, for mono-
symmetric sections. 

Single click 

Q For a class 4 section: This ratio is equal to f'y/fy, 
where f'y is corresponding to the equivalent yield 
stress of  a class 3 section. 

Single click 

Perimeter Perimeter of  the section. Single click 

 

Tau_max Computation Examples  
For a cylindrical shape: 

Tau_max = (Tz*r_ext)/J 

Where 

Tau_max:  Shear stress for max torsion; 

Tz:  Torsion Moment; 

r_ext: Exterior radius of cylinder (For a cylindrical shape, this distance 
corresponds to d(Tau|Tz).  

For a built-up shape, this distance is measured from centre of gravity to 
extreme fibre.); 

J:  Torsional constant of the section; 

Calculation of Tau_max for a single plate: 

Tf = torque applied to the whole section 

Ti = torque applied on one plate 

JT = torsional constant of the section 

Ji = torsional constant of one plate 



C H A P T E R  2  M A T E R I A L S  &  S E C T I O N S  

2-48  CivilDesign Inc. Engineering Software 

 

 
Therefore, the distance "d" corresponds to the plate thickness. 

Calculation of Tau_max for an open section: 

Tf = torque applied to the whole section 

Ti = torque applied on one plate 

JT = torsional constant of the section 

Ji = torsional constant of one plate 

Each plate will carry on a part of the applied torque according to its 
stiffness. 
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Therefore, the maximum value of "d" will be equal to the biggest thickness of 
plates composing the section.  
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Composite Slabs Spreadsheet 
This spreadsheet is used for composite beams only. The defined slab will be 
selected in the Composite Beam tab of Member Characteristics.  

Group: Structural data 

Column Description Editing 

ID Automatically calculated No 

Number Number (description) Single click 

Steel deck Double-click in the cell and choose a steel deck Double-click 

Direction Direction of  steel deck rib, relative to the beam 
(perpendicular, parallel) 

Double-click 

tc Total slab thickness (without the steel deck) Single click 

hd Thickness of  the slab located above steel deck. Single click 

to Total thickness (tc + hd) No 

Rod, top Rebars located at top of  slab. Double-click 

S, top Spacing between top rebars Single click 

d, top Distance between centre of  gravity of  top rebars 
and top of  slab. 

Single click 

Rod, bot Rebars located at bottom of  slab. Double-click 

S, bot Spacing between rebars at the bottom. Single click 

d, bottom Distance between centre of  gravity of  bottom 
rebars and top of  slab. 

Single click 

Rebar Material Choose the rebar steel grade among the drop-
down list box 

Double-click 

Concrete Material Choose the slab concrete material. Double-click 

See also 
Types of Steel decks  
Rebar Steel Grades  
Type of Rebars  
Defining a Member as Composite  

Composite Slabs 
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Composite Slab Parameters 

 

Studs Spreadsheet 
Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated No 

Number Stud number or concise description Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

Diameter Diameter of  the rod Single click 

Height Stud total height Single click 

Fu Tensile strength of  steel. Single click 
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Column Description Editing 

Type Type of  studs (Only the Neilson type is available 
for the moment) 

Double-click 

Steel Decks Spreadsheet 
Group: Structural Data 

Column Description Editing 

ID Automatically calculated No 

Number Steel deck number or concise description. Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

Thickness Thickness of  steel deck. Single click 

hd Height of  steel deck. Single click 

w1 Bottom width Single click 

w2 Top width Single click 

wp Slope width Single click 

wt Length of  the decks (information only) Single click 

nhd Height of  groove  Single click 

nw2 Exterior width of  groove Single click 

nw1 Interior width of  groove Single click 

Composite If  the deck is textured to increase the composite 
action, choose option [ x ]. 

Double-click 
or Space bar 

Type Type of  deck (Inclined grooves, Sinusoidal 
grooves, or Rectangular grooves, or Flat) 

Double-click 

Material Material of  the deck (code: ASTM A653 SS Grd 
230) 

Double-click 

See also 
Types of Steel decks  
Slabs spreadsheet  
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Floors spreadsheet  

Types of Steel Decks 

 
See also 
Steel decks spreadsheet  
Slabs spreadsheet  
Floors spreadsheet  
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Rebar Steel Grades Spreadsheet 
This spreadsheet, located in the Common/Reinforcement menu, includes a 
list of rebar steel grades.   

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated No 

Number Brief  description of  the rebar Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

E Modulus of  elasticity Single click 

G Shear modulus Single click 

µ Poisson’s ratio Single click 

Density Density of  material  Single click 

Thermal Coeff. Coefficient of  thermal expansion Single click 

Fy Yield strength of  steel. Single click 

Fu Tensile strength of  steel. Single click 

Weldable If  this steel grade is weldable, choose option [ x ]. Double-click 
or Space bar 

See also 
Rebar Bending Shapes 
Types of Rebars  

Reinforcement 
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Standard Reinforcing Bars Spreadsheet 
In this spreadsheet, you will find information about steel reinforcing bars: 
Diameters, bending dimensions according to grade (R,W), usage (S: anti-
seismic), and composition (E: epoxy coating).  

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated No 

Number 12 alphanumerical characters. Imperial rebars 
number must begin with symbol #. 

Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

Area Area of  the steel bar Single click 

Diameter Diameter of  the steel bar Single click 

Linear Mass Linear mass of  the steel bar Single click 

Perimeter Perimeter of  the steel bar Single click 

Maximum length Maximum manufactured length for this steel bar. Single click 

Colour Colour assigned to this bar. To modify it, double-
click in the cell and choose another one among 
the list box. 

Double-click 

k Factor  
Plain Bar 

This factor (> 1.0) is used to calculate the 
development length for plain bars.  
(Dev. Length of  plain bar = k * deformed rebar 
development length calculated by VisualDesign) 

Single click 

Surface Surface of  this steel bar: Deformed or Plain. Double-click 

DR Standard mandrel diameter for a rebar of  grade R Single click 

AG90R Length A or G for a 90 deg. standard hook (grade 
R). 

Single click 

AG180R Length A or G for a 180 deg. standard hook 
(grade R). 

Single click 

J180R Height J of  a 180 deg. hook (grade R). Single click 
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Column Description Editing 

DW Standard mandrel diameter for rebar of  grade W. Single click 

AG90W Length A or G for a 90 deg. standard hook (grade 
W). 

Single click 

AG180W Length A or G for a 180 deg. standard hook 
(grade W). 

Single click 

J180W Height J of  a 180 deg. hook (grade W). Single click 

DE Standard mandrel diameter for an epoxy coated 
rebar. 

Single click 

AG90E Length A or G for a 90 deg. standard hook epoxy 
coated. 

Single click 

AG180E Length A or G for a 180 deg. standard hook 
epoxy coated 

Single click 

J180E Height J of  a 180 deg. hook with epoxy coating. Single click 

DS Standard mandrel diameter for stirrups and cross 
ties. 

Single click 

AG90S Length A or G of  a 90 deg. standard hook for a 
rebar used as a stirrup or a cross tie  

Single click 

AG135S Length A or G of  a 135 deg. seismic hook for a 
rebar used as a hoop or seismic cross tie  

Single click 

Maximum Length Rebar maximum manufactured length.  Single click 

See also 
Rebar Steel Grades  
Bending Shapes  
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The FRP Reinforcing Bars Spreadsheet 
In this spreadsheet, you will find information about fibre reinforced polymer 
bars. These bars can be used to reinforced concrete structures.  

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated No 

Number 12 alphanumerical characters. Imperial rebars 
number must begin with symbol #. 

Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

Type of  fibre Select a type of  fibre among the list: Glass, 
Carbon or Aramid. 

Double-click 

Area Area of  this bar. Single click 

Diameter Diameter of  this bar. Single click 

Linear Mass Linear mass of  this bar. Single click 

Perimeter Perimeter of  this bar. Single click 

Maximum Length Maximum manufactured length for this bar. Single click 

Colour Colour assigned to this bar. To modify it, double-
click in the cell and choose another one among 
the list box. 

Double-click 

kb This factor is used to calculate the development 
length for FRP bars. It must exceed 1.0.  
(Ex: Dev. length of  FRP bar =  
kb * development length for deformed rebar, 
calculated by VisualDesign) 

Single click 

Ffu Ultimate tension limit of  the PRF bar. Single click 

Ef Young modulus of  the longitudinal PRF bar. Single click 

Coefficient for 
transv. thermal 
expansion 

Specify the coefficient for transverse thermal 
expansion for this bar if  temperature loads are 
applied to the structure. 

Single click 
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Column Description Editing 

Coefficient for 
longit. thermal 
expansion 

Specify the coefficient for longitudinal thermal 
expansion for this bar if  temperature loads are 
applied to the structure. 

Single click 

D Mandrel diameter for a FRP bar Single click 

AG90 Length A or G for a 90 deg. standard hook Single click 

AG180 Length A or G for a 180 deg. standard hook Single click 

DS Mandrel diameter for stirrups and cross ties. Single click 

AG90S Length A or G of  a 90 deg. standard hook for a 
FRP bar used as a stirrup or a cross tie  

Single click 

AG135S Length A or G of  a 135 deg. seismic hook for a 
FRP bar used as a hoop or seismic cross tie  

Single click 

The Meshes Spreadsheet 
This spreadsheet, accessible through Common / Reinforcement menu, 
includes information about available meshes that can be used to reinforced 
concrete structures.   

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated No 

Number Name of  this mesh (12 alphanumerical 
characters).  

Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

Area Area of  bars composing this mesh. Single click 

Diameter Diameter of  bars composing this mesh. Single click 

Linear Mass Linear mass of  bars composing this mesh. Single click 

Perimeter Perimeter of  bars composing this mesh. Single click 

Maximum Length Maximum manufactured length for this bar. Single click 
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Column Description Editing 

Colour Colour assigned to this bar. To modify it, double-
click in the cell and choose another one among 
the list box. 

Double-click 

Factor k 
Plain bar 

This factor is used to calculate the development 
length for pain bars. It must exceed 1.0.  
(Ex: Dev. length of  plain bar =  
k * development length for deformed rebar, 
calculated by VisualDesign) 

Single click 

Surface Type of  surface for bars that are composing this 
mesh. 

Double click 

Rebar Bending Shapes 
This spreadsheet, located in the Common/Reinforcement menu, includes a 
list of standard bending shapes that can be used for Concrete Design.  

If you own the Reinforced concrete design module, you will choose bar 
bends within the Main Reinforcement spreadsheet and Transverse 
Reinforcement spreadsheet in order to design continuous systems in your 
structure. In fact, these two spreadsheets have a column titled "Bending Shape" 
which includes all the bending shapes that you will find in this table. 

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated No 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

Image Image of  the bending shape No 

Bend number Type of  bend. See figures below Double-click 

Alias Rebar bending type: 
C: tie 
E: stirrup 
F: hoop 
L: L bent bar 
R: bent-up bar 
U: U bent bar 
Y: miscellaneous bent bar 

Double-click 
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Column Description Editing 

Modified Alias Some bending shapes may possess two aliases. Double-click 

Number of  Vy 
planes 

Number of  stirrup legs that may be used in the 
calculation of  the section shear capacity, 
according to strong axis. 

No 

Number of  Vx 
planes 

Number of  stirrup legs that may be used in the 
calculation of  the section shear capacity, 
according to weak axis. 

No 

Family Bending shapes family: 
 
1. Transverse Reinforcement: 
Closed tie 
Cross-tie 
Hoop 
Stirrup 
2. Longitudinal Reinf. 1 plan 
3. Longitudinal Reinf. 2 plans 

No 

Category Type of  reinforcement: main or transverse No 

Availability If  this bending shape is available, choose option [  
x  ]. 

No 
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Types 1 to 26 and type L represent standard bending shapes for longitudinal 
reinforcement bars. They are shown below:  

  
Types S1 to S11, SP included, represent bending shapes for transverse 
reinforcement bars for various concrete members. You will notice that the 
following bending shapes are open ties only: 
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Types T1 to T9 are closed ties (including hoop reinforcements, cross-ties and 
seismic cross-tie) for transverse reinforcements that must carry only shear 
stresses present in concrete members. These bending shapes are used in 
seismic design. They are the following: 

  
See also 
Types of Rebars  
Rebars Steel Grades 
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Cable Steel Grades Spreadsheet 
Define the steel grade that you will use in your prestressed concrete project. 
Select Cables/Steel Grades under Common menu.  

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated No 

Number Grade number (12 alphanumerical characters). Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  the 
file.  The distribution of  a pre-defined object is 
"Public" and is not editable. 

Double-click 

Fu Tensile strength for this grade Single click 

εa 0.008. See the note below Single click 

σ1 See the note below. Single click 

ε1 See the note below Single click 

k1 See the note below. Single click 

α 0.98. See the note below. Single click 

According to commentary C.8.4.3.2 "Stress-strain relationship" of S6-00 Code 
concerning strands: 

For a low-relaxation 7 wire prestressing strand: 

If 
008,0≤ε p    

We can say that: 

Ef ppp
⋅=ε  

If 
008,0>ε p  

 

 

Cables 
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For a Grade 1760 Strand: 

ff pu
p

p
⋅<

−
−= 98.0

00614.0
433.01749

ε  
In VisualDesign: 

fkf pu
p

p
⋅<

−
−= α

εεσ
1

1
1

   

So: σ 1 = 1749 

 k1  = 0.433 

 ε 1  = 0.00614 

 α  = 0.98 

N.B. Be careful with units. MPa are used in formulas. 

For a Grade 1860 Strand: 

ff pu
p

p
⋅<

−
−= 98.0

0065.0
517.01848

ε  
You will find the following values in the Cable Steel Grades spreadsheet: 

  σ 1 = 1848 

  k1  = 0.517 

  ε 1  = 0.0065 

  α  = 0.98 

See also 
Strands spreadsheet  
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Strands Spreadsheet 
Define the type of strands that will be included in your prestressed concrete 
project. Select Cables/Strands under Common menu.  

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated  No 

Number 12 alphanumerical characters Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  the 
file.  The distribution of  a pre-defined object is 
"Public" and is not editable. 

Double-click 

Type Choose a type of  strand among the drop-down list: 
Low relaxation, Smooth high strength bars, 
Deformed high strength bars, Normal relaxation 

Double-click 

Diameter Enter the strand diameter. (This value is used for 
screen display only.) 

Single click 

Area Enter the strand area Single click 

Material Choose the strand steel grade among the drop-
down list. To add or modify steel grades, select the 
Steel Grades spreadsheet under Common/ 
Cables menu. 

Double-click 

See also 
Prestressed Concrete Module  
Post-tensioning Mechanisms  
Cable Groups Spreadsheet  
Cable Layouts spreadsheet  
Cable Steel Grades Spreadsheet  



C H A P T E R  2  M A T E R I A L S  &  S E C T I O N S  

2-66  CivilDesign Inc. Engineering Software 

Post-tensioning Mechanisms 
Define the post-tensioning mechanisms that will be used in your prestressed 
concrete project. Select Cables/Post-tensioning Mechanisms under 
Common menu. Two types are available: with sheath or through external 
deviator. 

Group: Shared Data: VDBase.mdb 

Column Description Editing 

ID Automatically calculated  No 

Number 12 alphanumerical characters Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object is 
"Public" and is not editable. 

Double-click 

Type Choose a type of  post-tensioning mechanism: 
Sheath or External deviator. 

Double-click 

Wobble friction, 
K 

Enter the wobble friction coefficient per meter of  
strand length. 

Single click 

Friction 
coefficient, Mu 

Enter the friction coefficient Mu. Single click 

Sheath diameter Enter the sheath diameter (used for screen display 
only). 

Single click 

Length of  
deviator 

Enter the length Ld of  external deviator. This 
value is used to calculate prestress losses (friction 
between cable and deviator). 

Single click 

Deviator 
curvature 

Enter the deviator curvature, ρd, for screen 
display only. 

Single click 

See also 
Prestressed Concrete Module  
Project Configuration (Prestressing tab)  
Strands spreadsheet  
Cable Group spreadsheet  
Cable Layout spreadsheet  
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Bolt Steel Grades Spreadsheet 
Define the bolt steel grades that you will be using in the design or verification 
of bolted connections. In the Common menu, select heading Bolts/ Steel 
Grades. 

Group: Shared Database VDBase.mdb 

Column Description Editing 

ID Automatically calculated No 

Number Enter a number for this bolt steel grade (Up to 12 
alphanumerical characters). 

Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

See also 
Bolts spreadsheet  

Bolts Spreadsheet 
Go to Common menu and select heading Bolts/ Bolts. For each type of bolts 
(metric and imperial) listed in this spreadsheet, you will find its diameter, 
nominal area, hole diameter, steel grade and corresponding tensile strength Fu.  

Group: Shared Database VDBase.mdb 

Column Description Editing 

ID Automatically calculated No 

Number Enter a number describing this bolt (Up to 12 
alphanumerical characters). 

Single click 

Distribution Assign a "Public" or "Private" distribution to your 
personalized object.  A private object will not be 
merged into another database at the opening of  
the file.  The distribution of  a pre-defined object 
is "Public" and is not editable. 

Double-click 

Nominal Area Bolt nominal area Single click 

Diameter Bolt diameter Single click 

Bolts 
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Column Description Editing 

Hole Diameter Required hole diameter for this bolt. Single click 

Head thickness Thickness of  the bolt head. Single click 

Head diameter Diameter of  the bolt head Single click 

Fu Tensile strength for this type of  bolt. Single click 

Material Bolt steel grade Double-click 
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Coordinates Dialog Box and Axis System 
With VisualDesign™, you can work in 2D or 3D Cartesian system. 

A Coordinates dialog box appears when you use commands Add, Move and 
Rotate. General axes accompany this dialog box. This dialog box allows you to 
point coordinates or define new ones. It can be entitled Origin Point or 
Insertion Point. 

  
When defining an origin point or insertion point, coordinates can be selected 
by pointing and clicking or by typing in the Coordinates dialog box.  

Shortcut keys: 

x, y or z: Activates box X, Y or Z 

a: Activates option Attach to Node 

The coordinates are displayed as the pointer is moved.  

Note.  To select coordinates for one axis at a time, activate the respective axis check-
off box. 

"Delta" Option 
When selecting coordinates using the pointer, values of coordinates can be 
varied in increments (e.g. 0.1m.). To do so, click on "Delta" and type in the 
value.  

Note.  To select coordinates one axis at a time, activate the respective axis check-off 
box. 

"Attach to Node" Option 
With the "Attach to node" activated, locating the pointer near a node and 
clicking with the left mouse button will attach the pointer to the node and 
select its coordinates in the dialog box.  

Coordinates 
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Defining Coordinates 
To store the coordinates of a point, use one of the following methods: 

• With the left mouse button depressed move your cursor and press the 
"X", "Y" or "Z" keys on your keyboard when you want to select x, y or 
z values in the Coordinates dialog box. The respective check-off boxes 
will be activated and the values indicated. To store the coordinates and 
quit the dialog box, press the "OK" button. 

• Enter manually the x, y, and z values in the Coordinates dialog box 
after you have activated the check-off boxes of these values. In 
activating those boxes, you freeze all moves from the cursor. To store 
the coordinates and quit the dialog box, press the "OK" button. 

Note that if you want to move the cursor along one axis at the time, you can 
do so by blocking the two other axes. 

Note.  When working in 3D, VisualDesign™ offers the XY plane by default, blocking 
the z-axis. To unblock it, activate the corresponding check-off box. 
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The Node Element 
  

The "Node" icon of Elements toolbar 
The node is an element located at the junction of one or more members, floors 
or plates. 

There are two types of nodes: the normal node and the support node. 

The node has its own icon on the Elements toolbar. It can be added or moved 
with the Add or Move icons of Edit toolbar. Furthermore, the Node icon 
must be selected to move or add a support. 

See also 
Nodes spreadsheet  
Node Characteristics  
Inactive Nodes  
Forces on Nodes  

Inactive Nodes 
An inactive node is not linked to anything. We recommend that you delete 
inactive nodes that may be present in your structural model.  

VisualDesign warns you that there are inactive nodes in your project when you 
launch a static analysis or a design. It is written in the Analysis or Design 
dialog box. 

To find and delete these nodes, use the function Select/Inactive Nodes in 
Edit menu. Then, select them and press the [Delete] key. 

Node Characteristics Dialog box 
While in the "Structure" mode, access to the Node Characteristics dialog box 
by double-clicking on a node or a support. The dialog box will include the 
Node tab and Support tab if a support was selected.  If nodes were selected, 
only the Node tab will appear.  

To modify many nodes and/or supports in one click, select many of them and 
press the Properties icon. Enter values in blank fields.   

The table below shows the definition of headings composing the Node tab. 

Nodes 
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Heading Description 

Identification  

ID Identification number associated with a node (automatically 
calculated) 

Number Number of  the node 

Type of  node Specify if  the node is a normal node or a support node 

Coordinates Enter the x, y, and z coordinates of  the node 

Dependant node  

Master node ID Enter the ID of  the master node associated with this node. The 
node becomes a slave node to this master node. 

Number Number associated to the master node ID. 

Behaviour This shaded field indicates the behaviour of  the master node 
towards the slave nodes:  n/a, Rigid links, Translation. 

Consider this 
Elevation 

VisualDesign automatically seeks for levels in the structural 
model (horizontal plates or floors) and calculates the dead load 
of  each level. Activate options if  there is no horizontal element 
indicating a level for VisualDesign, if  you want to obtain results 
for particular levels. 
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Heading Description 

Level - Seismic Activate this box to include this level into seismic analysis. You 
should specify a level near supports to minimize the non-
participating mass that is distributed to supports. One node per 
level is sufficient. 

Level - Shear Wall Activate this box to obtain results at this level in the shear wall 
if  there are openings. One node per level is sufficient. 

(1) This box can be activated if you own the Dynamic Analysis module or 
Reinforced Concrete Design module (analysis of a shear wall).  

See also 
The Support tab  
Inactive Nodes  
Dynamic Analysis Module  
Shear Wall  
Reinforced Concrete Design module  

Nodes Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters describing the node 
number. 

Single click 

Type Type of  node: normal or support. Double-click 

X Coord.  X-coordinate Single click 

Y Coord.  Y-coordinate Single click 

Z Coord.  Z-coordinate  Single click 

Master Node ID ID of  the master node associated to this node. Single click 

Linked DOF  Degree of  freedom between the master and slave 
node (n/a, rigid link, translation). 

No 

Level - Seismic Activate option [ x ] to consider this node as a 
level in the seismic analysis. 

Double-click 
or Space bar 

Level - Shear Wall Activate option [ x ] to consider this node as a 
level for shear wall design, if  there is an opening 
in the wall.  

Double-click 
or Space bar 
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The Support Element 

  
The "Support" icon of Elements toolbar 
The support is a node that is generally located at the base of a column, for 
example, and receives the loads that are transmitted by the columns to the 
foundations. 

The support has its own icon on the Elements toolbar. A support can be added 
or moved by joining the Node icon to those of the Add or Move icons of the 
Edit toolbar. 

See also 
Support Characteristics Dialog Box 
Support’s DOF  
Support Orientation  
Support in Analysis  
Spring Supports  
Support Release  
Supports Spreadsheet  
Spring Supports Spreadsheet  
Released Supports Spreadsheet  

Support in Analysis 
There must be at least one support for each sub-structure. A structure might 
have sufficient supports, however, if one or more supports do not have 
rotational restraint (i.e. Fixed Mx, My or Mz), it will create structural instability. 
If this is the case, VisualDesign™ will warn you that a null pivot have been 
found in the stiffness matrix. 

See also 
Null pivot  

Support's Degrees of Freedom and Behaviour 
By default, translation degrees of freedom (Rx, Ry, Rz) are represented by 
yellow cones and rotation degrees of freedom (Mx, My, Mz), by red cones. 

When the degree of freedom is released in one direction, the attached cone 
disappears. 

Supports - General 
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By default, a new support is blocked in all directions (Rx, Ry, Rz, Mx, My, and 
Mz). However, it is possible to release one or more restraints in the Support 
tab of the Node Characteristics dialog box. Directions indicated in this tab 
are according to the support local axis system. 

Behaviour of Spring Supports 

A support can behave like a spring in one direction or more, to model the soil 
acting below a foundation slab or along walls, if you do not own the 
Foundation Design Module. In this case, you shall specify the support as a 
spring and enter the stiffness of the soil, K. Then, specify the tributary area of 
the soil acting on each spring support.  

If finite elements are present and fixed to spring supports, the tributary areas of 
the soil acting on each spring support, in each direction, can be automatically 
calculated with this function Calculation of Tributary Areas (Structure / Tools 
menu). Refer to topic Spring Supports.  

Secant Modulus K (Foundation Supports) 

If you own the Foundation Design Module, VisualDesign can automatically 
calculate the soil rigidity. Select the option Secant Mod. K in the Support tab, for 
some degrees of freedom, or for all of them, and select a foundation model. 
The rigidity of supports will be calculated and written in the shaded fields next 
to each degree of freedom.  

Support Axial Release 

The support can be released in one direction at a time, negative or positive, to 
simulate uplift.  It can also be considered inactive if released, meaning that the 
support degrees of freedom will be free, so the shear force will not be 
considered. Refer to topic Released Support.  
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Here is how to block or unblock a support displacement or rotation in one 
direction, or to create spring behaviour: 

Restraint and behaviour 

Displacement Rotation 

 

The support is free to move along the local 
x-direction. 

 

The rotation of  support is allowed around local 
x-axis. 

 

The support cannot move along the local 
x-direction. 

 

The support cannot rotate around local x-axis. 

 

The support is elastic along the local x-
direction. The linear rigidity constant of  
the spring must be entered according to 
displayed units. To modify units, open the 
Spring Supports spreadsheet and use the 
contextual menu. 

 

The elastic torsional rotation is allowed around 
the local x-axis. The constant for torsional 
stiffness must be entered according to displayed 
units. To modify units, open the Spring 
Supports spreadsheet and use the contextual 
menu. 

 

The secant modulus K of  this spring 
support is automatically calculated 
according to the stratigraphical profile, 
when a foundation model is selected in the 
Support tab.  

 

The secant modulus K for torsional rotation is 
automatically calculated according to the 
stratigraphical profile, when a foundation 
model is selected in the Support tab.  

See also 
Supports Spreadsheet  
Spring Supports  
Released Supports  

Static Analysis with Axial Release 
When supports or members are released, you must run a static analysis 
considering axial release. This type of analysis, which is linear, must be 
activated in the Analysis tab of Project Configuration dialog box. You 
cannot run a design, which is a non-linear type of analysis, if there are members 
or supports with axial releases.  
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Support Characteristics 
While in the "Structure" mode, activate the Support icon and access to the 
Support tab of Node Characteristics dialog box by double-clicking on a 
support. If the node element is activated on Elements toolbar, The Node tab 
will also be part of the Node Characteristics dialog box. 

  

To modify many supports in one click, select many of them and press the 
Properties icon. Enter values in blank fields.   

The table below shows the definition of headings composing the Support tab. 

Heading Description 

Restrictions and 
Rigidities 

Refer to Support's Degrees of  Freedom 

Support Release Refer to Support Release  

Foundation Model and Stratigraphical Profile 

Foundation Select the name of  foundation model to be assigned to this 
support. If  the support was modeled using option Secant Modulus 
K, the spring stiffness will be automatically calculated and posted 
next to each support degree of  freedom that uses this option.  

Support Characteristics Dialog Box 
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Heading Description 

Stratigraphical Profile  For Culvert Generation and Abutments, Piers, and Retaining 
Walls Generation Modules: the stratigraphical profile is 
automatically selected for spring supports, which model the soil 
stiffness. 

Tributary Area Spring Supports only: Enter the tributary area of  soil acting on 
the spring support. 

For spring supports with finite elements only: Call up the 
function Calculation of  Tributary Areas.  

For Culvert Generation and Abutments, Piers, and Retaining Walls Generation 
Modules: The tributary area of soil is automatically calculated.  

Support Orientation Refer to Orientation of  Support Node 

Moving Load 
Analysis 

Select the 2D axles factor that will be applied to this support. 
Refer to 2D Axle Factors for Supports  

Position of  Support 
During Design 

For a support that is linked to a member having lateral rigid 
extensions, refer topic to Position of  Support  

See also 
Support in Analysis  
Support Results  
Position of Support 
Definition of Foundation Models  

Orientation of a Support Node 
The support can be oriented in a specific direction, identified by the user in the 
Support Characteristics dialog box. The support orientation is defined by its 
local axis z (z’) that is oriented according to vectors x, y and z or towards a 
node specified by its number in Node Orientation field. 

Orientation Vectors 
The orientation of a support is always done through orientation vectors x, y 
and z. 

Orientation Node 
The support can be oriented according to a node. In this case, the user enters 
the node number in the appropriate field. Then, if the dialog box is open after 
orientation is done, orientation vectors will appear in the dialog box.  

Note. If the orientation node is moved, the orientation of support local axis system 
will also change. 
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Rotation of the support 
It may also be rotated about its local "z" axis by specifying an angle of rotation 
in the Rotation section. The direction of rotation follows the Beta angle 
convention for members. 

When the support node has no specified orientation, its local axis system is 
identical to the global axis system. 

Position of Support during a Design 
If a support is attached to a vertical member having lateral rigid 
extensions, do as follows:  

Activate this box in the Support Characteristics dialog box to keep the 
support centred on the member axis in order to avoid offset and bending 
moment in the member. This particular case can happen when the steel shape 
grows bigger during a steel design. 

Furthermore, this support node must be a master node and the end of the 
member, which is linked to this node, must be specified as a slave node. Look 
at the figure below.  
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See also 
Rigid Extensions  
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Spring Supports 
Spring supports are mostly used to model the soil behaviour beneath a footing 
or next to a wall.  

Spring supports are automatically generated when modeling culverts or piers, 
abutments and retaining walls using these generation modules. They are also 
modeled along piles when using the Foundation Design module.  

Soil stiffness 
Open the Support tab of the Node Characteristics dialog box. To model 
spring supports, Rx, Ry, and/or Rz boxes must be checked and shaded. The 
soil stiffness, K, must be specified in the blank fields next to theses boxes, as 
shown below.  This K value depends on the secant modulus of the soil, Ks, 
and on the tributary area of soil acting on a spring support. (K= Ks*A)  
(References: Bowles, 5e Ed., page 303. The secant modulus of the soil, Ks, can be calculated using the 
Young modulus of the soil and the parameter µ (mu), which are supplied in VisualDesign’s soils 
spreadsheet. Footing or wall dimensions and the thickness of the stratum are also required among others.  

Tributary Area of Spring Supports 
If spring supports are modeled with finite elements (plates), such as slabs or 
walls, use the function Calculation of Tributary Areas to quickly obtain the 
tributary areas of each spring support, in each direction. This function is 
available in Structure menu / Tools. The calculated values will be indicated in 
the Support tab and in the Spring Supports spreadsheet.  

  

Spring Supports 



C H A P T E R  2  M A T E R I A L S  &  S E C T I O N S  

2-82  CivilDesign Inc. Engineering Software 

Releasing Spring Support for Uplift: 
Sometimes, it is necessary to release spring supports, depending on the type of 
structure and its behaviour under particular loads. Uplift is one of these cases. 
Spring supports must be released towards the y-direction (if it corresponds to 
gravity axis). When a spring support is released, the soil will no longer act on 
the support if uplift occurs and reaction Ry will be null.  

Static Analysis with Axial Release 
When supports or members are released, you must run a static analysis with 
axial release. This type of analysis, which is linear, must be activated in the 
Analysis tab of Project Configuration dialog box. You cannot run a design, 
which is a non-linear type of analysis, if there are members or supports with 
axial releases.  

Secant Modulus K for Spring Supports Assigned to Foundations 
Models 
If you own the Foundation Design module, please refer to Foundation 
Supports. 

Tributary Areas for Spring Supports 
Use this tool, which is located in Structure menu / Tools, to automatically 
calculate tributary areas in the x-, y- and z-direction, for spring supports that 
are associated to plate elements.   

Procedure: 

• Activate the Structure activation mode. 

• Select spring supports. 

• Go to Structure / Tools and select Calculation of Tributary Areas. 

Calculated areas will be written in the Support tab (Node Characteristics 
dialog box).   

N. B. For the Generation of Abutments, Piers & Retaining Walls module, 
spring support tributary areas are automatically calculated from the 
stratigraphical profile data and are indicated in the Support tab. 
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Support Release 
VisualDesign allows you to release a support in the x, y and z direction 
(positive or negative).  When a support is released in one direction (positive or 
negative), the corresponding reaction will be zero. 

Spring supports can be released also. 

Example 1: If this support is uplifted, the reaction Ry will be zero but Rx and 
bending moment My will not be zero.  

  

Procedure: 
Go to Project Configuration Analysis tab and activate the analysis With 
Release.  Increase the number of iterations to 15 or more (this number can be 
reduced after an analysis have been ran.) 

Select the support and open the Node Characteristics dialog box. In the 
Support tab, you must first tick off the Rx or/and Ry boxes to indicate that 
the support cannot move. Then, in the "Support Release" zone, you will notice 
that the boxes corresponding to the positive or negative displacement are all 
checked. This status means that the support is normal (with no release).  

To activate a displacement in a positive or negative direction, uncheck one of 
the following boxes: Rx+, Ry+, Rz+ or Rx-, Ry- or Rz-. It is not allowed to 
release the support in the positive and negative direction at the same time. 

Support Release 
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In the dialog box shown above, the support release is activated in the negative 
direction of y-axis. This means that only the positive reaction Ry (upwards) will 
be considered in the analysis.  

Inactive Support if Released 
A support becomes inactive if all its degrees of freedom are free. To do so, 
activate option Inactive if released in the Support tab. 

  
Example 2: If this support is uplifted (case 2), all reactions will be zero.  
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Secant Modulus K 
 If you own the Foundation Design module, VisualDesign can automatically 
calculate the linear and torsional rigidity of spring supports. It is done using the 
soils properties composing the stratigraphical profile, which is specified in a 
foundation model. Lateral and vertical displacements of the footing or slab can 
be obtained from these calculated values.  

The secant modulus replaces the Interaction status that considered the 
soil/structure interaction in previous compilations (231 and less).  

Procedure: 
• Define a shallow foundation model. 

• Select supports and press the Properties icon.  

• In the Support tab, choose option Secant modulus K for Rx, Ry, Rz, Mx, My, 
and/or Mz. 

• Assign supports to foundation models. 

The linear and torsional rigidity of the support will be calculated and written in 
the shaded field next to each degree of freedom corresponding to Secant 
modulus K.  

 

Foundation Supports 
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Pressure and Capacity of Spring Supports along 
Piles 
Once that a pile foundation analysis is done, you can display pressures acting 
on each spring support located along piles along with the capacity of spring 
supports.  

This option is available in the Results tab of View Options dialog box. Check 
the "Pressure and Capacity" box in the Supports section. A coloured legend will 
also appear to differentiate pressure diagram (orange) from the capacity 
diagram (blue). If you display numerical values, they will be the same colour as 
their respective diagram.  

The displayed values correspond to the envelope minimum and maximum 
forces. 
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Supports Spreadsheet 
This spreadsheet is split into three tabs: Standard, Spring, and Released. 

Here is a description of the Standard Supports Spreadsheet columns: 

The Standard tab 
Group: Structural data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters describing the support 
number. 

Single click 

Rx Displacement restraint in the x-dir.: Free, Fixed, 
Spring, or Secant Mod. K.  

Double-click 

Ry Displacement restraint in the y-dir.: Free, Fixed, 
Spring, or Secant Mod. K. 

Double-click 

Rz Displacement restraint in the z-dir.: Free, Fixed, 
Spring, or Secant Mod. K.  

Double-click 

Mx Rotation restraint around x-axis: Free, Fixed, 
Spring, or Secant Mod. K.  

Double-click 

My Rotation restraint around y-axis: Free, Fixed, 
Spring, or Secant Mod. K. 

Double-click 

Mz Rotation restraint around z-axis: Free, Fixed, 
Spring, or Secant Mod. K. 

Double-click 

Orientation 
Vector 
X 

Orientation vector, which orients the support 
according to global x-axis. Refer to Orientation of  
Support. 

Single click 

Orientation 
Vector 
Y 

Orientation vector, which orients the support 
according to global y-axis. 

Single click 

Orientation 
Vector 
Z 

Orientation vector, which orients the support 
according to global z-axis. 

Single click 

Angle Angle of  rotation of  the support, around the local 
z-axis. 

Single click 

Foundation Foundation model associated to the support. Double-click 

Supports Spreadsheet 
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Column Description Editing 

Axle Factor Axle factor for moving load analysis. This column 
appears for owners of  the Moving Load Analysis 
module 

Single click 

Centred on  
axis of  section 

For a design: If  the support is linked to a member 
having lateral rigid extensions, select option [ x ]. 
Refer to Position of  Support  

Double-click 
or space bar 

See also 
Support DOF 
Released Support Spreadsheet  
Spring Supports Spreadsheet  
Spring Supports Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters describing the support 
number 

Single click 

Kx Linear rigidity of  spring support in the x 
direction, according to secant modulus K. 

Single click 

Ky Linear rigidity of  spring support in the y 
direction, according to secant modulus K. 

Single click 

Kz Linear rigidity of  spring support in the z 
direction, according to secant modulus K. 

Single click 

Krx Torsional rigidity of  spring support around the x 
axis, according to secant modulus K. 

Single click 

Kry Torsional rigidity of  spring support around the y 
axis, according to secant modulus K. 

Single click 

Krz Torsional rigidity of  spring support around the z 
axis, according to secant modulus K. 

Single click 

Profile Stratigraphical profile below the spring support.  Double click 

Tributary Area Tributary area of  soil acting on the spring 
support. 

Single click 

See also 
Secant Modulus K for a Foundation Support  
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Released Supports Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters describing the support 
number. 

Single click 

Release 
Rx+ 

Activate this option ([ x ]) to get a null Rx+ 
reaction if  the support moves towards the 
negative direction of  x-axis.  

Double-click 
or Space bar 

Release 
Rx- 

Activate this option ([ x ]) to get a null Rx- 
reaction if  the support moves towards the positive 
direction of  x-axis.  

Double-click 
or Space bar 

Release 
Ry+ 

Activate this option ([ x ]) to get a null Ry+ 
reaction if  the support moves towards the 
negative direction of  y-axis. 

Double-click 
or Space bar 

Release 
Ry- 

Activate this option ([ x ]) to get a null Ry- 
reaction if  the support moves towards the positive 
direction of  y-axis. 

Double-click 
or Space bar 

Release 
Rz+ 

Activate this option ([ x ]) to get a null Rz+ 
reaction if  the support moves towards the 
negative direction of  z-axis. 

Double-click 
or Space bar 

Release 
Rz- 

Activate this option ([ x ]) to get a null Rz- 
reaction if  the support moves towards the positive 
direction of  z-axis. 

Double-click 
or Space bar 

Inactive if  
released 

Activate this option ([ x ]) if  you want the support 
inactive if  it is released, meaning that the degrees 
of  freedom will be free.  

Double-click 
or Space bar 
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The Member 

  
The  "Member" icon of Elements Toolbar 
A member must be located between two nodes and must be split at the 
junction of other members.  

The Member Dialog Box  
The Member tab  
Member Incidence  
Geometry  
Orientation of Beta Angle  
Pre-tensioned Members  
Member End Conditions  
Member Properties  
Member Usage  
Member with a Linear Behaviour  
Effective Stiffness  
Types of sections  
The Composite Beam tab  
The Filled HSS tab  
The Connection tab  
The Behaviour tab  

Beta Angle Convention 
With VisualDesign™, member’s vector ij corresponds to local axis z (z’). 
According to the CISC convention, the x’ axis is considered as the strong axis 
and the y’ axis, the weak one. 

The x’ axis is parallel to the horizontal plan of the global axes system while the 
y’ axis always has a positive component on the vertical axis of the global axes 
system. 
E X C E P T I O N  C A S E :  

When z’ is parallel to the gravity axis, x’ can take an infinity of directions 
relatively to the horizontal global axes system. In fact, y’ being also parallel to 
the horizontal plan of the global axes system, it does not have any component 
on the vertical axis which could help to determine x’ orientation. 

In this particular case, x’ will then be parallel to the x-axis. Otherwise, x’ will be 
parallel to y when the gravity axis is X. 

Members - General 
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Convention of beta angle beta and Strong Axis 
According to this convention, we will have for the strong axis: 

Ix Inertia  

Mx Bending moment  

Vy Shear 

rx Gyration radius 

Beta angle convention when Y is the gravity axis  
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Convention - Forces in members 
Sections’ strong and weak axes: 

 
The resistance of sections (Mr and Vr, ...) and results (internal stresses and 
deflections) are given in accordance to the local axes system (x, y, z). Local z-
axis is longitudinal to the member. 
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For steel angles, Mw and Mz values are always transformed into orthogonal 
axis system once that the design is completed.  

  
See also 
Major/minor and Orthogonal Axis Systems  

Major/minor and Orthogonal axis system for steel 
angles 
If you chose single steel angles and plan to run a design, we strongly 
recommend that you switch to a minor/major axis system once that the steel 
angle is properly positioned in space.  

When modeling: 

Use an orthogonal axis system in order to position the steel angle. The field 
"Local Axis System" of the Member tab (Member Characteristics dialog 
box) allows you to specify the orientation of beta angle. Select "Orthogonal" 
and enter a beat angle. Display the shape of the section through the Attributes 
tab (View Options) to make sure that it is correctly oriented. 

  
If you cannot orient the steel angle properly, use the "Invert Node i ↔Node j" 
option shown above. 
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For a Steel design: 

Once that the steel angle is correctly positioned, select all of them and switch 
to a major/minor. You will notice that the beta angle is automatically 
readjusted. 

 
Major and minor axis will be displayed as follows: 
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Remark  Beta angle orientation can vary during cycles of design (when steel angle 
changes) in order to maintain the orientation of orthogonal axes.  

See also 
Convention – Forces in Member  
Steel Design Criteria  

Member Incidence 
The member incidence is set when creating one. Node i is the first node 
selected and node j, the second. The member ij vector defines the local z (z’) 
axis. 

Display the member local axis system to look at the member incidence. The z-
axis is always pointing towards node j.  

It is possible to change member incidence by reversing nodes i and j order 
through the Member dialog box. To do so, press the button "Invert Node i ↔ 
Node j". Notice that when member incidence is modified, so are the member 
orientation and loads applied to the member. 

Pre-tensioned Members 
Select the Member tab of Member Characteristics dialog box and enter a 
pre-tension on the selected member. 

If you are using some pre-tensioned members in your project, VisualDesign™ 
considers this tension within each load combination separately when analyzing 
the structure. So, do not overlap (by hand) results because you will add extra 
forces and results will be incorrect. 

• Example: Bridge with pre-tensioned cables. Your load combinations 
are: 

• First load combination: Dead load only 

• Second load combination: Live load only 

• Third load combination: Dead load + Live load. 

VisualDesign™ will calculate as follow: 

• Dead load with pre-tensioned members; 

• Live load with pre-tensioned members; 

• (Dead load + Live load), including pre-tensioned members. 

And: (Dead load+pre-tension) + (Live load+pre-tension) ≠ (Dead load+Live 
load+pre-tension) 
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So, let VisualDesign™ combine load cases for you. 

Member End Conditions 
In the Member dialog box, you are asked to set the member end conditions 
for bending, torsion and axial behaviour. Note that Mx corresponds to bending 
in the strong axis, and My, the weak axis. 

Following are the potential types of end conditions for internal forces: 

Internal Forces Symbols Definition 

Bending Mx +------------+ 

+------------O 

O------------+ 

O------------O 

Rigid – Rigid 

Rigid – Hinge 

Hinge – Rigid 

Rigid – Hinge 

Bending My +------------+ 

+------------O 

O------------+ 

O------------O 

Rigid – Rigid 

Rigid – Hinge 

Hinge – Rigid 

Hinge – Hinge 

Torsion Mz +------------+ 

+------------O 

O------------+ 

Rigid – Rigid 

Rigid – Hinge 

Hinge – Rigid 

Axial Fz (1) <->[ ]<-> 

<-[ ]-> 

->[ ]<- 

Tension/Compression 

Tension only 

Compression only 

Note 1 
To model bracings with tension-only behaviour, select an tension-only axial 
end condition (<-[ ]->) and select option "Diagonal[Xt] " as member usage.   

For compression-only member, select a compression-only axial end conditions 
(->[  ]<-) and run an analysis with release (activate this type of analysis in the 
Analysis tab of Project Configuration dialog box.). 

If you are planning a dynamic analysis and a ductile steel design according to 
section 27 of S16-01 Standard, refer to section Seismic Steel Design, in this 
chapter.  

See also 
The Member Dialog Box 
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Analysis tab  
Split Functions and Member End Conditions  
Seismic Steel Design (S16-01)  

Released Members 
If you want some members to act as compressed members only (->[  ]<-), 
specify such conditions in the "End Conditions" section of Member 
Characteristics dialog box. 

Then, you must activate option Analysis with Release in the Analysis tab of 
Project Configuration dialog box.  Increase the number of iterations to 15 or 
more (this number can be modified once that the static analysis is completed).  

This type of analysis is a linear type of analysis, but is an iterative one: When 
VisualDesign will encounter members that are specified with released 
conditions, it will correct the members' degrees of freedom and launch another 
linear analysis until it reaches convergence.  

See also 
Analysis tab (Project Configuration)  
Released Supports  
Type of Static Analyses  

Member with a Linear Behaviour 
It is possible to define a member having a linear behaviour at all times even in 
a non-linear analysis. To do so, select option "Linear only" among the Behaviour 
drop-down list box of the Member tab.  

This functionality is useful to model the small members that are located 
between bridge supports and pier supports. With a linear behaviour, these 
members will not create horizontal components (usually created in a non-linear 
analysis). Consequently, only axial forces will be transferred and the 
convergence will be faster than before. 

Selection of a shape 
Press this icon  to call up the shape selection tree. This selection tree is 
composed of roots "Timber", "Steel" and "Concrete". Each one of these roots 
includes a list of available shapes for the chosen material. 

To choose a shape, expand the root up to leafs and activate the radio button 
corresponding to a shape. Then, click OK. 
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Look at the shape properties dialog box by clicking the button displaying the 
name of the shape.  

HSS Design Thickness 
The design thickness of a selected HSS shape must be specified in the 
Member tab (Member Characteristics dialog box). HSS properties are 
adjusted with respect to this design thickness.  

The display of such shapes on screen and its nomenclature in the design brief 
is as follows: HS305x254x9.5 (0.9t). 

Note  Dead load is calculated without considering the thickness reduction. 
Consequently, dead load applied on the structure and bill of materials are adjusted to 
usual HSS (full wall thickness). 

See also 
Member tab  
Selection of Shapes  
HSS spreadsheet  

Definition of Sections 
In the "Section Properties" of Member tab (Member dialog box), you must 
specify the shape, material and composition of the section.  

When you will press the I Beam icon, a tree composed of shapes will appear. If 
the shape that you wanted to choose is not part of this tree, create it inside the 
appropriate spreadsheet. Then, the tree will include your shape. 
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Procedure: 
To create new timber sections, go to the Rectangular or Round spreadsheets. 
Enter dimensions and choose a timber material among the drop-down list box. 
These new sections will be part of the Shapes Selection tree.  

The table below shows the section and material that you must choose, and the 
parameters you must specify in a particular tab in order to run an analysis 
and/or a design for the chosen type of section. 

Type of  
Section 

Section Properties Action 

Steel Beam 

 

Material: Steel 

Composition: 
Standard 

Project 
Configuration: 
Modify default 
parameters in Steel 
tab. 

Member: Specify 
design parameters 
in the Steel Design 
tab. 

Composite 
Beam (steel-
concrete) 

All I, S, and WRF shapes Material: Steel 

Composition: 
Composite 
beam 

The member is 
effective at 
construction 
stage 1, by 
default. 

Define a slab 

Activate 
construction stages 
in the Composite 
Beam tab (Project 
Configuration) 

Member: Specify 
composite 
parameters in 
Composite Beam 
tab (Member dialog 
box) 

Define 
construction stage 
load combinations. 
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Type of  
Section 

Section Properties Action 

Composite 
Beam (concrete-
concrete) 

Solid sections, T-Section, 
AASHTO, and NEBT only. 

 

Material: 
Concrete 

Composition: 
Composite 
beam 

The member is 
effective at 
construction 
stage 2, by 
default. 

Define a concrete 
slab. 

Modify default 
parameters in 
Concrete Design 
tab (Project 
Configuration) 

Member: Specify 
design parameters 
in Composite 
Beam tab and 
Concrete Design 
tab. 

HSS (Filled with 
concrete)  

 

Material: Steel  

Composition: 
Filled HSS 

Design: choose a 
concrete material in 
the Filled HSS tab. 

Reinforced 
concrete 

 
N.B. Use L (t, w) sections as edge 
beams. 

Material: 
Concrete 

Composition: 
Standard 

Modify default 
parameters in 
Concrete Design 
tab (Project 
Configuration) 

Member: select the 
Concrete Design 
tab. 

Timber 

 

GL: glue laminated 

Material: 
Timber (See 
Timber 
Properties) 

Composition: 
Standard 

Member: select the 
Timber Design 
tab.  

Aluminium All appropriate sections. Material: 
Aluminium 

Composition: 
Standard 

Analysis only. 
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Member Usage 
Member usages are required for some modules only because VisualDesign 
needs to recognize particular members to properly design them. 

Usages are selected in the "Usage" selection tree included in the Member tab 
of Member Characteristics dialog box. This selection tree is composed of 
three roots: Wood Truss, Ductility and Towers. To select a usage, expand the root 
and branches and double click the chosen usage.  
T O W E R  D E S I G N  M O D U L E  

The following usages must be assigned to members that are composing a 
tower: Upright, Guy, Horizontal, Diagonal, Horizontal Secondary, Diagonal 
Secondary, Vertical Secondary, Stabilizer, and Internal Bracing.  

N.B. Usage must also be specified when wind loads and ice loads are applied to 
tower members.  
T I M B E R  D E S I G N  M O D U L E  

The usage for vertical and diagonal members within a wood truss must be set 
to "Secondary". Usage is not required for other wood members. 
S E I S M I C  D E S I G N  A S  P E R  C A N / C S A - S 1 6 - 0 1  –  S T E E L  D E S I G N  M O D U L E  &  
D Y N A M I C  A N A L Y S I S  M O D U L E  

VisualDesign recognizes members that will dissipate energy during an 
earthquake through their usages. Usages are specific to types of braced systems 
and corresponding ductility.  

Quick Selection of Members according to Usage 
Go to Edit / Select / Usage and select a type of usage in the dialog box. 
Members having the same usage will be selected on screen.  

Select Members according to Usage  

Effective Stiffness 
If you do not possess the Reinforced Concrete Design module, you can analyze your 
structure all the same using the cracked section of concrete elements in your 
structure. This function is part of the Member tab that is included in the 
Member Characteristics dialog box. 

Enter the ratio or percentage for the reduction of the section gross inertia to 
obtain an effective stiffness as specified per code. If you do not wish to reduce 
the stiffness, enter a value of 1.0. 

Effective bending stiffness on strong axis:  

• Effective EIxx = Ratio of bending stiffness * EIxx 
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Effective bending stiffness on weak:  

• Effective EIyy = Ratio of bending stiffness * EIyy 

Effective shear and torsion stiffness: 

• Effective GJ = Ratio of shear stiffness * GJ 

• Effective G*A*kx = Ratio of shear stiffness * G*A*kx 

• Effective G*A*ky = Ratio of shear stiffness * G*A*ky 

See also the topic Shear Energy. VisualDesign™ takes into account the shear 
energy in the deflection calculation. 

Effective axial stiffness: 

• Effective EA = Ratio of axial stiffness * EA 

See also 
Member Dialog Box  
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Member Dialog Box - General 
While you are working in the "Structure" activation mode, you can access the 
Member Characteristics dialog box by double-clicking on a member (after 
having activated this type of element on Elements toolbar) or by clicking on a 
member and pressing the Properties icon. 

This dialog box may be composed of several tabs. The most important one is 
the Member tab, which is the "master" one. In fact, this tab contains basic 
data about the member such as material, shape, composition, behaviour, 
activation of design criteria, etc.  

Specific information is entered using the Connection tab, Composite Beam 
tab, Filled HSS tab, and Behaviour tab. If design criteria were activated in the 
Member tab, there may be a Steel Design tab and Bolted Connections tab 
appearing in the dialog box, a Concrete Design tab, if he owns the 
corresponding modules (Steel Design or Reinforced Concrete Design Module), 
the Evaluation tab (Bridge Evaluation module), or the Timber Design tab 
(Timber Design module).  

Member tab 

  

Member Dialog Box 
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The table below shows the description for each topic included in the Member 
tab. 

Field Description 

Identification  

Number The member number. 

Incidence  

Node i, Node j Node i and node j numbers. Please refer to Member Incidence 

Invert Node i ⇔ Node 
j 

Click this button to invert the node incidence. Warning: Applied 
loads will be inverted too.  

Geometry  

Length  The member calculated length (shaded). 

Local axis system Steel angle only: Select an orthogonal axis system (standard) or 
Minor/Major axis system. Refer to Orthogonal and 
Major/Minor Axes System 

Beta angle The shape position in space. Refer to Beta Angle Convention  

Initial pre-tension Indicate the magnitude of  initial pre-tension, if  any. Refer to 
Initial Pre-tension 

End Conditions Specify member end conditions at node i and j. Symbols are: 
o  : hinged  
+  : fixed (continuous beams or columns) 

Refer to End Conditions  

Properties  

Icon  
Click the icon and choose a shape among the selection tree. See 
also topic Selection of  Shape. 

HSS t (design) If  a HSS shape has been selected, please specify the design 
thickness that will be considered during design or verification: 
1.0t (ICCA/Can), 0.9t (ICCA/US) or 0.93t (AISC/US). 

Material Select a material among the selection tree. 

Dead load Select the dead load case that automatically considers the 
member self-weight in generated load combinations. 

2L Distance or b1 2L: Gap between back-to-back angles 
b1: Dimension of  the flat side of  a V-section. 

Area  Area of  section. 
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Field Description 

Linear mass Linear mass of  this member. 

Activate design criteria Check this box to activate design criteria. The Steel Design 
tab, Concrete Design tab or Timber Design tab will appear 
in this dialog box according to the chosen shape material. 

Usage Specify the member usage, if  required. Refer to topic Member 
Usage. 

Composition Select the shape composition in the drop-down list box: 
Standard, Composite Beam, or Filled HSS. The Composite 
Beam tab or Filled HSS tab will appear in the dialog box. 
Select the tab and complete it.  

Behaviour Specify the member behaviour in the drop-down list box: 
Standard, Elastoplastic, Off-load or Linear only. If  the 
elastoplastic behaviour is selected, the Behaviour tab will 
appear in the dialog box. Select this tab and complete it. 

Effective Stiffness Refer to Effective Stiffness  

Ix'/Ix For a cracked section, specify the effective inertia of  this 
member, on its strong axis, as specified by code. Otherwise, 
enter a value of  1.0 (100% effective). 

Iy'/Iy For a cracked section, specify the effective inertia of  this 
member, on its weak axis, as specified by code. Otherwise, enter 
a value of  1.0 (100% effective). 

J'/J For cracked section, enter the effective torsion and shear 
stiffness of  the section. Otherwise, enter a value of  1.0 (100% 
effective). 

A'/A Specify the effective axial stiffness of  this member. Otherwise, 
enter a value of  1.0 (100% effective). 

Effective at stage Select the construction stage where the composite member will 
be effective. Refer to Construction stages. 

Moving load analysis  

Moving load axis If  the member is part of  a moving load axis, select it in the list 
box.  

2D axle factors If  you modeled in 2D, select the axle factors to be assigned to 
this member.  
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Rigid Extensions and Member Eccentricities 
Alignments ey & ex 
The section may be positioned vertically, longitudinally and transversely to the 
axis passing through the member end nodes. Make sure that eccentricities ex 
and ey are the same for a given member. 

Rigid Extensions ez 
All concrete members and prestressed concrete members must have rigid 
extensions because VisualDesign needs them to calculate the required rebars 
development lengths. Rigid extensions are specified in the Connection tab of 
Member Characteristics dialog box.  

VisualDesign automatically calculates rigid extensions when the function 
Automatic Calculation of Rigid Extensions is called up (available in 
Structure / Tools). 

The Connection tab 
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The table below shows the description for each topic included in the 
Connection tab. 

Field Description 

Alignment of  section 

Alignment x-direction Choose an alignment from the drop-down list box: "Manual", 
"Left" or "Right". Example: By choosing "Left", the section is 
positioned left to the node and the eccentricity value "ex" is 
automatically calculated and written in this field. This value is 
negative and equal to half  of  the section width. 

ex If  you choose "Manual", the value of  eccentricity "ex" will be 
equal to zero. The section will be centred on the node, in the x 
direction. 

Alignment y-direction Choose an alignment from the drop-down list box: "Manual", 
"Above" or "Below". Example: By choosing "Above", the 
section is positioned above the node and the eccentricity value 
"ey" is automatically calculated and written in this field. This 
value is positive and equal to half  of  the section height. 

ey If  you choose "Manual", the value of  eccentricity "ey" will be 
equal to zero. The section will be centred on the node, in the y 
direction. 

Alignment z-direction Specify the length of  rigid extension in the drop-down list box 
"Manual" or select option "Free edge". If  you choose "Free 
edge", the end of  the section will be positioned at the face of  
the support. For example, the end of  a beam will be positioned 
at the face of  the column. 

ez If  you choose "Manual", the value for rigid extension "ez" will 
be equal to zero. The end of  the section will be positioned on 
the node, meaning that there is no rigid extension. If  there is no 
transverse element, enter the length of  rigid extension. 

Include weight of  
rigid extensions 

Check the box to include the mass of  the rigid extension "ez" at 
node i and j, for columns OR beams. 

Semi-rigid connection Refer to topic "Semi-rigid Connections".  

 

Automatic Calculation of Rigid Extensions 
The tool Automatic Calculation of Rigid Extensions, located in the 
Structure/Tools menu, calls up a dialog box that will help you model steel or 
concrete member rigid extensions by calculating them automatically.  
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This functionality will automatically create rigid extensions at the face of each 
support, for concrete members only or for all members of your structure. It 
can also replace the already defined rigid extensions or keep the old ones. 
More, you can choose to automatically add these weights to columns or to 
beams or not considering any rigid extension weight in your project. 

  
See also 
The Connection tab  
Rigid Extensions  
Modeling Valid Rigid Extensions  

Semi-Rigid Connections 
Semi-rigid connections (or partial connections) can be modeled at member 
ends i and j through the Connection tab (Member Characteristics dialog 
box).  When the member has rigid extensions, partial connections will be 
located at the interior ends of rigid extensions, as shown below with spirals. 
Therefore, it is always located at the face of support (beam or column). 

Considering a beam of length L, of stiffness EI/L, with rigid extensions, and 
semi-rigid connections of stiffness equal to Rki and Rkj, we will obtain this 
model: 
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WARNING! 

To model such partial connections, appropriate stiffness factors must be 
specified. Before using this option, read the theory about semi-rigid frames.  

This example shows a beam of 4m long with fixed ends, with a uniform load of 
-20kN/m. If stiffness factors are equal to 6 (Fri = Frj = 6), the positive 
bending moment and negative bending moments will be equal.  

  
Note: 

The calculated value of Rki or Rkj depends on the length of the member. If 
you split up a member, the partial rigidity will be adjusted to account for the 
partial rigidities that have been defined at the ends of original member. 

If you split up the beam showed in the above example in two segments of 2m 
each, the factor Fri (beam at the left) and the factor Frj (beam at the right) will 
be adjusted to 6 * 2/4 = 3 because the stiffness of the two beams, Rki and Rkj, 
must the same as before the splitting.  
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The Behaviour tab 
You have access to the Member dialog box by double-clicking on a member 
while in the "Structure" mode. To define a member as elastoplastic, choose 
option Elastoplastic in the "Behaviour" field. Then, select the Behaviour tab 
and complete the information.  

 
See the table below for definition of headings included in the Behaviour tab. 

Field Description 

Elastoplastic 
mechanism 

Choose an Axial Elastoplastic or Elastic behaviour in the drop-
down list box. 

Tension-
Compression 
behaviour only 

Only for an axial elastoplastic analysis using friction dampers 
(PALL). See Non-linear Time History Analysis. 

Maximum Tension  Specify the allowed maximum tension in member or check the 
Use the Calculated Value box to use the calculated tension 
capacity of  the member. 

Maximum 
Compression  

Specify the allowed maximum compression in the member or 
check the Used Calculated Value box to use the calculated 
compression capacity of  the member. 
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Field Description 

Stiffness Ratio After 
Maximum 

Specify the stiffness ratio after it reached plasticity. 

Bi-axial Bending and Axial Load Behaviour 

Maximum Positive 
Moment Strong Axis 

Specify the allowed maximum positive moment relative to the 
strong axis of  the member or check the Use Calculated Value 
box to use the calculated resisting moment of  the member. 

Maximum Negative 
Moment Strong Axis 

Specify the allowed maximum negative moment relative to the 
strong axis of  the member or check the Use Calculated Value 
box to use the calculated resisting moment of  the member. 

See also 
Member Dialog Box  
Non-linear Time History Analysis with friction dampers  
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Members Spreadsheet 
Access this multi-spreadsheet by selecting Members under Structure Menu. 
The first spreadsheet, which is "Members", is the main one because it contains 
basic characteristics about the member connections, composition, and 
behaviour and this is where you activate the member design criteria (concrete, 
steel or wood).  

If you own all other modules, you will find the following tabs in the 
spreadsheets: Composite Beams, Concrete Design, Steel Design, Timber 
Design, Bolted Connections and Evaluation  

Members spreadsheet (Master) 
Group: Structural data 

Column Description Editing 

ID Automatically calculated No 

Number 12 alphanumerical characters  Single click 

Node i Number  Node number at origin of  member No 

Bending Mx Member end conditions in the plane of  the 
strong axis 

Single click 

Bending My Member end conditions in the plane of  the weak 
axis 

Single click 

Torsion Mz Member end conditions for torsion. Single click 

Axial Fz Member axial relaxation Single click 

Node j Number Node number at the end of  member No 

Shape 12 alphanumeric characters describing the 
member shape. 
Expand the Shape tree composed of  all the 
available shapes and choose one by activating a 
radio button. 

Double-click 

Material Choose the member material in the Material 
selection tree. 

Double-click 

HSS 
t (design) 

If  a HSS shape was selected, indicate the design 
thickness that will be considered during the 
design or verification, in the list box.  

Double-click  

Members Spreadsheet 
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Column Description Editing 

Usage Select the member usage among the drop-down 
list box. See topic Member Usage. 

Double-click 

Gap between 
Angles or b1 

2L section: Gap between two angles. 
b1: dimension of  the V section part that is not 
bend.  

Single click 

Local axes Indicate if  the local axes system is oriented 
according to an orthogonal or major-minor axes 
system. 

Double-click 

β angle Rotation angle Single click 

Length Member length No 

Pre-tension Initial pre-tension in the member  (positive in 
tension). N.B. This pre-tension will be applied to 
all load combinations. 

Single click 

Behaviour Choose the member behaviour: Standard, 
Elastoplastic, Off-load or Linear only. 

Double-click 

Composition Choose the member composition: Standard, 
Composite Beam or Filled HSS. 

Double-click 

Design Code Choose a design code: Steel or Reinforced 
concrete, (Timber and Aluminium are not yet 
available). 

Double-click 

Effective Inertia – 
Bending 
strong axis 

For a cracked section, specify the effective inertia 
of  this member, on its strong axis, as specified 
by code. Otherwise, enter a value of  1.0. 

Single click 

Effective Inertia – 
Bending 
weak axis 

For a cracked section, specify the effective inertia 
of  this member, on its weak axis, as specified by 
code. Otherwise, enter a value of  1.0. 

Single click 

Effective Stiffness 
for Torsion/Shear 

For cracked section, enter a ratio to reduce the 
torsional and shear stiffness of  the section. 
Otherwise, enter a value of  1.0. 

Single click 

Effective Inertia – 
Axial 

Enter the ratio to reduce the axial stiffness due 
to cracked section. Otherwise, enter a value of  
1.0. 

Single click 

Moving Load 
Axis  

If  the member is located on a moving load axis, 
select the one among the list box.  

Double-click  

2D Axle Factor Select the axle factor that will be applied to this 
member for moving load analysis.  

Double-click 



C H A P T E R  2  M A T E R I A L S  &  S E C T I O N S  

2-114  CivilDesign Inc. Engineering Software 

Connection Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Automatically calculated  No 

Number 12 alphanumerical characters  Single click 

Alignment exi Choose the type of  alignment: "Manual", "Left" 
or "Right" of  node i. 

Double-click 

exi Enter eccentricity exi Single click 

Alignment eyi Choose the type of  alignment: "Manual", 
"Above" or "Below" node i. 

Double-click 

eyi Enter eccentricity eyi Single click 

Rigid Extension 
ezi 

Choose option Manual and enter the rigid 
extension length at node i or choose option Free 
Face. The latter will create a rigid extension from 
node to free face of  column or beam.  

Double-click 

ezi If  you selected option Manual, enter rigid 
extension length ezi (according to member local 
axes, negative or positive).  

Single click 

Alignment exj Choose a type of  alignment: "Manual", "Left" or 
"Right" at node j. 

Double-click 

exj Enter eccentricity exj Single click 

Alignment eyj Choose a type of  alignment: "Manual", "Above" 
or "Below" at node j. 

Double-click 

eyj Enter eccentricity eyj Single click 

Rigid Extension 
ezj 

Choose option Manual and enter the rigid 
extension length at node j or choose option Free 
Face. The latter will create a rigid extension from 
node to free face of  column or beam. 

Double-click 

ezj If  you selected option Manual, enter rigid 
extension length ezj (according to member local 
axes, negative or positive). 

Single click 

Stiffness 
Node i 

Specify the stiffness of  connection at node i: 
Absolute (Rk), Relative (Fk) or According to 
connection.  

Double-click 
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Column Description Editing 

Rki Factor that represents the absolute stiffness of  
connection at node i. The default value of  1 
kN.m/rad is corresponding to an absolute 
stiffness. 

Single click 

Fki  Factor that represents the relative stiffness of  
connection at node i. The default value is 1000 
meaning that the connection is 100% rigid.   

Single click 

Stiffness 
Node j 

Specify the stiffness of  connection at node j: 
Absolute (Rk), Relative (Fk) or According to 
connection. 

Double-click 

Rkj Factor that represents the absolute stiffness of  
connection at node j. The default value of  1 
kN.m/rad is corresponding to an absolute 
stiffness. 

Single click 

Fkj Factor that represents the relative stiffness of  
connection at node j. The default value is 1000 
meaning that the connection is 100% rigid.   

Single click 

+Mass Noi If  "ezi" is different from 0, include the weight of  
the rigid extension at node i by activating this 
option [ x ]  

Double-click 
or Space bar 

+Mass Noj If  "ezj" is different from 0, include the weight of  
the rigid extension at node j by activating this 
option [ x ] 

Double-click 
or Space bar 

Composite Beam Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Automatically calculated  No 

Number 12 alphanumerical characters  No 

Composition Shaded field indicating that this member is a 
composite beam.  

No 

Composite Slab Choose a composite slab previously defined in the 
Composite Slabs spreadsheet. 

Double-click 

Stud Choose a type of  stud (previously defined in the 
Studs spreadsheet).  

Double-click 

Effective b  Effective width of  composite slab.  Single click 
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Column Description Editing 

Actual b  Real width of  composite slab.  Single click 

%Qr Fraction of  shear connection (ex: 100%, 70%, 
40%) of  studs. 

Single click 

Nos. Studs / 
Row 

Specify the number of  studs per row for the 
design or verification of  fatigue. 

Single click 

Dead Load Slab Choose option [ x ] to add the slab dead load to 
the structure dead load. Do not activate this option for 
a project with construction stages. 

Double-click 
or Space bar 

Composite 
Properties 

Consider the composite section properties for 
analysis by choosing option [ x ]. 

Double-click 
or Space bar 

With Reinf. 
If  Mfx - 

Consider the steel reinforcement in the slab 
located at negative moments by choosing option 
[ x  ]. As a result, the position of  neutral axis will 
be modified.  

Double-click 
or Space bar 

With Reinf. 
If  Mfx + 

Consider the steel reinforcement in the slab 
located at positive moments by choosing option 
[ x  ]. As a result, the position of  neutral axis will 
be modified. 

Double-click 
or Space bar 

Composite Beam with construction stages only 

Solid Concrete 
at Stage 

Composite effects will be effective at this 
construction stage. 

Single click 

Composite Beam with or without construction stages 

Face 
Number 

Choose the face on the beam where stresses will 
be calculated. 

Double-click 

Position x Enter the position of  this point on the beam 
according to the figure below. 

Single click 

Linear Mass Linear mass of  transformed section. No 

Composite Beams Spreadsheets - Short-term and Long-term 
These two spreadsheets include the section-transformed properties considering 
a ratio "n" (= Es/Ec) respectively for short-term and long-term, as specified in 
the Composite Beam tab of Project Configuration.  

The default values of "n" for short-term and long-term deformations are 
respectively of 1.0 and 3.0. These values will be used for those not owning the 
Steel Design module.  



C H A P T E R  2  M A T E R I A L S  &  S E C T I O N S  

CivilDesign Inc. Engineering Software  2-117 

Users owning the Steel Design module can modify the default values for "n" in 
the Composite Beam tab of Project Configuration. 

Group: Structural data 

Column Description Editing 

ID Automatically calculated  No 

Number 12 alphanumerical characters No 

Composition Shaded field indicating that this member is a 
composite beam.  

No 

Neutral Axis Position of  neutral axis in the composite section.  No 

yt Distance from neutral axis to top fibre. No 

yb Distance from neutral axis to bottom fibre. No 

Es/Ec Ratio n: Modulus of  elasticity of  steel divided by 
modulus of  elasticity of  concrete 

No 

Ix Inertia of  transformed section, on strong axis. No 

J Torsional constant of  the transformed section.  No 

Area  Area of  the transformed section. No 

Sx (ct) Elastic section modulus at the top of  concrete 
slab, on strong axis. 

No 

Sx (cb) Elastic section modulus at the bottom of  concrete 
slab, on strong axis. 

No 

Sx (st) Elastic section modulus at the top of  steel shape, 
on strong axis. 

No 

Sx (sb) Elastic section modulus at the bottom of  steel 
shape, on strong axis. 

No 

Behaviour Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Automatically calculated  No 

Number 12 alphanumerical characters  Single click 

Behaviour Choose an axial elastoplastic or elastic behaviour 
in the drop-down list box. 

Double-click 
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Maximum Tension  Specify the allowed maximum tension in 
member. 

Single click 

Maximum 
Compression  

Specify the allowed maximum compression in 
the member. 

Single click 

Maximum 
Stiffness Ratio  

Specify the stiffness ratio after it reached 
plasticity. 

Single click 

Bill of Materials (Members) 
Group: Structural data 

Column Description Editing 

Material The member material No 

Section Name of  the section  No 

Length Total length of  all members having the same 
section 

No 

Weight Weight of  all members having the same section No 

Surface Surface of  all members having the same section No 

Volume Volume of  concrete members No 
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The Floor Element 

  
The "Floor" icon of Elements Toolbar 
 

VisualDesign does not design or verify floors and joists. The Composite 
Slabs, Steel decks and Studs spreadsheets are used to model steel/concrete 
composite beams. 

VisualDesign takes the loads applied to surfaces (floors or joist) and transfers 
them to the beams surrounding the floor area according to the type of floor 
(Two-Way, One-Way or Joist).  

Restrictions 
▪ The nodes that delimit the floor element must be located in the same plan. 

▪ The floor might be an asymmetrical quadrilateral. 

▪ The distance between two corners may be covered par many beams. 

If you want to obtain information (forces, bending moments…) about the 
transfer of concrete floor bending moments to adjacent beams, model the floor 
with plates and run a finite element analysis.  

It is possible to view the floor local axes system by activating this option from 
the "Attributes" tab of the View Options dialog box. The local axes are then 
displayed inside the floor, near node i. 

 
See also 
Floor Characteristics  
Types of Floors  
The Diaphragm Effect  
Floor spreadsheet  

Floors - General 
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Slabs Spreadsheet  
Steel Decks Spreadsheet  
Activate Element  
Displaying Floor Characteristics  

Rigid Diaphragm for Floors 
A diaphragm action can be specified in the Floor Characteristics dialog box 
and in the corresponding spreadsheet. 
R E C O M M E N D A T I O N S  

Be careful when using this option. If girders are composed of a truss, never 
activate the diaphragm effect.  The diaphragm action will create a composite 
effect between the chords and the floor because the centre of gravity of the 
truss is too low compared to the floor. Thus, this system will be too rigid. If 
girders are composed of usual I-beams, this effect is less critical.  
B R I D G E  D E S I G N :  

Rigid floors should not be used to model a bridge, for the same reason 
explained above. Furthermore, the diaphragm effect will act opposite to 
temperature effects and finally, prestressing effects will be absorbed within the 
diaphragm.  
C O N C R E T E  F L O O R S   

You can use this option for concrete floors. 
S T E E L  D E C K  A N D  C O N C R E T E  S L A B   

You can use this option for storeys and roof. 
S E M I - R I G I D  D I A P H R A G M   

If the roof is composed of joists and steel decks, it is recommended to create a 
semi-rigid diaphragm with thin triangular plates. These plates should be 
modeled using all nodes located on this level.  
V E R T I C A L  F L O O R S   

Don't activate this option if you modeled vertical floors to distribute loads! 
T R U S S E S   

Be careful when using this option. If girders are composed of trusses, the 
diaphragm action will create a composite effect between top chords and floors 
because the centre of gravity of the truss is too low compared to the floor. 
Thus, this system will be too rigid. If girders are composed of usual I-beams, 
this effect is less critical.  
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Joist Floor 
When creating a joist floor, first make sure that you have clearly defined the 
members on the entire periphery of the floor. If you have missed one side of 
the floor, you will get a warning message indicating that there is one adjacent 
beam missing for the floor. 

The space between joists (delta) proposed by default is 600 mm. The quantities 
of joists, the first and last spaces between joists are calculated according to the 
specified direction and the delta. However, you can decide to enter a different 
quantity of joists, or specify a different space value (spacing, first or last), and 
other boxes will then be interactively calculated according to joist orientation. 

See also 
Floor Characteristics 
Load Transfer for Joist Floors  
Loads Transfer for Joist Floor 
Distributed loads are transferred to the joists according to their corresponding 
tributary surfaces, assuming a zero half-span shear. Consequently, joists loads 
are transferred along adjacent beams according to the user’s geometric 
selection. 

  
See also 
Floor Characteristics  

Two-Way Slab 
This type of floor transfers concentrated loads on adjacent beams. Beams must 
surround the floor outline. If you have missed one side of the floor, you will 
get a warning message at the beginning of the analysis.  

See also 
Floor Characteristics  
Creating a Two-Way Slab  
Load Transfer for Tw0-Way Slabs  
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Loads Transfer for Two-Way Slabs 
A concentrated load that is located on a two-way slab is distributed along the 
four sides of the floor without diffusion of load. Its distribution is carried out 
according to the floor uniform stiffness. 

  
As for distributed loads, they must be applied on the entire surface. The 
distribution is carried out according to the distribution lines indicated in the 
figure below. 

The sum of the loads is respected, although the distribution is approximated. 

  
See also 
Floor Characteristics  
Creating a Two-Way Slab  
Creating a Two-Way Slab 
To create a Two-Way slab, select the Two-Way Slab option in the Floor 
Characteristics dialog box. 

See also 
Floor Characteristics  

One-Way Slab 
This type of floor allows the transfer of loads on two opposite sides, according 
to the user’s choice. These sides are determined by the slab direction, as 
specified in Floor Characteristics dialog box. If you forgot to model a beam 
supporting this type of floor, a warning message will appear at the beginning of 
the analysis. 
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See also 
Floor Characteristics  
Creating a One-Way Slab  
Load Transfer for One-Way Slab  
Loads Transfer for One-Way Slab 
Concentrated loads are distributed with diffusion along the appropriate sides, 
according to the simply supported beam approach. 

  
Distributed loads are transferred along the appropriate sides according to the 
slab orientation and according to the slab stability when simply supported. 

Creating a One-Way Slab 
To create a one-way slab, select the One-way slab option as type of floor in 
Floor Characteristics dialog box. Then select slab direction (jk and li or ij and 
kl). 
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Floor Characteristics Dialog Box 
While in the "Structure" mode, you have access to the Floor Characteristics 
dialog box by double-clicking on a floor or by selecting many and pressing the 
Properties icon.  

  
If the floor self-weight is specified in this dialog box, VisualDesign will 
integrate it in the dead load case that will be selected here. To learn more about 
it, please refer to the Dead load tab of Loads Definition dialog box. 

Floor Characteristics Dialog Box 
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See the table below to know the definition of headings composing the dialog 
box. 

Field Description 

Identification  

Number Floor number 

Type Select the type of  floor in the drop-down list box: Two Way 
slab, One-Way slab or Joists. If  this slab is a one-way slab, 
specify the bearing direction in the field "Slab direction". 

Incidence Number of  nodes i, j, k, and l located at the floor corners. 

Characteristics  

Area Calculated area of  the floor. 

Centroid Calculated centroid of  this floor, relatively to zero point. 

Floor self-weight Specify the floor dead load here or use the Load Definition 
dialog box in order to apply the floor dead load graphically as 
other type of  loads. 

Dead load Select the type of  dead load that will consider the floor self-
weight. 

Rigid diaphragm Check this box if  you want the floor to behave as a rigid 
diaphragm. Refer to Diaphragm Effect. 

Length ij, jk, kl, li Calculated lengths between nodes that are composing this 
floor. 

Moving Load Axis  

Axis If  a moving load axis runs on one side of  the floor, specify 
which one.  

Position Specify the side where is located the moving load axis. 

One-Way  

Slab direction Specify the bearing direction for this one-way slab. 

Joist  

Number Joist floor number 

Direction Select the direction of  the joists 

Spacing Specify the distance between joists 
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Field Description 

First Spacing Distance to first joist. 

Last Spacing Distance between last joist and spandrel beam. 
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Floors Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters describing the floor. Single click 

Node i number Node number at corner i No 

Node j number Node number at corner j No 

Node k number Node number at corner k No 

Node l number Node number at corner l No 

Type Type of  floor: two way slab, one way slab, or joist Double-click 

Self-weight Self-weight of  this floor. Single click 

Dead load Dead load case that will integrate the floor self-
weight.  

Double-click 

Lij Length between nodes i and j No 

Ljk Length between nodes j and k No 

Lkl Length between nodes k and l No 

Lli Length between nodes l and i No 

Area Area of  the floor No 

Diaphragm 
action 

Choose option [ x ] if  the floor acts as a 
diaphragm. 

Double-click 
or Space bar 

Slab Direction Direction of  the one-way slab (supported at jk 
and li, supported at ij and kl, n/a) 

Double-click 

Joists Direction Choose the direction of  beams, joists Double-click 

Number of  Joists Validated upon exiting spreadsheet.  No 

Delta Regular spacing between joists Single click 

First Spacing Validated when exiting the spreadsheet No 

Last Spacing Validated when exiting the spreadsheet No 

Floors Spreadsheet 
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Column Description Editing 

Centroid Calculated centroid of  this floor relatively to zero 
point. 

No 

Moving load axis Select the moving load axis number, if  applicable. Double-click 

Location Select the side of  the floor that is part of  the 
moving load axis or choose N/A. 

Double-click 

Moving Load 
Axis 

Select the moving load axis number. Double-click 

See also 
Types of Steel decks  
Slabs spreadsheet  
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Rectangular and Triangular Plates 

 
The "Plates" icon of Elements toolbar 
 
Rectangular (24 DOF) and triangular plates (18 DOF) are available in 
VisualDesign™. This icon activates both types. The software uses an 
isoparametric formulation that includes a component for in-plane translation 
stiffness and a component for rotation stiffness in the normal direction of the 
plane element. 

For finite element analyses, it is recommended to create groups of plates for 
surfaces and shear walls. A common local axis system is assigned to each group 
of plates. Therefore, the interpretation of results is much easier.  

To split up plates, use function Multiple Split. If the plates are already loaded, 
you can split up plates along with their loads.  

See also 
The Plate Characteristics dialog box  
Splitting Plates Into Multiple Parts  
The Plates Spreadsheet  
Nodes Numbering Convention for Plates  
Plane Stresses Convention  
Principal Stresses Convention  
Interpreting Results  
Groups of plates - Surfaces  
Groups of plates - Shear wall  

Plates - General 
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Numbering Convention for Plates 
R E C T A N G U L A R  P L A T E S  

  
T R I A N G U L A R  P L A T E S  

  
See also 
Plane Stresses Convention  
Principal Stresses Convention  
Interpreting Results  
Displaying the Plate Local Axis System 

• Go to the Attributes tab of View Options dialog box and activate the 
option Local Axis system in the Plates section. 

Point (0,0,0) corresponds to the plate’s Node i. 



C H A P T E R  2  M A T E R I A L S  &  S E C T I O N S  

CivilDesign Inc. Engineering Software  2-131 

 
See also 
The Attributes Tab 
Display Plate Characteristics  

Convention for Plane Stresses 
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T H E  S I G N  C O N V E N T I O N  I S  I L L U S T R A T E D  B E L L O W :  

  
C A L C U L A T I O N  O F  Q X  A N D  Q Y  

  

  
Myx and Mxy bending moments are: 
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The dotted line shows the original position of the plate. 

See also 
Numbering Convention  
Principal Stresses Convention  
Interpreting Results  

Convention for Principal Stresses 
Convention for bending moments 

  

Convention for axial stresses 
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Convention for principal strains 

  
See also 
Numbering Convention  
Plane Stress Convention  
Interpreting Results  
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Plate Characteristics Dialog Box 
While in the "Structure" mode, you have access to the Plate Characteristics 
dialog box by double-clicking on a rectangular or triangular plate or by 
selecting any plates and choosing the Properties function of Edit menu.  

The Plate Characteristics dialog box can be composed of two or three tabs: 
The Plate tab, which is the main one, the Rectangular and Triangular tabs 
according to the selected type of plates.  

The General tab 

  

Plate Characteristics Dialog Box 
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See the table below to know the definition of headings composing this tab: 

Field Description 

Identification  

Number Number of  the plate. 

Type of  plate Shaded field that informs the user on the plate geometry: 
Rectangular or Triangular. 

Characteristics  

Thickness Enter the thickness of  the plate. 

Material Select the plate material in the drop-down list box. 

Dead load Select the type of  dead load that corresponds to the plate self-
weight. 

Rigid Plate Activate this box if  the plate is very rigid (100x). Warning! Use 
this option if  the plate cannot deform such as a plate located 
below a concrete column or above. 

Integrity Activate this option if  this rigid plate must include integrity 
reinforcement and VisualDesign will place extra reinforcement. 
This type of  plate could be located above a concrete column.. 

Alignment of  plate Select an alignment in the list box: "Manual", "Above" or 
"Below". If  a manual one is selected, the default eccentricity is 
0.0, meaning that the centreline of  the plate is in line with end 
nodes. 

Eccentricity If  you selected a manual alignment, enter the eccentricity 
relative to the centreline of  the plate and according to local axis 
system.   

Orientation System Select the group that orients this plate if  it is part of  a surface. 
Refer to Groups of  Plates - Surfaces.  

Shear Wall Select the group that orients this plate if  it is part of  a shear 
wall. Refer to Groups of  Plates - Shear walls. 

Analysis – DOF  

Shear and Torsion Check this box to consider the shear and torsion of  the plate in 
the analysis. 

G'/G Specify the ratio (< 1.0 or <100%) for effective stiffness in 
shear and torsion.  

Bending Check this box to consider the bending of  the plate in the 
analysis. 
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Field Description 

E'/E Specify the ratio (< 1.0 or <100%) for effective inertia in 
bending. 

Concrete Plate  

Effective from Stage: Indicate from which construction stage this plate will be 
considered effective (solid) for finite element analysis of  
concrete plates. 

Consider 
Ratio "n" 

Check this box to consider ratio "n" (E steel/E concrete), as 
defined in the Composite Beam tab of  Project 
Configuration. If  this option is not activated, ratio "n" will be 
equal to 1 for long-term and short-term effects. 

See also 
Interpreting plates analysis results  
Composite Beam tab (Project Configuration)  
The Rectangular tab 
In the "Structure" activation mode, you have access to the Rectangular tab of 
Plate Characteristics dialog box by double-clicking on a rectangular plate or 
by selecting many and choosing the Properties function of Edit menu.  
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See the table below to know the definition of the Rectangular tab. 

Heading Description 

Identification Plate ID number. 

Incidence Nodes i, j, k and l numbers. 

Characteristics  

Area Calculated plate area. 

Length ij, jk, kl and li Calculated lengths of  each side of  the plate. 

Moving Load Axis  

Axis If  a moving load axis runs on one side of  the plate, specify 
the one.  

Position Specify the side of  the plate where runs the moving load axis. 

The Triangular tab 
While in the "Structure" mode, you have access to the Triangular tab of Plate 
Characteristics dialog box by double-clicking on a triangular plate or by 
selecting many and choosing the Properties function of Edit menu.  
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See the table below to know the definition of headings composing the 
Triangular tab. 

Heading Description 

Identification Plate ID number. 

Incidence Node i, j, and k numbers. 

Characteristics  

Area Calculated plate area. 

Length ij, jk, ki Calculated lengths of  each side of  the plate. 

Moving Load Axis  

Moving Load Axis If  a moving load axis runs on one side of  the plate, 
specify which one.  

Position Specify on which side of  the plate runs the moving 
load axis. 

See also 
Interpreting plates analysis results  
Triangular Plates spreadsheet  
Composite Beam tab (Project Configuration)  
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The Plates Spreadsheet 
While in the Structure activation mode, go to menu Structure and select 
Plates. This spreadsheet is a multi spreadsheet that includes general data about 
plates and specific data about triangular and rectangular plates (the Triangular 
tab and Rectangular tab). The first page (the Plate tab) is the master one. Use 
this page to add or delete plates. Sorting can be done in either pages and it is 
saved when switching to one page to another.  

Here is a description of fields included in the master page: 

Group: Structural data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters Single click 

Geometry Rectangular or Triangular plate Double-click 

Orientation 
System 

Group of  this oriented plate that is part of  a 
surface. Refer to Groups of  Plates - Surfaces.  

Double-click 

Shear Wall Group of  this oriented plate that is part of  a 
shear wall. Refer to Groups of  Plates - Shear 
walls. 

Double-click 

Thickness Plate thickness Single click 

Material Plate material Double-click 

Dead load The type of  dead load that represents the plate 
self-weight. 

Double-click 

Rigid Plate Activate option [  x  ] to consider the plate as very 
rigid, such as a plate located under or above a 
concrete column. (The plate stiffness will be 
multiplied by 100).  

Double-click 
or Space 

Integrity Activate this option [ x ] if  this rigid plate must 
include integrity reinforcement and VisualDesign 
will place extra reinforcement. This type of  plate 
could be located above a concrete column. 

Double-click 
or Space bar 

Bending To consider bending in the stiffness matrix of  the 
plate, choose option [ x  ]. 

Double-click 
or Space bar 

The Plates Spreadsheet 
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Column Description Editing 

Stiffness 
Ratio 
Bending 

According to chosen units, specify the stiffness 
ratio or percentage that will be considered for 
bending. 

Single click 

Shear 
Torsion 

To consider shear and torsion in the stiffness 
matrix of  the plate, choose option [  x  ]. 

Double-click 
or Space 

Stiffness 
Ratio 
Shear 

According to chosen units, specify the stiffness 
ratio or percentage that will be considered for 
shear and torsion. 

Single click 

Vertical alignment Alignment of  this plate: "Manual", "Above" or 
"Below". If  a manual one is selected, the default 
eccentricity is 0.0, meaning that the centreline of  
the plate is in line with end nodes. 

Double-click 

Eccentricity Eccentricity of  the plate relatively to its centreline. Single click 

For a project with composite elements only  

Effective from 
Construction 
Stage: 

Indicate from which construction stage this plate 
will be considered effective (solid) for finite 
element analysis of  concrete plates. 

Double-click 

Consider 
Ratio "n" 

To consider ratio "n" (E steel/E concrete), as 
defined in the Composite Beam tab of  Project 
Configuration, choose option [  x  ]. If  this 
option is not activated, ratio "n" will be equal to 1 
for long-term and short-term effects. 

Double-click 
or Space bar 

See also 
Triangular Plates Spreadsheet  
Rectangular Plates Spreadsheet  
Groups of Plates - Surfaces  
Groups of Plates - Shear Walls  
Composite Beam tab (Project Configuration) 
Rectangular Plate Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters No 

Node i number Node number at corner i Single click 

Node j number Node number at corner j Single click 
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Column Description Editing 

Node k number Node number at corner k Single click 

Node l number Node number at corner l Single click 

Lij Length between nodes i and j No 

Ljk Length between nodes j and k No 

Lkl Length between nodes k and l No 

Lli Length between nodes l and i No 

Area Calculated area of  the plate No 

Centroid Centroid of  this plate relatively to the axis of  
gravity of  the project. This coordinate can be 
useful to select plates located at a level when there 
are many of  them in a building.  

No 

Moving load axis Select the moving load axis number. Double-click 

Location Select the side of  the plate that is part of  the 
moving load axis or choose N/A. 

Double-click 

Triangular Plate Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters No 

Node i number Node number at i Single click 

Node j number Node number at j Single click 

Node k number Node number at k Single click 

Lij Length between nodes i and j No 

Ljk Length between nodes j and k No 

Lki Length between nodes k and i No 

Area Calculated area of  plate No 
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Column Description Editing 

Centroid Centroid of  this plate relatively to the axis of  
gravity of  the project. This coordinate can be 
useful to select plates located at a level when there 
are many of  them in a building.  

No 

Moving load axis Select the moving load axis number. Double-click 

Location Select the side of  the plate that is part of  the 
moving load axis or choose N/A. 

Double-click 

Bill of Materials (Plates) 
The bill of materials for plates is available in the Results menu, under Bill of 
Materials. 

Group: Structural Data 

Column Description Editing 

Material Material of  the plate No 

Thickness Thickness of  the plate No 

Weight  Weight of  all plates composed of  the same 
material. 

No 

Surface Area of  all plates composed of  the same material. No 
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Groups of Plates - Surfaces 
Access this spreadsheet by selecting Plates - Surfaces under the 
Structure/Groups menu.  

This spreadsheet is useful to interpret finite elements results. A local axis 
system is assigned to a group of horizontal or vertical plates that are 
composing a slab or a simple wall (not shear walls). Results will be 
homogeneous and so it will be easier to read results. 

Design of 2-way slabs  
Plates are oriented through direction vectors that are normalized by 
VisualDesign™.  

A group of plate must be assigned to the plates that are composing the 
concrete slab. A specification must be selected and concrete covers must be 
specified.  

 

 

Groups of Plates 
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Description of spreadsheet columns: 

Group: Structural Data 

Column Description Editing 

ID Automatically calculated No 

Number Group number or name Single click 

Origin 
x 

Global x-coordinate of  zero point for this group. 
This data can be useful to localize a group when 
sorting data. 

Single click 

Origin 
y 

Global y-coordinate of  zero point for this group. 
This data can be useful to localize a group when 
sorting data. 

Single click 

Origin 
z 

Global z-coordinate of  zero point for this group. 
This data can be useful to localize a group when 
sorting data. 

Single click 

X-Axis 
x 

Local x-axis component of  the group projected 
on the global x-axis. 

Single click 

X-Axis 
y 

Local x-axis component of  the group projected 
on the global y-axis.  

Single click 

X-Axis 
z 

Local x-axis component of  the group projected 
on the global z-axis. 

Single click 

Y-Axis 
x 

Local y-axis component of  the group projected 
on the global x-axis. 

Single click 

Y-Axis 
y 

Local y-axis component of  the group projected 
on the global y-axis. 

Single click 

Y-Axis 
z 

Local y-axis component of  the group projected 
on the global z-axis. 

Single click 

Concrete Design   

Specification Design of  2-way slab: Select the concrete 
specification. 

Double click 

Top 
Cover 

Specify the concrete cover at the top of  the slab. Single click 

Bottom 
Cover 

Specify the concrete cover at the bottom of  the 
slab. 

Single click 

Lateral 
Covers 

Specify the lateral concrete covers of  the slab. Single click 
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See also 
The Plates Spreadsheet  
Design of 2-way slabs  
Numbering Convention of nodes  
Plane Stresses Convention  
Principal Stresses Convention  
Interpreting Results  

Groups of Plates - Shear Walls 
This spreadsheet is available in Structure/Groups / Plates – Shear Wall.  

This spreadsheet is required for a shear wall design.  Common local axes are 
assigned to plates that are composing a wall section, which can be of any form 
(T, C, or cubic). The longitudinal axis of the shear wall must be parallel to 
gravity axis (up or down) according to the right hand rule. Otherwise, 
VisualDesign will not be able to build the vertical continuous system, which is 
represented by a vertical fictitious member.   

VisualDesign normalizes vector directions. 

Groups are assigned to plates through the Plates spreadsheet or Plate 
Characteristics dialog box.  

Group: Structural Data 

Column Description Editing 

ID Automatically calculated No 

Number Group number or name Single click 

Strong axis x If  the strong axis of  the shear wall is pointing 
towards the positive global x direction, enter a 
value of  1.0. If  it points towards the negative 
direction, enter –1.0.  

Single click 

Strong axis y If  the strong axis of  the shear wall is pointing 
towards the positive global y direction, enter a 
value of  1.0. If  it points towards the negative 
direction, enter –1.0. 

Single click 

Strong axis z If  the strong axis of  the shear wall is pointing 
towards the positive global z direction, enter a 
value of  1.0. If  it points towards the negative 
direction, enter –1.0. 

Single click 

See also 
Modeling and designing shear walls  
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Bolted Connection Definition Spreadsheet 
Select Bolted Connections in Structure menu and specify the required 
parameters for connections and bolts that will be used for the design. 

Go to topic Bolt Layouts for more information about variables that are part 
of this spreadsheet. 

Group: Structural data 

Column Description Editing 

Specification ID Automatically calculated  No 

Connection 
Number 

Connection number (Up to 16 alphanumerical 
characters) 

Single click 

Connection 
Model 

Choose a connection model among the list box. 
See topic Bolted Connection Models  

Double-click 

Model 5 and 9 
Other section 

Additional section used as connector for models 5 
and 9. 

Double-click 

Nos. of  bolts Total number of  bolts for this connection  Single click 

Bolt Choose the bolts that are used in this connection. Double-click 

Bolts Layout Choose the bolts layout: In line, Staggered A, or 
Staggered B. See topic Bolts Layout. 

Double-click 

Nos. of  
transverse lines 

Specify the number of  transverse lines for this 
connection.  

Single click 

Nos. of  
longitudinal lines 

Specify the number of  longitudinal lines for this 
connection.  

Single click 

Nos. of  planes 
Bolts 

Specify the number of  planes considered for 
bolts. This parameter is different from shear planes. 

Single click 

Nos. of  planes 
Member 

Specify the number of  planes considered for 
member(s). 

Single click 

Nos. of  planes 
Plate 

Specify the number of  planes considered for 
plate(s). 

Single click 

Intercepted 
Threads 

If  bolt threads are intercepted in this connection, 
choose option [ x ]. 

Double-click 
or Space Bar 

Bolted Connections 



C H A P T E R  2  M A T E R I A L S  &  S E C T I O N S  

2-148  CivilDesign Inc. Engineering Software 

Column Description Editing 

Member 
em 

Longitudinal distance measured from free edge of  
steel angle to the first bolt in a row.  

Single click 

Member 
p 

Longitudinal distance measured centre-to-centre 
between two bolts.  

Single click 

Member 
g1 

Transverse distance measured from outside edge 
of  bent angle to the nearest bolt row.  

Single click 

Member 
g2 

Transverse distance measured centre-to-centre 
between two consecutive bolt rows.  

Single click 

Plate 
ep 

Longitudinal distance measured from free edge of  
plate to the first bolt in a row.  

Single click 

Plate 
t 

Thickness of  the plate used in the connection. Single click 

Plate 
Fu 

If  a plate is part of  this connection, specify its 
tensile strength. 

Single click 

See also 
Bolts Steel Grades  
Bolts spreadsheet  
Connection Models  
Bolts Layout  
Checking or designing bolted connections 
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Modeling Strategy 
When modeling a structure, it is important to work with strategy in order to 
minimize errors and time for inputs. Here are recommended steps to model a 
structure in the most productive way: 

• Identify reference spatial coordinates; 

• Always work according to functionalities that you will be using. You must 
master the many Split functions (Multiple split, Split according to node, 
Split at exact position, Split with a pin connection and Split with a rigid 
connection) and the Copy/Paste function (translation, rotation and mirror) 
before modeling a structure; 

• Before splitting a member, specify design criteria such as the building code 
that you will be using, the type of shape and others. End conditions are also 
very important before you split a member (hinged or fixed ends); 

• Adjust beta angle at this step. (If can use the Rotate function also); 

If you cannot place the member in the right direction in space with the beta 
angle (it can happen for single symmetrical shape), use option "Invert Node 
I ↔ Node j" in the Member Characteristics dialog box.   

• When these steps are completed, split members. Members will keep original 
characteristics (beta angle, end conditions and design criteria).  

• When members are split, define load titles and types (live, dead add., snow, 
etc.), load combinations, load factors and envelopes. Then, apply load on 
the structure directly by double-clicking on elements on the screen (in the 
"Load Case" activation mode).   

• Use VisualDesign View Options to verify the structural model and loads 
that you applied on it. 

• If you are planning to run a modal analysis, model a rough structure in 
order not to create local vibration modes (Ex.: mezzanine, walkway or 
footbridge) but do not forget to transfer these dead loads on nodes.  

See also 
Systematic Process from Input to Output  
Practical example - 2D Frame  
 

Creating a Structural Model 
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Structure Modeling Process from Input to Output 
This systematic process includes a brief description of the different stages in 
creating a project with VisualDesign™.  

VDBase.mdb Database  
This database includes data on materials, shapes, reinforcement, cables, studs, 
steel decks and soils. Users are allowed to add new data so it can become a 
customized database. In addition, it can be shared among users: copy the 
database in VisualDesign™ "Sections" directory on your workstation.  

P.S. This database will not be overwritten if you update VisualDesign™.  

Modeling 
Before beginning with the modeling, configure your project. Select Project 
Configuration under File menu.  

To quickly model a structure (nodes, supports, members and floors), use the 
Building Generator function. You will find this tool in the 
Structure/Generator menu. 

You can create elements separately by using the spreadsheets in the Structure 
menu or directly on your screen with the Add function (Edit menu).  

Definition of Loads  
Once that the structure is modeled, define load case titles and types. Select the 
Loads Definition spreadsheet under Loads/Load Cases menu and insert the 
number of lines corresponding to the number of load case type that you need 
in your project. At each line, double-click in the "Type" cell to specify the type 
of load.  

Then, activate the Load Case mode and choose a type of load in the drop-
down list box of Activation toolbar. 

Now you are ready to apply loads on your structure.  

P.S. You must define at least one load combination to run VisualDesign™. 

Generation and Definition of Load Combinations 
A quick way to create load combinations is through the Load Combination 
Generator. This tool, available under Loads/ Load Combinations/ 
Automatic Generation menu, will generate load combinations according to a 
selected code or Standard.. Load factors can be modified. When the generation 
if finished, you can deactivate load combinations that you do not wish to 
analyze. 
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If you prefer to define load combinations yourself, select the Combinations 
dialog box (Loads/Load Combinations/Definition). This dialog box also 
includes a Load Factors tab in which you will specify the load factor for each 
load that is part of the load combination.  

Analysis – Design - Verification 
There is no limit to the number of elements included in a model, neither 
concerning the number of load cases or load combinations.  VisualDesign™ 
cannot analyze a structure that has no support nodes. If a user forgot to assign 
a type of shape or material to members, a warning message will be posted on 
the screen. In addition, the user must define at least one load combination to 
run VisualDesign™. 

Structures can be analyzed, checked or designed. To check or design a 
structure according to a code, you must define a steel (or concrete) 
specification. Specifications spreadsheets are available under the 
Structure/Specifications menu. They also include other parameters 
corresponding to design criteria. 

Available analyses are: 

  Static Analysis  

  Dynamic Analysis 

  Spectral Analysis 

  Time History Analysis 

  Non-linear Time History Analysis 

  Moving Load Analysis 

  Analysis and Design 

Results 
VisualDesign™ automatically activates the Load Combination mode once that 
the analysis is done. You must choose a load combination title among the 
drop-down list box of Activation toolbar.  

To look at an envelope results, activate the Envelope mode and select an 
envelope title among the drop-down list box of Activation toolbar. 

Results may be viewed in many ways: 

• Select the Results tab or FE Results (Finite Elements) tab of View 
Options dialog box. Check the box that corresponds to the results 
(numerical or graphical) that you want to see on the screen; 
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• With the mouse, double-click on any element to call up the results 
dialog box of this element; 

• Select one of results spreadsheets in the Results menu to consult load 
combination results (nodes, members, plates, etc.) or envelope results.  

Code and Element Alphanumerical Number 
VisualDesign™ gives a code number (ID) to all newly created elements. The 
user cannot modify this number. 

More, each element has an alphanumerical number. While the automatic 
generation is in process, the user sets the first value of the numbering in the X, 
Y, and Z-axis. The application displays the elements numerical values 
according to the selected gravity axis. 

Selected Gravity Axis Numbering (Automatic Generation) 

X (Y, Z, X) 

Y (X, Z, Y) 

Z (X, Y, Z) 

It is possible to modify the alphanumerical numbering using the structure 
spreadsheets. To do so, select the numbers to be changed, right click to get 
access to the contextual menu. Select the Auto-numbering function. 

The spreadsheets will not accept identical alphanumerical numbers for 
elements of the same category. 

When elements are created individually using the Add function, 
VisualDesign™ gives them a default code number (ID) as alphanumerical 
number. 

Note.  The Copy/Paste function may generate identical alphanumerical numbers 
under certain circumstances (e.g. when duplicating elements or parts of a structure). 
These identical numbers are shown in the nodes spreadsheets.  The "Auto-
numbering" option of the spreadsheet contextual menu may be used to re-number 
nodes. 

See also 
The Add Function  
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The Building Generator 

  
The "Building Generator" icon of Tools toolbar 
 

Use the 3D Building Generator function (Structure/Gnerators) menu to 
automatically generates a building according to specified dimensions, material 
and shapes included in the following tabs: Geometry, Numbering, Axis X, 
Axis Y, Axis Z & Mat/Sec.  

When the function is called up, the Building Generator dialog box opens on 
screen. 

The Geometry tab 
Select the Geometry tab of the Building Generator dialog box to specify 
parameters needed for the generation of the structure. The gravity axis 
corresponds to the global y-axis, as specified in the Preferences tab of Project 
Configuration.  

  

Generators 
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See the table below for the definition of parameters included in this tab. 

Field Description 

Coordinates of  origin and rotation 

X, Y, Z Generate the structure from the starting coordinates 
entered in these fields. 

Angle Angle of  rotation of  the structure relative to the X axis, if  
Y is the axis of  gravity; or relative to the Z axis, if  X is the 
axis of  gravity; and finally, relative to the Y axis, if  Z is the 
axis of  gravity. 
Note: Positive clockwise. 

Elements to be generated  

Members Members are automatically generated when this check box 
is activated. 

Type of  horizontal surface: Select the type of  horizontal surface to be generated: 
Plates, 2-way floor, one-way floor, joist floor or None. 
Note: if  the selected surface is a floor, the member check 
box cannot be disabled.  

Exterior sheathing: Select the type of  vertical surfaces (sheathing) to be 
generated around the building: Plates, 2-way floor, one-
way floor, joist floor or None. (Wind loads can be applied 
to these surfaces afterwards.) 

Base supports If  you wish to automatically generate supports at base 
level, choose "pin" or "fixed", otherwise, choose "none". 

Generation of  elements at 
support level 

When this check box is activated, the members, plates and 
floors are generated starting from the first level (supports) 
of  the structure.  

If you want to look at the structure without exiting the dialog box, press the 
"Visualize" button. If it is OK, press the OK button. You will then exit the 
dialog box. 
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The Numbering tab 
Select the Numbering tab to specify some parameters needed to generate the 
structure's element numbering. 

See the table below for the definition of parameters included in this tab. 

Field Description 

Starting Values   

X, Y, Z Begins the nodes numbering according to the values indicated in 
these edit boxes. The numbering increases in the positive 
direction of  the axes. 

Separators  

Between X and Z Inserts a separator character, indicated in this box, between the 
X and the Z numbering. 

Between Z and Y Inserts a separator character, indicated in this box, between the 
Z and the Y numbering. 

Member, Floor, Plate  Inserts a separator character, indicated in this box, in the 
numbering of  members, plates and floors. 

The X-Axis tab 
Select the X Axis tab of Building Generator dialog box to specify the 
distance between bays that will be generated in the x direction. 

Group: Structural data 

Column Description Editing 

Delta Distance centre to centre between two axes in the 
x direction. 

Single click 

Press the "Preview" button to visualize the generated mesh. If it is correct, 
press the OK button. 

The Y-Axis tab 
Select the Y Axis tab of Building Generator dialog box to specify the 
distance between the bays (or stories, if y is the gravity axis) that will be 
generated in the y direction. 



C H A P T E R  3  M O D E L I N G  &  E D I T I N G  

3-8  CivilDesign Inc. Engineering Software 

Group: Structural data 

Column Description Editing 

Delta Distance centre to centre between two axes in the 
y direction. 

Single click 

Press the "Preview" button to visualize the generated mesh. If it is correct, 
press the OK button. 

The Z-Axis tab  
Select the Z Axis tab of Building Generator dialog box to specify the 
distance between bays that will be generated in the z direction. 

Group: Structural data 

Column Description Editing 

Delta Distance centre to centre between two axes in the 
z direction. 

Single click 

Press the "Preview" button to visualize the generated mesh. If it is correct, 
press the OK button. 

The Mat/Sec tab 
Select the Mat / Sec tab of Building Generator dialog box and specify the 
material and shape that will be assigned to generated members. Default values 
are supplied depending on the type of generated structure (steel, concrete, 
timber or aluminium). 
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Field Description 

Type of  Project Select one option (Steel, Concrete, Wood, Aluminium) among the 
drop-down list box that describes the main material used in the 
building.  Appropriate selection trees will be available for each 
element listed below. Choose option Null if  you do not want to 
assign materials and shapes to members. 

Plate thickness Specify the thickness for the generated plates.  

Material / Shape  

Beams and Columns Click on the arrow and select a material in the drop-down list 
box. Then, click on the icon that represents a I beam and select 
a shape in the selection tree.  

Plates Click on the arrow and select a material in the drop-down list 
box. 

The Truss Generator 

   
The "Truss Generator icon of Tools toolbar 

 

Press this icon on Tools toolbar or select this function under 
Structure/Generators menu to have access to a dialog box that generates pre-
existing trusses. 
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Customized Options 
CivilDesign is happy to put its programming expertise, intellectual abilities 
and innovative approach at your service by creating customized applications to 
optimize your operations and increase the reliability of results.  

We can develop an automated customized structure just for you to make your 
design quicker than ever! We can also upgrade and improve your house made 
programs into Windows environment! 

Save time and money: Contact CivilDesign today! 

Phone:    (450) 674-0657 

Toll Free 1-800-724-5678 

E-mail: custom@civild.com   

 



C H A P T E R  3  M O D E L I N G  &  E D I T I N G  

CivilDesign Inc. Engineering Software  3-11 

Axis Transformation 

  
The "Axis Transformation" icon of Tools toolbar 
 
Generate circular or parabolic curves from existing segments of your structure, 
using the Axis Transformation function under Structure/Tools menu. 

You must at least select three nodes to be allowed to use this function. N.B. If 
nodes were not merged with others when generating a particular curve, nodes 
will still be selected.  

  

Modeling Tools 
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Description of the dialog box: 

Field Description 

Type of  Arc  Allows to choose the type of  arc to generate: 

Linear-Po fixed: Build a linear segment between the Po and the 
Pn with Po fixed. 

Linear-Pn fixed: Build a linear segment between Po and Pn with 
Pn fixed. 

-Parabolic: Build a parabolic arc between Po and Pn. 

-Half  Circular arc: Build a half  circular arc between Po and Pn. 

-Circular arc: Build a circular arc between Po and Pn. 

Calculation of  
Coordinates  

Two options are offered for the curve generation: 

Nodes stay perpendicular to the axis: In this case, nodes only 
move vertically. 

To obtain equidistant segments: In this case, nodes are moved to 
obtain equal segments. 

Parameters Two types of  curves can be generated:  

Symmetrical or Linear Shape. This case allows a rise to the 
curve. 

Non-symmetrical Shape. This case allows generating a parabolic 
curve using a known equation. 

Axis Rotation See Convention of  Angle beta  

Automatic Calculation of Rigid Extensions 
The tool Automatic Calculation of Rigid Extensions, located in the 
Structure/Tools menu, calls up a dialog box that will help you model steel or 
concrete member rigid extensions by calculating them automatically.  

This functionality will automatically create rigid extensions at the face of each 
support, for concrete members only or for all members of your structure. It 
can also replace the already defined rigid extensions or keep the old ones. 
More, you can choose to automatically add these weights to columns or to 
beams or not considering any rigid extension weight in your project. 
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See also 
The Connection tab  
Rigid Extensions  
Modeling Valid Rigid Extensions  

Auto-Hinge Function 
This function, available in Structure / Tools, adds hinges along selected 
continuous columns while working in the Structure mode. Hinges will be 
placed according to a specified length.  

This length may represent the maximum length that is manufactured or the 
capacity of a truck for transport.  
R E S T R I C T I O N S :  

We recommend using this function for columns only. 

This function can be applied to all materials, except concrete.  

Using the Auto-Hinge Function 
• Activate the Structure mode. 

• Make sure that a steel specification is assigned to columns that will be 
grouped before using the function Auto Group (Structure / Groups).  

• Select continuous columns that you want to split with hinges. 

• Go to Structure / Tools and select Auto Hinge. 

• Enter a maximum length in the following dialog box and press OK.  
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• To look at created hinges, activate the option "End conditions" in the 

Attributes tab of View Options dialog box.  

• Use function Auto Group, located in menu Structure / Groups. 
VisualDesign will automatically group these columns according to the 
positions of hinges. 

Automatic Calculation of Kx, Ky, Kt and Kz 
This function, available under the Structure/Tools menu calculates the 
effective length factor (K) for a restrained member located between two joints. 
The user has to specify K factors for particular cases. 

In fact, the program verifies if lateral bracing has a minimum stiffness to 
prevent the buckling of the member that is attached. For example, if 
VisualDesign™ found that some lateral members have not a sufficient 
stiffness, members that are attached to those members will be design with a 
greater KL/r. The calculation of the ideal stiffness is based on the theory of 
Theodore V. Galambos Guide to stability design criteria for metal structures, 4th 
edition, 1988, pages 55 to 57. 

Kx and Ky values are generally equal to 1. If elements are continuous and 
make up a sole column between two floors, VisualDesign™ calculates new K 
values, for each element, in order to obtain KL value equal to the total length. 

Example: 
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For truss crossing members connected at their centre, the program considers a 
K factor of 1, on half of their total length (distance between end connection 
and bolt connection). If you wish to consider the total length of crossing 
members in the case where the two bracings are in compression at the same 
time, you must create a group for these members and specify Kx and Ky 
factors in the Steel Design tab of Member Characteristics dialog box. 

Automatic calculation of Kt: 

The Kt factor is used for the computation of buckling due to torsion for single 
symmetrical shapes 2L, WRF, V, WT and cold-formed sections. The automatic 
calculation of Kt will be done according to the selected option in the Steel tab 
of Project Configuration dialog box.  

Automatic calculation of Kz: 

The Kz factor is used to calculate the buckling of single steel angles in an 
orthogonal axis system for the design of towers and antennas. The automatic 
calculation of Kz will be done according to the selected option in the Steel tab 
of Project Configuration dialog box. 

See also 
Steel Design Criteria 
Steel Design Results  
Steel tab (Project Configuration)  
The Tower Design Module  

Tributary Areas for Spring Supports 
Use this tool, which is located in Structure menu / Tools, to automatically 
calculate tributary areas in the x-, y- and z-direction, for spring supports that 
are associated to plate elements.   

Procedure: 

• Activate the Structure activation mode. 

• Select spring supports. 

• Go to Structure / Tools and select Calculation of Tributary Areas. 

Calculated areas will be written in the Support tab (Node Characteristics 
dialog box).   

N. B. For the Generation of Abutments, Piers & Retaining Walls module, 
spring support tributary areas are automatically calculated from the 
stratigraphical profile data and are indicated in the Support tab. 

See also 
The Support tab  
The Spring Supports spreadsheet  
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Activate Selection Window 
VisualDesign™ allows one of two selection window modes: the Extended 
Window and the Restricted Window. Both windows allow you to select an 
element or group of elements. Whichever mode is used, the whole element is 
selected. 

The difference between the two selection windows appears when you use the 
pointer to plot a window around an element or a group of elements. 

Whichever mode you chose, you must always specify the type (member, node, 
plate etc.) of element that you want to select. The list of available elements 
appears both in the Edit Menu, under the "Elements" heading, and on the 
Elements toolbar. 

See also 
Extended Window  
Restricted Window  
Selecting Mixed Elements  
Using the Pointer (in Extended Window mode or Restricted Window mode)  

 Extended Window 
  

The "Extended Window" icon of Cursor toolbar 
 
When you use the Extended Window, all objects touching the selection 
window and inside it will be selected. 

To simultaneously select elements or groups of the same type, keep the [Ctrl] 
key down while clicking on objects. 

Selecting Objects using the Extended Window 

• Indicate the type of element you want to choose by activating one of the 
buttons on the Elements toolbar. 

• Then, do one of the following: 

• Click the icon  on Cursor toolbar. 

• Go to Edit / Activate Window and choose Extended Window. 

• With the help of the mouse pointer, trace a window around the element(s) 
that you wish to select while keeping the left mouse button pressed. 

Selection Windows 
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Only elements belonging to the activated category within or touching the 
window will be chosen. 

Restricted Window 

  
The "Restricted Window" icon of Cursor toolbar 
 
When using the Restricted Window, only elements completely located inside this 
window will be selected if the cursor moves from left to right. The selection 
window is displayed with dotted lines. 

If the cursor moves from right to left, this selection mode changed to an 
Extended Window mode. The window selection is then displayed with 
continuous lines.  

To simultaneously select elements or groups of the same type, keep the [Ctrl] 
key down while clicking on objects. 

Selecting Objects with the Restricted Window 

• Indicate the type of element that you wish to select by pressing one of the 
buttons on the Elements toolbar or by activating one of the options under 
Activate Elements on the Edit menu. 

• Then, do one of the following: 

• Click the icon  on Cursor toolbar. 

• Go to Edit / Activate Window and choose Restricted Window. 

• Use the mouse pointer, from left to right, and draw a selection window 
around the element(s) that you wish to select. Only elements that are 
completely contained within the window will be selected. 

• To change to an extended selection mode, draw the selection window from 
right to left.  

Only elements that are completely contained within the window will be 
selected. 
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Using the Pointer in Extended or Restricted 
Window 
To Using the Pointer 

Select an object Click once on the object with the pointer 

Selecting mixed elements Keeping the [Shift] key down, draw a window 
to select all elements. 

Select a group of  objects of  
the same type 

Click on one of  the objects keeping the [Ctrl] 
key down while clicking on the next objects  

Withdraw one object from the 
selection 

Keeping the [Ctrl] key down, click once on 
(or near) the selected object with the pointer 

Cancel all the selection Click on one of  the objects without keeping 
the [Ctrl] key down 

Cancel all the selection while 
selecting a new object 

Click on one object not part of  the selection 
without keeping the [Ctrl] key down 

See also 
Activate Selection Window 
Selecting Mixed Elements  
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The Elements Toolbar 

  
The Element toolbar of VisualDesign Main Window 
 
Before selecting an element on your screen or activating a function on Edit 
toolbar, you must activate a type of element on Elements toolbar. It may be a 
node, support, member, continuous system, plate or floor. 

Activating an Element 
• Do one of the following: 

• Select one of the icons on the Elements toolbar and go to Edit / 
Activate Elements and choose a type of element. 

• Use the short-cut keys: [Ctrl]+1 for activating nodes, [Ctrl]+2 for 
activating supports, [Ctrl]+3 for activating members, [Ctrl]+4 for 
activating continuous systems, [Ctrl]+5 for activating triangular plates, 
[Ctrl]+6 for activating rectangular plates, and [Ctrl]+7 for activating 
floors. 

Activate Elements 
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The Select Function 
The Select function of Edit menu allows selecting specific elements in your 
model such as: 

• Columns 

• Personalized Selections of Mixed Elements (1)   

• Beams 

• Inclined Members 

• Rectangular plates 

• Triangular Plates 

• Floors 

• Horizontal Continuous Systems 

• Vertical Continuous Systems 

• Members according to Usage 

• Inactive Nodes 

• Incomplete Modeling 

This submenu also includes functions Cancel and Invert selection. 

When elements are selected, they are highlighted on screen. 

Personalized Selections of Mixed Elements 
This submenu also includes functions to create personalized selections of 
miscellaneous elements. These selections can be called back at anytime while 
working in the project, helping you to quickly edit and consult results. 
Functions are: 

• Create a Selection 

• Choose Selection(s) 

• Update Current Selection 

• Edit selections 

Select Elements 
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Selecting Mixed Elements 
To select different types of elements, do as follows: 

• Use the [Shift] key while drawing a window to select elements, either in the 
Restricted Window or Extended Window selection mode. All elements 
(nodes, supports, members, plates, and floors) will be selected if they are 
displayed through the View Options. (Tip: Use this function and make the 
structure, then, create a selection of mixed elements. Refer to Personalized 
Selections of Mixed Elements.) 

• Activate the element icon on Activation toolbar and select elements of the 
same type. Then, activate another element and select other elements while 
keeping the [Ctrl] key down. Note that the Delete function applies to both 
selections. 

See also 
Extended Window  
Restricted Window  

Select Identical Items in a Spreadsheet 
Spreadsheet Contextual menu: Access the spreadsheet’s contextual menu in 
any open spreadsheet by clicking the right mouse button.  

Function Selection of Contiguous Identical Items is useful to group 
elements, to look at results, to modify parameters, etc.  

Example:  

Open the Steel Design Results spreadsheet and sort member shape W310x39. 
Then, use function Selection of contiguous identical items to select all 
W310x39. Click OK. These members will be highlighted on the screen. Go to 

Edit menu and select Create a Selection or press icon . Give a name to 
this selection. You can call back this selection any time. 

See also 
Selection of Contiguous Identical Items  
Sort in a spreadsheet  
Create a selection  

Personalized Selections of Mixed Elements 
This functionality includes four commands located in Edit / Select menu and 
is useful to create and save selections of miscellaneous elements (nodes, 
members, plates, and floors). A colour can be assigned to each selection and 
can be displayed on screen or disabled. The same element can be part of many 
selections.  
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Quickly select mixed elements by pressing the [Shift] key, in either the 
Restricted or the Extended window selection mode, while drawing a window 
with the cursor. All elements will be selected if they are displayed on screen 
through the View Options.  

Look at the table below to have a description of each function. 

Function Description Shortcut /Icon 

Create a selection Creation of  a new selection from selected 
elements on the screen. 

[Ctrl] + L  

Choose a selection Choose one selection or more in the 
Selections dialog box. Selections will be 
highlighted on screen. 

[Ctrl] + K or 

Icon  
 

Update current 
selection 

Choose one selection, add or withdraw 
elements, and update the final selection using 
this command. 

 

Edit selections Assign a colour to a selection, delete a 
selection or modify a selection title in the 
Selections spreadsheet.  

 

Create a selection 

• Activate an element on Elements toolbar and, while you keep the [Ctrl] key 
down, click on elements. Then, activate another type of element and, while 
you keep the [Ctrl] key down again, click on other elements.  

• Use shortcut keys [Ctrl]+L or go to Edit / Select / Create a Selection. 
In the following dialog box, give a name to this selection. Press OK. 

  

Choose a Selection: 

• To choose selections, press this icon  on Edit toolbar or use the 
shortcut keys [Ctrl] + K or go to Edit / Select / Choose a Selection. 
Click on selection titles and press OK. All selections will be highlighted on 
the screen.   

N. B. You can choose more than one title among the list.  
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Update Current Selection: 

• Choose one selection (Edit / Select / Choose a Selection). 

• Keep the [Ctrl] key down while you click on elements that want to add or 
withdraw from selection. 

• Go to Edit menu and select Select / Update Current Selection.  

Edit Selections: 
This function can be called up to assign a colour to each selection, to disable 
the colour, or to erase a selection or modify titles.  

• Go to Edit / Select / Edit Selections.  

• In the Selections spreadsheet, double-click in the Colour cell and select 
one. Then, to activate the display, double click in the next cell to get this 
symbol:  [x]. 

• To delete a selection, select the line and press [Delete]. 

• To modify the title, double click in the Number cell and enter a new title.  

   
Notes: 

If an object is part of more than one selection, the colour that will be displayed 
is the colour that was assigned to the first selection that includes this object.  
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If split functions are used on elements that are part of a selection, the newly 
created elements will be part of the selection that included original elements.   

Incomplete Modeling 
This tool, available in Edit menu / Select Elements, selects elements with 
incomplete or inadequate modeling such as members with no assigned shape 
or material, floors and plates with invalid geometry and plates with no assigned 
material or thickness.  

In fact, this tool activates the following options, which are listed in the View 
Options’ Attributes tab:  

  
When invalid elements are selected using this function, click on each one in the 
Structure activation mode or select many of the same type and call up the 
default spreadsheet by pressing the shortcut keys [Ctrl]+H. The appropriate 
spreadsheet (members, Floors or Plates) will be displayed on screen. Complete 
the missing information such as materials, shapes or thickness).   

Concerning invalid geometry for plates and floors, VisualDesign will notice 
them only if an analysis is launched. A warning message will appear on screen 
to inform you that it detected invalid geometries. Then, use the function 
Incomplete Modeling to locate and select them.  Correct node coordinates 
for these surfaces.  
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Invert Selection 
This function, available in Edit menu under command Select, is useful to 
select elements that are not selected on the screen. The element icon must be 
activated beforehand on Elements toolbar.  

Shortcut keys: [Ctrl]+Ι 

Example: 

• Activate the Member icon; 

• Select columns on the 4th floor and use the Mask function; 

• Select columns located on the contour and do some modifications; 

• Go to Edit menu and select Invert selection to select the story 
interior columns. 

See also 
Mask  
The Mask Function (Tricks)  

Cancel Selection 
This function, available in Edit menu under command Select, is useful to 
cancel any selection of elements on the screen. 

Shortcut key: [Escape] 
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Properties 

  
The "Properties" icon of the Edit toolbar 
 
With the Properties function, you may view or edit the characteristics of an 
object or the common characteristics of many selected objects while working 
in the "Structure" activation mode. 

While in the "Load Case" mode, and with the load case chosen in the 
activation toolbar, use the Properties function to view and edit the loads 
applied on selected elements. 

Use the Properties function while working in "Load Combination" mode, to 
obtain analysis results for the load combination title selected on the Activation 
toolbar. 

In "Envelope" mode, use the Properties function to obtain the analysis results 
for the envelope title selected in the Activation toolbar. 

In the "Design Results" mode, the Properties function will allow you to 
display the Design Results Spreadsheet. 

The Reinforced and Prestressed Concrete Design modules: 
 If you are working in the "Structure" mode, the Properties function gives 
access to the Continuous Systems spreadsheet.  

Activate the "Rebar Placement" activation mode and click on a continuous 
system. Press the Properties function to open the Rebar Placement window.  

See also 
Multiple Modifications of Elements in the "Structure" mode  
Multiple Modifications of Applied Loads in the "Load Case" mode  
Consulting Load Combination Results  
Consulting Envelope Results  
Consulting or Modifying Characteristics of a Selected Element  

Properties of Elements  
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Modifying Characteristics of Selected Elements 

• Use one of the following procedures: 

• Click on the "Structure" icon  of Activation toolbar. 

• Go to Edit/Activate Mode /Structure. 

• Select an object by using one of the following procedures: 

• Click the "Properties" icon  from Edit toolbar. 

• Select the Edit/Properties menu. 

• Use the shortcut key [Ctrl]+T 

A dialog box including the object characteristics appears on the screen. 
Characteristics can be examined or modified. 

Consulting or Modifying Characteristics of a 
Selected Element 
• Use one of the following procedures: 

• Click on the "Structure" icon  of Activation toolbar. 

• Go to Edit/Activate Mode /Structure. 

• Select an object by using one of the following procedures: 

• Click the "Properties" icon  from Edit toolbar. 

• Select the Edit/Properties menu. 

• Use the shortcut key [Ctrl]+T 

A dialog box including the object characteristics appears on the screen. 
Characteristics can be examined or modified. 

Applying Multiple Modifications to Elements in the 
"Structure" mode 
• Activate the "Structure" mode using one of the following procedures: 

• Click on the "Structure" icon  of Activation toolbar. 

• Select the Edit/Activate Mode/Structure. 

• Select elements of the same category while pressing down the [Ctrl] key. 
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• Access the Properties dialog box using one of the following procedures: 

• Click on the "Properties" icon  of Edit toolbar. 

• Select the Edit/Properties function. 

You get access to the Member Characteristics dialog box. Empty fields 
indicate that values will be applied to all selected elements. 

• Type in values, then press OK. 
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Add an Element 
An element addition is possible only while working in "Structure" mode. To 
get access to this mode, select Edit/Activate Mode/Structure. 

It is possible to add one or more elements through the spreadsheets available 
under the Structure menu, but it is usually easier to do it directly on the screen 
using the Add command from the Edit menu. 

To add an element directly on the screen, select its category from the icons of 
the Elements toolbar (node, support, member, plate or floor). Then, select the 
"Add" icon of the Cursor toolbar or select the Add command from the Edit 
menu. 

Note.  Right click to cancel any addition in mid action. 

A "Continuous system" (Reinforced Concrete and Prestressed Concrete 
Design) cannot be added with this function because it is already composed of 
many contiguous members. To copy a continuous system, use the 
Copy/Paste function of Edit menu. 

Dialog Box Display: 
Do not forget that you can stop the displaying of characteristics dialog boxes 
when adding elements. To do so, un-check the appropriate boxes in the 
Preferences tab of Project Configuration.  

See also 
Code and Alphanumerical Number of Each Element  
Adding a Node  
Adding a Support  
Adding a Member  
Adding a Plate  
Adding a Floor  
Adding Elements to your Model  

Add and Delete Elements 
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Procedure: 

• Activate the Structure mode.  

• Select the element type you wish to add. 

The "Continuous System" element is the only one that cannot be added 
because it is already composed of several elements. See the Reinforced 
Concrete Design module 

• Activate the Add mode. To do so, choose Add Element from the Edit 
menu or click the "Add" button on the "Cursor" toolbar. 

• Click once on nodes that are forming an element. 

• To exit the "Add" mode, press the "Cancel" button posted in the 
Insertion-Point-Coordinates dialog box. To cancel a current selection 
when adding a member or a floor, press the right mouse button. 

Remark. To prevent the display of Element Characteristics dialog box when entering 
new data, deactivate the "Dialog Box Display" option in the Preferences tab of 
Project Configuration in (File menu).  

Adding a Node 
• Activate the "Structure" mode by doing one of the following procedures: 

• Click the icon  on Activation toolbar 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the Node element by doing one of the following: 

• Click the icon  on Elements toolbar.  

• Go to Edit / Activate Elements / Node. 

• Activate the Add mode by doing one of the following: 

• Click the icon  on Cursor toolbar. 

• Choose Add Element from Edit menu. 

• Determine the coordinates in the Coordinates of Insertion-Point dialog 
box. 
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If you activate the "Attach-to-Node" option, VisualDesign™ will give you 
the coordinates of the node closest to your pointer when you press the left 
mouse button. This option may come in handy when you want to position 
a new node in relation to an existing node using an x, y or z displacement 
delta. 

• Press OK in the Coordinates dialog box to access the Node 
Characteristics dialog box. 

• Modify the default node number and indicate what type of node you are 
dealing with (normal or support). VisualDesign™ will propose, by default, 
a normal type of node in the "Node Type" field. 

If you want the node parameters to be graphically presented, tick off the 
appropriate boxes in the View tab of View Options dialog box. 

You may also modify the X, Y, and Z coordinates. 

• Press "OK" to validate the new node parameters or "Cancel" to annul the 
addition.  

When you exit the Node Characteristics dialog box, you will remain in 
the "Add-at-Cursor" mode to be able to continue to add new nodes.  

• To exit the "Add-at-Cursor" mode and return to the previous selection 
mode (Extended-Selection or Restricted-Selection), press "Cancel". 

Restriction when Adding a Node 
When you select the "Attach to Node" option from the Coordinates dialog 
box, VisualDesign™ gives you the coordinates of the nearest node to which 
your pointer is attached when you press down you mouse left button. 

This option may be useful if you wish to position a new node with a 
displacement delta in x, y or z in relation with an existing node. 

However, if you forget to modify one of the coordinates x, y or z in the 
Coordinates dialog box and press down the "OK" button of the 
characteristics of the node dialog box, you will get an error message. 

Adding a Support 
• Add a support right in the Nodes spreadsheet or use the following 

procedure: 

• Follow the same steps as for adding a node. 

• Select a "Support" type of node in the Node Characteristics dialog 
box. 
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Adding a Member 
• Activate the "Structure" mode using one of the following procedure: 

• Click the icon  on Activation toolbar. 

• Select Activate Mode/Structure from Edit menu. 

• Activate the Member element by doing one of the following: 

• Click the icon  on Element toolbar. 

• Select Activate Elements/Member from Edit menu. 

• Activate the "Add" cursor mode using one of the following procedure: 

• Click the icon  on Cursor toolbar. 

• Select Add Element from Edit menu. 

• Using the cursor, plot a member from node i to node j. 

Note that the member point of origin will determine its incidence. This is very 
important, since the positive direction of the z’ axis (local z axis) corresponds 
to the ij vector of the member (See Angle β Convention). 

If you are adding several members, end conditions (Mx, My, Axial and 
Torsion) will be set from the previous added member.   

If you have selected the "Display Dialog Box" option from the Preferences 
tab of the Project Configuration dialog box the Member dialog box will be 
displayed. You may choose to fix the parameters at this point, or do so later by 
setting common characteristics to a group of selected members. 

Note. You will remain in the "Add" mode as long as the "Extended" or "Restricted" 
Window cursor mode is not activated. 
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Adding a Plate 
• Activate the "Structure" mode using one of the following procedure: 

• Click the icon  of Activation toolbar. 

• Select Activate Mode/Structure from Edit menu. 

• Activate a Plate element by doing one of the following: 

• Click the icon  on Element toolbar. 

• Select Activate Elements / Plate from Edit menu 

• Activate the Add mode by doing one of the following: 

• Click the icon  on Cursor toolbar. 

• Select Add element from Edit menu. 

• Rectangular plate: Plot the rectangular plate by sliding the mouse and 
clicking on each of the four nodes located in the same plane. 

• Triangular plate: Plot the triangular plate by clicking once on each corner 
(3) and close the surface by clicking the first node. Nodes must be located 
in the same plane. 

Note that the plate's origin point is very important, since the x’ axis (local x 
axis) corresponds to the ij vector of the plate. y’ axis is then perpendicular to x’ 
(See Angle β Convention). 

If you have activated the "Display Dialog Box" option in Preferences tab 
(Project Configuration dialog box), the Plate Characteristics dialog box will 
be displayed. You may choose to fix the parameters right now, or to do so later 
by setting common characteristics to a group of selected plates. 

Note.  You will remain in the "Add" mode as long as you do not select the "Extended 
Window" or "Restricted Window" cursor mode. 

Adding a Floor 
• Activate the "Structure" mode using one of the following procedure: 

• Click the icon  on Activation toolbar. 

• Select Activate Mode/Structure from Edit menu. 

• Select the type of element you wish to add using one of the following 
procedure: 
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• Click the icon  on Element toolbar. 

• Select Activate Elements/Floor from Edit menu. 

• Activate the Add mode using one of the following procedure: 

• Click the icon  on Cursor toolbar. 

• Select Add Element from Edit menu. 

• Using the cursor, plot a floor by sliding the mouse and clicking on each of 
the four nodes located in the same plane. 

If you have selected the "Display Dialog Box" option from the Preferences 
tab of the Project Configuration dialog box, the Floor dialog box will be 
displayed. You may choose to fix the parameters right now, or to do so later by 
setting common characteristics to a group of selected floors. 

Note.  Select the "Extended Window" or "Restricted Window" cursor mode to exit the 
"Add" mode. 

Delete 

  
The "Delete" icon of Edit toolbar 

 

The Delete function may be used in "Structure" and "Load Case" activation 
modes. 

In "Structure" mode, this function eliminates the elements selected on the 
screen. If you cancel nodes, their linked elements are also eliminated. 

In "Load Case" mode, the Cancel function eliminates loads applied to selected 
elements for the chosen load case. 

Deleting Elements 

• Activate the "Structure" mode . 

• Activate a type of element on Elements toolbar. 

• Select the elements that you wish to delete.  

• Do one of the following: 

• Click the icon  on Edit toolbar. 

• Choose Delete from the Edit menu. 

• Press the [Delete] key. 



C H A P T E R  3  M O D E L I N G  &  E D I T I N G  

CivilDesign Inc. Engineering Software  3-35 

Configuration of Copy/Paste 

    
The "Copy/Paste" icon of Standard Toolbar 
 
You may copy all kind of elements in different ways: Translation, Mirror, and 
Rotation. VisualDesign will create missing nodes and assign default numbers 
based on the separator specified in the Copy/Paste Configuration dialog 
box. This dialog box is called up through the Copy or Copy/Paste 
Configuration function of Edit menu or through the short-cut keys [Ctrl] + 
C (If elements are selected). Loads applied to elements can also be 
copied/pasted by activating the appropriate check box in the Copy/Paste 
dialog box. 

  
It is also possible to copy and paste elements from another VisualDesign™ 
document. This is the purpose of the Configure Copy/Paste dialog box. This 
function enables you to keep a certain pasting configuration (in rotation, for 
example) for document A, and another one (in translation, for example) for 
document B. 

Copy/Paste 
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Note that the translation deltas set in a document Configure Copy/Paste 
dialog box will be applied to the origin coordinates of the pasted elements. If 
the last pasted elements of the working session have been pasted in another 
document, different than the one that will receive the new copied elements, the 
translation deltas will be applied to the origin coordinates of the pasted 
elements in this other document. 

VisualDesign™ enables you to undo and redo all pasting carried out. It keeps 
in memory the copied selection even after saving or after analysis have been 
carried out. However, it cannot be cancel if loads have been copied to new 
elements. 

A copied selection will be erased from memory only when another selection 
will be prepared for pasting. 

Note: The Copy/Paste function cannot be applied to members composed of a master 
node and more than one slave node. The members will be pasted but the dependence 
between nodes will not be preserved. 

See also 
Copy/Paste in Rotation  
Copy/Paste in Translation  
Copy/Paste Mirror  
Copy/Paste Loads on New Elements  
Copying and Pasting Elements  
Copy/Paste Elements Between 2 VD Files  
Copy/Paste in Rotation 
To apply a rotation to pasted elements, activate the "Rotation" radio button of 
Configuration zone in the Copy/Paste Configuration dialog box. You can also 
apply a rotation according to coordinates or even a node (you must enter the 
node number in the "Node" field). 

Then, enter the rotation angle and axis.  

Copy/Paste in a Spiral: 

Activate a rotation axis and enter delta Dx, Dy, or Dz in the zone "In a Spiral". 
Then, specify a rotation angle and enter the node number corresponding to the 
point of rotation.  

Click OK. Use the short cut keys [Ctrl]+V the number of times that you want 
to paste elements using this configuration. 
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Remark   The pasted elements will have the same beta angle as the copied members.  

See also 
Copying and Pasting Elements  
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Copy/Paste in Translation 
To paste one or many selected elements in translation, activate the 
"Translation" radio button of the "Configuration" zone of the Copy/Paste 
dialog box. Set the displacement deltas in X, Y and Z in the appropriate boxes. 

Click OK. Use the short cut keys [Ctrl]+V the number of times that you want 
to paste elements using this configuration. 

Remark   The pasted elements will have the same beta angle as the copied members.  

See also 
Copying and Pasting Elements  
Copy/Paste Mirror 
Copy mirror according to a selected plane by activating the "Mirror" radio 
button in the "Configuration" zone of the Copy/Paste dialog box. Then, 
specify the plane in which will be pasted the selected elements. Press OK.  

Use the shortcut keys [Ctrl]+V the number of time that you wish to paste 
these elements. 

Remark   The pasted elements will have the same beta angle as the copied members.  

See also 
Copying and Pasting Elements  

Copying & Pasting Elements 
• Activate the "Structure" activation mode by doing one of the following: 

• Click the icon  on Activation toolbar. 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the appropriate type of element on the Elements toolbar. 

• Select elements that you wish to copy and paste by pressing the left mouse 
button. 

• To copy the element, use the shortcut keys [Ctrl]+C or click . Then, 
the Copy/Paste Configuration dialog box will appear on the screen. 
Modify parameters if needed and press OK. 

• To paste the copied elements, use the short-cut keys [Ctrl] + V or click 

. Press down the shortcut keys [Ctrl] + V every time you wish to paste 
the copied elements (for the same parameters you defined in the dialog 
box).  
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• If you want to modify the configuration of the Copy/Paste function, do 
the following: 

• Select the element that you wish to copy and call up the Copy/Paste 
Configuration dialog box by pressing the [Ctrl] + C shortcut keys. 
Modify the parameters and click OK to close the dialog box. 

• Press the [Ctrl]+V shortcut keys every time you want to paste the 
copied element. 

OR 

• Select the Copy/Paste Configuration function under the Edit menu. 

• Modify the parameters in the dialog box and press OK. 

• On your screen, select the element that you wish to copy and press the 
[Ctrl]+C short-cut keys. The Copy/Paste dialog box that appears on 
your screen includes similar parameters just entered. Press OK. 

• Press the [Ctrl]+V short cut keys every time you want to paste the 
copied element. 

Paste 

   
The "Paste" icon of Standard Toolbar 

 

Use this function, available in Edit menu, to paste copied elements or items or 
use the shortcut keys [Ctrl] + V. 

Copy/Paste Loads on Elements 
When copying and pasting elements, loads can be copied and pasted too. To 
do so, activate the appropriate option in the Copy/Paste dialog box.  

Warning!   When the pasting of loaded elements is done, you will not be allowed to 
use the Undo function because VisualDesign will automatically save loads on 
elements.  

See also 
Copying and Pasting Elements  



C H A P T E R  3  M O D E L I N G  &  E D I T I N G  

3-40  CivilDesign Inc. Engineering Software 

Copy/Paste Elements Between two Files 
Elements will be pasted according to the copy/paste configuration of the 
second file. The source file configuration is not considered.  

Loads can be copied and pasted in the second file if this option is activated in 
the Copy/Paste dialog box located in the second file.  

If you want to copy and paste elements or a partial structure from one 
VisualDesign™ document into another VisualDesign™ document, some 
attributes will be lost in the second document.  

When copying a support, the orientation node will be lost in the second 
document. 

When copying a member, continuous systems will be lost in the second 
document. 

N. B. When using the Copy/Paste function between two files, use symbol "$" as a 
separator to keep the number and member numbers intact.  

See also 
Configuration of Copy/Paste  
Copying and Pasting Elements  



C H A P T E R  3  M O D E L I N G  &  E D I T I N G  

CivilDesign Inc. Engineering Software  3-41 

Undo 

  
The "Undo" icon of Standard toolbar 

 

If you change your mind or make a mistake during an operation, 
VisualDesign™ lets you undo the last action(s) you performed.  

See also 
Application of the Undo Function 
Redo  
Restrictions to the Undo function 
Undoing Last Operation(s)  
Application of the Undo Function 
With VisualDesign™, most available functions of the Edit menu can be 
cancelled, such as Properties, Add, Enlarge, Copy/Paste, Move, 
Translation, Rotate, Delete and Split functions. 

Restrictions to the Undo function 
You may use the Undo function only in "Structure" activation mode. 
Furthermore, some actions will empty the modification contents and disable 
the Undo function: 

• Saving the file (VisualDesign™ erases from its memory the prior stages 
to a saving); 

• Automatic generation functions and analysis; 

• Modifications made inside a spreadsheet if the OK button was pressed 
down. 

Undoing Last Operation(s) 

• Do one of the following: 

• Click the icon  on the Standard toolbar as many times as you wish 
to undo actions. 

• Choose Undo from Edit menu. 

• Use the [Ctrl]+Z shortcut. 

Undo and Redo 
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Redo 

  
The "Redo" icon of Standard toolbar 

 

If you wish to recover the operation(s) undone, simply click the Redo button 
the number of times you need. 

See also 
Undo  
Redoing Cancelled Operation(s) 

• Do one of the following: 

• Click the icon  on the Standard toolbar as many times as you wish 
to recover cancelled operations. 

• Choose Redo from Edit menu. 

• Use the [Ctrl]+A shortcut. 

Note.  The Redo function has the same limitations as the Undo function. 
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Enlarge 
The Enlarge function of Edit menu allows moving selected nodes. The 
multiplication factors (x, y, and z) will be applied to the coordinates of selected 
node.  

Zero point coordinates can be used as a reference point to enlarge selected 
nodes. In this case, the distance will be equal to the difference between the 
coordinates of selected nodes and the coordinates of the reference point. 

  
Trick: To get a mirror image of selected nodes, enter a factor or –1 for the axis 
that you want nodes to be copied mirror.  

Enlarging a Part of the Structure 

• Activate the "Structure" mode using one of the following procedures: 

• Select the "Structure" icon  of Activation toolbar. 

• Select Activate Mode/Structure from Edit menu. 

• Activate the Node element . 

• Select the nodes to be stretched. 

• Select Enlarge from Edit menu. 

• Do one of the following: 

• Enter zero point coordinates; 

• Enter enlargement factors for X, Y or Z-axis. 

Move Elements 
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Move  

  
The "Move" icon of Edit toolbar 

 

The only element that you can move around is the node.  

When you move a node, everything that is attached to it will be moved, too. 
You can move more than one node simultaneously. However, you may only 
move one attribute at a time. 

Moving one Node or More 

• Activate the "Structure" mode . 

• Activate the Node element . 

• Select nodes to be moved. 

• Do one of these procedures: 

• Click the icon  on Edit toolbar. 

• Choose Move from the Edit menu.  

The Coordinates-at-Point-of-Origin dialog box will appear, displaying 
the global axes allowing you to specify the point of origin.  

• Validate the coordinates at the point of origin by pressing the left mouse 
button or by choosing "OK" in the Coordinates-at-Point-of-Origin 
dialog box.  

The Coordinates-at-Insertion-Point will now replace the Coordinates-
at-Point-of-Origin dialog box and allow you to determine the insertion 
point for the selected node(s).  

• Use the mouse to move the selected node(s). 

• Press the left mouse button to select the new node location, or press OK 
in the Coordinates-at-Insertion-Point dialog box.  
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Translation 

  
The "Translation" icon of Edit toolbar 

 

The Translation function (Edit menu and Edit toolbar) allows translating a 
node by an amount delta (∆). This function applies exclusively to nodes. 

Translating a Node 

• Activate the "Structure" mode by doing one of these procedures: 

• Click the icon  on Activation toolbar 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the Node element . 

• Select the node(s) to be translated.  

• Then, do one of the following: 

• Click the icon  on Edit toolbar. 

• Select Translation from Edit menu.  

• Use the shortcut keys [Ctrl]+B. 

• Enter the displacement Delta (D) for the X, Y, and Z coordinates in the 
Translation dialog box. 

• Press OK to validate your displacement Deltas (D) or Cancel to annul the 
operation. 

Rotate 

  
The "Rotate" icon of Edit toolbar 

 

The Rotate function of Edit menu allows rotating nodes or members. A 
specific dialog box will either nodes or members are selected.  

When nodes are selected, the Rotate function can be used to rotate a part of 
the structure around a selected axis, and from an orientation node and a 
rotation angle. Elements that are linked to nodes will also rotate.  

When members are selected, the Rotate function allows modifying the beta 
angle of selected members according to a rotation angle and with respect to an 
orientation node, if a node number is specified. 
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Rotating Nodes 

• Activate the "Structure" mode by doing one of these procedures: 

• Click the icon  on Activation toolbar 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the Node element . 

• Select the nodes that will be rotated.  

• Do one of the following: 

• Click the icon  on Edit toolbar. 

• Choose Rotate from the Edit menu.  

   

• In the Rotate dialog box, specify the node coordinates from which the 
nodes will rotate. This node may be an existing node or another point in 
space. A node number is already assigned by default as zero point. This 
node corresponds to the first selected node, in order to speed up the 
editing if you need such a node.   

• Determine the angle of rotation. A positive rotation angle means a counter 
clockwise rotation.  

• Click OK to validate your choices or Cancel to annul the current operation.  
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Rotating Members 

• Activate the "Structure" mode by doing one of these procedures: 

• Click the icon  on Activation toolbar 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the Member element . 

• Select members which beta angle needs to be modified.  

• Do one of the following: 

• Click the icon  on Edit toolbar. 

• Choose Rotate from the Edit menu.  

  

• In the Rotate dialog box, modify the beta angle of selected member(s), 
enter the rotation angle (a), and the orientation node (N), if needed. 

• Press OK to validate. 
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The Split/Join Toolbar 

  
The "Split/Join" toolbar of VisualDesign Main Window 

 

Split functions are available in the "Structure" activation mode to help you split 
members in different ways and split plates in multiple parts. When using split 
functions, the initial member end conditions will be copied to the newly 
created members and plates. 

Members can be split at an exact position or according to one node position or 
more. Pin connections or rigid connections can be generated for crossing 
members also. The Split toolbar also includes a function that joins members or 
nodes and connects members or nodes.  

An option is available for splitting loaded elements along with applied loads. 

Restriction: 

Functions Split Multiple, Split at Exact Position, and Split according to 
Nodes(s) cannot be used to split rigid extensions. We recommend not 
splitting rigid extensions.  

Split functions can be used for the following elements: 
F O R  N O D E S  

Join  
Connect  
F O R  M E M B E R S :  

Split a Member on screen  
Split a Member Evenly (Multiple) 
Split Members and Create a Pin Connection  
Split Members and Create a Rigid Connection  
Split Members at Exact Position  
Split Members according to Node(s) Position  
Join  
Connect  
F O R  P L A T E S :  

Split Plates into Multiple Parts  
See also 
Split Functions and Member End Conditions  

Split, Join & Connect 
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Split a Loaded Element 
Loaded members and plates can be split with respect to the loads applied to 
original element. Loads will be copied and applied to new elements. However, 
the Undo function cannot be used because VisualDesign will automatically 
save information after the operation.  

Split Functions and Member End Conditions 
 

Case Before the split After the split 

Case 1 

End Conditions 

Member 1: pinned - fixed 
Member 1: pinned – fixed 
Member 2: fixed – fixed 
 

Case 2a 

Lateral Support 

Member 1: laterally supported at node i 
and j. Member 1 is laterally supported at node i 

only. 
Member 2 is laterally supported at node j 
only. 

No lateral support is provided in the 
middle, at the new node. 

Case 2b 

Lateral Support 

Member 1: A continuous lateral support 
is provided at superior fibre, inferior 
fibre is laterally supported at node i and j. 

Member 1: A continuous lateral support is 
provided at superior fibre and at node i at 
inferior fibre. 
Member 2: A continuous lateral support is 
provided at superior fibre and at node j at 
inferior fibre. 
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Case Before the split After the split 

Case 3 

Rigid 
Extensions 

Member 1 with rigid extensions A and B 
at nodes i and j. 

Member 1: Rigid extension A at node i 
only. 
Member 2: Rigid extension B at node j 
only. 

Case 4 

Rigid 
Extensions and 
semi-rigid 
connections 
Rki and Rkj at 
nodes i and j. 

Member 1 with rigid extensions A and B 
and semi-rigid connections Rki et Rkj at 
nodes i and j. 
Where ki = Rki * EI/L 

Ki is dependent of  the member length. 
Member 1: Rki at node i is the same as it 
was for the original member. The value 
Rkj at the centre will be equal to half  of  
the original Rkj: 

Rkj = (kj*L1/2)/EI 

Member 2: Value Rki in the middle will be 
equal to half  of  original Rki, and Rkj will 
be the same as it was for the original 
member. 

See also 
Member Eccentricities and Rigid Extensions  
Automatic Generation of Rigid Extensions  
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Split a Member 

   
The "Split a member" icon of Split toolbar 

 

Use this function on the Split toolbar, while in the "Structure" activation mode, 
to graphically split a member on screen. 

This function will retain all original member features such as end conditions, 
beta angle, lateral support parameters (as a fraction of the length), section type, 
and material.  

See also 
Split Function and Member End Conditions  
Split a Loaded Element  
Splitting a Member on Screen 

• Activate the Structure mode by doing one of the following: 

• Click the icon  on Activation toolbar. 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the Member element  on Elements toolbar. 

• Then, do one of the following: 

• Click the icon  on Split toolbar. 

• Choose Member from Edit/Split menu. 

• Click the member you want to split. When the mouse button will be 
released, a split node will appear on the member. Its distance from node i 
will be displayed perpendicularly to the member. 

• Glide the split node along the member with the mouse and press the 
left mouse button to freeze it in the desired position. 

• The New Node dialog box will appear on the screen so that you can 
specify its characteristics. 

• The Split with Loads dialog box will appear also. If you want to save 
and apply loads on the split members, activate appropriate box.  

Note. The newly created member keeps the characteristics of the original member. 

Split Members 



C H A P T E R  3  M O D E L I N G  &  E D I T I N G  

3-52  CivilDesign Inc. Engineering Software 

Multiple Split - Members 

   
The "Multiple split" icon of Split Toolbar 

 

While working in the Structure activation mode, you are allowed to split up one 
or more members into segments of equal lengths, by selecting function 
Multiple Split. Specify the number of desired subdivisions in the Multiple 
Split - Members dialog box. 

If members are guys (Tower Design module), check option Automatic split of 
guy members and VisualDesign will automatically divide guy members into 
appropriate lengths.  

See also 
Automatic Split of Guy Members  
Splitting Members Evenly in Multiple Parts 

• Activate the Structure mode by doing one of the following: 

• Click the icon  on Activation toolbar. 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the Member icon  on Elements toolbar. 

• Select members that you wish to split equally. 

• Do one of the following: 

• Click the icon  on Split toolbar. 

• Choose Multiple from Edit/Split menu. 

• Use the short-cut keys Ctrl+M. 

• Specify the number of desired subdivisions in the Multiple Split dialog 
box. 

• The Split with Loads dialog box will appear also. If the original member 
was loaded and you want the loads to be saved and applied on smaller 
parts, activate appropriate box.  

Note. Characteristics of original element are transferred in newly created members. 
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Split a Member at Exact Position 

   
The "Split at exact position" icon of Split toolbar 

 

Use this function to specify the exact position, from node i or node j, where 
you want to split a member.  

Splitting a Member at Exact Position 

• Activate the "Structure" mode by doing one of the following: 

• Click the icon  on Activation toolbar. 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the Member element  and select the member on your screen. 

• Do one of the following procedure: 

• Click the icon  on Edit toolbar. 

• Choose Split at exact position from Edit/Split menu. 

• Use the short cut keys Ctrl+E. 

• The following dialog box will appear on the screen. In the example below, 
a member 1.3 m long will be split at 0.5 m from node i. 

   

Note. Newly created members keep characteristics of the original member. 
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Split According to Node(s) 

   
The "Split according to node" icon of Split Toolbar 

 

The command Split according to node(s) allows splitting one or more 
members according to one or many nodes positions. A cutting plane, passing 
through the selected node(s), must also be selected. By default, a perpendicular 
plane will be chosen. Other planes are available, namely xy, yz, or zx cutting 
planes.   

Splitting Member(s) According to Node(s) 

• Activate the "Structure" mode by doing one of the following: 

• Click the icon  on Activation toolbar. 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the Node element  and select one node or more. Activate the 

Member element  and, while keeping down the [Ctrl] key, select a 
member or more. Then, do one of the following: 

• Click the icon  on Split toolbar. 

• Select function Split with node in Edit/Split menu. 

• Press the short cut keys [Ctrl]+Y. 

• The following dialog box will appear. Choose an intersection plane passing 
through the node coordinates or use the default cutting plane. 

   

Remark. Newly created members keep characteristics of original member. 
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Generate Pin Connection 

   
The "Generate pin connection" icon of the Split Toolbar 

 

The command Generate Pin Connection allows splitting X-bracings at the 
point of intersection. A master node and dependant node is created at the 
intersection. The dependant node is dependant of the master node translation.  

  

Generating a Pin Connection (Bracings)  

• Activate the "Structure" mode by doing one of the following: 

• Click the icon  on Activation toolbar. 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the "Member" icon  on Elements toolbar. 

• Select two braces while keeping the [Ctrl] key down. 

• Click the icon  on Split toolbar. 

Note. Newly created members keep characteristics of original member. 

Generate Rigid Connections 

  
The "Generate rigid connections" icon of Split Toolbar 

 

In the Structure activation mode, use the function Rigid Connections in 
menu Edit/ Split to automatically generate rigid connections (welded) at the 
junction of crossing members.  
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Generating Rigid Connections 

• Activate the "Structure" activation mode by doing one of the following: 

• Click the icon  on Activation toolbar. 

• Choose Activate Mode/Structure from Edit menu. 

• Activate the "Member" element  on Elements toolbar 

• On your screen, select two or three crossing members. 

• Do one of the following: 

• Click the icon  on Split toolbar. 

• Select Rigid Connection from Edit/Split menu. 

• Press short cut keys Ctrl+R. 
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Multiple Split - Plates 

   
The "Multiple split" icon of the Split Toolbar 

 

When you are working in the Structure activation mode, you can graphically split 
rectangular or triangular plates by using the Multiple function of Edit/Split 
menu or by using short-cut keys [Ctrl]+M.  

  
The Multiple Split – Plates dialog box allows splitting rectangular plates into 
rectangular or triangular plates. To split into rectangular plates, enter the 
number of subdivisions according to the plate local x and y directions, as 
shown below. Three configurations are available for splitting rectangular plates 
into triangular plates. 

  

Split Plates 
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To split a triangular plate, specify the desired number of subdivisions in the 
Multiple Split – Plates dialog box. 
S P L I T T I N G  L O A D E D  P L A T E S  

If plates are loaded, activate option "Split along with loads" in the Multiple 
Split dialog box.  

Splitting Plates Evenly in Multiple Parts 

• Activate the Structure mode by doing one of the following: 

• Click the icon  on Activation toolbar. 

• Choose Activate Mode/Structure from Edit menu. 

• Activate plate elements  on Elements toolbar. 

• Select plate(s). 

• Do one of the following: 

• Click the icon  on Split toolbar. 

• Go to Edit / Split / Multiple. 

• Use the short cut keys [Ctrl]+M. 

• If you selected triangular plate(s), specify the number of side subdivisions 
in the Multiple Split – Plates dialog box. 

• If you selected rectangular plate(s), specify the number of side subdivisions 
in the x and y directions, according to plate local axes system. To split into 
rectangular plates, select the split configuration.   

• Activate the box "Split plates along with loads" if the original plate was 
loaded and if you want the load to be saved and applied on smaller parts. 

Note. Newly created plates keep characteristics of original element. 
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Join 

  
The "Join" icon of Split toolbar 

 

The function Join, used with the "Structure" mode, allows joining members or 
nodes. 

Nodes 

This function can be used to join two selected nodes. The first selected node 
will be the one that will be moved and merged to the second selected node 

Members 

Use this function to join co-linear (with a 1 degree tolerance) members into a 
single member. Intermediate nodes are automatically deleted. As soon as more 
than one member is selected, the "Join" button and menu option will be 
available.   

If selected members have different shapes, VisualDesign will use the shape 
assigned to the first selected member and assign it to all other members.  

If an element is attached to an intermediate node located between selected 
members, VisualDesign will not join members surrounding this node. For 
example, if a beam is connected to the second node among five selected co-
linear members, VisualDesign will join three members only. 

See also 
Joining Members  
Joining Nodes  
Split Functions and Member End Conditions  
Split a Loaded Element  
Joining Nodes 

• Activate the "Structure" mode . 

• Activate the "Node" icon  on Elements toolbar. 

• Select node, while keeping the control key [Ctrl] down. The first selected 
node will be the one that will be moved and merged 

• Follow one of these procedures: 

• Click the icon  on Split toolbar. 

• Choose the function Join under Edit menu. 

Join & Connect 
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Joining Members 

• Activate the "Structure" mode . 

• Activate the "Member" icon  on Elements toolbar. 

• Select members that you want to join: keep the control key [Ctrl] down 
while you click on each member. 

• To join members, follow one of these procedures: 

• Click the icon  on Split toolbar. 

• Choose the function Join under Edit menu. 

Note. The newly created member will have the characteristics of the first selected 
member. 

Connect 

  
The "Connect" icon of Split toolbar 
 
The Connect function is available in Edit menu if the Structure mode is 
activated. It allows connecting selected members by stretching some of them 
and it allows connecting selected nodes through rigid links.  

Nodes 

The function used with nodes will create rigid link between them. The last 
selected node will be the master node. All others selected nodes will be slave 
nodes linked to this master node. 

Members 

This new function (Edition menu) connects two members or more that are 
separated from a distance. The function will lengthen members and moves 
their end node if no transverse element (member, plate, or floor) is connected 
to these nodes. The first selected members will be stretched. 

See also 
Connecting Nodes (Rigid Links)  
Connecting Members  
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Connecting Nodes 

• Activate the "Structure" mode . 

• Activate the "Node" icon  on Elements toolbar. 

• Select two nodes while keeping the [Ctrl] key down.  

• Follow one of these procedures: 

• Click the Connect icon  on Split / Join toolbar. 

• Select the Connect function in Edit menu. 

Connecting Members 

• Activate the "Structure" mode . 

• Activate the "Member" icon  on Elements toolbar. 

• Select two members while keeping the [Ctrl] key down. The first selected 
member will be the one that will be stretched. 

• Follow one of these procedures: 

• Click the Connect icon  on Split / Join toolbar. 

• Select the Connect function in Edit menu. 
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Find 

  
The "Find" icon of Edit toolbar 

 

The Find function will circle on-screen the element(s), (e.g. member, node 
etc.) which correspond(s) to the search criteria. The search criterion is 
composed of type of element and element alphanumerical numbers. The 
search operation considers the position of characters (beginning, end, or 
anywhere in the number) as well as upper- and lower-case, if applicable.  

The Find function is available in all activation modes (Structure, Load Case, 
Load Combination, Envelope, Vibration modes, and Design Results). 

Finding an Element 

• Do one of the following: 

• Click the icon  on Edit toolbar. 

• Choose Find from the Edit menu.  

   

• In the Search dialog box, select a type of element in the drop-down list 
box.  

• Enter the full alphanumerical number of the element that you are looking 
for, or simply a part of this number. 

• Specify whether the entered number matches the whole field, or 
corresponds to the beginning or end, or anywhere in the field.  

• Indicate whether upper- or lower-case characters apply.  

• Press the "Next" button to launch the search operation. 

Search for Elements 
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The elements that correspond to all the search criteria will be encircled on-
screen every time you press "Next" until the search operation is completed and 
there are no more elements of the requested category. Do not close the dialog 
box if you want to zoom-in, zoom out or to change the view because the 
coloured circle will disappear. 

• To exit the dialog box, press the "Close" button. The last element found 
will remain on the screen. 
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2D Frame 

• Start VisualDesign™. Click on the New Project icon . The Structure 
activation mode is automatically activated. 

• Select the Preferences tab of Project Configuration (File menu) and 
uncheck all the boxes included under the heading "Display Dialog Boxes". 

Nodes 
• Create nodes through the Nodes spreadsheet (Structure menu). Specify 

nodes 1 and 4 as support nodes: Double click in the "Type" column and 
select option Support.  

 

Members 

• Select the Member icon  on the Elements toolbar and press the Add 
icon  on the Cursor toolbar. To create a member, click on a node 
(origin node, i) and on a second one (end node, j). Do the same to create 
the other members. When elements are created, select the extended 

selection mode  to exit the Add mode. 

Supports 

• To create supports, activate the Node element on the Elements toolbar 
and select all nodes at the bottom of the structure. Press the Properties 

icon . In the Node Characteristics dialog box, choose option Support 
in the "Type of node" field. (New supports have restrained displacements 
and rotations by default values.) To look at support restraints, activate the 

Support icon , double-click on a support node and select the Support 
tab in the dialog box.  

• Press the control key [Pg Up] on your keyboard to get an isometric view of 
the structure.  

Practical Example: 2D Frame 
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• Save your file. To do so, press the Save icon . Give a name to your 
project and choose a directory.  

Definition of Members  

• Activate the Member icon  and select all three members. Press the 

Properties icon . Complete the parameters in the Member tab. 
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• Choose a steel specification in the Steel Design tab and press OK. 

  

Load Cases 

• Give a title to each load case. To do so, go in the Loads menu and select 
the heading Load Cases/Definition. 

• In the Loads Definition spreadsheet, insert a line (To insert a line, select 
the line number 2 and press down the [Insert] key.) Double-click in the 
"Type" cell and choose a "Live" type of load. Double-click in the 
"Number" cell and give it a name. Press OK. 

• Activate the Load Case activation mode and choose the Live load case. At 
the message: "Do you wish to save your project?", answer yes. The name of 
the load case will be written at the bottom of your screen.  
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Applying Loads 
You are now ready to enter loads on the structure. We are going to place a 
distributed load on the horizontal member and on a vertical member. A 
punctual load will also be applied to a node. 

• Double-click on the horizontal member. In the Loads on Member dialog 
box, click on the number 1, at the first line and insert a line.  Double-click 
in the cell "Load Wa" and enter –20. Double-click in the cell "Load Wb" 
and enter –20. Press OK. You will see the loads applied to the member. 

  

• Double-click on the vertical left member. In this case, the load will be 
applied on the weak axis, at 90 degrees. Load Wa is applied at node i and 
Wb, at node j. Loads are positive because their orientation is positive 
relatively to the member weak axis, as shown below. Display the shape of 
steel section through the Attributes tab of View Options dialog box.  
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• To apply the punctual load on node, activate the Node icon and double-
click on the node. Enter a positive load of 25 kN in the global x direction. 
Click on Ok. 

  

Now, at least one load combination must be defined to run an analysis or a 
design.  

Load Combination 

• Go in the Loads menu and select the heading Load Combinations / 
Definition. Insert a line in the spreadsheet. Double-click in the "Number" 
cell, give it a number or name, and do the same for the description. 

• Select the Load Factors tab. Insert two lines in the right section of the 
dialog box. In the first line, double click in the "Load" column, choose the 
Dead load case, and enter 1.25 as load factor. Do the same for the second 
line: choose the live load case and enter 1.5. Click on OK.  

  

You are now ready to launch the analysis and steel design. 

Analysis  

• Press the icon Analysis and Design  on the Tools toolbar. The 
Design dialog box will be displayed on the screen. It is written that three 
members will be optimized according to shape area. Press the button 
"Analyse". When results will be available, close the dialog box.  

Results 

You will notice that the "Design results" icon  is automatically activated 
once that the design is done. Select all the members and then, select the 
heading Structure Design / Steel in the Results menu.  
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• Call the View Options dialog box by pressing the icon . Display the 
members design load by checking the "Design load" box in the Results 
tab.  

• To look at forces and deflection diagrams, you must activate the Load 
Combination mode beforehand and choose a load combination title in the 
drop-down list box of Activation toolbar. 

  

• Then, in the Results tab of View Options, check the "Deflection" box or 
another type of results that you want to look at.  

To adjust the amplitude of diagram and to display numerical values, use the 
Diagrams toolbar functions. 

• You can also display numerical values of forces and deflections diagrams 
by ticking off the appropriate boxes below the "Numerical" title.  
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Verification of your Structural Model – Steps 
Use this topic as a guide to verify your structural model before and after an 
analysis if a problem occurs.  

First, complete the General tab (Project Configuration) to distinguish your 
current model from others (previous versions). 

Before an analysis: 
1 .  P R O J E C T  C O N F I G U R A T I O N  

• Project title and description; 

• Type of analysis. If non-linear: convergence criterion, number of iterations, 
etc.; 

• Parameters for spectral and time history analysis: Za, Zv, R, U, I, F, 
Spectrum (code), Total height Hn, Number of stories, etc. 

• Units for materials, foundations, structure, loads and results. 
2 .  M A T E R I A L S  A N D  S H A P E S  

• Make sure that new materials / sections parameters are well defined; 

• E, G, Rho (density); 

• Ix, Iy, J. 
3 .  G E O M E T R Y  ( N O D E S  C O O R D I N A T E S )  

• Location of columns; 

• Elevation of floors. 
4 .  S T R U C T U R A L  M O D E L  

• If a modal analysis is planned, try to model the structure as roughly as you 
can in order not to create local modes of vibration created by mezzanine or 
footbridge. Transfer the dead load of such structures to nodes. 

• Members: assign shape and material, end conditions, beta angle, pretension, 
if necessary, release, specifications and design group. For a design, activate 
design criteria. 

• Design: member lateral supports: do not forget to specify a continuous 
support along a member top fibre if the floor acts this way.  

Checking your model 
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• Important: if cantilevers are present in your structural model, read carefully 
the On-line Help because the user must specify some cases himself.  

• Plates: material, thickness, group of plates. 

• Supports: displacements and moment’s degrees of freedom, orientation, 
release. Do not forget that VisualDesign is a 3D software. If you have a 2D 
model, you must fix Rz and rotation Mx (or My depending on your 
principal axes). If you do not, a "Null pivot" warning will be posted on 
your screen (invalid stiffness matrix).  

• Floors: One-Way, Two-way, joist, diaphragm action. 
5 .  L O A D  C A S E S  

• Dead: member dead load (automatic), floors, plates;  

• Extra dead loads: floors or mechanical equipments; 

• Live loads: Overload, wind (2 directions), snow on roof, seismic load, 
temperature, etc.; 

• Differential settlements on supports. 
6 .  L O A D  C O M B I N A T I O N S  

• Load Combinations Generation Wizard; 

• "Mass" load combination for modal analysis. 
7 .  M O D A L  A N A L Y S I S  

• Frequencies and vibration modes; 

• Seismic directions, Ds (width of lateral resisting system for braced bays or 
rigid frame); 

8 .  S P E C T R A L  A N A L Y S I S  

• Percentage of modal (weight) participation for the two main directions 
(90% according to CNB) 

• Information on Levels (stories), check interstory sliding; 

• Shear forces and overturning moment. 

See also 
A Few Tips  
FAQ  
Modeling Strategy  
Structural Modeling 
Incomplete Modeling  
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If there is a problem after the analysis 
You got a "Null pivot" message? It means that your structure is not stable. 
Read this topic: Null pivot in the stiffness matrix  

Do not forget that at least one degree of freedom must be active at one node. 
For example, if there are many beams attached to one column, do not model 
hinges everywhere because a mechanism will be created in your model.  

Make sure that shapes are appropriate (Filled HSS, built-up section properties 
in the spreadsheet). 

Do members rotate around themselves? (Check their local z-axis). 

Make sure that continuous members are co-linear. To avoid this problem, 
model a long member and split it into pieces. 

Use functions Mask and Zoom+ to look at certain part of your structure. 

Use function Overlapped Elements (Structure / Tools) to detect 
overlapped elements and delete them. 

Use the View Options dialog box. 

Look carefully at inputs by using the sort function for spreadsheet.  

Not sure about results? Check the following: 
Check the message about analysis in the Summary spreadsheet (Results / 
Load Combinations). If some load combination analyses have not converged, 
you cannot use these results because they are not correct. Change the 
convergence parameters in Project Configuration.   

Look at nodes displacements. Some displacements could be excessive. 
Convergence may be the cause. 

For a steel design, check member end conditions and lateral supports. These 
are very important for a design. Display them through the View Options 
dialog box.  

For a concrete design and prestressed concrete design: Did you model rigid 
extensions? If not, results are not accurate. Go to Connection tab (Member 
Characteristics dialog box) and specify minimum rigid extensions in the field 
"ez".  

Are loads too large? VisualDesign will choose the biggest available steel section 
among the type that you specified in the steel specification (W, WWF, C, L, 
etc.) if it cannot find any for the loads acting on members. Check the loads, 
modify the steel specification and launch a new design.  

See also 
Technical Support  
Sorting a spreadsheet  
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Inactive Nodes  
Display Member Characteristics  
Display Plate Characteristics  
Display Floor Characteristics  

Incomplete Modeling 
This new tool, which is available in Edit menu / Select Elements, selects 
elements with incomplete or inadequate modeling such as members with no 
assigned shape or material, floors and plates with invalid geometry and plates 
with no assigned material or thickness.  

In fact, this tool activates the following options that are included in the View 
Options’ Attributes tab:  

  
When invalid elements are selected using this function, click on each one in the 
Structure activation mode or select many of the same type and call up the 
default spreadsheet by pressing the shortcut keys [Ctrl]+H. The appropriate 
spreadsheet (members, Floors or Plates) will be displayed on screen. Complete 
the missing information such as materials, shapes or thickness).   

Concerning invalid geometry for plates and floors, VisualDesign will notice 
them only if an analysis is launched. A warning message will appear on screen 
to inform you that it detected invalid geometries. Then, use the function 
Incomplete Modeling to locate and select them.  Correct node coordinates 
for these surfaces.  
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Checking the Model 
Before launching an analysis, use function Checking the Model in the 
Structure/Tools menu to look at missing material and sections. This function 
also searches for overlapped elements (members, plates or floors) and nodes 
that are not linked to edges of plates or members but are located on these 
elements.  

Activate options in the dialog box and press OK. 

  
When the search will be over, incomplete modeling and overlapped elements 
will be selected (highlighted) on screen. Use the Mask function to hide other 
elements and correct your model. 

Checking Nodes 
Inactive Nodes 
An inactive node is not linked to anything. We recommend that you delete 
inactive nodes that may be present in your structural model.  

VisualDesign warns you that there are inactive nodes in your project when you 
launch a static analysis or a design. It is written in the Analysis or Design 
dialog box. 

To find and delete these nodes, use the function Select/Inactive Nodes in 
Edit menu. Then, select them and press the [Delete] key. 
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Checking Members 
Displaying Members' Shapes 

• Select the Attributes tab of View Options dialog box and activate the 
"Shape outline" option in the Member section of this tab.  

For a definition of the shape symbol, go to Member tab of Member 
Characteristics dialog box and open the Shape selection tree, which is 
accessible through the I-Beam icon posted in the member tab. 

• To display the shape on the whole (or fraction) length, activate option 3D 
Display. Refer to the Preferences tab (Project Configuration) to adjust the 
fraction of the member length that is not displayed to avoid hiding member 
end conditions.   

Displaying Members End Conditions 

• Activate the "End Conditions" option available in the Attributes tab of 
View Options dialog box. The direction of the swivel for the strong and 
weak axes will be displayed at member ends. 

• To modify the colours for swivel points, go to the Colours tab, expand the 
Structure root and select Member / End conditions). 

Displaying Members with Axial Release 

• Go to the Attributes tab of View Options dialog box and activate the 
With axial release option. Members in Tension-Only (<-[]->) or 
Compression-Only (->[]<-) will be highlighted on screen.  

• Modify the colour through the Colours tab, by clicking the "invalid 
elements" colour.  

Displaying Members with Pre-tension 

• Go to the Attributes tab of View Options dialog box and activate the 
option With pre-tension in the Member section. 

Displaying Lateral Supports for Members 

• Go to the Attributes tab of the View Options dialog box and activate the 
option Lateral Support in the Member section. 

Displaying Members Having no Material 

• Go to the Attributes tab of View Options dialog box and activate the No 
Material option. Members with no material will be highlighted on screen.  

• To assign a material, press the Properties function. In the Member dialog 
box (Member tab), complete the missing information. 

Note. The analysis cannot be performed if one member has no material defined. 
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Displaying Members Having No Section 

• Go to the Attributes tab of View Options dialog box and activate the No 
Section option. Members with no specified section will be highlighted on 
screen.  

• To assign them a material, click on the Properties function. In the 
Member dialog box, go to the Member tab and complete the required 
information. 

Note.  The analysis cannot be performed if one or more members are without section. 

Displaying Overlapped Elements 
This function allows users to seek for overlapped elements (members, plates 
and floors) and nodes that are not linked to members or edges of plates.  
P R O C E D U R E :  

Activate the "Structure" mode before selecting this function. Then, select this 
function located in the Structure/Tools menu.  

Activate search options in the Overlapped Elements dialog box. 
VisualDesign will post messages about the results of the search. 

Link the "free" nodes to appropriate elements and delete overlapped elements.  

Checking Plates 
Displaying Geometrically Invalid Plates 

• Launch a static analysis, which allows VisualDesign to detect invalid 
geometries (one node or more is out of plane).  

• Go to the Attributes tab of View Options dialog box and activate the 
option Invalid Geometry in the Plates section. 

Note. The analysis cannot be performed if one plate is geometrically invalid. 

Displaying Plates Having no Material 

• Go to the Attributes tab of View Options dialog box and activate option 
With no Material. The plates having no material will be highlighted on 
screen. 

• To correct this situation, call up the Plate Characteristics dialog box by 
pressing the Properties function. Enter a material. 

Note. The analysis cannot be performed if a material is missing for one plate.  



C H A P T E R  3  M O D E L I N G  &  E D I T I N G  

CivilDesign Inc. Engineering Software  3-77 

Displaying Plates with Unspecified Thickness 

• Select the Attributes tab of View Options dialog box and activate the 
option With no Thickness. Invalid plates will be highlighted on screen. 

• To correct this situation, call up the Plate Characteristics dialog box by 
pressing the Properties function. Enter a plate thickness. 

Note. The analysis cannot be performed if one or more plates lack thickness. 

Displaying Overlapped Elements 
This function allows users to seek for overlapped elements (members, plates 
and floors) and nodes that are not linked to members or edges of plates.  
P R O C E D U R E :  

Activate the "Structure" mode before selecting this function. Then, select this 
function located in the Structure/Tools menu.  

Activate search options in the Overlapped Elements dialog box. 
VisualDesign will post messages about the results of the search. 

Link the "free" nodes to appropriate elements and delete overlapped elements.  

Checking Floors 
Displaying Floors Orientation 
View the orientation of both one-way slabs and two-way slabs by doing as 
follows: 

• Go to the Attributes tab of View Options dialog box and activate option 
One-Way slab or Two way Slab in the "Floors" section. 

The symbols represent the following directions: 

Direction Symbol 

One-Way Slab 

  

Two-Way Slab 

  

Displaying Two-Way Slab Tributary Surfaces 

• Go to the Attributes tab of View Options dialog box and activate the 
(Two-way Slab) Tributary option in the "Floors" section. 
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Displaying Geometrically Invalid Floors 

• Launch a static analysis to allow VisualDesign detecting invalid geometries. 

• To identify invalid floors, which have at least one node out of plane, go to 
the Attributes tab (View Options) and activate the Invalid Geometry option 
in the "Floors" section. Invalid floors will be highlighted. 

• Click on an invalid floor and open the Floors spreadsheet (use shortcut 
keys [Ctrl] + H). Correct node coordinates. 

Note. The analysis cannot be performed if one or more floors are geometrically 
invalid. 

Displaying Overlapped Elements 
This function allows users to seek for overlapped elements (members, plates 
and floors) and nodes that are not linked to members or edges of plates.  
P R O C E D U R E :  

Activate the "Structure" mode before selecting this function. Then, select this 
function located in the Structure/Tools menu.  

Activate search options in the Overlapped Elements dialog box. 
VisualDesign will post messages about the results of the search. 

Link the "free" nodes to appropriate elements and delete overlapped elements.  
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Loads 
VisualDesign™ allows you to define and apply loads on nodes, members and 
floors, apply pressure and temperature variation on triangular and rectangular 
plates and define support settlements. The loads may be applied graphically 
with the help of dialog boxes or numerically through spreadsheets. 

In this chapter, you will find the following headings among others: 

Load Definition Spreadsheet 
Loads on nodes 
Support Settlements   
Loads on Members  
Loads on Floors 
Loads on Plates Dialog Box  
Reduction of tributary surfaces  
Automatic Generation of Ice Loads  
Automatic Generation of Wind Loads  
Snow Loads  
Load Types  
Display convention of Loads on Floors and Members 
Defining and Applying Loads on Elements  
Modifying Applied Loads  
Deleting Loads Applied on Elements  

Reduction of Tributary Area 
VisualDesign allows considering a reduction of tributary areas for "Live" type 
of loads, as per CNBC. Reduction may be of type A or B. 

 

General 
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VisualDesign™ calculates the "real" tributary area by finding the location 
where the Vf diagram of live load is equal to zero. The live load case must be 
defined in the Live tab of Loads Definition dialog box. The columns 
included in this tab are optional but must be filled in to reduce the floor 
overloads. 

All the applied loads that are corresponding to this particular "Live" type of 
load must be of the same type of reduction (A or B) and of the same 
magnitude (2.4 kPa, 4.8kPa, etc.).  

The delimitation of tributary area surrounding an element is at Vf = 0. Unlike 
the code, VisualDesign™ allows reducing overloads even if the structure has 
an irregular geometry such as variable spans, elements with different inertias, 
etc. If you want to check by hand the reduction of overload using the code, 
you will not obtain the same answer as VisualDesign™ unless tributary areas 
are calculated in an accurate way as explained above.  

IMPORTANT. We recommend modelling floors with respect to the tributary 
widths of beams that will support the reduced live loads. For example, don't 
model only two floors along three continuous beams because the reduced 
overloads will not be valid. Instead, model six floors along the continuous 
beams (three floors on each side).  

Procedure: 
• Select the Loads Definition spreadsheet and create a "Live" type of 

load that you will apply to the floors afterwards. 

• Select the Live tab. 

• In the column "Tributary Area - Reduction", specify the type of 
reduction (A or B). 

• Enter the magnitude of overload in the column " Tributary Area – 
Overload". VisualDesign™ will reduce the reactions according to this 
value. 

Display Convention for Loads on Floors and 
Members 
Loads applied on members and floors are displayed on the screen according to 
the following conventions, if the projection of load is specified as the global 
axes system: 

• When the load is located above the element, its numerical value is negative 
and the load points down. 

• When the load is located below the element, its numerical value is positive 
and the load points up. 
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Projection and Type of Load 
Type of  Load Type of  Projection 

Dead Global 

Snow Global-Horizontal 

Wind Local 

Live Global 

Temperature Strong axis or weak axis 

Seismic N/A 

Snow Loads 
When snow loads accumulate close to a vertical surface, it is sometimes 
necessary to split up the floor in two parts or to transform the snow 
accumulation (trapezoidal + rectangle) in a trapezoidal snow live load.   

You may use the following equations to transform the load: 

  
Where: 
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Guys' Dead Load 
The load factor for guy dead load (1.0) is different from the structure dead load 
(1.25), according to CAN/CSA-S6-00, AASHTO-LRFD-04 (bridges) and 
CAN/CSA-S37-01 (towers). So, when using the Load Combination 
Generation Wizard, be sure to specify the appropriate type of dead load for 
guys, "[D] Guy", in the Dead load tab of Load Definition dialog box. Then, 
this dead load must be assigned to guy members in the Member tab of 
Member Characteristics dialog box. .  

See also 
Analysing a Guyed Tower  
Guys  
Type of loads - CAN/CSA-S6-00  
Type of loads - CAN/CSA- S37-01  
Type of loads - AASHTO-LRFD-04  

Displaying applied loads 
Loads are always displayed on the screen when a load title is selected. If you do 
not want to see the loads applied on the structure, select the Loads tab of 
View Options and uncheck the boxes. 

  
To hide numerical values, uncheck the boxes below the "Numerical" heading. 
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Type of Loads 
This topic describes load cases that are listed in the Type list box of Load 
Cases tab (Load Definition dialog box). A selection tree appears in the list 
box. It is composed of roots that correspond to building codes and Standards, 
namely NBC (95 &05), CAN/CSA-S6-00, CAN/CSA-S37-01, ASCE-7, and 
AASHTO-LRFD-04. Load cases that are listed under each root belong to the 
building code or standard. The letter describing each load case (L, S, W, etc) is 
also supplied.  

It is very important to choose the right type of load when using the generator 
because VisualDesign will combine load cases and put appropriate load factors 
according to these types. 

  
When a line is inserted, the Not Defined type is selected. The user should open 
the appropriate, and select a load case type if he plans to use the Load 
Combination Generation Wizard.  

If load combinations have already been generated, as for an existing file, the 
appropriate root is open by default.  

It is permitted to select load case types that are listed in other roots. However, 
if they are not part of the building code or standard that will be selected to 
generate load combinations, these load cases will not be included in the 
generated load combinations. The user can add them by hand when the 
generation is completed.  

Please refer to following topics to know the list of load case types available in 
VisualDesign for each building code and standard: 

NBC-95 Load Cases  

Load Types and Families 
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NBC-2005 Load Cases  
CAN/CSA-S6-00 Load Cases  
CAN/CSA-S37-01 Load Cases  
ASCE-7 Load Cases  
AASHTO-LRFD-04 Load Cases  
See also 
Loads Definition Spreadsheet  
The Load Cases tab  
The Ice tab  
The Wind tab  
The Dynamic tab  
Load Case Families  
Automatic Generation of Load Combinations  
NBC-95 Load Cases 
To select load case types that belong to the Canadian National Building Code 
(95), double click in the "Type" cell of Loads Definitions spreadsheet. 
Expand the NBC-95 root and double click on a load case type.  

This table lists the NBC-95 load case types that are available in VisualDesign:  

Type of Load Description Family (1) Note 

(D) Dead  Permanent Loads N/a  

(E) Seismic Overload due to seismic 
forces. 

N/a Spectral Envelope E 

(L) Live Overload due to usage. 4  

(L) Snow  Overload due to snow. 1 The snow load is always 
combined with the live load (L).  

A Snow load and an Auto-Ice 
load (or Auto-snow in this case) 
can be part of  the same family.  

(L) Auto Ice Overload due to ice 
coating on members. 

1 Generation of  Ice Loads  

(L) Dynamic Overload due to dynamic 
forces other than those 
created by an earthquake. 

4 General Dynamic Analysis 
(transient, harmonic, etc.)  

(T) Temperature Overload due to 
temperature variations. 

2 Temperature loads are always 
combined with creep and 
shrinkage effects if  this option is 
activated in the Load 
Combination Generation 
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Wizard. 

(T) Deformation Overload due to 
deformations other than 
those created by 
temperature loads and 
settlements. 

2  

(T) Interaction Overload due to resulting 
forces induced by 
differential settlement 
under the structure 
foundation. 

2 Refer to Soil-Structure 
Interaction  

(W) Wind  Overload due to wind 
forces acting on the 
structure. 

3  

(W) Auto Wind Overload due to wind 
forces acting on the 
structure. 

3 Generation of  Wind Load  

(P) Prestressing 
(Virtual load) 

Overload due to creep 
and shrinkage of  
materials. 

N/a This load case is automatically 
created by VisualDesign if  this 
option is activated in the Load 
Combination Generation 
Wizard.  
The Prestressing load case is 
always combined with 
temperature and deformation 
loads.  

Note 1: In this table, the number representing the family means that these load 
cases can be part of the same family. It does not represent the number that has 
to be entered in the "Family" cell of Load Definitions spreadsheet.   

NBC-2005 Load Cases 
To select load case types that belong to the Canadian National Building Code 
(2005), double click in the "Type" cell of Loads Definitions spreadsheet. 
Expand the NBC-2005 root and double click on a load case type.  

This table lists the NBC-2005 load case types that are available in 
VisualDesign:  

Type of Load Description Family (1) Note 

(D) Dead  Permanent Loads N/a  

(H) Lateral earth 
pressure 

Permanent Loads N/a This load case is always 
combined with the dead load 
case "(D) Dead" 
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Type of Load Description Family (1) Note 

(E) Seismic Overload due to seismic 
forces. 

N/a Spectral Envelope E 

(L) Live Overload due to usage. 4  

(L) Dynamic Overload due to dynamic 
forces other than those 
created by an earthquake. 

4 General Dynamic Analysis 
(transient, harmonic, etc.)  

(S) Snow (2) Overload due to snow. 1 A Snow load and an Auto-Ice 
load (or Auto-snow in this case) 
can be part of  the same family.  

(S) Auto Ice Overload due to ice 
coating on members. 

1 Generation of  Ice Loads  

(T) Temperature Permanent load 

Overload due to 
temperature variations. 

Note 3 Temperature loads are always 
combined with creep and 
shrinkage effects if  this option is 
activated in the Automatic 
Generation of  Load 
Combinations. 

(T) Deformation Permanent load 

Overload due to 
deformations other than 
those created by 
temperature loads and 
settlements. 

N/a  

(T) Interaction Permanent load 

Overload due to resulting 
forces induced by 
differential settlement 
under the structure 
foundation. 

N/a Refer to Soil-Structure 
Interaction  

(W) Wind  Overload due to wind 
forces acting on the 
structure. 

3  

(W) Auto Wind Overload due to wind 
forces acting on the 
structure. 

3 Generation of  Wind Load  
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Type of Load Description Family (1) Note 

(P) Prestressing 
(Virtual load) 

Overload due to creep 
and shrinkage of  
materials. 

Note 3 Activate option "prestressing 
and shrinkage/creep" in the 
Specific Options page of  
Automatic Generation of  Load 
Combination Generator  
The Prestressing load case is 
always combined with 
temperature and deformation 
loads.  

 

Note 1: In this table, the number that represents the family means that these 
load cases can be part of the same family. It does not represent the number 
that has to be entered in the "Family" cell of Load Definitions spreadsheet.  

Note 2 The CNBC-2005 uses different load factors when combining snow load 
cases (art. 4.1.6.3.2). Load factors for combined and reduced loads are (1.5, 
0.75) and (0.5, 0.25). VisualDesign generates the following aliases when load 
combinations are automatically created and when snow load cases are 
belonging to the same family. 

 
Note 3: The Prestressing load case is always combined with temperature and 
deformation loads if this special load case was activated in the in the Specific 
Options page of the Load Combination Generator for a prestressed concrete 
project.  

With a steel design, temperature loads are always combined with 
shrinkage/creep effects applied to the slab. Refer to Thermal gradient.  
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CAN/CSA-S6-00 Load Cases 
To select load case types that belong to this Canadian Standard, double click in 
the "Type" cell of Loads Definitions spreadsheet. Expand the CAN/CSA-
S6-00 root and double click on a load case type.  

Dead Loads and Load Factors 
The nomenclature used in VisualDesign to describe dead loads and load 
factors is based on CAN/CSA-S6-00 standard, table 3.5.1 b) Permanent Loads: 
Maximum and Minimum Values of Load Factors for ULS. 

VisualDesign DL  Dead Load αD Max αD Min 

(D1) Prefab 
Elements 

Prefab elements, excepted timber. 1.10 0.95 

(D2) Cast 
Concrete 

Concrete cast-in-place, wood 
(timber), and all non-structural 
elements. 

1.20 0.90 

(D3) Wearing 
Surface 

Wearing surface from nominal or 
specified thickness. 

1.50 0.65 

(D4) Backfill Backfill, negative friction on piles. 1.25 0.80 

VisualDesign DL Earth Pressure αE Max αE Min 

(E23) Pressure 
Active + At rest  

Pressure at rest and active pressure 1.25 0.80 

(E4) Backfill 
Pressure 

Backfill Pressure 1.25 0.80 

(E5) Hydrostatic 
Pressure 

Hydrostatic Pressure 1.10 0.90 

 

This table describes load types included in VisualDesign and to be used with 
CAN/CSA/S6-00 standard:  

Type of Load Description Family (1) Note 

(D1) Prefab 
Elements 

Dead load of  prefab 
elements 

N/a  

(D2) Cast 
Concrete 

Dead load of  cast 
concrete 

N/a  

(D3) Wearing 
Surface 

Dead load of  wearing 
surfaces. 

N/a  
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Type of Load Description Family (1) Note 

(D4) Backfill Dead load of  backfill. N/a  

(D6) Guys Guys dead load. N/a Refer to Dead load of  guys 

(E23) Active + At 
rest Pressure 

Loads due to earth 
pressure: 
Active pressure and 
pressure at rest. 

N/a  

(E4) Backfill 
Pressure 

Loads due to earth 
pressure: 
Backfill pressure. 

1  

(E5) Hydrostatic 
Pressure 

Loads due to earth 
pressure: 
Hydrostatic pressure. 

N/a  

(L) Live Overload due to usage.  4  

(L) Dynamic Overload due to dynamic 
forces other than those 
created by an earthquake. 

4 General Dynamic Analysis 
(transient, harmonic, etc.)  

(K) Temperature Overload due to 
temperature variations. 

2 Temperature loads are always 
combined with creep and 
shrinkage effects. 

(K) Deformation Overload due to 
deformations other than 
those created by 
temperature loads and 
settlements. 

2  

(S) Interaction Overload due to resulting 
forces induced by 
differential settlement 
under the structure 
foundation. 

2 Refer to Soil-Structure 
Interaction  

(W) Wind on 
Structure 

Overload due to wind 
forces acting on the 
structure. 

3  

(W) Auto Wind Overload due to wind 
forces acting on the 
structure. 

3 Generation of  Wind Load 

(V) Wind on 
Traffic 

Overload due to wind 
forces acting on live load. 

3  



C H A P T E R  4  L O A D S  &  L O A D  C O M B I N A T I O N S  

4-12  CivilDesign Inc. Engineering Software 

Type of Load Description Family (1) Note 

(EQ) Seismic Overload due to seismic 
forces. 

N/a  

(F) Hydrodynamic 
Pressure 

Overload due to water 
loads, stream pressure, 
and floating debris. 

N/a  

(A) Ice Accretion Overload due to ice 
accretion 

N/a  

(H) Collision Overload due to collision 
forces (vehicular or 
vessel). 

N/a  

(P) Prestressing 
(VisualDesign 
virtual load) 

Overload due to creep 
and shrinkage of  
materials. 

N/a VisualDesign automatically 
creates this load case if  it had 
been asked for in the Load 
Combination Generation 
Wizard.  
The Prestressing load case is 
always combined with 
temperature and deformation 
loads.  

 

Note 1: In this table, the number representing the family means that these load 
cases can be part of the same family. It does not represent the number that has 
to be entered in the "Family" cell of Load Definitions spreadsheet.   
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CAN/CSA-S37-01 Load Cases 
To select load cases that belong to the Canadian CAN/CSA-S37-01 standard, 
double click in the "Type" cell of Loads Definitions spreadsheet. Expand the 
CAN/CSA-S37-01 root and double click on a load case type.  

This table lists load cases per CAN/CSA-S37-01 standard and available in 
VisualDesign:  

Type of Load Description Family (1) Note 

(D) Dead  Permanent Loads N/a  

(D) Guys Permanent loads of  guys. N/a Refer to Dead load of  guys 

(I) Ice  Overload due to ice 
coating on members. 

1  

(I) Auto Ice Overload due to ice 
coating on members. 

1 Generation of  Ice Load 

(W) Wind  Overload due to wind 
forces acting on the 
tower. 

2  

(W) Auto Wind Overload due to wind 
forces acting on the 
tower. 

2 Generation of  Wind Load  

(T) Temperature Overload due to 
temperature variations. 

3  

(T) Deformation Overload due to 
deformations other than 
those created by 
temperature loads and 
settlements. 

3  

(T) Interaction Overload due to resulting 
forces induced by 
differential settlement 
under the structure 
foundation. 

3 Refer to Soil-Structure 
Interaction  

(E) Seismic Overload due to seismic 
forces. 

N/a Spectral Envelope E 

 

Note 1: In this table, the number representing the family means that these load 
cases can be part of the same family. It does not represent the number that has 
to be entered in the "Family" cell of Load Definitions spreadsheet.   
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ASCE-7 Load Cases 
To select load cases that belong to the American Standard ASCE-7, double 
click in the "Type" cell of Loads Definitions spreadsheet. Expand the ASCE-
7 root in the selection tree and double click on a load case type.  

This table lists the ASCE-7 load case types that are available in VisualDesign:  

Type of Load Description Family (1) Note 

(D) Dead  Permanent Loads N/a  

(L) Live Overload due to usage. 6  

(L) Dynamic Overload due to dynamic 
forces other than those 
created by an earthquake. 

6 General Dynamic Analysis 
(transient, harmonic, etc.)  

(Lr) Live load on 
roof 

Overload on roof 1  

(W) Wind  Overload due to wind 
forces acting on the 
structure. 

2  

(W) Auto Wind Overload due to wind 
forces acting on the 
structure. 

2 Generation of  Wind Load  

(S) Snow  Overload due to snow. 3 The snow load is always 
combined with the live load (L).  

A Snow load and an Auto-Ice 
load (or Auto-snow in this case) 
can be part of  the same family.  

(S) Auto Ice (or 
Auto-snow) 

Overload due to ice 
coating (or snow) on 
members. 

3 Generation of  Ice Load 

(E) Seismic Overload due to seismic 
forces. 

N/a Spectral Envelope E 

(R) Rain Nominal overload due to 
initial rainwater or ice 
exclusive of  the ponding 
contribution. 

4  

(T) Temperature Overload due to 
temperature variations. 

5 Temperature loads are always 
combined with creep and 
shrinkage effects, if  asked for. 
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Type of Load Description Family (1) Note 

(T) Deformation Overload due to 
deformations other than 
those created by 
temperature loads and 
settlements. 

5  

(T) Interaction Overload due to resulting 
forces induced by 
differential settlement 
under the structure 
foundation. 

5 Refer to Soil-Structure 
Interaction  

(F) Fluids Overload due to fluids   

(H)  Overload due to lateral 
earth pressure, water & 
bulk 

  

(Fa) Flood Overload due to flood   

(Di) Ice Overload due to ice 3  

(Wi) Wind-on-ice Overload due to wind-
on-ice 

2  

(P) Prestressing 
(VisualDesign 
virtual load) 

Overload due to creep 
and shrinkage of  
materials. 

N/a VisualDesign automatically 
creates this load case, if  asked 
for  
The Prestressing load case is 
always combined with 
temperature and deformation 
loads.  

 

Note 1: In this table, the number representing the family means that these load 
cases can be part of the same family. It does not represent the number that has 
to be entered in the "Family" cell of Load Definitions spreadsheet.   
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AASHTO-LRFD-04 Load Cases 
Permanent Loads 
The nomenclature used in VisualDesign to describe dead loads and load 
factors is based on AASHTO-LRFD-04 standard, Table 3.4.1-2 Load Factors for 
Permanent Loads, γp. 

Type of Load γp max γp min 

DC: Component and Attachments 1.25 0.90 

DD: Downdrag 1.80 0.45 

DW: Wearing Surfaces and Utilities 1.50 0.65 

EH1: Horizontal Active Earth 
Pressure 

1.50 0.90 

EH2: Horizontal Earth Pressure At 
Rest 

1.35 0.90 

EV: Vertical Earth Pressure 1.35 0.90 

ES: Earth Surcharge 1.50 0.75 

 

This table describes load case types included in VisualDesign per AASHTO-
LRFD-04 standard:  

Type of Load Usage Family (1) Note 

(DC) Dead  Dead loads of  structural 
components and non-
structural attachments 

N/a  

(DC) Guys Dead loads of  guys. N/a Refer to Dead load of  guys  

(DD) Downdrag Downdrag.  N/a  

(DW3) Wearing 
Surface 

Dead loads of  wearing 
surfaces and utilities. 

N/a  

(EH1) Active  Horizontal active earth 
pressure 

1  

(EH2) At rest Horizontal earth pressure 
at rest 

1  

(EV) Earth Fill Vertical pressure from 
dead load of  earth fill. 

N/a  
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Type of Load Usage Family (1) Note 

(ES) Earth 
Surcharge 

Earth surcharge load. N/a  

(CE) Centrifugal 
Force 

Vehicular centrifugal 
force. 

2  

(L) Live Vehicular live load, 
breaking force, 
pedestrian, etc. 

5 In VisualDesign: 
(LL) = Lm + (IM)  

(L) Dynamic Dynamic forces other 
than those created by an 
earthquake. 

5 General Dynamic Analysis 
(transient, harmonic, etc.)  

(WA) Water Load Water load and stream 
pressure. 

N/a  

(WS) Wind on 
Structure 

Wind forces acting on 
the structure. 

3  

(WS) Auto Wind Wind forces acting on 
the structure. 

3 Generation of  Wind Load 

(WL) Wind on 
Traffic 

Wind forces acting on 
live load. 

3  

(FR) Friction Friction N/a  

(T) Temperature Overload due to 
temperature variations. 

4 Temperature loads are always 
combined with creep and 
shrinkage effects, if  asked for. 

(T) Deformation Overload due to 
deformations other than 
those created by 
temperature loads and 
settlements. 

4  

(TG) 
Temperature 
Gradient 

Temperature Gradient 4  

(SE) Interaction Overload due to resulting 
forces induced by 
differential settlement 
under the structure 
foundation. 

4 Refer to Soil-Structure 
Interaction  

(EQ) Seismic Seismic forces. N/a  
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Type of Load Usage Family (1) Note 

(IC) Ice Accretion Overload due to ice 
accretion 

N/a  

(CV/CT) 
Collision 

Overload due to collision 
forces (vehicular or 
vessel). 

N/a  

(P) Prestressing 
(VisualDesign 
virtual load) 

Overload due to creep 
and shrinkage of  
materials. 

N/a VisualDesign automatically 
creates this load case, if  asked 
for. It is always combined with 
temperature and deformation 
loads.  

 

Note 1: In this table, the number representing the family means that these load 
cases can be part of the same family. It does not represent the number that has 
to be entered in the "Family" cell of Load Definitions spreadsheet.   

Load Case Families 
A family is useful when using the Load Combination Generation Wizard 
when particular load cases need to be combined together. The family is 
automatically created for some load case types only and a family will always 
include load cases that belong to the same type such as Wind, Autowind, Wind on 
traffic or Ice, Auto-Ice, etc. These load cases will always be combined together 
when generating load combinations. Family numbers are editable by double 
clicking in the cell. 

Select option N/a in the drop-down list box if you do not want to use families.  

The concept was created for backfill pressure loads used with CAN/CSA-S6-
00 standard.  Backfill pressure loads are combined together but they have 
different load factors.  VisualDesign combines backfill earth pressures and 
Alpha E load factors as per table 3.5.1b) of this standard.  

Up to 25 families can be created in the Loads Definition spreadsheet. It is 
permitted to have a family number 1 for wind loads and another family 
number 1 for temperature loads. However, we recommend using different 
numbers to avoid mistakes and confusion.  
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Families are allowed for the following Codes and load cases:  

NBC-1995:  
• Live and Dynamic; 

• Wind and Autowind; 

• Temperature and Interaction; 

• Snow and Auto-ice (In this case, Auto-ice can be considered as Auto-
snow). 

NBC-2005:  
• Wind and Autowind; 

• Live and Dynamic; 

• Snow and Auto-ice (In this case, Auto-ice can be considered as Auto-
snow). 

ASCE-7: 
• Live and Dynamic; 

• Wind and Autowind; 

• Temperature and Interaction; 

• Snow and Auto-ice (In this case, Auto-ice can be considered as Auto-
snow). 

• Live load on Roof; 

• Rain. 

CAN/CSA-S6-00 and AASHTO-LRFD-04: 
• Live and Dynamic; 

• Wind, Autowind, and wind on traffic; 

• Temperature and Interaction; 

• Backfill pressure. 

CAN/CSA-S37-01: 
• Wind, and Autowind; 

• Ice, and Auto-ice. 



C H A P T E R  4  L O A D S  &  L O A D  C O M B I N A T I O N S  

4-20  CivilDesign Inc. Engineering Software 

Example 
We have six load cases of the Wind type (W1, W2, ... W6). Usually, when using 
the Wizard, the load combination D + W will generate six load combinations, 
each including the dead load and one of a wind load.   

If W1 and W2 are part of the same family and W3 and W4, another family, 
VisualDesign will generate four load combinations instead of six: 

LC1 = D + (W1+W2);  
LC2 = D + (W3+W4); 
LC3 = D + W5; 
LC4 = D + W6. 

In the Selections page of Load Combination Wizard, the wind load cases 
and corresponding aliases will be as follows: 

W1-1: Wind load W1 included in family #1; 
W1-2: Wind load W2 included in family #1; 

W2-1: Wind load W3 included in family #2; 
W2-2: Wind load W4 included in family #2; 

W01: single wind load W5 

W02: single wind load W6 

Restrictions: Wind and Ice Loads 
VisualDesign calculates wind on iced members. (The field "Ice thickness" is 
part of the Wind tab.) To avoid problems when using families with wind loads, 
make sure that: 

All the wind loads that are belonging to the same family have an ice thickness 
of zero; 

Or 

All the wind loads that are belonging to the same family have an ice thickness 
greater than zero.  

See also 
The Load Cases tab  
The Wind tab  
The ice tab  
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Loads Definition Spreadsheet 
Before applying loads on your structure, all load cases title and type must be 
defined. This spreadsheet is located in Loads / Load Cases / Definition. It 
is divided into four tabs: Load Cases, Dead, Live, Dynamic, Wind, Ice and 
Temperature.   

The Load Cases tab is the main one. All load case titles and types must be 
defined in this tab. Specific parameters are entered in other tabs. Load case 
families are supplied in the Load Cases tab in order to combine appropriate 
load cases when using the Load Combination Generation Wizard. Families 
are created for backfill pressure, wind, and ice loads. To learn more about 
families, refer to topic Load Case Families. 

The Dead tab is useful to differentiate dead load cases, such as self-weight, 
additional dead load, and others.  

The Live tab must be filled in if a reduction of tributary areas for loaded floors 
is required. A "Live" type of load must be selected in the Load Cases tab to 
activate the Live tab. 

The Dynamic tab is activated if a Dynamic type of load has been entered in the 
Load Cases tab. A dynamic type of load is used to define general dynamic 
load cases. You must own the Dynamic Analysis module. 

The Wind and Ice tabs are used for applying wind and ice loads on open 
structures such as towers.  

The Wind tab will be activated if a Wind or Autowind type of load is entered in 
the Load Cases tab and if calculation method (CAN/CSA-S37-01 or 
Environment Canada) for wind loads has been chosen in the Steel tab of 
Project Configuration.  

The Temperature tab is useful to indicate if this load can be combined with 
ice and snow loads, when using the Load Combination Generation Wizard. 

See also 
Type of Loads  
Load Cases tab  
The Dead tab  
The Live tab  
Dynamic tab  
Wind tab  
Ice tab  
The Temperature tab  

Loads Definition Spreadsheet 
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The Load Case tab (Master) 

 
Group: Load case data 

Column Description Editing 

ID Calculated automatically No 

Number Number/name of  this load case (12 alphanumeric 
characters) 

Single click 

Type Double click to open the Load Case selection tree. 
Open the appropriate root and highlight a type of  
load case. Please refer to Type of  Loads for more 
details.  

Double-click 

Family Family number to which belongs this load case 
(backfill pressure, wind, ice, etc.), if  it needs to be 
combined with specific load cases. Choose option 
N/a if  you do not want to use families. Please 
refer to Load Case Families  

Double-click 

Stage Steel design module or Prestressed concrete 
design module: 
When the analysis is completed, this shaded field 
informs the user the construction stage that 
corresponds to this load case.  

No 

Auto Generation 
Combinations 

Disable this option ([     ]) to remove this load 
case from the automatic generation of  load 
combinations. By default, all load cases are 
activated.  See topic Generator of  Load 
Combinations  

Double-click 
or Space bar 

Auto generated 
Torsion 

Dynamic Analysis module: This option ([  x  ]) 
includes accidental torsion effects from the 
spectral analysis.  Equivalent static loads will be 
generated by the software and automatically 
integrated into static analysis or design. 

No 

Definition Comment. Single click 
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Note  If you want to include accidental torsion effects into a static or time history 
analysis, you must perform a spectral analysis beforehand. The spectral analysis 
generates equivalent static loads to take into account accidental torsion effects. 

The Dead tab 
All dead loads are grouped in this tab. The subdivision of dead load cases 
allows differentiating the self-weight of elements from other cases that could 
correspond to construction stage loads (composite beams with the steel design 
module or prestressed concrete module).  

The option "Automatically calculated" must be activated for the dead load 
cases that represent the elements' self-weight, if they are not part of any 
construction stages. In fact, the user must specify a dead load case in each 
Member, Plate and Floor Characteristics dialog box to inform VisualDesign 
about the calculation of self-weights. We recommend not modifying this 
option if other dead loads are already applied to the structure. You could loose 
dead load cases. 

 
Group: Load Case Data 

Column Description Editing 

ID Calculated automatically No 

Number Number/name of  this load case (12 alphanumeric 
characters) 

No 

Automatically 
calculated 

Activate this option ([ x  ]) if  you want 
VisualDesign to consider this load case as the 
structure self-weight, which is automatically 
calculated.  

Double click 
or spacebar 
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The Live tab 
All live load cases are grouped in this tab. Complete the parameters to reduce 
the floor tributary areas.  

  
Group: Load Case Data 

Column Description Editing 

ID Calculated automatically No 

Number Number/name of  this load case (12 alphanumeric 
characters) 

No 

Tributary Area - 
Reduction 

Select the reduction formula that applies to the 
floor tributary area. 

Double-click 

Tributary Area - 
Overload 

Enter the magnitude of  overload that will be 
considered in reducing the forces transferred to 
columns. 

Single click 

See also 
Reduction of tributary area  
The Load Cases tab  
The Dynamic tab 
This tab applies to general dynamic loadings. Therefore, you must own the 
Dynamic Analysis module.  

A "Dynamic" type of load must be selected in the Load Cases tab to activate 
this tab. It allows selecting a pre-defined dynamic loading (Loads menu) and 
specifying a starting time for this accelerogramm.  
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Group: Load case data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters Single click 

General Dynamic 
Analysis- 
Accelerogram 

Choose an accelerogram that will be applied to a 
specific node of  the structure. 

Double-click 

General Dynamic 
Analysis – 
Starting time 

Specify a starting time for the accelerogram. Single click 

See also 
General Dynamic Analysis  
The Wind tab 
A Wind or Auto wind type of load case must be selected in the Load Cases tab 
of Loads Definition spreadsheet in order to activate this tab. A calculation 
method must also be selected in the Steel tab of Project Configuration dialog 
box. Fields that will appear in this spreadsheet are those relative to the chosen 
calculation method.  

 
A "Wind" type of load can be used for a wind load that is applied to a selected 
tower panel. (Refer to Wind on Panels). Ice coating can be specified for 
members composing the selected panel.  
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An "Auto-wind" type of load is useful to generate ice loads for an open 
structure such as towers. If sections changed during the design process, ice 
coatings are automatically calculated and applied by VisualDesign. Ice coatings 
are considered in the calculation of the projected area under wind loads.  

Wind Loads According to CAN/CSA-S37-01 Calculation Method 
Group: Load case data 

Column Description Editing 

ID Calculated automatically No 

Load case 
number 

12 alphanumeric characters Single click 

q Reference Pressure Single click 

Gust Effect 
Factor (Cg) 

Gust Effect Factor (Cg) Single click 

Speed-up Factor 
(Ca) 

Speed-up Factor (Ca) Single click 

Drag Factor (Cd) Drag Factor (Cd) Single click 

Ice Thickness Enter the ice thickness on members that will be 
subjected to wind loads. 

Single click 

Wind in the x-
direction 

A value of  1.0 represents 100% of  wind applied 
in this direction. 

Single click 

Wind in the y-
direction 

A value of  1.0 represents 100% of  wind applied 
in this direction 

Single click 

Wind in the z-
direction 

A value of  1.0 represents 100% of  wind applied 
in this direction 

Single click 

Member 
Usage 

Select the member usage for which this load will 
be apply.  

Double click 

Wind Loads According to Environment Canada Calculation Method 
 

Column Description Editing 

ID Calculated automatically No 

Load case 
number 

12 alphanumeric characters Single click 

Gust Effect 
Factor (Cg) 

Gust Effect Factor (Cg) Single click 
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Column Description Editing 

Speed-up Factor 
(Ca) 

Speed-up Factor (Ca) Single click 

Drag Factor (Cd) Drag Factor (Cd) Single click 

Ice Thickness Enter the ice thickness on members that will be 
subjected to wind loads. 

Single click 

Wind in the x-
direction 

A value of  1.0 represents 100% of  wind applied 
in this direction. 

Single click 

Wind in the y-
direction 

A value of  1.0 represents 100% of  wind applied 
in this direction 

Single click 

Wind in the z-
direction 

A value of  1.0 represents 100% of  wind applied 
in this direction 

Single click 

Member 
Usage 

Select the member usage for which this load will 
be apply.  

Double click 

a1 Site coefficient given by Environment Canada Single click 

a2 Site coefficient given by Environment Canada Single click 

a3 Site coefficient given by Environment Canada Single click 

Zh Site coefficient given by Environment Canada Single click 

Zo1 Site coefficient given by Environment Canada Single click 

Vo1 Wind velocity per Environment Canada (mph). Single click 

See also 
Tower Design  
Automatic Generation of Wind Loads  
Generating Wind Loads  
Automatic Generation of Ice Loads  
Wind on Panels  
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The Ice tab  
An Auto ice type of load must be selected in the Load Cases tab of Loads 
Definition spreadsheet in order to activate this tab. 

If sections are modified during the design process, VisualDesign will 
automatically calculate and apply new ice coatings over members.  

 
Group: Load case data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters Single click 

Ice thickness Enter the ice thickness on members Single click 

Density Enter ice density. Single click 

Member 
Usage 

Select the member usage for which this load will 
be apply. 

Double-click 

See also 
Tower Design  
Automatic Generation of Ice Loads  
Generating Ice Loads  
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The Temperature tab 
A Temperature type of load must be specified in the Load Cases tab of Loads 
Definition spreadsheet in order to activate this tab. 

If this temperature load can be combined with ice or snow loads, according to 
selected code, activate the option ([  x  ]) in the column "Snow/Ice possible" if 
you plan to use the Load Combination Generator.  

 
Group: Load case data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters No 

Snow/Ice 
possible  

Activate this option ([  x  ]) if  this temperature 
load can be combined with snow or ice loads. 

Double click 
or Spacebar 
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Automatic Generation of Ice Loads 
The Automatic Generation of Ice Loads function (under Loads menu 
/Load Cases) allows you to generate ice loads on open structure (such as 
towers) during all cycles of design.  

N.B. You must define an Auto ice type of load in the Load Cases tab of Loads 
Definition spreadsheet. Then, in the Ice tab, complete the required 
parameters.  

Tower Design Module: 
When shapes change, VisualDesign™ calculates new ice loads according to 
new shapes. VisualDesign™ will apply the ice according to the configuration 
that you chose before launching the design. The program will keep it during all 
its design cycles.  

Steel Design Module: 
When shapes change, VisualDesign™ calculates new ice loads according to 
new shapes and applies ice according to the configuration that you chose 
before launching the design. The program will keep it during all its design 
cycles. This means that if you deleted some ice loads on members, the program 
will not create ice loads on those members even if the shapes have changed 
during the design.  

See also 
Generating Ice Loads  
Loads Definition spreadsheet  
Tower Design Module  
Calculation of ice coating  
Generating Ice Loads 

• Select an Auto-Ice type of load in the Load Cases tab of Loads Definition 
spreadsheet. 

• Select the Ice tab and complete required parameters. 

• Then, activate the "Load Case" mode on Activation toolbar and select the 
Auto-Ice load case in the drop-down list box. 

• Go to Loads / Load Cases / Automatic Generation / Ice Loads. You 
can modify parameters in the Ice Load dialog box.  

 

Automatic Generation of Loads 
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• If you wish to delete some ice loads, select elements and press [Delete]. 
VisualDesign will keep this configuration during all design cycles except for 
tower design, where ice coating cannot be deleted. They will be 
automatically added.  

Calculation of Ice Coating 
Ice coatings are linear loads oriented according to global axis system. Ice loads 
applied on floors and plates are surface loads oriented according to global axis 
system.   

The weight of the ice coating on members is calculated as follows: 

W = Density * Thickness * S 

"S" is the area of ice surrounding the shape and is calculated with the equations 
presented below: 
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General 

   
Round shapes 

  
2L shapes 
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Automatic Generation of Wind Loads 
Selecting a method for wind calculation 
The calculation method for wind loads must be selected in the Steel tab of 
Project Configuration dialog box before generating wind loads. Available 
methods are based on CAN/CSA-S37-01 Standard and Environment Canada. 
The Wind Load dialog box will include specific fields for the chosen method.  

Then, an Auto wind type of load must be defined in the Load Cases tab of 
Loads Definition spreadsheet beforehand. The wind parameters can be 
specified in the Wind tab of Loads Definition spreadsheet. 

Generating Wind Loads 
Then, from the Loads / Load Cases menu, select Automatic 
Generation/Wind Loads to automatically generate wind pressure on an open 
structure according to a given direction of wind (x, y and z components). 
Furthermore, the total projected area acting on the structure is automatically 
calculated. Only members can be loaded with wind. Then, VisualDesign™ will 
transfer wind loads as forces at end nodes.  

 

Note  The Auto-wind type of load is used for the calculation of wind on guys only, and 
a Cd of 1.2 must be specified. The wind applied to members must be a Wind type of 
load, and a Cd of 1.0 is required.  
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During a Cyclic Design (Steel design): 
If VisualDesign™ modifies shapes during its cyclic steel design, new wind 
loads will be calculated according to new shapes and a new analysis will be 
carried on with new pressure loads. The program will do so as long as it 
reaches convergence. VisualDesign™ will apply wind loads according to the 
wind configuration that you chose before launching the design. The program 
will keep it during all its design cycles. 

According to chosen method used to calculate wind pressure (Steel tab of 
Project Configuration), the dialog box will include the following parameters: 

Wind Pressure according to CAN/CSA-S37-01: 
 

Fields Description 

Parameters  

q Reference pressure 

Cg Gust Effect Factor 

Ca  Speed-up Factor 

Cd Drag Factor 

Ice Thickness Ice coating on members 

Wind Direction  

X X component of  wind direction 

Y: Y component of  wind direction 

Z: Z component of  wind direction 

Members Specify member usage that will be loaded 
automatically at design. 

Fn = qh Cg Ca Projected Area 

(Af) Total Projected Area Automatic calculation of  total projected area. 
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Wind Pressure according to Environment Canada: 
 

Topic Description 

Parameters  

Cg Gust Effect Factor 

Ca  Speed-up Factor 

Cd Drag Factor 

a1 Site coefficient given by Environment Canada 

a2 Site coefficient given by Environment Canada 

a3 Site coefficient given by Environment Canada 

Zh Site coefficient given by Environment Canada 

Zo1 Site coefficient given by Environment Canada 

Vo1 Wind velocity as per Environment Canada (mph) 

Ice Thickness Ice coating on members 

Wind Direction  

X X component of  wind direction 

Y: Y component of  wind direction 

Z: Z component of  wind direction 

Members Specify member usage that will be loaded 
automatically at design. 

Fn = qh Cg Ca Projected Area 

(Af) Total Projected Area Automatic calculation of  total projected area. 

See also 
Generating Wind Loads  
Tower Design module  
Loads Definition spreadsheet  
Steel tab of Project Configuration  
Wind on Panels  
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Generating Wind Loads 

• Select Project Configuration in File menu. In the Steel tab, select a 
method for the calculation of wind pressure.  

• Select the Loads Definition spreadsheet. Define an "Auto-wind" type of 
load in the Load Cases tab. Then, select the Wind tab and complete 
required parameters. Close the spreadsheet. 

• Activate the "Load Case" mode on Activation toolbar and select the Auto-
Wind load in the drop-down list box. 

• Go to Loads menu and select Automatic Generation / Wind Loads. Fill 
in parameters in the Wind Load dialog box.  
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Defining Loads 
• Define load titles and types in the Loads Definition dialog box. To do so, 

go to Loads/Load Cases / Definition. Insert lines to enter load cases. 
Give a name to each and double-click in the "Type" column to select the 
right type of load case according to code. 

  

• Activate the Load Case mode. To do so, choose Activate mode/Load 
Case from the Edit menu or click "Load Case" on the "Activation" 
toolbar. 

• Select a load case title from the scroll list on the Activation toolbar, 

    
You are now ready to graphically apply loads to elements. 

Applying Loads 
• Double-click on an element to open the Loads dialog box or click once 

and press the Properties icon. Enter the load magnitude according to local 
or global axis system. Loads can also be applied through spreadsheets, 
which are listed in the Loads menu. 

Or 

• To apply common loads on many elements of the same type, keep the 
[Ctrl] key down while you select (click once) each element and press the 
Properties icon. Enter loads in the dialog box. Loads will be applied to all 
selected elements.   

Editing Loads 
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Modifying Applied Loads 
• Activate the "Load Case" activation mode by pressing the "Load Case" 

icon  of Activation toolbar. 

• Select the load case title from the pull-down menu of the Activation 
toolbar. 

• Select the appropriate spreadsheet in the Loads menu. The spreadsheet 
will include all elements of the same type. 

OR 

• Activate a type of element on Activation toolbar, select elements and open 
the appropriate spreadsheet in the Loads menu. The spreadsheet will 
include loads applied to selected elements only.  

• You may now modify loads using the spreadsheet's contextual menu 
(Replace, Modify (+, -, x or /), etc.) or by typing in new values. 

Applying Multiple Modifications to Loads 

• Activate the "Load Case" mode using one of the following procedures: 

• Click the "Load Case" icon  of Activation toolbar. 

• Go to Edit/Activate Mode/Load Case. 

• Select a group of elements of the same category. 

• Open the Loads dialog box using one of the following procedures: 

• Click on the "Properties" icon  of Edit toolbar. 

• Go to Edit/Properties. 

• Types in common loading values then press OK. 

Deleting Applied Loads to Elements 
• Activate the "Load Case" mode by doing one of the following: 

• Click the "Load Case" icon  of Activation toolbar. 

• Choose Activate Mode/Load Case from the Edit menu. 

• Select the appropriate load case on Activation toolbar. 

• Activate the appropriate element on Elements toolbar and select the loaded 
elements of this type. 
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• Do one of the following: 

• Click the "Delete" icon on the Edit toolbar. 

• Choose Delete from the Edit menu. 

• Press the [Delete] key. 

• The applied loads will be deleted on selected elements.  
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Loaded Nodes 
To apply loads on nodes, first activate the "Load Case" mode from Activation 
toolbar. Then, select a load case title from the list box. 

Double-click on a node to open the Forces on Nodes spreadsheet or select 
many and activate the Properties function from Edit menu.  

Specify the intensity of concentrated loads or bending moments in the global x, 
y, and z-axis. 

See also 
Forces on Nodes Spreadsheet  
Support Settlements Spreadsheet  
Colour Display of Loads on Nodes  
Applying Loads on Nodes  

Forces on Nodes Spreadsheet 
Group: Load case: (title) 

Column Description Editing 

ID Calculated automatically No 

Node Number 12 alphanumeric characters Single click 

Fx Concentrated load towards global x-axis. Single click 

Fy Concentrated load towards global y-axis. Single click 

Fz Concentrated load towards global z-axis. Single click 

Mx Bending moment around x-axis (global system) Single click 

My Bending moment around y-axis (global system) Single click 

Mz Bending moment around z-axis (global system) Single click 

 

Loads Applied to Nodes 
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Applying Loads to Nodes 
• Go to Loads/Load Cases /Definition. 

• Create a load case title and select the appropriate type of load in the 
spreadsheet. 

• Activate the "Load Case" activation mode by pressing the "Load Case" 
icon of the Activation toolbar. 

• Select the load case title from the pull-down menu of the Activation 
toolbar. 

• Do one of the following: 

• Click twice on a node to reach the Forces on Nodes spreadsheet or 
select many nodes and click the Properties icon from Edit toolbar. 

• Access the Forces on Nodes spreadsheet through the Loads/Load 
Cases menu. 

Coloured Display of Loads applied on Nodes 
Forces and bending moments are always displayed by default. To disable this 
option, open the View Options dialog box and uncheck option "Loads on 
Nodes" in the Loads tab. 

Arrows represent forces and bending moments on nodes. The direction of 
arrows follows the rule of the right hand. 

You can modify their graphic attributes through the Colour tab of View 
Options dialog box. 

See also 
View Options  
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Loaded Supports 
Two loads can be applied to supports: Displacement (x, y, and z) and rotations 
(theta x, y, and z). These loads are always applied according to global axes 
system, except if the support is oriented. 

Note: To assign a settlement in one of the specified directions, the support 
must have been blocked beforehand in that direction under the "Structure" 
activation mode, or have a preset rigidity (spring support). 

The following table indicates which settlement can be applied to a support in 
the "Load Case" mode, as well as results that will be supplied, depending on 
the degree of freedom allowed for in the "Structure" mode. (To enter or view 
data, activate the "Structure", "Load Case", or "Load Combination" mode, and 
select a support or many. Then call the Properties function.)  

Support’s 
degrees of  
freedom  

Loads (Settlement) 
Displacement or 
Rotation 

Load combination 
Results (Displacement or Rotation) 

  Displacement Response 

Restrained 
Unrestrained 
Spring 
Secant modulus K 

Applicable 
Not applicable 
Applicable 
Applicable 

Settlement Value 
Variable 
Variable 
Variable 

Variable 
Null 
Variable 
Variable 

See also 
Colour Display of Loads Applied to Supports 
Support’s DOF  
Applying Settlements to Supports  

Applying Settlements to Supports 
To apply forces or settlements to supports, you must first activate the "Load 
Case" mode on the Activation toolbar and select the load case title. Then, 
activate the Support icon on Elements toolbar and select one support or more. 
Select Properties from Edit menu.  

 

• Create a load case title. To do so, select the Definition heading under 
Loads / Load Cases menu. 

• Activate the "Load Case" activation mode on Activation toolbar and select 
the load case title from the pull-down menu of the Activation toolbar. 

Loads Applied to Supports 
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• Activate the Support icon on Elements toolbar and select one support or 
more. 

• Select the Properties function of Edit menu. 

• Enter the direction of displacement or rotation (x, y, or z-axis) in the 
Support Settlements spreadsheet.  

• To add a load directly to a support, use the Forces on Nodes spreadsheet.  

Support Settlement Spreadsheet 
Group: Load case: (title) 

Column Description Editing 

ID Calculated automatically No 

Support Number 12 alphanumeric characters Single click 

Displ. x Imposed settlement in the x-direction (global axis 
system) 

Single click 

Displ. y. Imposed settlement in the y-direction (global axis 
system) 

Single click 

Displ. Z Imposed settlement in the z-direction (global axis 
system) 

Single click 

θx Imposed rotation – x-direction (global axis 
system) 

Single click 

θy Imposed rotation – y-direction (global axis 
system) 

Single click 

θz Imposed rotation – z-direction (global axis 
system) 

Single click 

Coloured Display of Support Displacements 
Only displacements can be viewed graphically on the screen. Rotations are 
ignored. 

To view displacements, check the "Support Settlements" option of Loads tab 
from the View Option dialog box. 

The graphic attributes of this option can be modified through the Colours tab 
from the same dialog box. 
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General 
Application of Loads on Members 
There is no limit regarding the quantity of loads that can be applied to one 
member for the same load case title (concentrated, distributed, torsion, 
temperature, and shrinkage).  

Users have the choice to apply loads on member(s) through a spreadsheet or a 
dialog box. 

Through the dialog box:  
• Select one or many members and select the Properties function from Edit 

menu. The Loads on Member dialog box is then displayed on the screen. 
It is composed of five tabs: Distributed, Concentrated, Temperature 
Variations, Torsion, and Shrinkage. Enter or modify loads. 

Through the spreadsheet: 
• To enter, modify, or sort data, select all members or a few of them and call 

up the Load on Members spreadsheet under Loads/Load 
Cases/Members menu. Modify values in the spreadsheet using functions 
included in spreadsheet's contextual menu (right click). Refer to 
Spreadsheet's contextual menu (Contextual menu). 

Temperature Load: Behaviour and Assumptions 

• VisualDesign™ applies the temperature variation in a linear way from the 
top to the bottom of the section, according to the selected projection axis. 

• Position of top and bottom depends essentially on the member incidence. 

• If a concrete beam is subjected to a thermal gradient that makes it curve 
upwards, the top of the section will not be cracked because this behaviour 
is caused by the expansion of material. If ends of member are restrained, 
the top of the section will be compressed and the bottom, tensioned. 

To look at the constant bending moment caused by a thermal gradient applied 
between two fixed supports: Pinned the supports and apply the same bending 
moments (in opposite direction) on each support. You will obtain the same 
effect as thermal gradient.  

Remark  It is not the temperature, but solely the temperature differential that must be 
indicated in boxes "Top of Section" and "Bottom of Section" 

Example: 
We want to evaluate the internal forces in a steel column where the bottom 
fibre is exposed to a 20oC while the temperature at the top fibre is -40oC. 

Loads Applied to Members 
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If the steel section has been factory manufactured at 20oC, the temperature 
differential that should appear in the box "Top of Section" will be –60oC and 
the "Bottom of Section", will be 0oC. 

Thermal Gradient and Shrinkage Effects 
A thermal gradient can be applied to the slab of a steel/concrete composite 
beam. It will be applied to the top and bottom of the slab. Enter the 
temperature variation at the top and bottom of the concrete slab and select 
option Thermal Gradient in column "Type of Application". 

VisualDesign's approach 
Step 1: 
Deflections σw and θx are calculated with the transformed properties of the 
composite beam without considering any sliding effects (theoretical composite 
beam).   

   
Step 2: 
The deflection found at step one is applied to the steel member and the real 
area and inertia are used. 

• If the section is composite, VisualDesign will consider the transformed 
area and inertia and will include sliding effects. 

• If the section is not composite, only the steel section is considered. The 
real area and inertia of the steel section will be used in the calculation 
unless the user activated the option that considers the reinforcement in 
the slab for negative bending moments. In this case, the calculation of 
inertia will be done considering tensioned reinforcement in the slab.  
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Balanced Effects 
The correction of stresses in the section is due to balanced effects (shrinkage 
and thermal gradient). It is done with the section-transformed properties with 
no sliding effect and a ratio of 1n is used (or the one specified by the user in 
the Composite Beam tab of Project Configuration). 

  

Applying Loads to Members 
• Go to Loads / Load Cases / Definition menu. Insert lines and create 

load case titles and types. 

• Activate the "Load Case" activation mode and select the load case title 
from the pull-down menu of Activation toolbar. 

• Select one member or more. 

• Call the Properties function under Edit menu. Enter loads in the Loads 
on Member dialog box. It is composed of five tabs: Distributed, 
Concentrated, Temperature Variations, Torsion, and Shrinkage. 
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• You can also define loads on members through spreadsheets (Loads 
/Load Cases / Members. 

Loads on Member Dialog Box 
This dialog box is composed of the following tabs: Distributed, Concentrated, 
Temperature Variations, Torsion, and Shrinkage (composite member only) 

 

Distributed Loads 
You can apply an unlimited number of distributed loads on any members. 
They can be uniform, trapezoidal or triangular, depending on the selected 
projection. 

 
Select one member or more and click the Properties function from Edit menu 
to open the Loads on Member dialog box.  

The table below describes the headings included in the Distributed tab of this 
dialog box. 
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Heading Description 

Loads Wa and Wb Magnitude of  distributed load located at point A and B along 
the member length. 

Beginning (a) and 
End (b) 

Beginning and ending positions of  the distributed load along 
the member. By default, load is fully distributed along the 
member length. 

Positions can be specified as fraction of  the member length, 
depending on selected units. (To modify units, click on column 
title "Position" and press down right mouse button. Select 
"Change Units"). 

Angle The angle of  inclination of  distributed load on the member 
strong or weak axis must be specified if  the projection is 
"Strong Axis" or "Weak Axis". 

If  the selected projection is "Global Horizontal" or "Global", 
the numerical value of  angle will be ignored. 

Projection Strong Axis: The distributed load is applied according to the 
member positive local y-axis. 

Weak Axis: The distributed load is applied according to the 
member positive local x-axis. 

Global: The distributed load is applied according to positive 
global y-axis (dead weight). 

Global Horizontal: The distributed load is applied according 
to positive global y-axis, along the horizontal projection of  
member. Mostly used for snow loads. 

 

See also 
Distributed Loads on Members spreadsheet  
Concentrated Loads 
A concentrated load is applied to one point along the member length. An 
unlimited number of concentrated loads can be applied to a member. 

Select one member or more and click the Properties function from Edit menu 
to open the Loads on Member dialog box.  
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The table below gives a description of headings included in the Concentrated 
tab of this dialog box. 

Column Description 

Position Position of  the concentrated load along the member length. 

The position can be expressed as a fraction of  the member 
length, depending on selected units. (To modify units, click on the 
column title "Position" and right click. Select "Change Units") 

Force Magnitude of  concentrated load. 

Angle Angle of  inclination of  concentrated load according to the 
member strong or weak axis. The angle must be defined if  the 
selected projection is "Strong Axis" or "Weak Axis". 
 
(If  the selected projection is "Global", the angle will be ignored 
even if  a value is specified) 

Projection Strong Axis: the concentrated load is applied according to the 
member positive local y-axis. 

Weak Axis: the concentrated load is applied according to the 
member positive local x-axis. 

Global: the concentrated load is parallel to gravity axis (ex.: a dead 
load would have a negative value). 

See also 
Concentrated Loads on Members spreadsheet  
Torsional Loads 
It is possible to apply an unlimited number of torsion loads on a member. 
Torsion loads are applied at an angle of 90°. Projection of load is not required.  

Select one member or more and click the Properties function from Edit menu 
to open the Loads on Member dialog box.  Select the Torsional tab. 
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Column Description 

Load Wa Magnitude of  torsion load at point A (node I). 

Load Wb Magnitude of  torsion load at point B (node j). 

Start a Start position of  torsion load along the member length. By 
default, load is fully distributed along the member length. 
 
Position can be entered as a fraction of  member length, 
depending on selected units. (To modify units, click on column 
title "Position", right click, and select "Change Units". 

End b End position of  torsion load along the member length. By 
default, load is fully distributed along the member length. 

See also 
Torsional Loads on Members Spreadsheet  
Temperature Variations 
Select one member or more and click the Properties function from Edit menu 
to open the Loads on Member dialog box. Select the Temperature 
Variations tab and specify the temperature differential at top and bottom of 
the section. 
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The table below describes the headings included in this tab. 

Column Description 

Top of  Section Temperature differential at the top fibre. 

Bottom of  Section Temperature differential at the bottom fibre. 

Type of  Application The selection of  strong or weak axis will influence the 
linear application of  the temperature variation on the 
section. The option Thermal Gradient is specific to 
steel/concrete composite beam. See Composite Beam  

See also 
The Temperature Variations on Members spreadsheet  
Composite Beams  
Shrinkage 
Select this tab and enter deformation due to shrinkage that will be applied to 
the concrete slab of a composite (steel/concrete) section.  

N.B. Calculation of shrinkage effects is done automatically for a prestressed 
concrete composite element. 

 

The table below describes the headings included in this tab. 
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Heading Description 

ID Automatically calculated 

Shrinkage 
x10e-6 

Deformation due to shrinkage. It will be applied to the 
concrete slab of  a composite section. 

Loads on Member Spreadsheet 
These spreadsheets are accessible in Loads / Load Cases / Members. 

Concentrated Loads on Members Spreadsheet 
Group: Load case: (title) 

Column Description Editing 

ID Calculated automatically No 

Member Number 12 alphanumeric characters Single click 

Position Position of  concentrated load on member (x=0 at 
node i) 

Single click 

Force Magnitude of  concentrated load applied to the 
member. 

Single click 

Angle Angle of  applied load. Single click 

Projection Type of  load projection: according to weak, 
strong or global axis.  

Double-click 

Distributed Loads on Members Spreadsheet 
Group: Load case: (title) 

Column Description Editing 

ID Calculated automatically No 

Member Number 12 alphanumeric characters. Single click 

Load Wa Magnitude of  distributed load at point a. Single click 

Load Wb Magnitude of  distributed load at point b. Single click 

Start a Position of  load Wa along member length. Single click 

End b Position of  load Wb along member length. Single click 

Angle Angle of  applied load. Single click 
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Column Description Editing 

Projection Type of  load projection: according to weak, 
strong, global, or horizontal global axes. 

Double-click 

See also 
The Distributed tab (Load on Member Dialog Box)  
Temperature Variations on Members Spreadsheet 
Group: Load case: (title) 

Column Description Editing 

ID Calculated automatically No 

Member Number 12 alphanumeric characters Single click 

Top. Temp. Temperature differential at the top of  the section. Single click 

Bot. Temp. Temperature differential at the bottom of  the 
section. 

Single click 

Type of  
Application  

Select the weak or strong axis. Option Thermal 
Gradient is specific to composite beams 
(steel/concrete). See Composite Beams  

Double-click 

See also 
Composite Beams  
Torsional Loads on Members Spreadsheet 
Group: Load case: (title) 

Column Description Editing 

ID Automatically calculated No 

Wa Load Magnitude of  torsional load at point a  Single click 

Wb Load Magnitude of  torsional load at point b Single click 

Start a Position (origin) of  the torsion load along the 
member length. By default, the load will be 
applied on the entire member length.  

Single click 

End b End position of  the torsion load along the 
member length. 

Single click 

See also 
The Torsional tab (Load on Members Dialog Box)  
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Loads due to Shrinkage 
Group: Load case: (title) 

Column Description Editing 

ID Automatically calculated No 

ε shrinkage Shrinkage factor that will be applied to the 
concrete slab of  a composite section. 

Single click 

See also 
Steel-concrete Composite Beam  
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Load on Plate Dialog Box 
The Load on Plate dialog box allows applying or modifying pressure loads 
and temperature variations.  

  
Description of this dialog box: 

Topic  Description 

Number Plate number (if  you selected only one). 

Pressure  

Pressure Uniform pressure applied to the plate(s) 

Direction Local: the pressure load is applied perpendicular to the 
plate, in the positive direction of  local z-axis. 
Global: the pressure load is applied according to the positive 
direction of  global y-axis. 
Global Horizontal: the pressure load is applied along the 
horizontal projection of  plate, according to the positive 
direction of  global y-axis.  
 

Temperature Variations  

Top  Temperature differential at the top of  the plate. 

Bottom  Temperature differential at the bottom of  the plate. 

Loads applied to Plates 
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See also 
Pressure on Plates spreadsheet  
Temperature Variations on Plates spreadsheet 
Applying Loads on Plates  

Applying Loads to Plates 
• Activate the Load Case mode and select the load case title from the pull-

down menu of Activation toolbar. 

• Click twice on a plate to reach the Loads on Plate dialog box or select 
many plates and press the Properties icon from the Edit toolbar. 

• Enter pressure and temperature variation on plates.  

OR 

• Access one of the loads spreadsheets from Loads menu. 

Loads on Plates Spreadsheets 
Pressure on Plates Spreadsheet 
Group: Load case: (title) 

Column Description Editing 

ID Calculated automatically No 

Plate Number 12 alphanumeric characters Single click 

Geometry Geometry of  this plate: Rectangular or Triangular No 

Pressure Magnitude of  applied pressure. Single click 

Projection Type of  load projection: local, global, or 
horizontal global. 

Double-click 



C H A P T E R  4  L O A D S  &  L O A D  C O M B I N A T I O N S  

CivilDesign Inc. Engineering Software  4-57 

Temperature Variation on Plates 
Group: Load case: (title) 

Column Description Editing 

ID Automatically calculated  No 

Plate number 12 alphanumerical characters describing the plate. Single click 

Geometry Geometry of  this plate: Rectangular or Triangular. No 

Temperature 
Top Fibre 

Enter the temperature variation at the top of  the 
plate. 

Single click 

Temperature 
Bottom Fibre 

Enter the temperature variation at the bottom  of  
the plate. 

Single click 

See also 
Shear wall and effects of temperature loads  
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General 
Application of Loads 
Distributed loads and concentrated loads can be applied to floors. (The floor 
dead load can be integrated into the structure dead load through the Floor 
Characteristics dialog box.) There is no limit regarding the quantity of loads 
that can be applied to one floor.  

Beams are required along the floor outline (4 sides). Loads will be distributed 
on adjacent beams at an angle of 45 degrees for a two-way floor and on the 
end beams, for a one-way floor. Use a material density of zero to create a 
"fictive" beam if there is no beam on one side of a two-way floor.  

To apply loads on floors, select the "Load Case" activation mode on Activation 
toolbar. Then, select the appropriate load case title. Loads can be applied 
through the spreadsheet or dialog box.  

Dialog box:  
• Select one or many floors and select the Properties function from Edit 

menu. The Loads on Floor dialog box is then displayed on the screen. It is 
composed of two tabs: Distributed and Concentrated. Enter loads. 

Spreadsheet: 
• To enter, modify, or sort data, select all floors or a few of them and select 

the Load on Floors spreadsheet through Loads/Load Cases /Floors 
menu.  

See also 
Floor Characteristics dialog box  
Distributed Loads on the Floor  
Concentrated Loads on the Floor  
Floor Dead Load  
The Display Convention for Loads on Floors and Members  
Displaying Floors having no Dead Load  
Floor Dead Load 
The software uses the floor material and thickness to automatically calculate 
the dead weight. However, the user can also specify it through the "Floor Dead 
Load" field available in the Floor Characteristics dialog box. 

This floor dead load is distributed on adjacent beams, as other loads on floors, 
depending on the type of floor (one-way or two-way). So, the floor dead load 
will be added to adjacent members' dead load (automatically calculated by 
VisualDesign™).  

Loads applied to Floors 
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To view the distribution of the floor dead load, select the "Load Case" 
activation mode and from the pull down list of load case titles, select "Dead". 
Select the floor and call the Properties function. The Loads on Floor dialog 
box allows viewing (but not modifying) the floor dead load. 

See also 
Floor Characteristics  
Displaying Floors with Unspecified Dead Load 

• Go to the Attributes tab of View Options dialog box and activate the No 
Dead Load option in the "Floors" section. Floors with no specified dead 
load will be highlighted on screen. 

• To assign a dead load to them (optional), select the Properties function to 
open the Floor Characteristics dialog box, and enter a dead load. This 
dead load will be considered in the structure dead load case (it is 
automatically calculated in the Loads Definition spreadsheet). 

Note.  The analysis can be performed even if there is no dead load specified for floors. 

See also 
Floor Characteristics  
The Attributes Tab  

Load on Floor Dialog Box 
To apply or modify concentrated loads on floors, select the "Load Case" 
activation mode on Activation toolbar. Then, select the appropriate load case 
title. 

Select one or several floors and click the Properties icon to open the Load on 
Floor dialog box. It is composed of two tabs: the Distributed tab and 
Concentrated tab. 

Distributed Loads 
A distributed load on a floor is corresponding to a pressure load. Beams (real 
or fictitious) are required on the outline for 2-way floors.  Bearing beams are 
needed on the two sides of a one-way floor. You can apply an unlimited 
number of distributed loads to any floor. 

Distributed loads can be uniform or trapezoidal.  
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The table below describes the headings included in the Distributed tab of this 
dialog box. 

Column Description 

Identification Shaded fields that inform the user about the selected floor 
number, incidence nodes and load case title. 

ID VisualDesign's ID number for this distributed load. 

Loads Wi, Wj, and Wk These loads (pressure) must be set by the user and will be 
applied to the floor nodes i, j, and k. 

Load Wl Load Wl is automatically calculated to form a plane with loads 
Wi, Wj, and Wk. 
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Column Description 

Projection Local: the distributed load goes along the positive direction of  
the local z-axis system of  the floor. 

Global: the distributed load goes along the positive direction 
of  the global y-axis system.  

Global Horizontal: the distributed load goes along the 
positive direction of  the global y-axis system. The load is 
distributed on the horizontal projection of  the floor. 
 

Concentrated Loads 
A concentrated load applied to the floor is a point load and is positioned (x, y) 
according to the floor local axis system. 
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The table below describes the headings included in the Concentrated tab: 

Column Description 

Identification Shaded fields inform the user about the selected floor number, 
incidence nodes and load case title. 

ID VisualDesign's concentrated load ID number. 

Force  Magnitude of  concentrated load. 

X-, Y-
Coordinates  

Position of  concentrated load: Coordinates X and Y are 
corresponding to the floor local axes system. 

Projection Local: the concentrated load is applied perpendicular to the floor. 

Global: the concentrated load is oriented in the same direction as 
gravity axis. 

See also 
Concentrated Loads on Floors Spreadsheet  

Load on Floor Spreadsheets 
Concentrated Loads on Floors Spreadsheet 
This spreadsheet is accessible through the menu Loads / Load Cases / Floor / 
Concentrated. 

Group: Load case: (title) 

Column Description Editing 

ID Calculated automatically No 

Floor Number 12 alphanumeric characters Single click 

Force Force to be applied Single click 

Coord. X Local x-coordinate Single click 

Coord. Y Local y-coordinate Single click 

Projection Type of  load projection: local or global.  Double-click 

See also 
The Concentrated tab (Load on Floor Dialog Box)  
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Distributed Loads on Floors Spreadsheet 
This spreadsheet is accessible through the menu Loads / Load Cases / Floor / 
Distributed. 

Group: Load case: (title) 

Column Description Editing 

ID Calculated automatically No 

Floor Number 12 alphanumeric characters Single click 

Wi Pressure of  distributed load at corner i of  floor. Single click 

Wj Pressure of  distributed load at corner j of  floor. Single click 

Wk Pressure of  distributed load at corner k of  floor. Single click 

Wl Pressure of  distributed load at corner l of  floor. 
This value depends on the three previous values. 

No 

Projection Type of  load projection: local, global, or 
horizontal global. 

Double-click 
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Definition of Load Combinations 
Load combinations are automatically generated according to a selected 
Standard or Code when using the Load Combination Generation Wizard. 
This function is available under Load Combinations /Automatic 
Generation in Loads menu. 

However, for those wanting to define load combinations "by hand", they can 
do it through the Combinations dialog box (Loads / Load Combinations 
/Definition). It is composed of two tabs: Load Combinations and Load 
Factors. Each one of these tabs includes a spreadsheet.  

See also 
The Load Combinations Tab  
The Load Factors Tab  
Load Combination Generator 
Copying a Load Combination along with Load Factors  

Load Combinations Dialog Box 
This dialog box is completed if you used the Load Combination Generator. 

To open this dialog box, go to Loads / Load Combinations / Definition. 

The Load Combinations Tab 
If you want to create load combinations by hand, insert lines in the spreadsheet 
and complete the columns. Look below at the definition of each cell that is 
included in the spreadsheet.   

  

Load Combinations 
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Group: Load Combination data 

Column Description Editing 

ID Calculated automatically No 

Number Load combination name or number (12 
alphanumeric characters). 

Single click 

Status Specify the load combination status, according to 
a code, through the selection tree. If  a code is not 
required, select option Analysis only.  To learn 
more, refer to topic Load Combination Status  

Double-click 

Required This option [  x  ] integrates this load combination 
at analysis or withdraws it [      ]. By default, all 
generated load combinations will be analysed. 

Double-click 
or Spacebar 

Definition Example: 1,25+(1,50Lx) Single click 

Stage (1) Steel Design module or Prestressed Concrete 
Design module: 
If  construction stages were defined, indicate the 
stage number where this load combination will be 
applied to the structure. 

Single click 

Duration Kd Timber Design only: This duration factor will be 
constant for this load combination if  it differs 
from load cases. 

Single click 

 

Note 1: Composite Beams (steel/concrete and concrete/concrete) 

Loads specified at a given construction stage are automatically cumulated at 
each following construction stages. Example: stage 3 loads will be added to 
stage 4 loads.  

See also 
The Load Factors Tab  
Load Combination Generator  
Prestressing tab (Project Configuration)  
Composite Beam tab (Project Configuration)  
Copying a Load Combination along with Load Factors  
The Timber Design module  
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The Load Factors Tab 
This tab is part of the Load Combinations dialog box, which is accessible 
through the Loads menu / Load Combinations. The Load Factor tab is 
completed if the Load Combination Generator was used. 

The left part of the dialog box is a list box that contains the name of the 
generated load combinations. You can move to another load combination by 
clicking on its name. The right part of the dialog box is a spreadsheet where 
load factors are entered and assigned to each load case and pre-defined 
envelopes (E, Et, Etnl et Lm), if any. 

 
If no lines are present in the spreadsheet, insert the number of required lines 
(one line per load case that is part of a load combination). 

Group: Load Combination: (title) 

Column Description Editing 

ID Calculated automatically No 

Load factor Highlight a load combination in the left part of  
the dialog box and enter each load factor that 
must be assigned to each load case and each pre-
defined envelope that is composing this load 
combination. 

Single click 

Load case Highlight a load combination in the left part of  
the dialog box and select the load case that is part 
of  this load combination. 

Double-click 

Pre-defined 
envelope 

Highlight a load combination in the left part of  
the dialog box and select the pre-defined envelope 
that is part of  this load combination. 

Double-click 

See also 
Load Combination Generator  
Copying a Load Combination along with Load Factors  
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Defining Load Combinations 
• Use the Load Combination Generator (Loads / Load Combinations / 

Automatic Generation).  

Or 

• Go to Loads / Load Combinations / Definition. Insert lines in the first 
tab. Give a name to each load combination and specify the status.  

• Select the Load Factors tab.  

• Click once on a load combination in the left part of the dialog box and 
insert lines in the right part. The number of lines must correspond to 
the number of load cases that is composing this load combination.  

• Double-click in the "Load Case" column and select a load case. If a pre-
defined envelope must be included, do the same in the "Pre-defined 
Envelope" column.  

• Enter load factors for each load case and pre-defined envelope. 

• Click OK to exit the dialog box. 

Copying a Load Combination & Load Factors 
To simultaneously copy a load combination along with load factors, use 
function Duplicate available in the spreadsheet's contextual menu.   

Procedure: 

• Open the Load Combinations spreadsheet. 

• Select the line that corresponds to the load combination you want to copy. 

• Right click and choose function Duplicate in contextual menu. 

Load Combination Statuses (General) 
Load combination statuses must be specified in the Load Combinations 
Definition spreadsheet, through a selection tree when double clicking in the 
"Status" cell. The roots that you will find in this selection tree correspond to a 
code or standard and they are composed of a list off available statuses. 
Available Codes and Standards are: CNBC-95-ULS, CNBC-95-WSD, CNBC-
05-ULS, CAN/CSA-S6-00, CAN/CSA-S37-01, AASHTO-LRFD-04, ASCE-
02-SD, and ASCE-02-ASD. 

Statuses are automatically initialized when the Load Combination Generator 
is used to generate required load combinations per selected code. 
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If a design is not required, use the general statuses that are listed under the No 
code root, namely Not required, Analysis only, Ultimate, Service, Fatigue, 
Instantaneous deflection, Long-term deflection, and Mass.  

The table below describes the statuses that are common for all codes and 
standards: 

Status Description 

Construction 
Stage (1) 

This status is specific to construction stage load combinations.  

Analysis only Management of  analyses. This load combination will be 
analysed and included in envelopes but will not be considered 
for a design. 

Ultimate This load combination status means that it is required for a 
design. 

Service This load combination status applies to serviceability load 
combinations. 

Fatigue This load combination status applies to fatigue load 
combinations. They are not generated by VisualDesign but can 
be specified by users. 

Instantaneous 
Deflection 

Instantaneous deflection usually includes live loads only.  

Long-Term 
Deflection 

Long-term deflection usually includes permanent loads only. 

Mass This load combination is required for modal analysis and 
usually includes the structure dead loads and some percentage 
of  snow loads, among others.  

 
Note 1: Construction stages are available for the design of composite beams. 
The Steel Design module is required for steel/concrete composite beams and 
the Prestressed Concrete module is required for verifying prestressed 
composite beams. The Reinforced Concrete Design module is required to 
design concrete/concrete composite beams. 
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Specific Statuses 
Load Combination Statuses - CAN/CSA-S6-00 
The description of load combinations is taken from Table 3.5.1 (a) 

Status Description 

ULS no 1 Ultimate Limits States No. 1 
αDD + αEE + αPP + 1.70L 

ULS no 2 Ultimate Limits States No. 2 
αDD + αEE + αPP + 1.60L + 1.15K 

ULS no 3  Ultimate Limits States No. 3 
αDD + αEE + αPP + 1.40L + 1.0K + 0.50W + 0.50V 

ULS no 4 Ultimate Limits States No. 4 
αDD + αEE + αPP + 1.25K + 1.64W 

ULS no 5 Ultimate Limits States No. 5 
αDD + αEE + αPP + 1.0EQ 

ULS no 6 Ultimate Limits States No. 6 
αDD + αEE + αPP + 1.30F 

ULS no 7 Ultimate Limits States No. 7 
αDD + αEE + αPP + 0.9W + 1.30A 

ULS no 8  Ultimate Limits States No. 8 
αDD + αEE + αPP + 1.0H 

ULS no 9 Ultimate Limits States No. 9 
1.35D + αEE + αPP 

FLS no 1 Fatigue Limits States 
1.0D + 1.0E+ 1.0P + 1.0L 

SLS no 1 Serviceability Limits States No. 1 
1.0D + 1.0E+ 1.0P + 0.9L + 0.8K + 1.0S 

SLS no 2 Serviceability Limits States No. 2 
0.9L 

 



C H A P T E R  4  L O A D S  &  L O A D  C O M B I N A T I O N S  

4-70  CivilDesign Inc. Engineering Software 

Load Cases 
A: ice accretion load; 
D: dead load; 
E: loads due to earth pressure and hydrostatic pressure including surcharges 
other than dead load; 
F: loads due to stream pressure and ice forces, or debris torrents; 
H: collision load arising from highway vehicles or vessels; 
K: all strains, deformations, displacements, and their effects, including the 
effects of the restraint and those of friction or stiffness in bearings. Strains and 
deformations include those due to temperature change and temperature 
differential, concrete shrinkage and creep; but not elastic strains; 
L: live load, including dynamic load allowance when applicable, based on CL-
625 Truck or Lane; 
P: secondary prestress effects; 
EQ: earthquake load; 
S: load due to differential settlement and/or movement of the foundation; 
V: wind load on traffic; 
W: wind load on structure; 

Load Combination Statuses - AASHTO-LRFD-04 
The description of load combinations is taken from Table 3.4.1-1 Load 
Combinations and Load Factors. 

N. B. To lighten the table, some load cases have been grouped together 
according to AASHTO Standard Table 3.4.1-1, unless otherwise noted. The 
following groups are used in this table (the definition of load case codes is 
given below): 

D:  DC, DD, DW, EH, EV, ES, EL 

L: LL, IM, CE, BR, PL, LS 

T: TU, CR, SH 

N. B.: Refer to Table 3.4.1-2 for the definition of load factors for permanent 
loads, γp. 

Status Description 

STRENGTH I γPD + 1.75L + 1.0WA + 1.0FR + (0.50 and 1.20)T + γTGTG + 
γSESE 

STRENGTH II γPD + 1.35L + 1.0WA + 1.0FR + (0.50 and 1.20)T + γTGTG + 
γSESE 

STRENGTH III γPD + 1.0WA + 1.4WS + 1.0FR + (0.50 and 1.20)T + γTGTG 
+ γSESE 
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Status Description 

STRENGTH IV γP (EH+EV+ES+DW+DC) + 1.0WA + 1.0FR + (0.50 and 
1.20)T 
and 
1.5(EH+EV+ES+DW+DC) + 1.0WA + 1.0FR + (0.50 and 
1.20)T 

STRENGTH V γPD + 1.35L + 1.0WA + 0.4WS + 1.0WL + 1.0FR + (0.50 and 
1.20)T + γTGTG + γSESE 

EXTREME EVENT 
I 

γPD + γEQL + 1.0WA + 1.0FR +1.0EQ 

EXTREME EVENT 
II 

γPD + 0.50L + 1.0WA + 1.0FR + (1.0IC or 1.0CT or 1.0CV) 

SERVICE I  1.0D + 1.0L + 1.0WA + 0.3WS + 1.0WL + 1.0FR + (1.0 and 
1.20)T + γTGTG + γSESE 

SERVICE II 1.0D + 1.3L + 1.0WA + 1.0FR + (1.0 and 1.20)T  

SERVICE III 1.0D + 0.8L + 1.0WA + 1.0FR + (1.0 and 1.20)T + γTGTG + 
γSESE 

SERVICE IV 1.0D + 1.0WA + 0.7WS + 1.0FR + (1.0 and 1.20)T + 1.0SE 

FATIGUE 0.75 (LL, IM & CE) 

 

Load Cases 
P E R M A N E N T  L O A D S  

DD: downdrag; 
DC: dead load of structural components and non-structural attachments; 
DW: dead load of wearing surfaces and utilities; 
EH: horizontal earth pressure load; 
EL: accumulated locked-in force effects resulting from the construction 
process, including the secondary forces from post-tensioning; 
ES: earth surcharge load; 
EV: vertical pressure from dead load of earth fill. 
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T R A N S I E N T  L O A D S  

BR: vehicular braking force; 
CE: vehicular centrifugal force; 
CR: creep; 
CT: vehicular collision force; 
CV: vessel collision force; 
EQ: earthquake; 
FR: friction; 
IC: ice load; 
IM: vehicular dynamic load allowance; 
LL: vehicular live load; 
LS: live load surcharge; 
PL: pedestrian live load; 
SE: settlement; 
SH: shrinkage; 
TG: temperature gradient; 
TU: uniform temperature; 
WA: water load and stream pressure; 
WL: wind on live load; 
WS: wind load on structure. 

Load Combination Statuses - ASCE-7-02 SD 
The description of load combinations is taken from ASCE-7-02, Section 2.3 
"Combining Factored Loads Using Strength Design".  

Status Description 

Ultimate 1 1.4 (D + F) 

Ultimate 2 1.2 (D+F+T) + 1.6 (L+H) + 0.5 (Lr or S or R) 

Ultimate 3 (1) 1.2D + 1.6 (Lr or S or R) + (L or 0.8W) 

Ultimate 4 (1) 1.2D + 1.6W + L + 0.5 (Lr or S or R) 

Ultimate 5 (1) 1.2D + 1.0E + L + 0.2S 

Ultimate 6 (2) 0.9D + 1.6W + 1.6H 

Ultimate 7 (2) 0.9D + 1.0E + 1.6H 

Service 1* D + F 

Service 2* D + H + F + L + T 

Service 3* D + H + F + (Lr or S or R) 

Service 4* D + H + F + 0.75 (L + T) + 0.75 (Lr or S or R) 
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Status Description 

Service 5* D + H + F + W 

Service 6* D + H + F + 0.75 (L + W) + 0.75 (Lr or S or R) 

Service 7* 0.6D + W + H 

Fatigue This status is available but VisualDesign does not 
automatically generate Fatigue load combinations for this 
code. Users must define them. 

 

Note 1: The load factor on L in combinations (3), (4), and (5) is permitted to 
equal 0.5 for all occupancies in which L in Table 4.1 is less than or equal to 100 
psf, with the exception of garages or areas occupied as places of public 
assembly. 

Note 2: The load factor on H shall be set equal to zero in combinations (6) and 
(7) if the structural action due to H counteracts that due to W or E. Where 
lateral earth pressure provides resistance to structural actions from other 
forces, it shall not be included in H but shall be included in the design 
resistance. 

*: These load combinations can be generated by VisualDesign, based on the 
ASD method, even if they are not required per this code, because the software 
needs them to calculate forces and stresses under serviceability limits states, for 
some particular applications.  

Load Cases 
D: dead load; 
Di: weight of ice; 
E: earthquake load; 
F: load due to fluids with well-defined pressures and maximum heights; 
Fa: flood load; 
H: load due to lateral earth pressure, ground water pressure, or pressure of 
bulk materials; 
L: live load; 
Lr: roof live load; 
R: rain load; 
S: snow load; 
T: self-straining force; 
W: wind load; 
Wi: wind-on-ice determined in accordance with Section 10. 
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2.3.3 Flood Load: 
When a structure is located in a flood zone, the following load combinations 
shall be considered: 

In V-Zones or Coastal A-Zones, 1.6W in combinations Ultimate 4 and 
Ultimate 6 shall be replaced by 1.6W + 2.0Fa. 

In noncoastal A-Zones, 1.6W in combinations Ultimate 4 and Ultimate 6 
shall be replaced by 0.8W + 1.0Fa. 

2.4.3 Atmospheric Ice: 
When a structure is subjected to atmospheric ice and wind-on-ice loads, the 
following load combinations shall be considered: 

0.5 (Lr or S or R) in combination Ultimate 2 shall be replaced by 0.2Di + 0.5S.  

1.6W + 0.5 (Lr or S or R) in combination Ultimate 4 shall be replaced by Di + 
Wi + 0.5S. 

1.6W in combination Ultimate 6 shall be replaced by Di + Wi. 

Load Combination Statuses - ASCE-7-02 ASD 
The description of load combinations is taken from ASCE-7-02, Section 2.4 
"Combining Nominal Loads Using Allowable Stress Design".  

Status Description 

Service 1 D + F 

Service 2 D + H + F + L + T 

Service 3 D + H + F + (Lr or S or R) 

Service 4 D + H + F + 0.75 (L + T) + 0.75 (Lr or S or R) 

Service 5 D + H + F + (W or 0.7E) 

Service 6 D + H + F + 0.75 (W or 0.7E) + 0.75L + 0.75 (Lr or S or R) 

Service 7 0.6D + W + H 

Service 8 0.6D + 0.7E + H 

Fatigue This status is available but VisualDesign does not automatically 
generate Fatigue load combinations for this code. Users must 
define them. 
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Load Cases 
D: dead load 
Di: weight of ice 
E: earthquake load 
F: load due to fluids with well-defined pressures and maximum heights 
Fa: flood load 
H: load due to lateral earth pressure, ground water pressure, or pressure of 
bulk materials 
L: live load 
Lr: roof live load 
R: rain load 
S: snow load 
T: self-straining force 
W: wind load 
Wi: wind-on-ice determined in accordance with Section 10. 

2.4.2 Flood Load: 
When a structure is located in a flood zone, the following load combinations 
shall be considered: 

In V-Zones or Coastal A-Zones, 1.5Fa shall be added to other loads in 
combinations Service 5, Service 6, and Service 7 and E shall be equal to zero 
in combinations Service 5 and Service 6. 

In noncoastal A-Zones, 0.75Fa shall be added to other loads in combinations 
Service 5, Service 6, and Service 7 and E shall be equal to zero in 
combinations Service 5 and Service 6. 

2.4.3 Atmospheric Ice: 
When a structure is subjected to atmospheric ice and wind-on-ice loads, the 
following load combinations shall be considered: 

0.7Di shall be added to combination Service 2.  

(Lr or S or R) in combination Service 3 shall be replaced by 0.7Di + 0.7Wi + 
S. 

W in combination Service 7 shall be replaced by 0.7Di + 0.7Wi. 
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Load Combinations Generator 
This wizard allows generating load combinations according to a specific 
construction code and with the user-defined load cases (live, dead, wind, 
seismic, etc.). Access this tool by selecting Load Combinations/ Automatic 
Generation under Loads menu.  

The dialog box is composed of three pages: General Options, Specific 
Options and Selections.  

Bridge Evaluation module only (S6-00): 

An additional page is included in the generator for the calculation of load 
factors: 

General Options Page 
The General Options page concerns general options, as the building code that 
will be used to generate appropriate load combinations. It also includes 
generation options that apply to all building codes and standards.  

  

Load Combination Generator 
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Here is the description of fields included in this page: 

Heading Description 

Specifications Code: Specify the construction code to be used for the 
generation of  load combinations. The following codes and 
standards are available: 

NBC 1995 (Canada) – LSD (Limit States Design); 
NBC 1995 (Canada) – WSD (Working Stress Design); 
CAN/CSA-S6-00: Highway and Bridge Design Code; 
CAN/CSA-S37-01: Tower Design; 
ASCE-7-02 SD: American standard for Strength Design; 
ASCE-7-02 ASD: American standard for Allowable Stress 
Design; 
AASHTO-LRFD-04 (USA): Highway and Bridge Design Code;  
CNB-2005 (Canada) 

Load Combinations 
to be Generated 

Activate options by checking boxes. Available options are: 

Generate an unfactored load combination for each load case; 

Generate with seismic loads acting towards the positive 
direction only (1); 

Mass. 

Particular Load Cases to be Included 

Spectral Envelopes Specify spectral envelopes to be included in generated load 
combinations: E01, E02, and/or E03. Refer to Linear Seismic 
Directions for specifying envelopes that correspond to seismic 
directions. 

Time History 
Envelopes 

Specify time history envelopes to be included in generated load 
combinations: Et1, Et2, and/or Et3. 

Non-linear Time 
History Envelope 

Specify non-linear time history envelope Etnl to be included in 
generated load combinations 

Generation Options Add generated load combinations to existing ones: The 
generated load combinations are simply added to the previously 
defined ones. 

Delete load combinations except those edited by user: Only 
load combinations that have been previously generated with the 
wizard will be destroyed. 

Delete all previous load combinations: All the existing load 
combinations included in the project are destroyed before 
creating new load combinations.  

Envelopes to be 
generated 

Generate an envelope per type of  load combination (Strength, 
Ultimate, ULS, Service, Fatigue, etc.) 
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Note 1: 
Generation of Seismic Loads: 

For Generation Modules – Culverts and Piers, Abutments: VisualDesign™ will 
generate positive AND negative seismic load cases if this option is not 
activated. This is true for ULS, LRFD, and ASD codes. 

Press the "Next" button to reach the second page of the Wizard, Specific 
Options, which includes generation options that apply to the selected building 
code or standard.  

See also 
Linear Seismic Directions (Creating envelopes E01, E02, E03)  
Specific Options Page 
The Specific Options page will appear on screen as soon at you click the 
"Next" button posted in the bottom of the first page. This page is composed 
of specific generation options that apply to the selected building code.  

Use the "Back" button to go back to previous page. 

  

Here is the description of fields included in this page: 
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Topic Description 

Specifications Code: Shaded field that shows the selected building code or 
standard.  

Load Factors 
spreadsheet (1) 

Use load factor default values (alpha, gamma and psy) listed in 
the "Default" column or enter your own load factors in the 
"Value" column. See note 1 below, to know more about the 
gamma factor of  NBC building code and ASCE standard. 

Load Combinations 
to be Generated 

By default, all load combinations are activated and will be 
generated. To disable some, uncheck boxes. Refer to: 

Load Combinations - General  
Load Combinations - CAN/CSA- S6-00  
Load Combinations - AASHTO-04  
Load Combinations - ASCE-7-02 SD  
Load Combinations - ASCE-7-02 ASD  

Deflection Load 
Combinations 

If  available for chosen code, this option generates required load 
combinations fro checking the maximum Instantaneous Deflection 
deflections. Please activate the live loads to be considered in 
these load combinations.  

Particular Load 
Cases to be Included 
(2) 

If  available for selected building code, specify particular load 
cases to be included in generated load combinations:  

Moving Load envelope (Lm)  
Prestressing load and shrinkage/creep loads 
Combination of  seismic envelopes: 100%E1 + 30%E2. 

The "Moving Load 
Envelopes" button 

This button calls up the Definition of  Moving Load 
Envelopes spreadsheet. This spreadsheet allows getting the 
default load combinations that shall be included in each moving 
load envelope, as required per selected code. To know more, 
please go to Definition of  Moving Load Envelopes. 

The "Bridge 
Evaluation" button 

For CAN/CSA-S6-00 Standard Only: 

This button, located in the lower part of  the page, gives access 
to a dialog box. Parameters shall be specified for computing 
load factors required for a bridge evaluation.  Refer to topic 
Load Combinations –Bridge Evaluation. 

Press the "Next" button to go the last page of the Wizard, which is the 
Selections page. 

Use the "Back" button to go back to previous page.  

Note 1: Importance Factor (gamma) 

This factor affects some factored loads other than dead loads, in order to 
consider the consequences of collapse as related to the use and occupancy of 
the building.  
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NBC 1995 (Canada): The factor is normally 1.0 or 0.8. 

ASCE-7 (US): the factor is equal to 0.5, except for places of public assembly, 
live loads in excess of 100 psf, and for garage live load where the factor is 1.0. 

Note 2: Combination of Seismic Envelopes  

Two spectral envelopes will have to be specified in the Linear Seismic 
Directions spreadsheet. Each envelope will be assigned to a seismic direction. 
If this option is activated in the Specific Options page of the Wizard, 
VisualDesign will generate the load combinations that include 100% E01 + 
30% E02, and vice-versa, instead of including E01 only.   

See also 
Load Combinations Generator  
Definition of Moving Load Envelopes  
The Selections tab  
Load Combinations for Bridge Evaluation  
Linear Seismic Directions spreadsheet  
Selections Page 
In this dialog box, a selection tree is displayed which includes all the load 
combinations that will be generated. To simplify the writing of load 
combination names and descriptions, aliases (short names) are generated and 
described in this page.  

These aliases will be automatically added to your load cases description in the 
Loads Definition spreadsheet so that you can identify them easily. Dead loads 
are consecutively named D1, D2, …,Dn, if they are not part of the same 
family, and so are wind loads (W1, W2…) and temperature loads (T1, T2…). 
Since live loads are combined, they are represented like binary numbers: Lxoxx 
means L1+L3+L4.   

Topic Description 

Load Combinations 
to be Generated 

When you press the "Finish" button, look at the expanded tree 
including all load combinations to be generated.  You are 
allowed to select and deselect the tree’s branches and leaves in 
order to select the load combinations that you wish to generate.  

Load case aliases This list shows load case names’ aliases used for load 
combinations nomenclature. 
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At the push of the "Finish" button, selected load combinations are 
automatically generated and the Load Combinations Definition spreadsheet 
is opened. You can modify them as you wish or exit the spreadsheet. 

See also 
The Options tab  
Load Combinations Generator 
Load Case Families  
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Moving Load Envelopes 
The spreadsheet Definition of Moving Load Envelopes, which is available 
in the Loads / Moving Loads menu, allows activating and defining moving 
load envelopes that will be included when generating load combinations with 
the Wizard and when the Moving Load Analysis will be launched. 
Furthermore, it allows specifying the type of 2D axle factors that must be used 
for each envelope.  

This spreadsheet can also be open with the button "Mov. Load Envelopes", 
posted in the Moving Load Analysis dialog box and in the Specific Options 
page of the Load Combination Wizard.   

Here is the description of columns included in this spreadsheet: 

Column Description Editing 

ID Automatically calculated No 

Number Number of  moving load envelope (Lm01 to 
Lm10). 

Single click 

To be analysed Activate this box [  x  ] to include this moving 
load envelope in the moving load analysis and/or 
in generated load combinations when using the 
Wizard.  

Double click 
or Space bar 

2D Axle Factors 
to be used 

This column represents the type of  2D axle factor 
that applies to this envelope, for a 2D project, 
according to the chosen code. 2D axle factors are 
defined in the 2D Axle Factors spreadsheet, for a 
single loaded lane and for many loaded lanes.   

Double click 

Type of  Load 
Combinations 

According to selected code, activate [  x  ] or 
disable the box [  x  ] to include or not the 
envelope when generating this type of  load 
combination according to this code.  

Double click 
or Space bar 

 

Computation of Load Factors for Bridge Evaluation 
If you are evaluating a bridge according to code S6-00, the Load 
Combinations Generator will generate the required load combinations. 

To do so, select Code S6-00 in the General Options page, press "Next". In 
the Specific Options page, press the "Bridge Evaluation" button to call up the 
Calculation of Load Factors dialog box.  
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Enter the required parameters in this specific dialog box. The reliability Index 
beta will be calculated, along with αD and αL load factors.  

 
The table below describes the parameters included in the dialog box: 

Field Description 

Information on the bridge 

Transitory loads Specify the type of  transitory loads applied to the bridge: 
Alternative, Level 1, Level 2 or Level 3.  

Inspection Level Choose among INSP1, INSP2 or INSP3. 

Traffic Type Choose among Normal, PA, PB, PC or PS. 

Type of  span Specify the type of  span: Short or Other. 

Calculation Method Choose a calculation method: Statically determinate, 
Sophisticated or Simplified. 

System Behaviour Specify the category S1, S2 or S3 that describes the system 
behaviour. 

Element Behaviour  Specify the category E1, E2 or E3 that describes the element 
behaviour. 
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Field Description 

Important Structure Check this option if  the bridge is considered as an important 
structure according to code S6-00. 

Calculated Load Factors 

Reliability Index Beta According to the parameters that you entered, VisualDesign™ 
calculates a reliability index beta and load factors alpha D and 
alpha L. 

Alpha D  Calculated load factor that will be applied to permanent loads. 

Alpha L. Calculated load factor that will be applied to live loads. 

See also 
Specific Options page of Load Combination Wizard  
Bridge Evaluation Module  
Deterioration of Rebars and Cables  
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Definition of Envelopes 
To define envelopes, select headings Envelopes/Definition under Loads 
menu. The Envelopes dialog box is composed of two tabs: Envelopes and 
List of Envelopes. Each one of these tabs includes a spreadsheet to facilitate 
the data entries. 

See also 
The Envelopes Tab  
The List of Envelopes Tab  
Copying an Envelope and Load Combinations  
The Envelopes Tab 
The Envelopes tab is part of the Envelopes dialog box, which is accessible 
through the Loads menu / Envelopes. Insert a line and enter a name for each 
envelope that you wish to study in your project. Then, select the List of 
Envelopes tab and integrate load combinations that are part of each envelope. 

  
Group: Envelope data 

Column Description Editing 

ID Calculated automatically No 

Number 12 alphanumeric characters Single click 

Definition Comment Single click 

See also 
The List of Envelopes Tab  
Copying an Envelope and Load Combinations  

Envelopes 
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The List of Envelopes Tab 
The List of Envelopes tab is part of the Envelopes dialog box.  

The left part of the dialog box is a list box that contains the name of envelopes. 
Highlight each envelope and, in the right part of the dialog box, enter the 
number of lines that correspond to the number of load combinations that are 
included in the envelope. Then, select each load combination in the "Load 
Combination" list box. The "Available" column informs the user about the 
availability of this load combination.   

   
Group: Envelope: (title) 

Column Description Editing 

ID Calculated automatically No 

Load 
Combination 

Select load combination in the list box. Double-click 

Available This column informs the user about the 
availability of  this load combination.  

Single click  

See also 
Copying an Envelope and Load Combinations  
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Copying an Envelope Definition along with Load 
Combinations 
To simultaneously copy an envelope along with load combinations that are part 
of this envelope, use function Duplicate available in the spreadsheet's 
contextual menu.   

Procedure: 
• Open the Definition of Envelopes spreadsheet. 

• Select the line that corresponds to the envelope you want to copy. 

• Right click and choose function Duplicate in contextual menu. 
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The Base Module 
The Basic module includes the Static analysis and performs linear and non-
linear static analysis of structures composed of members, floors, and triangular 
or rectangular finite elements. There is no limit for the number of elements and 
nodes included in the structural model.  All types of loads are permitted 
(concentrated, distributed, trapezoidal, pressure on plates or temperature 
loads). Furthermore, there is no limit either for the number of load 
combinations and load cases.  

Restrictions 
VisualDesign™ cannot perform an analysis if the structure does not include 
support nodes or if shapes or materials are missing.  

VisualDesign™ cannot perform a static analysis if seismic envelopes or moving 
load envelopes are integrated into load combinations and have not been 
analyzed beforehand. 

Types of Static Analyses 
Users must specify the type of static analysis to be run, in the Analysis tab of 
Project Configuration dialog box:  

Linear Static Analysis 
Forces and displacements are obtained without considering second order 
effects such as P-delta effects.  

Non-Linear Static Analysis 
Forces and displacements are obtained considering second order effects such 
as P-delta effects. This type of analysis is a non-linear analysis in the geometric 
point of view as opposed to a dynamic analysis, which is non-linear analysis in 
the material point of view where material can reach plasticity.   

Static Analysis with Release (Members and/or Supports)  
This type of analysis is like a linear static analysis, but is an iterative one: When 
VisualDesign encounters members that are specified with released conditions, 
it corrects appropriate members' degrees of freedom and launches another 
linear analysis until it reaches convergence. Refer to this procedure to learn 
more: Modeling and analysing a slab-on-grade. 

See also 
Analysis tab (Project Configuration)  
Released Supports (Chapter 2)  

General 
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Released Members (Chapter 2) 
Display Released Members  

Project Configuration 
Analysis Tab  
Specify the type of static analysis to be run (linear, non-linear, or with release), 
parameters for non-linear analysis, subdivision of members for the display of 
internal forces, reduction factor for tributary area, and parameters for a general 
dynamic (transient) analysis.  

 
Description of the dialog box:  

Field Description 

Type of  analysis Activate a linear or non-linear static analysis. The static 
analysis with release is required if  supports or members 
need to be released during analysis.  Refer to topics: Types 
of  Static Analysis and Tension-only Members  
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Field Description 

Tributary Area Specify the type of  reduction factor that will be applied to 
tributary areas: Compression or Bending. 

With the drop-down list box, select the code that will be 
apply to reduce overload. 

Parameters for Non-linear 
Analysis 

Parameters are shaded if  you activated a linear analysis. 

If  you activated an analysis "with release", only the 
number of  iterations can be specified for said analysis. 

Max. variation for P axial  The non-linear analysis will end when this variation will 
fall below this value. 

Max. variation for 
displacements 

This tolerance is applied to displacements of  axially 
released supports only. 

Number of  iterations The non-linear analysis or the one considering release will 
end when the specified maximum number of  iterations 
will be reached. 

Rigidity factor (axial release) Specify a rigidity factor for axially released members. 

Parameters for cyclic design  

Number of  cycles 
(optimization) 

Number of  cycles for optimization when designing 
members. 

Number of  cycles (correction) When the optimized number of  cycles is reached, 
members that have not been optimized will be evaluated 
with the correction mode.  

Number of  subdivisions for 
the diagrams 

Number of  subdivisions applied to all members no matter 
the load condition. It can be specified for loaded beams, 
unloaded beams, unloaded pinned beams, concrete 
members and rectangular plates. 

General Dynamic Loadings  

Duration Fix a maximum time for the application of  this type of  
dynamic loading. 

Time pitch Specify the time pitch. Make sure that "dti" is larger than 
the time pitch otherwise there will be a warning. Refer to 
topic General dynamic load diagrams for more details. 

Save node displacements Save the time responses of  node displacements in the 
database (Project_Name.vr1). See the note below. 
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Convention - Forces in Members 
Sections’ strong and weak axes: 

  

Forces and resistances 
Resistances, forces and deflections are given in accordance to the member local 
axes system (x, y, z). Local z-axis is longitudinal to the member and points 
towards node j. 
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For steel angles, Mw and Mz bending moments are always transformed into 
orthogonal axis system when the design is completed.  

  
See also 
Major/minor and Orthogonal Axis Systems  
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Static Analysis Dialog Box 

  
The "Static Analysis" icon of Tools toolbar 

 

Open the Static Analysis dialog box by clicking the "Analysis" icon on Tools 
toolbar or by selecting Static Analysis from Analysis menu. 

The upper part of the Static Analysis dialog box displays the project title (as 
defined in Project Configuration under File menu). You will also find the 
number of nodes, members, plates, and floors as well as the number of load 
types and load combinations that you defined.  

Press the "Analyse" button to launch the analysis. 
D A T E  A N D  T I M E  

VisualDesign displays the date of analysis in the Static Analysis dialog box. 
You will also find the time it was launched and the time it ended in the upper 
part and lower part of the dialog box.  

See also 
Accessing Analysis Results  
Null pivot in the stiffness matrix  
Activating a Static Analysis when a Spectral Analysis is called for  

Starting a Static Analysis 
• Click the "Analyse" icon on Tools toolbar or go to Analysis / Static.  

• Click the "Analyse" button in the Analysis dialog box. 

Static Analysis 
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The load combination has not reached the 
specified level of precision. 
This message appears in the Analysis dialog box during analysis process when 
VisualDesign could not reach the convergence criterion that is specified for 
P axial, in the Analysis tab of Project Configuration.  

Results are not valid because stress/strain compatibility has not being 
reached. 

It could be caused by instability in your model. Look at the magnitude of 
applied loads. Look carefully at support restraints and look at hinged members 
(too many hinges = instability). Look at deflections to locate the problem. 

Null Pivot in the Stiffness Matrix 
During an analysis, this message indicates that a null pivot was detected in the 
stiffness matrix. It is a strong indication that there is an instability problem 
within the model. The node number that is given with the message is a hint to 
locate the instability source. 

Good to know: 

Don't forget that VisualDesign™ is a 3D program. If you modeled a 2D 
structure, you must fix the third direction in order to get a stable structure. 

A 3D structure that is stable could become unstable if lateral forces are applied 
and if you ran a non-linear analysis. It means that instability was not detected 
under gravity loads. Consequently, we recommend that you always check the 
structure behaviour under lateral loads.  

Always check the structure deflection, if possible. An extreme displacement is 
an important indication that a mechanism is present in the structure. 
Strengthen the structure where the mechanism took place.  

If you have gone through many tries but haven't resolve the problem, here are 
a couple of suggestions to make sure that the model is stable:  

• Create a unit load case on each node of the model. Loads should be applied 
in the three orthogonal directions (x, y, z, Mx, My and Mz).  

• Create a load combination that corresponds to this load case.  

• Configure your project for a static analysis (File / Project 
Configuration / Analysis tab / "Type of analysis").  

• Run a static analysis. If you obtain the null pivot message, the model is 
still unstable.  

Instability Messages 
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• Observe the model deflections to detect instabilities that could be 
present. Huge deflections are a sign of instability, inferior structural 
stiffness or excessive loads.  

• If there are some Built-Up sections in your project, change all these 
sections for symmetrical shapes or pre-defined shapes such as HSS, to 
make sure that instability is not caused by data entry.  
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Shear Energy - Deflection Calculation 
VisualDesign™ integrates the shear energy of a deformed section into the 
calculation of the total deflection of a member. The program adds the 
deflection due to shear energy to the deflection caused by bending.  

Total Deflection = Deflection|BENDING + Deflection|TORSION.  

Deflection Due to Shear:  
The deformation due to the shear force is equal to the shear force V divided by 
the product of the area As and G.  

 
For a rectangular beam:      

              
The equation for deflection is the integral of the deformation γ. 

 
Find equation V(x): 

at x = 0: V(x) = Vmax 

Deflections 
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at x = L/2: V(L/2) = 0 and the slope m = 2Vmax/L 

    

 

EXAMPLE 1 
Calculate the total deflection at the centre of a rectangular beam, simply 
supported and loaded with a uniform live load.  

Beam 405mm x 405mm, simply supported 
L = 5 meters 
Distributed live load = 50 kN/m 
A gross = 164025mm²  (calculated by VisualDesign™) 
Linear mass = 399,6 kg/m  (calculated by VisualDesign™) 
Concrete: 30 MPa 
E = 26621 MPa (calculated by VisualDesign™) 
G = 11092 MPa (calculated by VisualDesign™) 
υ = 0,20   (given by VisualDesign™) 
I = bd³/12 = 224.2*10exp7 
Density = 23.54 kN/m³  (given by VisualDesign™) 

Unfactored distributed load:   

 w = (0.405² * 23.54) + 50 = 53.86 kN/m 

 So, Vmax = 53.86 * 5 / 2 = 134.65 kN 

Calculation of As = Kx * A gross      
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( )

υ+
υ+= 1112

110Kx
 = 20.0*1112

2.1*10
+  =  0,84507 

      A gross = 164025 mm² 

     As = 164025 * 0,84507 = 138612.7 mm² 

Calculation of the total deflection at centre 

 ∆centre  = ∆bending  +  ∆shear 

  = EI384
L5 4ω

 + 4
Lmax*V*G*As

1
 

  = 

( ) ( )
4*11092*67.138612

5000*134650
10*2.224*26621*384

5000*86.53*5
7

4

+
 

  = 7.34387mm  + 0.10947mm  

  = 7.4533mm   

VisualDesign™ Static Analysis Results:  7.45 mm 

EXAMPLE 2: Reduced Stiffness Due to Cracked Concrete. 
This is the same example as above except for the elements stiffness that needs 
to be reduced because of the cracked concrete. The ratio of reduced stiffness is 
specified in the Member tab of Characteristics of the Member dialog box. 
See also the topic Effective Stiffness. 

For bending: Ratio for reduction of inertia = 0.8 

For torsion/shear: Ratio for reduction of stiffness = 0.5 

∆centre  =  ∆bending  +  ∆torsion,shear 

  =  







 ω
EI384
L5

8.0
1 4

 + 
( )4

Lmax*V*G*As
1

5.0
1

 

  =  

( ) ( )
4*11092*67.138612*5.0

5000*134650
10*2.224*26621*384*8.0

5000*86.53*5
7

4

+
 

  =  9.1799mm + 0.21894mm 

  =  9.3988mm   
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Accessing Analysis Results 
As soon as a static analysis is done, VisualDesign™ activates the Load 
Combination mode. A load combination title can be selected from the scroll 
list on the Activation toolbar. To look at numerical results, activate a type of 
element on Elements toolbar and double-click on the element. 

To view envelope results, activate the Envelope mode, and then select an 
envelope title from the scroll list on the Activation toolbar. Activate the type of 
element on Elements toolbar and double-click on any element of this type. 

Alternatively, select one of the load combinations or envelopes spreadsheets 
under Results menu.  

See also 
Starting a Static Analysis  
Static Analysis 

Support Results 
Results can be viewed by activating the "Load Combination" or "Envelope" 
mode when the analysis is done. Choose a load combination title from the pull 
down list of the Activation toolbar. 

Select a support and call the Properties function. You will then see the 
Results in the Node dialog box. Alternatively, you can also double-click on a 
support to call up the Support Results spreadsheet. 

The Node tab includes displacement results and the Support tab includes 
support reactions. 

See also 
Support Characteristics  
Support Reactions for a load combination  
Support Reactions for an envelope  

Results - General 
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Graphical and Numerical Results 
Select the Results tab in the View Options dialog box and check the box that 
corresponds to the force, stress or deflection diagrams you want to display on 
screen.  Click [Apply] or OK to exit the dialog box. 

  

• To look at numerical results associated to the diagram, check the box under 
the "Numerical" heading, in the Results tab. You can also click on the 

Numerical Values icon  of Diagrams toolbar.  

Amplitude of Diagrams and Fonts:  

• Use the "Automatic Scaling" icon  of Diagrams toolbar if the diagram 
amplitude is too big or too small.  

• Use icons  and  to increase or decrease the displayed text for the 
activated element on Elements toolbar.   
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Coloured Results 
To modify graphic attributes for results, select the Colour tab of View 
Options and expand the Results selection tree.  With your cursor, highlight a 
type of results in the list. The colour, for this type of result, will be shown in 
the "Selection" field. To modify it, click on a coloured square and press OK to 
exit the dialog box. 

  
See also 
Graphical and Numerical Results  
The Colour tab of View Options  
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Summary of Load Combinations 
 

Consult this spreadsheet to look at 
the obtained precision for each 
analysed load combination.  

This spreadsheet is available through Results / Load Combinations / 
Summary. It is composed of two tabs, Load Combinations and Summary, which 
present a summary of results obtained for each load combination such as ΣFx, 
ΣFy, ΣFz (Sum of applied loads only; envelopes are not considered), maximum 
displacement of node (node number), message posted after analysis, number of 
iterations, precision obtained, etc.).  

Here is a definition of fields included in these tabs: 

Load Combinations tab 

Column Description Editing 

ID Automatically calculated No 

Number Number (name) of  this load combination No 

Definition Enter a definition (optional) Ex: 1.25D + 1.5Lx No 

Analysis 
Message 

Message obtained at the end of  analysis for this 
load combination. Ex: Design OK or The load 
combination has not reached the specified level of  precision. 

No 

Number of 
iteration (1) 

Non-linear analysis: Number of  iterations for this 
design or non-linear static analysis to attain 
convergence. 

No 

Precision 
obtained (1) 

Non-linear analysis: This value represents the 
maximum variation obtained for P axial.  

No 

 

Note (1): These parameters are defined in the Analysis tab of Project 
Configuration dialog box, at section Parameters for non-linear analysis.  

 

Load Combination Results 

Results are not valid if VisualDesign 
has not reached convergence. 
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Summary tab 

Column Description Editing 

ID Automatically calculated No 

Load 
combination 
number 

Load Combination name or number. No 

ΣFx Sum of  applied forces in the x direction. This 
result is not available for load combinations that 
include one envelope or more. 

No 

ΣFy Sum of  applied forces in the y direction. This 
result is not available for load combinations that 
include one envelope or more. 

No 

ΣFz Sum of  applied forces in the z direction. This 
result is not available for load combinations that 
include one envelope or more. 

No 

Node 
Number 
(Max Displ.) (2) 

Node that has the maximum displacement in the 
structure 

No 

x- displ.  Displacement of  critical node in the x direction.  No 

y- displ. Displacement of  critical node in the y direction. No 

z- displ.  Displacement of  critical node in the z direction. No 

θx Rotation of  critical node on global x-axis.  No 

θy Rotation of  critical node on global y-axis. No 

θz Rotation of  critical node on global z-axis. No 

 
Note (2): VisualDesign uses the following equation to find the maximum 
displacement in the structure: 

Maximum displacement = zyx 222 ++
 

See also 
Analysis tab (Project Configuration)  
Nodes Displacements Results  
Load Combinations Definition  



C H A P T E R  5  S T A T I C  A N A L Y S I S  

CivilDesign Inc. Engineering Software  5-17 

Consulting Load Combination Results 
• Activate the "Load Combination" mode using one of the following 

procedures: 

• Click on the "Load Combination" icon  of Activation toolbar. 

• Select Edit/Activate Mode/Load Combination. 

• Select a load combination title from the load combination and envelope 
titles of the pull-down list of the Activation toolbar. 

• Select a group of elements of the same type and observe the results using 
one of the following procedures: 

• Click on the "Properties" icon  of Edit toolbar. 

• Select the Edit/Properties functions. 

• You can also look at results with one of load combination results 
spreadsheets from the menu Results/Load Combinations. The load 
combination results spreadsheet for the selected elements appears on your 
screen. Only the results corresponding to the selected elements are 
displayed. 

See also 
Summary  
Displacement at Nodes  
Reactions at Supports  
Internal Forces in Members  
Internal Forces in Members (min./max.)  
Internal Stresses in Members  
Internal Stresses in Members (min./max.)  
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Nodes Displacements 
Group: Load Combination Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Displ. x x-displacement in the global system No 

Displ. y y-displacement in the global system No 

Displ. Z z-displacement in the global system No 

θ x Rotation of  node around global x axis No 

θ y Rotation of  node around global y axis No 

θ z Rotation of  node around global z axis No 

Reactions at Supports 
Group: Load Combination Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Value Indicates the type of  results found on this line 
(Max., Min., …).  An empty field indicates a 
standard analytical result 

No 

Rx Reaction in the x direction – local or global 
system 

No 

Ry Reaction in the y direction – local or global system No 

Rz Reaction in the z direction – local or global system No 

Mx Moment around x axis – local or global No 

My Moment around y axis – local or global No 

Mz Moment around z axis – local or global No 

Orientation Orientation of  the reaction: Local or global axes 
system  

No 
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Column Description Editing 

Elastic supports only, with finite elements  

Soil pressure 
x-dir. 

Soil pressure acting on this support in the global 
x-direction, with respect to the spring stiffness 
and tributary area. Refer to Automatic Calculation 
of  Tributary Areas 

No 

(Kp) Soil 
x-dir 

Maximum passive soil pressure on the support, in 
the global x-direction. 

No 

Soil pressure 
y-dir. 

Soil pressure acting on this support in the global 
y-direction, with respect to the spring stiffness 
and tributary area. Refer to Automatic Calculation 
of  Tributary Areas 

No 

(Kp) Soil 
y-dir 

Maximum passive soil pressure on the support, in 
the global y-direction. 

No 

Soil pressure 
z-dir. 

Soil pressure acting on this support in the global 
z-direction, with respect to the spring stiffness 
and tributary area. Refer to Automatic Calculation 
of  Tributary Areas 

No 

(Kp) Soil 
z-dir 

Maximum passive soil pressure on the support, in 
the global z-direction. 

No 

See also 
Elastic supports  
Calculation of spring supports for piles (foundation design)  
Display pressure load on spring supports (pile foundation) 
Spring supports' stiffness for lateral backfill on culverts  

Internal Forces and Deflections - Members 
Group: Load Combination Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Shape Shape of  this member. No 

Position Position on the chord (x=0 at node i) No 

Value Indicates the type of  results found on this line 
(Max., Min., …).  An empty field indicates a 
standard analytical result 

No 
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Column Description Editing 

Bending Mx Bending moment – strong axis No 

Shear. Vy Shear force – strong axis No 

Bending My Bending moment – weak axis No 

Shear. Vx Shear force – weak axis No 

Axial Nz Axial force (positive in tension) No 

Torsion Tz Torsion force on the member No 

u (weak axis)  Deflection on weak axis No 

v (strong axis)   Deflection on strong axis No 

w (axial)  Axial deformation (accurate solution only at ends 
of  member) 

No 

Internal Forces and Deflections (min./max.) in 
Members  
Group: Load Combination Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Shape Shape of  this member. No 

Value Indicates the type of  results found on this line 
(Max., Min., …).  An empty field indicates a 
standard analytical result 

No 

Bending Mx Bending moment – strong axis No 

Shear. Vy Shear force – strong axis No 

Bending My Bending moment – weak axis No 

Shear. Vx Shear force – weak axis No 

Axial Nz Axial force (positive in tension) No 

Torsion Tz Torsion force on the member No 

u (weak axis)  Deflection relative to weak axis No 
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Column Description Editing 

v (strong axis)   Deflection relative to strong axis No 

w (axial)  Axial deformation (accurate solution only at ends 
of  member) 

No 

Internal Stresses in Members 
Group: Load Combination Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Shape Shape of  this member. No 

Position Position on the chord (x=0 at node i) No 

σ z|Nz Stress due to axial load No 

σ z|Mx Stress due to moment – strong axis No 

σ z|My Stress due to moment – weak axis No 

σ z Max Maximum stress caused by Nz, Mx and My 
combined 

No 

σ z Min Minimum stress caused by Nz, Mx and My 
combined 

No 

τ_yz|Vy Stress caused by shear - strong axis No 

τ_xz|Vx Stress caused by shear - weak axis No 

τ|Tz Shear stress caused by torque No 

Internal Stresses in Members (min./max.) 
This spreadsheet is available in the menu Results / Load Combination and 
Results / Envelope. It includes internal stresses in steel members OR internal 
stresses located in the inferior part of a composite section (steel or concrete) 
that have been analysed with no construction stages  

N. B. These results are not valid for a composite beam that have been analysed 
with construction stages. Please refer to composite beam graphical results, 
available in menu Results / Load Combination / Stresses in Composite 
Beams. Graphical results are valid for a composite beam with or without 
construction stages and include stresses in the section and in the slab. 
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Group: Load Combination Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Shape Shape of  this member. No 

σ z|Nz Stress due to axial load No 

σ z|Mx Stress due to moment – strong axis No 

σ z|My Stress due to moment – weak axis No 

σ z Max Maximum stress caused by Nz, Mx and My 
combined 

No 

σ z Min Minimum stress caused by Nz, Mx and My 
combined 

No 

τ_yz|Vy Stress caused by shear - strong axis No 

τ_xz|Vx Stress caused by shear - weak axis No 

τ|Tz Shear stress caused by torque No 

See also 
Interpretation of Composite Beam Results  
Composite Beam Graphical Results  
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Consulting Envelope Results 
• Activate the "Envelope" mode using one of the following procedures: 

• Click on the "Envelope" icon  of Activation toolbar. 

• Select Edit/Activate Mode/Envelope. 

• Select an envelope title from the load combination and envelope titles of 
the pull-down list of the Activation toolbar. 

• Select a group of elements of the same category and observe the results 
using one of the following procedure: 

• Click on the "Properties" icon  of Edit toolbar. 

• Select the Edit/Properties functions. 

• You can also look at results through one of the envelope results 
spreadsheets from the menu Results/Envelopes. The envelope results 
spreadsheet for the selected elements appears on your screen. Only the 
results corresponding to the selected elements are displayed. 

See also 
Properties  
Reactions at supports (min/max)  
Reactions at supports and Critical Load Combination  
Internal Forces in Members and Deflections  
Internal Forces in Members and Deflections (min./max)  
Members' Internal Forces and Design Groups  
Variation of Stresses in Members  

Envelope Results 
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Nodes Displacements 
Group : Envelope Results: (title) 

Column Description Editing 

Number Node number No 

Value Minimum or maximum displacement for this 
envelope. 

No 

x- displ. Displacement of  node in the x direction.  No 

y- displ.  Displacement of  node in the y direction. No 

z- displ.  Displacement of  node in the z direction. No 

θx Rotation of  node on global x-axis.  No 

θy Rotation of  node on global y-axis. No 

θz Rotation of  node on global z-axis. No 

Reactions at Supports (min./max.) 
Group: Envelope Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Value Indicates the type of  results found on this line 
(Max., Min., …).  An empty field indicates a 
standard analytical result. 

No 

Rx Reaction in x direction – local or global system No 

Ry Reaction in y direction – local or global system No 

Rz Reaction in z direction – local or global system No 

Mx Fixing moment around local or global x axis No 

My Fixing moment around local or global y axis No 

Mz Fixing moment around local or global x axis No 

Orientation Orientation of  the reaction: local or global axes 
system. 

No 
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Column Description Editing 

Elastic supports only, with finite elements  

Soil pressure 
x-dir. 

Soil pressure acting on this support in the global 
x-direction, with respect to the spring stiffness 
and tributary area. Refer to Automatic Calculation 
of  Tributary Areas 

No 

Soil pressure 
y-dir. 

Soil pressure acting on this support in the global 
y-direction, with respect to the spring stiffness 
and tributary area.  

No 

Soil pressure 
z-dir. 

Soil pressure acting on this support in the global 
z-direction, with respect to the spring stiffness 
and tributary area 

No 

Reactions at Supports (min./max.) and Critical 
Load Combinations 
Group: Envelope Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Value Maximum or minimum forces for this envelope. No 

Load 
Combination 

Critical load combination for the force indicated 
at column "Value". 

 

Rx Reaction in x direction – local or global system No 

Ry Reaction in y direction – local or global system No 

Rz Reaction in z direction – local or global system No 

Mx Fixing moment around local or global x axis No 

My Fixing moment around local or global y axis No 

Mz Fixing moment around local or global x axis No 

Soil Pressure 
x-direction 

Soil pressure acting on this spring support 
towards direction x, considering its tributary 
surface.  

No 

Soil Pressure 
y-direction 

Soil pressure acting on this spring support 
towards direction y, considering its tributary 
surface.  

No 
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Column Description Editing 

Soil Pressure 
z-direction 

Soil pressure acting on this spring support 
towards direction z, considering its tributary 
surface.  

No 

Orientation Orientation of  this reaction: local or global axes 
system. 

No 

 

Internal Stresses and Deflections - Members 
Group: Envelope Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Shape Shape of  this member. No 

Position Position on the chord (x=0 at node i) No 

Value Indicates the type of  results found on this line 
(Max., Min.).  An empty field indicates a standard 
analytical result 

No 

Bending Mx Bending stress – strong axis plane No 

Shear Vy Shear stress – strong axis No 

Bending My Bending stress – weak axis plane No 

Shear Vx Shear stress – weak axis No 

Axial Nz Axial stress (positive in tension) No 

Torsion Tz Torsion stress on member No 

u (weak axis)  Displacement in direction of  weak axis. No 

v (strong axis)  Displacement in direction of  strong axis. No 

w (axial)  Axial deformation (exact solution only at ends of  
member) 

No 
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Internal Forces and Deflections (min./max) - 
Members 
Group: Envelope Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Shape Shape of  this member. No 

Value Indicates the type of  results found on this line 
(Max., Min.). An empty field indicates a standard 
analytical result. 

No 

Bending Mx Bending stress – strong axis plane No 

Shear Vy Shear stress – strong axis No 

Bending My Bending stress – weak axis plane No 

Shear Vx Shear stress – weak axis No 

Axial Nz Axial stress (positive in tension) No 

Torsion Tz Calculated automatically No 

u (weak axis)  Displacement in direction of  weak axis. No 

v (strong axis)  Displacement in direction of  strong axis. No 

w (axial)  Axial deformation (accurate solution only at 
member ends). 

No 

 

Stresses Variations in Members 
Interpretation of Results 
This spreadsheet supplies the difference between maximum and minimum 
values for shear forces (Vy) or stresses (Sigma) obtained for the selected 
envelope. 
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Group: Envelope Results: (title) 

Column Description Editing 

Number Member number. No 

Shape Shape of  member. No 

Position Position on the chord (x=0 at node i) No 

Delta σ|Nz Stress variation due to axial force. No 

Delta σ|Mx (y+) Stress variation at the top of  section, due to 
bending moment on strong axis.  

No 

Delta σ|Mx (y-) Stress variation at the bottom of  section, due to 
bending moment on strong axis. 

No 

Delta σ|My (x+) Stress variation at the right end of  section, due to 
bending moment on weak axis. 

No 

Delta σ|My (x-) Stress variation at the left end of  section, due to 
bending moment on weak axis. 

No 

See also 
Spacing of Studs – Composite Beam Results  
Extra Calculations - Composite Beam  
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Convention for Plane Stresses 

  

Sign convention 

  

Calculation of Qx and Qy 

  

  

Finite Elements 
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Myx and Mxy Bending Moments 

  
The dotted line shows the original position of the plate. 

See also 
Numbering Convention  
Principal Stresses Convention  
Interpreting Results  

Convention for Principal Stresses 
Convention for Bending Moments 
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Convention for Axial Stress 

  

Convention for Principal Strains 

  
See also 
Plane Stress Convention  
Interpreting Results 
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The Slab & FE Generator 
This powerful tool ((Structure / Generator / Slab & FE) creates a slab 
surface along with finite elements composed of triangular plates. Any slab 
geometry can be created and meshed with this tool. The mathematical concept 
used in VisualDesign is called the Convex Hull.  

The loaded surface can be statically analysed to obtain stress/force contours. It 
can be designed if users own the Reinforced Concrete Design module. 

The slab surface is determined by selected nodes on its outline (members are 
optional). The user specifies the maximum areas of plates, the material and 
thickness along with vectors to orient finite elements. 

 
Orientation vectors are automatically initialized in the Groups of plates – 
Surfaces spreadsheet, which is called up when the slab is created. The 
direction of vectors depends on the order of selected nodes (clockwise or 
counterclockwise). 

 
Coordinates correspond to the coordinates of the first selected node before 
calling up the generator.   
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Openings in the slab 
Before calling up the generator, coplanar nodes must be selected. But, 
members can also be selected to define an opening. The mesher will consider 
the selected members and no plates should go through these members. 
However, the generated plates over the opening will have to be erased by hand.  

Detecting Columns (Optional) 
The tool can search for columns (perpendicular elements) through selected 
nodes. Nodes at top of columns must then be selected along with nodes on the 
slab outline. The outline of the biggest column will be added to the imposed 
boundaries that were created through selected nodes before meshing the 
convex hull (surface). The biggest column is based on maximum area. It is not 
necessary to select column along with nodes. Only nodes located at the top of 
columns and nodes delimitating the floor surface are required. 

Saving 
We recommend saving the file before calling up the generator. It might be 
impossible for the mesher to create the slab from selected nodes and members. 
However, this tool is satisfactory in most cases.   

The Undo function can be used. 

See also 
2-way Slab Design  
Procedures for 2-way Slab Design  
Limitations for 2-way Slab Design  
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Groups of Plates - Surfaces 
Access this spreadsheet by selecting Plates - Surfaces under the 
Structure/Groups menu.  

This spreadsheet is useful to interpret finite elements results. A local axis 
system is assigned to a group of horizontal or vertical plates that are 
composing a slab or a simple wall (not shear walls). Results will be 
homogeneous and so it will be easier to read results. 

Plates are oriented through direction vectors that are normalized by 
VisualDesign™.  

 

 

Design of 2-way Slabs 
A group of plate must be assigned to plates that are composing a concrete slab. 
A specification must be selected and concrete covers must be specified.  
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Group: Structural Data 

Column Description Editing 

ID Automatically calculated No 

Number Group number or name Single click 

Origin 
x 

Global x-coordinate of  zero point for this group. 
This data can be useful to localize a group when 
sorting data. 

Single click 

Origin 
y 

Global y-coordinate of  zero point for this group. 
This data can be useful to localize a group when 
sorting data. 

Single click 

Origin 
z 

Global z-coordinate of  zero point for this group. 
This data can be useful to localize a group when 
sorting data. 

Single click 

X-Axis 
x 

Local x-axis component of  the group projected 
on the global x-axis. 

Single click 

X-Axis 
y 

Local x-axis component of  the group projected 
on the global y-axis.  

Single click 

X-Axis 
z 

Local x-axis component of  the group projected 
on the global z-axis. 

Single click 

Y-Axis 
x 

Local y-axis component of  the group projected 
on the global x-axis. 

Single click 

Y-Axis 
y 

Local y-axis component of  the group projected 
on the global y-axis. 

Single click 

Y-Axis 
z 

Local y-axis component of  the group projected 
on the global z-axis. 

Single click 

Reinforced Concrete Design Module only 

Specification Design of  2-way slab: Select the concrete 
specification. 

Double click 

Top 
Cover 

Specify the concrete cover at the top of  the slab. Single click 

Bottom 
Cover 

Specify the concrete cover at the bottom of  the 
slab. 

Single click 

Lateral 
Covers 

Specify the lateral concrete covers of  the slab. Single click 
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Groups of Plates - Shear Walls 
This spreadsheet is available in Structure/Groups / Plates – Shear Wall.  

This spreadsheet is required for analyzing or designing a shear wall.  Common 
local axes are assigned to plates that are composing this "section", which can 
be of any form (T, C, or cubic). The longitudinal axis of the shear wall must be 
parallel to the gravity axis (up or down), according to the right hand rule. 
Otherwise, VisualDesign will not be able to build the vertical continuous 
system, which is represented by a vertical fictitious member.   

VisualDesign normalizes vector directions. 

Groups are assigned to selected plates through the Plates spreadsheet or Plate 
Characteristics dialog box.  

Group: Structural Data 

Column Description Editing 

ID Automatically calculated No 

Number Group number or name Single click 

Strong axis x If  the strong axis of  the shear wall is pointing 
towards the positive global x direction, enter a 
value of  1.0. If  it points towards the negative 
direction, enter –1.0.  

Single click 

Strong axis y If  the strong axis of  the shear wall is pointing 
towards the positive global y direction, enter a 
value of  1.0. If  it points towards the negative 
direction, enter –1.0. 

Single click 

Strong axis z If  the strong axis of  the shear wall is pointing 
towards the positive global z direction, enter a 
value of  1.0. If  it points towards the negative 
direction, enter –1.0. 

Single click 

See also 
Interpreting FE Results  
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Interpreting FE Analysis Results 
While visualizing moments and shear diagrams of a structure composed of 
plates, you will notice that there are sudden jumps where the plates meet. It can 
be explained by the way that the plates were modeled. The orientation of the 
local axes system and the plates meshing can influence the results of the 
analysis. 

Important jumps are seen in the shear forces diagram because VisualDesign™ 
uses a polynomial to approximate plate’s deflections. For example, 
VisualDesign™ will use a 12 terms polynomial to calculate the deflection of a 
plate composed of four nodes. 

Analysis of plates will generally be of good precision for displacements results, 
a bit less for rotations, fairly well for moments and acceptable for shear forces. 
These results correspond to the following derivative order: 

 u   very good  displacements 

 du  theta  good   rotations 

 d theta  Moment fairly good  moments 

 d Moment  V  acceptable  shear forces 

In fact, the more we derive, less good is the precision. 

The engineer does the interpretation of results. He can distribute the forces on 
a given plate width and do some more verification himself to make sure that 
the plate strength is OK. 

Shear forces Vxy 
If you want to determine the shear force acting at the base of a shear wall that 
is composed of rectangular plates, select the horizontal plates located at the 
bottom and look at the Vxy column in the Internal Forces in Rectangular Plates 
spreadsheet. 

To get the shear force acting on a given level of the wall, you must add the 
shear force of plates located at this level. The shear force acting on a plate is 
equal to Vxy at nodes, which is an average value for the whole plate, multiplied 
by the dimension of the plate in the local x direction.  

So: 

Shear force of the wall at level n = sum of [(Vxy for each plate at this level) * 
dimension of each corresponding plate in the x direction] 

Finite Element Analysis Results  
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Example: 
The analysis results for a 0.25m x 0.5m rectangular plate is shown in the table 
below. The given shear force is the average of the forces at nodes, multiply by 
the local x-dimension of the plate (0.25m). 

Nodes Vxy (kN/m) 

i 147.13 

l 147.13 

j 147.13 

k 147.13 

 

Vxy Plate:  147.13kN/m x 0.25m = 36.78 kN 

See also 
The Plates Spreadsheet  
Numbering Convention  
Plane Stress Convention  
Principal Stresses Convention  

The Finite Elements Results Tab 
The Results FE tab is useful to graphically or numerically display stresses and 
forces such as, bending moments, shear forces, axial forces, and deflections for 
rectangular and triangular plates. 

Following a static analysis, select a load combination on Activation toolbar and 
open the View Options dialog box. Select the Results FE tab. 

Select a diagram among the list box. Activate a type of display (stress/force 
contour or mesh, with or without deflection). Click OK. 
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Force/Stress Contours 
Activate a load combination on Activation toolbar. 

The left radio button displays graphic results in the form of stress/force 
contours if a graph is selected in the list box. Click any icon on Diagrams 
toolbar to open the Scaling of Intervals dialog box. This tool allows 
modifying the scale (upper and lower limits) for the displayed values (intervals) 
and colours. Refer to the topic Scaling for Intervals to learn more about this 
tool.  

Mesh and Deflection 
Activate a load combination on Activation toolbar. 

The right radio button displays the mesh and allows consulting numerical 
results. Double click on a plate to open the Internal forces and stresses 
spreadsheet or select many plates and press the Properties icon to open the 
spreadsheet.  

The check box "Deflection u, v w" displays the deflection of plates for the 
selected load combination. The deflection can be displayed along with the 
mesh or coloured stress/force contours. 
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Slab Reinforcement 
The Reinforced Concrete Design is required.  

This section applies to the display of calculated rebars for 2-way slabs. Four 
layers of bars can be displayed. The colour of rebars can be modified through 
respective reinforcement spreadsheets.  

See also 
Groups of Plates - Surfaces  
Scaling for Intervals  
View Options 
Interpreting Plates Analysis Results 
Concrete Design of 2-Way Slabs  

Scaling for Intervals 
When coloured stress/force contours are displayed for consulting finite 
elements results, press any icon on Diagrams toolbar to open the Scaling for 
Intervals dialog box.  

This tool allows modifying the intervals (values and number of colours) for the 
displayed legend. 

  
Select a number of colours for the display (9, 25, 45, 105, 225, 525 or 1021).   

The dialog box is composed of two scroll bar sliders that allow the scaling of 
intervals from maximum or minimum values when displaying stress/force 
contours (legend). Each scroll bar is subdivided into 100 units. Marks indicate a 
subdivision of 25 units. To move the indicator, click on it and slide the mouse 
at the right or left on the scroll bar. Displayed intervals will be increased or 
reduced as a result. 

The Manual Mode: 

When the Manual mode is activated, the absolute minimum and maximum 
values will still be displayed in the coloured legend but the specified value (min 
and max) will be used as upper and lower limits for the critical zone. If scroll 
bar sliders are used to modify the displayed values for intervals, the min and 
max specified values would be used for the modification instead of absolute 
values.  
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Therefore, critical zones (red or blue) are always delimited by the absolute 
value and specified value if the Manual mode is activated. If sliders are used, the 
modification will be done according to specified values.  

The legend displays the lower and upper limits for the two critical zones and 
intermediate zones (colours) display the middle value of the interval.  

Shortcut Keys: 

Use keyboard shortcut keys to adjust intervals when your cursor is located in 
the Max or Min scroll bar.  

Shortcut key Action 

[Home] The [Home] key moves the indicator at the 
beginning of  the scroll bar slider. 

[End]  The [End] key moves the indicator at the end 
of  the scroll bar slider. 

→  This arrow moves the indicator one unit right. 

←  This arrow moves the indicator one unit left. 

Load Combination Results 
Activate the Load Combination mode and select a load combination on Activation 
toolbar. Activate the Plate element on Elements toolbar, select plates and click the 
Properties icon to open this spreadsheet.   

Internal Forces in Plates 
Group: Load Combination Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Geometry Geometry of  the plate: Rectangular or Triangular. No 

Group Name of  the group where this plate belongs. No 

x Coordinate relative to the local x-axis. No 

y Coordinate relative to the local y-axis. No 

Mx The moment per unit of  width, perpendicular to 
the local x-axis.  

No 
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Column Description Editing 

My The moment per unit of  width, perpendicular to 
the local y-axis. 

No 

Mxy The torsion per unit of  width, around the local x 
and y-axes. 

No 

Qx Shear force per unit of  width, in the direction of  
z-axis, at the y face of  local axis system. 

No 

Qy Shear force per unit of  width, in the direction of  
the z-axis, at the x face of  local axis system. 

No 

Nx Normal average force per unit of  width, on local 
x-axis. 

No 

Ny Normal average force per unit of  width, on local 
y-axis 

No 

Vxy Average shear force per unit of  width, on the x 
face of  local axis system. 

No 

u Displacement in direction of  the local x-axis. No 

v Displacement in direction of  the local y-axis. No 

w Displacement in direction of  the local z-axis. No 

Mmax Maximum bending moment according to the 
orientation angle Alpha_M 

No 

Mmin Minimum bending moment perpendicular to 
Mmax 

No 

αm Orientation angle of  the principal moment Mmax No 

Nmax Maximum axial force per unit of  width, according 
to orientation angle α n 

No 

Nmin Minimum axial force perpendicular to Nmax, per 
unit of  width. 

No 

αn Orientation angle of  the axial stress Nmax No 

σxTop Axial strain σ in the x direction, at the top of  the 
plate  

No 

σyTop Axial strain σ in the y direction, at the top of  the 
plate  

No 
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Column Description Editing 

σxyTop Shear strain τ in the xy direction, at the top of  the 
plate  

No 

σmaxTop Maximum axial strain σ in the αTop direction on 
the top of  the plate  

No 

σminTop Minimum axial strain σ perpendicular to 
σmaxTop, at the top of  the plate  

No 

αTop Orientation angle of  the principal axial strain 
σmaxTop 

No 

σxBot Axial strain σ in the x direction, at the bottom of  
the plate 

No 

σyBot Axial strain σ in the y direction at the bottom of  
the plate 

No 

τxyBot Combine shear xy at the bottom of  the plate No 

σmaxBot Maximum axial strain σ in the αTop direction, at 
the bottom of  the plate 

No 

σminBot Minimum axial strain σ perpendicular to 
σmaxTop, at the bottom of  the plate 

No 

αBot Orientation angle of  the principal axial strain 
σmaxBot 

No 

~τxz Average shear strain perpendicular to the plate, in 
the xz plan 

No 

~τyz Average shear strain perpendicular to the plate, in 
the yz plan 

No 

See also 
Numbering Convention of nodes  
Plane Stresses Convention  
Principal Stresses Convention  
Interpreting Results  
Groups of plates - Surfaces  
Groups of plates – Shear Walls 
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Envelope Results 
Max/Min Internal Forces in Plates 
Activate the Envelope mode and select an envelope on Activation toolbar. Activate 
the Plate element on Elements toolbar, select plates and click the Properties icon 
to open this spreadsheet.   

Group: Envelope Results: (title) 

Column Description Editing 

Number 12 alphanumeric characters No 

Geometry Geometry of  the plate: Rectangular or Triangular. No 

Group Group in which belongs this plate. No 

x Coordinate relative to local x-axis. No 

y Coordinate relative to local y-axis. No 

Value Indicates type of  results found on this line (Max., 
Min., …).  Empty field indicates a standard 
analytical result 

No 

Mx Moment per unit of  width, perpendicular to local 
x-axis. 

No 

My Moment per unit of  width, perpendicular to local 
y-axis. 

No 

Mxy Torsion per unit of  width, around local x and y-
axes. 

No 

Qx Shear force per unit of  width, in the direction of  
z-axis, at the y face of  local axis system. 

No 

Qy Shear force per unit of  width, in the direction of  
z-axis, at the x face of  local axis system.. 

No 

Nx Normal average force per unit of  width on local 
x-axis. 

No 

Ny Normal average force per unit of  width on local 
y-axis. 

No 

Vxy Average shear force per unit of  width, at the x 
face of  local axis system. 

No 

u Displacement in direction of  local x-axis. No 

v Displacement in direction of  local y-axis. No 
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Column Description Editing 

w Displacement in direction of  local z-axis. No 

See also 
Numbering Convention of nodes  
Plane Stresses Convention  
Principal Stresses Convention  
Interpreting Results  
Groups of Plates  
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Modeling and Analysing a Slab-On-Grade 
Modeling  

• Activate the Structure mode. 

Create a FE Slab using the Generator 

• Activate the Node icon. 

• Select coplanar nodes that surround the slab and call up the Slab & FE 
Generator (Structure / Generator / Slab & FE).  

• In the dialog box, specify the maximum area of plates, the material, 
thickness and direction vectors. The slab main direction corresponds to 
the direction of main layers of bars (layers 1 and 4). Click OK.  

• In the Groups of plates – Surfaces spreadsheet, verify the direction 
vectors. Close the spreadsheet. 

Model Elastic Supports 

• Activate the Node icon. 

• Select all nodes (draw a window around all of them with the cursor). 
Activate the Properties icon (Edit / Properties). 

• Select a "Support" type of node in the Node dialog box. Click Ok. 

• Activate the Support icon. 

• Select all supports and click the Properties icon. 

• In the Support tab, select the Spring option for Ry and enter the linear 
rigidity of the soil, K, in the blank field next to it. Free the rotations for 
Mx, My, and Mz degrees of freedom. Refer to Spring Supports 
spreadsheet. 

Elastic Supports with Axial Release:  

• Stay in the Support tab and look at the right part that is titled "Release". 
Reaction Ry must be released for uplift. To release Ry, uncheck the "[-]" 
option. Refer to Support Release. Click OK. 

Calculation of tributary areas for elastic supports: 

• Select all supports and go to Structure / Tools / Calculation of Tributary 
Areas.  

Slab-on-Grade 
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Loads 

• Go to Loads / Load Cases / Definition. 

• Insert a line (click on the number 2 line and press the [Insert] key) in 
the Loads Definition spreadsheet. Give a name to the load case and 
select a type of load case in the "Type" column. 

Apply Loads 

• Activate the Load Case mode and select a load case title on Activation 
toolbar. 

• Activate the Plate icon. 

• Select all the plates and click on the Properties icon. 

• In the Loads on Plates dialog box, enter the pressure acting on the 
plates, according to the global or local axis system of the plates. Click 
OK. 

Load Combination Generator 

• Go to Loads / Load Combinations / Automatic Generation. 

• Select the appropriate design code in the upper part of the dialog box and 
activate the generation options. Click on the Next button. Look at load 
combinations that will be generated. If everything OK, click the Finish 
button. The Load Combinations spreadsheet will open. Click OK to exit.  

Static Analysis with Axial Release 

• Go to File menu and open the Project Configuration dialog box. Select 
the Analysis tab and activate a linear static analysis with axial release.  

• Launch the static analysis. 

Load Combination Results 

• Activate the Load Combination mode. 

• Select a load combination title on Activation toolbar. 

Results for Supports 

• Go to Results / Load Combination menu and open the Reaction at 
Supports spreadsheet. You will find forces on supports and soil pressures, 
among others. Double-click on a support to open the same spreadsheet. 

• Go to Results / Load Combination menu and open the Node 
Displacements spreadsheet. You will find the displacement of each 
support according to global axis system. Double-click on a node to open 
the same spreadsheet. 
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Finite Elements Results 
Graphic Results 
• Open the View Options dialog box and select the FE Results tab.  

• To look at deflections, activate the radio button at the right and check the 
"Deflection" box (u, v, w). 

• To look at stress/force contours, activate the radio button at the left and 
select a type of graph in the list box. A coloured legend will be posted on 
screen along with stress/force contours. To edit colours and displayed 
values that go along with them, click on any icon on Diagrams toolbar (or 
go to View / Diagrams / and select any function). The Scaling of 
Intervals dialog box will open. Use this tool to modify the number of 
displayed colours and modify values of intervals (a minimum and 
maximum value can be specified if the "Manual" mode is activated). Use 
the "Max" and "Min" scroll bar sliders to modify minimum and maximum 
displayed values for the selected graph.  

Numerical Results 
• Go to Results / Load Combination / Internal forces in Plates.  

Or, 

• Click the Plate icon. 

• Double-click on any plate to open the results spreadsheet for this plate 
only or select many plates and click the Properties icon to open the 
spreadsheet including results for these plates.  

• Refer to topic Interpreting Plates Results, to help you interpreting data in 
this spreadsheet.  
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The Foundation Design module 
The Foundation Design module includes the S6-88, S6-00, S16-01, and 
AISC-LRFD standards for the computation of structural and geotechnical 
forces for shallow and deep foundations. These calculations are based on the 
recommendations given in the Canadian Foundation Engineering Manual and on 
other models used in the practice. 

All calculations are done using the limit states design allowing a better 
integration of load cases already used by structural engineers. In all cases, the 
ground water elevation can be specified. 

The static analysis is used for the calculation. However, when a design module 
is used, the design of foundations takes part in the cyclic process.  

A stratigraphical profile and foundation specification must be created before 
defining a foundation model, except in the case where the Foundation 
Modeling Wizard is used. The Modeling Wizard is provided to help users to 
quickly define foundation models. In this case, the software fixes parameters. 
However, they can be modified in all time through spreadsheets. 

When shallow foundation design is carried out, VisualDesign calculates the 
required dimensions for the footing but it does not modify the footing 
thickness, which is specified by the user. If the bearing capacity is sufficient, 
VisualDesign will place reinforcing bars in the footing. The user can change the 
rebars dimension and results will be automatically recalculated within this 
results spreadsheet.  

Piles foundations can only be verified, for the moment. The structural capacity 
of the pile is verified and the geotechnical capacity also. Graphic results are 
also supplied for verification of piles. 

Soil-structure interaction can be considered during analysis. Footing 
settlements induce forces in the structure, which will be redistributed by 
VisualDesign until convergence is reached.  

See also 
Axis System Convention  
Configuration of the Project Foundations Parameters  
Rocks spreadsheet  
Cohesive Soils spreadsheet  
Granular Soils spreadsheet  
Important parameters to define soils  
Foundation Modeling Wizard  
Stratigraphical Profiles spreadsheet  

General 
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Foundation Model Dialog Box  
Assigning Foundation Models to Supports  
Shallow Foundation  
Piles Foundation  
Load parameters specific to the Foundation Design module  
Foundation Modeling Procedure  
Results of Foundation Module Calculations  
View Options  

Design Limitations 
Sloped footings 
VisualDesign does not consider sloped footings.  

Reactions 
The calculated reactions are applied to the centre of footings. 

Several nodes on a footing 
It is possible to place several nodes on a footing by defining very rigid elements 
(10 to100 times more rigid than the most rigid element in the structure) at the 
support node located at the centre of the footing. 

If a shallow foundation is supporting two columns, VisualDesign™ will not 
calculate the extra reinforcement needed around columns. The engineer must 
use his own discretion in these cases. 

Rigid footing 
Shallow foundations are calculated in keeping with the basic hypothesis that 
footings are rigid and not flexible elements. 

Rigid Links 
To automatically create rigid links, select a node that you wish to be dependent. 
Call the Node Characteristics dialog box by double-clicking on it and specify 
the master node’s ID in the appropriate field. You will notice that "Rigid link" 
is posted in the "Behaviour" box and that it is shaded, meaning that you cannot 
edit this characteristic. Example: A support node is the master node of four 
dependent nodes corresponding to the beams starting nodes at the foundation 
level.  



C H A P T E R  6  F O U N D A T I O N  D E S I G N  

CivilDesign Inc. Engineering Software  6-3 

  

Configuration for Foundations Parameters 
The first step to do when you use the foundation design module is to configure 
the project foundations in the Foundation tab of Project Configuration 
dialog box (File menu).  

Axis System Convention 
The foundation column rests just below the support node and is centred on 
both the column and footing.   

Gravity can be represented by the x, y or z-axis, depending on the user’s 
preference (Preferences tab- Project Configuration).   
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Shallow Foundations 
The Foundation Design module allows optimizing or checking shallow 
foundations.  

In the design mode, VisualDesign™ optimizes the footing dimension for a 
more economical design that satisfies safety criteria and all load combinations. 
The thickness of the footing is not modified. If the shear stress is too high, or 
the calculated bearing capacity is insufficient, a new model has to be defined.  

In the verification mode, VisualDesign™ checks the footing bearing capacity 
and the settlements for all load combinations. 

The following calculation models for bearing capacity are included in 
VisualDesign™: Meryerhof, Hansen, Vesic, Terzaghi, CNBC/CFEM/S6-00, 
SPT, vane shear test and static penetrometer test.  
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This module considers the soil/structure interaction. In this case, the internal 
forces created by footing settlements are redistributed into the structure. The 
software performs iterations until it reaches convergence between the 
settlements and forces to attain force/settlement compatibility. In Design 
mode, footings are optimized according to the soil capacity (ultimate limit 
states) or settlement (serviceability limit states). Eccentricities caused by 
bending moments or eccentric loads are considered for the design or analysis. 
Eccentricities may be limited as specified.  

After analysis, the following results are available: footing dimension, effective 
footing dimension, bearing capacity, soil pressure beneath the foundation, 
settlements, service reactions and ultimate reactions and percentage of used 
capacity for each footing.  

A spreadsheet allows the structural design of the footing. The engineer 
specifies the code, the reinforcing material, the type of concrete and the 
minimum concrete cover. The spreadsheet will automatically calculate the 
required number of rebar in the two directions, the spacing of rebar, the 
footing bending strength, shear strength and punching shear strength. 

See also 
Definition of Foundation Model  
Shallow Foundation Spreadsheet  

Piles Foundations 
The Foundation Design module also analyzes a foundation consisting of a 
sole pile or a group of piles. Geotechnical and structural strength are verified in 
the design of the pile foundation. The pile location, steel shape, inclination and 
beta angle are defined in the Foundation Model Spreadsheet. Any number 
of irregular layouts can be defined. However, the engineer may use the 
geometric layout generator available in VisualDesign™. VisualDesign™ has 
predefined steel shapes that may be used for pile sections. The pile section may 
also be filled up with concrete, if desired.  

The pile lateral strength is calculated using a finite element model that uses the 
soil Kh or nh value (soils secant module) according to the defined stratigraphical 
profile. The computation of the soils secant moduli takes into account the 
different soil layers that define the stratigraphical profile. 
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Following analysis, the results can be seen in the form of spreadsheets or 
graphically on the screen. One of the available results spreadsheets contains 
geotechnical results for each foundation support node. It includes the 
following information: geotechnical axial strength of a pile or group of piles, 
geotechnical lateral strength, settlements, ultimate and service reactions forces, 
and the design load of the foundation. A second spreadsheet includes the 
forces acting in each of the piles (axial forces, shear forces, bending moments 
and deflections) and the calculation of their structural strength (axial strength, 
bending strength, shear strength, etc).  

See also 
Pile Foundation Spreadsheet 
Definition of Foundation Model  

View Options – Foundations 
To display the foundation attributes on the screen, click on the View Options 
icon and check the "Foundation" box in the View tab. You can also display 
footing dimensions, model name, pile number and/or pile section. Press the 
"Font" button that is posted in the "Nodes" section to modify the font as you 
wish.  
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Before the analysis is performed, the maximum or actual dimensions of the 
footing entered in the foundations spreadsheet will be displayed in keeping 
with the chosen mode of analysis: In Design mode, foundations will display 
the maximum dimensions specified in the Foundation Models spreadsheet, 
whereas in Verification mode, foundations will display their actual 
dimensions. 

To visualize the name of the foundation model associated with a support node, 
tick the box "Model name". As for pile foundations, display pile numbers or 
pile sections by ticking off the appropriate boxes. 

See also 
View Options 
The Colours tab  
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Foundation tab 
Parameters and global resistance factors used for the design of shallow 
foundations as well as those applied to the verification of pile foundations are 
listed in the Foundation tab of Project Configuration. 

  

Field Definition 

General Information  

Round-off  Dimensions to: Allow you to round off  dimensions of  the foundation 
according to a specified value. 

Load Factor Alpha D Max: If  the load factor for dead load is greater than 1.0 
for ULS, VisualDesign™ will used this load factor. 

Min: If  the load factor for dead load is smaller than 1.0 
for ULS, VisualDesign™ will used this load factor. 

Project Configuration 
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Field Definition 

Friction Wall/Soil - 
Delta/Phi 

Specify the reduction (in decimals) to apply to the angle 
of  friction, delta (δ), of  a granular soil against a concrete 
wall.  According to Bowles, this angle can be considered as 
the angle of  internal friction of  the soil, phi (Φ), for 
concrete materials. The delta angle is used to calculate the 
active (Pa) and passive (Pp) earth pressure. Some 
standards reduce this angle by a factor of  2/3 or 50%. 

Shallow Foundations  

Global Resistance Factor USD global resistance factors replace the safety factor 
used in the allowable stress method. For a shallow 
foundation, a global resistance factor of  0.50 equals to a 
safety factor of  3 when the ASD method is used. 
Default values are: 
φ capacity = 0.5 
φ passive = 0.5 
φ horizontal = 0.8 

Calculation Method for Max 
Eccentricity 

Choose a model for calculating the maximum allowable 
eccentricity. Three models are proposed:  
1. Model OHDBC: e < 0,3B 
2. Model ACI 318: B > 4e + w 
3. Custom model:  B > FE(e) + FC(w) 
where "w" is the column width. 

Column Factor (FC) and  If  you chose a custom model, enter FC value needed to 
compute B. 

Eccentricity Factor (EF) If  you chose a custom model, enter FE value needed to 
compute B. 

Allowable Settlement Allowable settlement of  spread footings for the analysis 
of  limit conditions during service. (Generally equal to 
25mm) 

Pile Foundations  

Global Resistance Factor USD global resistance factors replace the safety factor 
used in the allowable stress method. For a pile 
foundation, a global resistance factor of  0.40 equals a 
safety factor of  3 when the ASD method is used. 

Default values are: 
φcs compression/friction = 0.4 
φcb compression/point = 0.4 
φts tension = 0.3 
φ passive horizontal = 0.5 
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Heading Definition 

Number of  subdivisions per 
pile 

Specify pile number of  subdivisions for the display of  
internal force and deflection diagrams.  

Allowable Lateral Deflection Specify allowable pile lateral deflection. Generally equal to 
25 mm 

See also 
Project Configuration 
The Foundation Design Module  
The Foundation Factor F  
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Typical Values for Soils' Properties 
Note Typical values given in the tables below may vary. They cannot be used for a 
detailed design. 

SOFT AND SENSITIVE CLAYS§ 
Properties  Typical value 

Effective cohesion, c’ 5 - 10 kPa 

Effective angle of  internal friction, 
φ’ 

25 - 31° 

Poisson's ratio (saturated), µ 0.4 – 0.5 (Bowles, 1988) 

Young modulus, E 2 - 25 MPa (Bowles, 1988). 

Undrained shear resistance, cu 20 - 70 kPa 

Humid unit weight, γhum 16 -18 kN/m3 

Saturated unit weight, γsat 16 -18 kN/m3 

♣
Soft and sensitive clays of Champlain Sea included. 

 

FINE AND LOOSE SAND 
Properties  Typical value 

Effective cohesion, c’ 0 kPa 

Effective angle of  internal friction, 
φ’ 

30- 34° 

Poisson's ratio (saturated), µ 0.3 – 0.4 (Bowles, 1988) 

Young modulus, E  10 -30 MPa (Bowles, 1988) 

Humid unit weight, γhum 16 -18 kN/m3 

Saturated unit weight, γsat 16 -18 kN/m3 

 

Soils 
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STIFF CLAYS 
Properties  Typical value 

Effective angle of  internal friction, 
φ’ 

30 - 40° 

Poisson's ratio (saturated), µ 0.4 – 0.5 (Bowles, 1988) 

Young modulus, E 50 -100 MPa (Bowles, 1988) 

Undrained shear resistance, cu 75- 200 kPa 

Humid unit weight, γhum 17 - 19 kN/m3 

Saturated unit weight, γsat 17,5 -20 kN/m3 

 

DENSE SAND 
Properties  Typical value 

Effective cohesion, c’ 0 kPa 

Effective angle of  internal friction, 
φ’ 

36- 45°    (Meyerhof,1974; Peck, 1974) 

Poisson's ratio (saturated), µ 0.3 – 0.4  (Bowles, 1988) 

Young modulus, E 50 - 80 MPa (Bowles, 1988) 

Humid unit weight, γhum 18 –22 kN/m3 

Saturated unit weight, γsat 19 –23 kN/m3 

 

SEDIMENTARY ROCK 
Properties  Typical value 

Effective cohesion, c’ 0,5 – 5,0 MPa 

Effective angle of  internal friction, 
φ’ 

33° - 37° 

Poisson's ratio (saturated), µ 0.3 – 0.35 

Young modulus, E 40 - 70 GPa 

Humid unit weight, γhum 27,0 kN/m3 
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GRANITIC ROCK 
Properties – Granitic rock Typical value 

Effective cohesion, c’ 1 – 10 MPa 

Effective angle of  internal friction, 
φ’ 

33° - 40° 

Poisson's ratio (saturated), µ 0.3 – 0.4 

Young modulus, E 50 – 100GPa 

Humid unit weight, γhum 27,0 kN/m3 

Important Parameters for Soils 
If personalized soils are added in one of VisualDesign Soils spreadsheets, you 
must, at least, define the following parameters: 

Cohesive Soils Calculation of  Bearing Capacity Calculation of  Settlements 

 Name of  the soil 
Undrained shear resistance (not 
necessary if  qult is known) 
Saturated and Unit Humid Weights  

Young's modulus 
Poisson's ratio  

Granular Soils Calculation of  Bearing Capacity Calculation of  Settlements 

 Name of  the soil 
Effective angle of  internal friction 
Saturated and Unit Humid Weights  

Young's modulus 
Poisson's ratio 

See also 
Cohesive Soils spreadsheet  
Granular Soils spreadsheet  
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Rocks Spreadsheet 
Pre-defined rocks are not editable but personalized ones can be added at the 
end of the spreadsheet. This spreadsheet is located the Common menu, at 
heading Soils.  

Group: Shared data: Vdbase.mdb 

Column Description Editing 

ID Automatically calculated No 

Name Soil name Single click 

Cohesion Roc cohesion: Enter the undrained cohesion for 
calculating short-term shifts. 

Single click 

φ Angle of  internal friction of  the soil Single click 

q ultimate Ultimate bearing capacity of  soil, if  known Single click 

γ Humid Specific humid weight of  soil Single click 

γ Saturated Specific saturated weight of  soil Single click 

E Elastic modulus of  soil (Young) Single click 

Poisson Poisson’s ratio of  soil Single click 

RQD Rock quality index Single click 

See also 
Typical Properties for Soils  

Cohesive Soils Spreadsheet 
Pre-defined cohesive soils are not editable but personalized ones can be added 
at the end of the spreadsheet. This spreadsheet is located the Common menu, 
at heading Soils.  

Important  The humid and saturated weights of a soil are used to calculate the weight 
of soil located above and below water table. Usually, the saturated weight is slightly 
higher that the humid weight. Do not subtract the weight of water from the 
saturated weight of soil because VisualDesign already does that automatically. 
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Group: Shared data: Vdbase.mdb 

Column Description Editing 

ID Automatically calculated No 

Name Soil name Single click 

Undrained Shear 
Resistance, Cu 

Undrained shear resistance for this soil. This 
variable is represented by "cu" or "su", according 
to codes.   

Single click 

φ Angle of  internal friction of  the soil Single click 

q ultimate Ultimate bearing capacity of  soil, if  known. Single click 

γ Humid Specific humid weight of  soil. Single click 

γ Saturated Specific saturated weight of  soil Single click 

E Elastic modulus of  soil (Young) Single click 

µ Poisson’s ratio of  soil Single click 

qc End bearing of  static penetrometer Single click 

Ip Plasticity number Single click 

N1-60 Corrected N index corresponding to 60% of  
energy of  the SPT test. 

Single click 

Granular Soils Spreadsheet 
Pre-defined granular soils are not editable but personalized ones can be added 
at the end of the spreadsheet. This spreadsheet is located the Common menu, 
at heading Soils.  

Important  The humid and saturated weights of soils are used to calculate the weight 
of soil located above and below water table. Usually, the saturated weight is slightly 
higher that the humid weight. Do not subtract the weight of water from the 
saturated weight of soil because VisualDesign already does it automatically. 
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Group: Shared data: VDbase.mdb 

Column Description Editing 

ID Automatically calculated No 

Name Name of  soil Single click 

Cohesion Undrained cohesion of  this soil. Letter "c" in 
most of  the codes represents this variable. 

Single click 

φ Angle of  internal friction of  the soil Single click 

q ultimate Ultimate bearing capacity of  soil, if  known Single click 

γ Humid Specific humid weight of  soil Single click 

γ Saturated Specific saturated weight of  soil Single click 

E Elastic modulus of  soil (Young) Single click 

µ Poisson’s ratio of  soil Single click 

qc End bearing of  static penetrometer Single click 

N1-60 Corrected N index corresponding to 60% of  
energy of  the SPT test 

Single click 

β 
Driven piles 

Combined resistance factor along the driven pile Single click 

Nt 
Driven piles 

Bearing capacity factor for driven piles. Single click 

β 
Bored piles 

Combined resistance factor along the bored pile Single click 

Nt 
Bored piles 

Bearing capacity factor for bored piles. Single click 

nh Factor relative to the unit weight of  the soil 
(kN/m3) 

Single click 

See also 
Typical Properties for Soils  
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Foundation Modeling Wizard 
The Foundation Modeling Wizard has been created to help engineers to 
quickly generate a shallow or deep foundation model. VisualDesign creates a 
stratigraphical profile, according to the design soil that is chosen by the user. In 
addition, the program automatically generates specifications for shallow or 
deep foundations. This tool is available in the Structure menu, at heading 
Foundation Models.  

Once that the required parameters are entered in the dialog boxes that are 
composing this tool, you can open the Deep or Shallow Foundations 
spreadsheet and the Stratigraphical Profiles spreadsheet and modify default 
parameters set by the program. The data that were entered through the 
modeling wizard will be included in spreadsheets.  

You are allowed to use to modeling wizard the number of times that fits you. 
The program will number the foundation models starting from 1 with an 
increment of 1. The user only has to select the appropriate foundation model 
number to be assigned to supports. Refer to topic Assign a foundation model 
to a support  

If you think that you made a mistake in the modeling wizard, you can create a 
new foundation model and erase the first one in appropriate spreadsheets. 
Alternatively, you can open the spreadsheets and modify data.  

Data to be specified in dialog boxes 
Shallow Foundation: 

• Design Soil; 

• Ground Elevation (it must be compatible with elevation of supports); 

• Height and dimensions of concrete column; 

• Footing dimensions and thickness. (Enter current dimensions for 
verification or enter maximum dimensions for a design). 

Pile Foundation: 
• Design Soil; 

• Ground elevation (it must be compatible with elevation of supports); 

• Height and dimensions of concrete column; 

• Dimension and thickness of footing. Enter current dimensions for a 
verification and maximum dimensions for a design). 

• Piles steel shape, material, and length; 

Foundation Modeling Wizard 
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• Definition of piles layout. 

Generated Data 
Stratigraphical Profile  
VisualDesign creates a stratigraphical profile according to the specified ground 
elevation and design soil. The depth of this soil layer is 21.45 meters. The 
ground water table is located at –21.45 m. The name of this profile is the same 
as the foundation name. To modify the generated stratigraphical profile, go to 
Structure / Stratigraphical Profiles.  

Shallow Foundation Model 
S P E C I F I C A T I O N  F O R  S H A L L O W  F O U N D A T I O N  

VisualDesign creates a specification having the same name as the foundation 
name. The CAN/CSA-A23.3-94 standard is used for design and the rebars 
material is G30.18-400R. To modify these data, go to Structure / 
Specifications / Shallow Foundations. 
D E S I G N  C R I T E R I A  F O R  S H A L L O W  F O U N D A T I O N S  

VisualDesign chooses the "known q ult" method for the calculation of bearing 
capacity (the value of q ult is written in the Cohesive soils spreadsheet). 
Adhesion, Ca, is equal to 250 kPa for a cohesive soil. Footing concrete covers 
are set to 75 mm. The rebars layout favours Mx and the type of rebars are 25M 
for both directions.   

Deep Foundation Model 
S P E C I F I C A T I O N S  F O R  D E E P  F O U N D A T I O N  

VisualDesign creates a specification for the deep foundation model. The name 
of this specification is the same as the foundation name. The standard that is 
applied for the structural verification of piles is CAN/CSA-A23.3-95. To 
modify these data, go to Structure / Specifications / Deep Foundations.  

D E S I G N  C R I T E R I A  F O R  D E E P  F O U N D A T I O N S  

Piles are driven in place and they work as point bearing. Piles end conditions 
are fixed at both ends and the buckling length is 0%. These default parameters 
are the same for a cohesive or granular soil. 



C H A P T E R  6  F O U N D A T I O N  D E S I G N  

CivilDesign Inc. Engineering Software  6-19 

Foundation Modeling Wizard Dialog Boxes 
Modeling Wizard – General 
First Wizard dialog box for both deep and shallow foundation models:  

  

Field Description 

Number Keep the default number or enter a name for this foundation 
model.  

Foundation Activate the appropriate radio button that corresponds to the 
foundation model you want to generate: Shallow foundation or 
Deep Foundation. 

Concrete Keep the default concrete material or click the arrow and select 
another one.  

Modeling Wizard – Soil 
Second Wizard dialog box for both deep and shallow foundation models. 
VisualDesign will generate a stratigraphical profile according to these data. 
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Field Description 

Design Soil Click on the arrow and select the design soil located under the 
footing.  

Ground Elevation Enter the ground elevation. Make sure that this elevation is 
compatible with elevation of  supports in your model.  

Modeling Wizard – Column 
Third Wizard dialog box for both deep and shallow foundations:  

  

Field Description 

Height H Enter the height of  concrete column that s located above 
the footing. 

Dimension Wx Enter the dimension of  column in the global x-axis. 

Dimension Wz Enter the dimension of  column in the global z-axis. 

Modeling Wizard - Footing (Deep foundation) 
Fourth Wizard dialog box for a deep foundation model:  
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Field Description 

Thickness Ds Enter the footing thickness located above piles head. 

Current Bx Enter the current dimension Bx, according to global x-axis. 

Current Bz Enter the current dimension Bz, according to global z-axis. 

Modeling Wizard - Footing (Shallow Foundation) 
Fourth and last Wizard dialog box for a shallow foundation model:  

  

Field Description 

Design of  
Dimensions 

Activate the appropriate radio button for a design or a 
verification of  the footing dimensions. 

Verification This is a geotechnical verification. 

Thickness Ds Enter the footing thickness. After analysis is completed, 
check the minimum thickness, H min, written in the Results 
spreadsheet for shallow foundation. 

Current Bx Enter the current dimension Bx, according to global x-axis. 

Current Bz Enter the current dimension Bz, according to global z-axis. 

Design This is a structural design. VisualDesign will place 
reinforcement in the footing. 

Thickness Ds Enter the footing thickness. VisualDesign does not modify 
this thickness. After analysis is completed, check the 
minimum thickness, H min, written in the Results 
spreadsheet for shallow foundation. 
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Field Description 

Bx Max Enter a maximum dimension for the design, according to 
global x-axis. 

Bz Max Enter a maximum dimension for the design, according to 
global z-axis. 

Modeling Wizard – Piles 
Fifth Wizard dialog box for a deep foundation: 

  

Field Description 

Shape Click the I-Beam icon and choose a shape among the 
Shape Selection tree.  

Shape Material Click the arrow and choose a material in the among the 
Steel Material Selection tree. 

Filled Piles By default, this box is activated. If  you chose a shape 
other than a hollow section, VisualDesign will not 
consider this field.  

Infilling Material By default, the infilling material is a 30 MPa concrete. 
To modify this data, click the arrow and select another 
material. . If  you chose a shape other than a hollow 
section, VisualDesign will not consider this field. 

Pile Length Enter the length of  piles. 

Button  
"Pile Layout" 

Press this button to open the Pile Layout dialog box. It 
is the same dialog box as the one included in the Deep 
Foundation Model dialog box.  
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Modeling Wizard - Piles Layout 
This is the sixth, and last Wizard dialog box for a deep foundation model. This 
dialog box is identical to the Piles Layout tab included in the Deep 
Foundation Models Dialog box.  

See 
Piles Layout tab  
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Stratigraphical Profiles Dialog Box 
You must define the stratigraphical profile on which the foundations will rest. 
The soils report may indicate that the foundations may be erected on different 
strata. Indicate, for each of these strata, elevation of topsoil, groundwater table 
and rock elevation. To do so, select the Stratigraphical Profiles heading 
under Structure menu, enter values in the first tab. Switch to the Layer 
Definition tab, and enter each soil layer parameters. 

  
See also 
Stratigraphical Profiles tab  
Layer Definition tab  

Stratigraphical Profiles 
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Stratigraphical Profiles tab 
Group: Structural data 

Column Description Editing 

ID Automatically calculated. No 

Profile Name of  stratigraphical profile  Single click 

Elevation 
Topsoil 

Elevation of  natural ground with respect to 
support nodes elevation (Ex. 0.0 m) 

Single click 

Elevation 
Water 

Elevation of  water table (Ex: -12.0 m) Single click 

N.B. Elevations can be negative or positive. 

To have a look at a stratigraphical profile cross-section, refer to topic below. 

See also 
Invalid Stratigraphical profile  
Stratigraphical Profile Cross-Section  
Stratigraphical Profiles spreadsheet  
Layer Definition tab  
Layer Definition tab 
Group: Structural data 

Column Description Editing 

ID Automatically calculated. No 

Rank Rank of  soil layer. Rank 1 is just below topsoil. Single click 

Thickness Thickness of  layer (ex.: 12 m)  Single click 

Soil Name Name of  soil as defined in one of  available Soils 
Spreadsheet, which makes up the layer (ex.: Clay) 

Double-click 

See also 
Stratigraphical Profiles tab  
Layer Definition tab  
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Invalid Stratigraphical Profile 
If you obtained the following message: 

"Elevation of the soil failure plane is below the bottom of the deepest soil 
layer. Please modify the thickness of soil layers or reduce footing dimensions.  

Explanation: 

VisualDesign calculates the failure plane under each footing. This soil volume 
is trapezoidal and its depth corresponds to about 2 times the footing width 
(each direction). If the bottom of the deepest soil layer is located within this 
volume, you get this message. Look at the figure below.  

  
What can you do?  

♦ Check the elevations that you entered in the Stratigraphical Profiles 
spreadsheet. They must be compatible with the elevation of support 
nodes; 

♦ Check if bottom of the deepest soil layer is deeper that you expected; 

♦ Reduce footing dimensions in order to reduce the depth of the soil failure 
plane and launch another analysis; 

♦ If the message still appears, add piles under the footings. 

See also 
Stratigraphical profiles spreadsheet  
Layer Definition tab  
Display the Stratigraphical Profile Cross-Section  
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Cross-section of Stratigraphical Profile 
Check elevations of soils composing the stratigraphical profile at a specific 
support. Follow the procedure below: 

• Activate the Structure mode; 

• Click on a support (or more) and go to menu Structure / Supports.  

• Click in any cell located in the line representing the support in the 
Standards Supports spreadsheet and right click. The spreadsheet 
contextual menu will appear on the screen. Select the Details function.  

   
You can print this graph by clicking the Print button available in this dialog 
box. 

See also 
Stratigraphical Profiles spreadsheet  
Standards Supports spreadsheet  
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Specifications for Shallow Foundation 
To design or verify a shallow foundation, you must create a Shallow 
Foundation Specifications spreadsheet. Afterwards, a specification must be 
selected in the Design tab of Shallow Foundation Models dialog box.  

This spreadsheet is available in the Structure menu, under Specifications. 

Here is a description of parameters that you need to define: 

Group: Structural data 

Column Description Editing 

Specification ID Automatically calculated  No 

Number Specification number (16 alphanumerical 
characters)  

Single click 

Type of  Analysis Indicate in which case the specification will be 
used for: Design or Verification.  

Verification of  footings: The footing dimensions 
are verified and bearing capacity is calculated. If  
the footing thickness is insufficient, vf  >vr. If  so, 
modify the thickness and launch another analysis. 
Look at calculated Hmin in the Shallow 
Foundation Results spreadsheet.  

Design of  footing: Footing dimensions and 
reinforcement will be designed. The footing 
thickness is not modified. Look at minimum 
thickness, Hmin, calculated by VisualDesign. 

Double-click 

Bx max  Design: Enter a maximum dimension of  footing 
according to global axis system. VisualDesign will 
not exceed it during the design. 

Verification: Enter the actual footing dimension 
according to global axis system. 

Single click 

Bz max.  Design: Enter a maximum dimension of  footing 
according to global axis system. VisualDesign will 
not exceed it during the design. 

Verification: Enter the actual footing dimension 
according to global axis system. 

Single click 

Fix a dimension Fix dimension Bx or Bz for a design, or choose 
n/a. 

Double-click 

Specifications 
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Column Description Editing 

Saf Forces amplification factor. Refer to topic Saf  and 
Waf  Factors. 

Single click 

Waf Amplification factor for the effective width of  
footing. See Saf  and Waf  Factors 

Single click 

Design   

Code Choose the standard that will be used for the 
design of  reinforcement in the footing. 

Double-click 

Rebar Material Specify the steel grade for rebars that will be 
placed in the footing. 

Double-click 

See also 
Shallow Foundation Models Spreadsheet  
The Design tab  

Specifications for Deep Foundations 
Go to Structure / Specifications and create a deep foundation specification 
that is going to be applied for the geotechnical and structural verification of the 
deep foundation.  

Afterwards, while modeling the foundation, you will select this deep 
foundation specification in the Piles tab of the Deep Foundation Models 
dialog box.  

Here is a description of parameters that you need to define: 

Group: Structural data 

Column Description Editing 

Specification ID Automatically calculated  No 

Number Specification number (16 alphanumerical 
characters)  

Single click 

Type of  Analysis For the moment, only the (geotechnical and 
structural) verification of  piles is available. The 
program does not design piles. 

Double-click 

Steel 
Specification 

Choose a steel specification for the structural 
verification of  piles. 

Double-click 
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Read the following topics before defining a shallow foundation model: "Fields 
of application for theoretical calculation models" and "Fields of application for 
empirical calculation models". 

If you decide not using the Foundation Models Wizard, we recommend that 
you enter data through corresponding dialog boxes instead of spreadsheets 
because dialog boxes are more explicit and contains more fields than 
spreadsheets. To open the dialog box when the spreadsheet is open, select any 
cell in the Foundation spreadsheet (first one), right click, and choose function 
"Details". 

See also 
Foundation Modeling Wizard  
Shallow Foundation Models Dialog Box  
Fields of application for theoretical calculation models 
Fields of application for empirical calculation models 
Saf and Waf Factors  
Rebar Layout in the Footing  
Shallow Foundation Models spreadsheet 

Fields of Application of Empirical Calculation 
Models 
Standard penetration test (SPT) 
The standard penetration test (SPT) is widely used in the field for the study of 
foundation sites on granular soils. This test measures the number of blows 
required for a standardised split core sampler to penetrate 300 mm into the soil 
by striking the respective soil layer. The number of blows corresponds to the 
standard penetration index (N). According to the NBC 1995, the allowable 
contact pressures obtained through this method must be compared to the 
pressures due to unfactored loads. In addition, in accordance with the NBC 
1995, this method is useful in the initial calculation of foundations as well as 
the final calculation for most ordinary buildings. However, foundations for tall 
buildings and towers, and special buildings that are sensitive to movement or 
built on sensitive soil must be assessed using theoretical calculation models.  

Vane shear test 
For a footing on cohesive soil, the bearing capacity is generally governed by 
undrained resistance (cu). In practice, this resistance is suitably estimated by 
means of the vane shear test, which simulates the undrained load adequately.  

The vane shear test applies to sensitive and non-sensitive clays. Strip, 
rectangular or square footings may be used. Footings may be either sunken or 
not sunken. 

Shallow Foundation Models 
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Static penetrometer test 
End bearing (qc ) is measured in the interval from B/2 on top of the base of 
the foundation to 1.1B below it. 

A static penetrometer can be used for: 

• Cohesive and coarse-grained soils; 

• Strip or square footings; 

• Df / B ≤ 1.5. 

Fields of Application of Theoretical Calculation 
Models 
 Terzaghi* Meyerhof CFEM Hansen Vesic 

Df  <= B • • • • • 

Df  >= B  • • • • 

Shallow 
foundation 

• • • • • 

Deep foundation    • • 

Strip, square or 
rectangular 
footing 

 • • • • 

Vertical or sloped 
load 

 • • • • 

Footing next to a 
slope 

   • • 

Cohesive soils • • • • • 

Granular soils  • • • • 

Moment  • • • • 

* Above all for estimating q ultimate. 

See also 
Shallow Foundation Model Dialog Box  
Deep Foundation Model Dialog Box  
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Bearing Capacity Equations 
General Equation: 

4847648476876  termload live
       depth term

termcohesion  

''2
1 qqfDHccult NDNBNcq f ζγζγζ γγ ⋅⋅⋅+⋅⋅⋅⋅+⋅= ⋅

 
where, 

qult = ultimate bearing capacity of the soil (kN/m2); 

c = cohesion (kPa); please note that: 

c = c’, effective cohesion, used for effective stresses analysis (long term 
analysis). 

c = cu, undrained cohesion, used for total stresses analysis with cohesive soils 
(short term analysis). 

B = the foundation effective width (m). 

γ’H = effective unit weight of the soil under the footing, inside the rupture 
zone (H) (kN/m3). 

γ'Df = effective unit weight of soil at the top of the footing, inside a zone 
located between the ground surface and the footing base (kN/m3). 

Nc, Nγ, Nq = bearing capacity factors used for the calculation of cohesion, 
depth and live load term (factors depending on the chosen calculation model). 

ζc, ζγ, ζq = correction factors used for the calculation of cohesion, depth and 
live load terms (factors depending on the chosen calculation model). 

Standard Penetration Test (SPT) 

situin
vo
atmsituinn NPNCN −⋅−⋅ == '1 σ  

where:  

Nin-situ =  Value of N index, measured in the field. 

Cn =  Correction factor for the effective stress. 

N1 =  Corrected N index for effective stress. 

Patm = 101,3 kPa (or 1 ton /square foot). 

σ’vo = effective vertical stress at the depth corresponding to the measure of 
the N index. 
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BOWLES MODEL (1988):  
1) If B is ≤ 1,2 m, then: 

  
dnetallowable KF

Nq ⋅=−
1

'
  

2) If B is ≥ 1,2m, then 

  
( ) dnetallowable KB

FB
F
Nq ⋅+⋅=−

2
3

2

'
  

where: 

q allowable = allowable net bearing capacity (kPa) corresponding to a 
settlement of 25 mm. 

N’  = adjusted standard penetration test index for an effective stress of 100 
kPa and an effective rate equal to 70% of the delivered energy through the 
hammer (i.e. N’70; you must follow the procedures proposed by Bowles  
(1988, chap.3.7); 

 Kd = 1 +0,33⋅(Df  / B)   

F factors depend on the energy rate and are given below: 
T A B L E  1 . 1   F A C T O R  F  F O R  T H E  B O W L E S  M O D E L  ( 1 9 8 8 )  

Factor F N’55 N’70 

F1 0,05 0,04 

F2 0,08 0,06 

F3 0,30 0,30 

Field Vane Test 

q c D
B

B
L

Dult f u
f

f= ⋅ ⋅ ⋅ + ⋅




⋅ + ⋅





+ ⋅5 1 0 2 1 0 2µ γ, ,
 

where, 

qult = gross ultimate bearing capacity (kPa); 

cu = undrained resistance measured in the field vane test (kPa); 

µf  = reduction factor proposed by Bjerrum (1973); 

Df = footing depth (m); 

B = footing width (m); 
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L = footing length (m); 

γ = unit weight of material above the base of footing (kN/m3) 

Saf and Waf Factors 
Factor "Waf" allows the redistribution of the calculated qf on a larger width. 
We recommend the following width: 

New width = effective footing width for the analyzed direction + at least 1Hs 
(Footing thickness).  

If you wish to redistribute the forces on a greater width, all you have to do is to 
increase factor Waf: 

Effective width = B eff  + (Waf * Hs) 

If the axis of gravity is the Y axis: 

  

  

B’x = Bx - 2⋅eccentricity_x 
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B’z = Bz - 2⋅eccentricity_z 

Mfz (kN ⋅ m / m) = )Hsx 2(B'
xB'z qf 2

Waf⋅+
⋅⋅

⋅ factor 

Mfx (kN ⋅ m / m) = )Hs z2(B'
zB'x qf 2

Waf⋅+
⋅⋅

⋅ factor 

Qfx (kN/m) = )Hs  z(B'
zB'x qf
Waf⋅+

⋅⋅

⋅ factor 

Qfz (kN/m) = )Hs x (B'
xB' qf
Waf

z
⋅+

⋅⋅

⋅ factor 

factor  = alpha ⋅ m + b 

alpha = B’x or B’z (according to the analyzed direction) / Bx or Bz 

b = (Saf – 0.3) / 0.7 

m = 1 - b 

If factor > Saf, then the factor = Saf 

We introduced the forces amplification factor to make up for the fact that 
VisualDesign™ distributes a uniform pressure under the footing. Actually, we 
should consider a triangular or trapezoidal distribution of forces under the 
footing, which is caused by eccentricities towards one or two directions. A 
triangular distribution of stresses can only be obtained from a non-linear 
analysis. Then, we fixed the following default values: Saf = 1.25 and Waf = 
1.50. When there is not any eccentricity in the calculation of a footing, the Saf 
and Waf factors are not considered. 

Rebars Layout in the Footing 
If axis of gravity is the Y axis: 
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Shallow Foundation Models Dialog Box 
It is important that you enter data in the dialog box, because it contains more 
fields and it is much more explicit than columns included in the Shallow 
Foundations spreadsheet. Spreadsheets are useful for printing, editing and 
sorting data. 

To open the Shallow Foundation Models Dialog box, do as follows: 

• Create a stratigraphical profile (Structure / Stratigraphical Profiles). 

• Define a specification for the shallow foundation model (Structure / 
Specifications / Shallow Foundations.  

• Go to Structure / Foundation Models / Shallow. 

• Insert a line in the spreadsheet. Click in any cell, right click, and choose the 
Details function in the contextual menu.  

This dialog box includes the following tabs: Model Definition, Column, 
Footing and Design tabs.  

The Model Definition Tab 
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Here is a description of the Model Definition tab: 

Field Description 

Identification  

Foundation Name Name of  this shallow foundation model 

Footing/Column  

Concrete Material Click on the arrow and select a concrete material for the 
footing and column. 

Soils  

Stratigraphical Profile Click on the arrow and select a stratigraphical profile as 
defined in the Stratigraphical Profiles spreadsheet  

Backfill Soil Click on the arrow and select a backfill soil. The soil must 
be defined in one of  the Soils spreadsheets. 

Slab  

Position HDd Position of  the slab: Height from bottom of  footing to 
top of  slab 

Thickness Dd Thickness of  the slab. 

The Column Tab 
You must complete this tab to define the concrete column or wall above the 
footing. 

Field Description 

Column  

Height H Column height measured from top of  footing. 

Wx Dimension  Column x-dimension (according to global x-axis). 

Wz Dimension Column x-dimension (according to global x-axis). 

Eccentricity Ecx  Column eccentricity x (calculated from centre of  footing) 
according to global x-axis. 

Eccentricity Ecz Column eccentricity z (calculated from centre of  footing) 
according to global z-axis. 
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The Footing Tab 

Field Description 

Dimensions  

Bx max or  
Current Bx 

Design: Enter the maximum dimension of  the footing 
according to the global x-axis. 
Verification: Enter the current footing dimension. 

Bz max or  
Current Bz 

Design: Enter the maximum dimension of  the footing 
according to the global z-axis. 
Verification: Enter the current footing dimension. 

Thickness Ds Footing thickness 

Concrete material Select the concrete material for this footing model. 

Slab  

Position HDd Position of  top slab from bottom of  footing. 
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Field Description 

Angle of  Friction 
Soil/Footing 

Angle of  friction between soil and footing. 

Backfilled part(s) of  
the footing 

See the explanation below. 
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Backfill over the footing 
This tool describes the location of backfill material over the footing. The plane 
view of the footing is surrounded by check boxes. They can be of three kinds: 
checked, checked and shaded, or unchecked. Here is a description of each type: 

Checked: there is backfill over the footing and it is located outside of the 
building. The backfill thickness is calculated from natural ground to top of 
footing. 

Checked and shaded: there is backfill over the footing and it is located inside 
of the building. The backfill thickness is taken from bottom of slab to bottom 
of footing. If the slab is located directly above the footing, there is no backfill 
considered. 

Unchecked: there is no backfill. 

The Design Tab 
This tab includes shallow foundation design criteria that you must complete in 
order to run a verification or design of footing dimensions Bx and Bz, and 
reinforcement. 
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Field Description 

Calculation Method  

Bearing Capacity Choose a method for the calculation of  bearing capacity. See also 
"Fields of  application for theoretical calculation models" and 
"Fields of  application for empirical calculation models".  

Stability Parameter   

Adhesion, Ca Adhesiveness of  footing and soil (kPa). 

Design of   Footing and Reinforcement 

Specification Select a specification for the design or verification of  this 
foundation model. To add or modify a specification, press the 
button […] located at the right of  this field. It will open the 
Shallow Foundation Specifications spreadsheet. 

Concrete Covers  

Top Specify the concrete cover at the top of  footing. 

Bottom Specify the concrete cover at the bottom of  footing. 

Sides Specify the concrete cover around the lateral sides of  the footing. 

Design of  Rebars  

Dir. x Select a type of  rebar that will be placed along the footing global 
x-axis. 

Dir. z Select a type of  rebar that will be placed along the footing global 
z-axis. 

Rebar Layout Select an option for the placement of  rebars: Favour Mx or Favour 
Mz. Refer to topic Rebar Layout  

See also 
Shallow Foundation Model Dialog Box  
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Shallow Foundation Spreadsheet 
Go to Foundation Models in the Structure menu and select the Shallow 
Foundation spreadsheet. The spreadsheet is divided into four spreadsheets to 
facilitate the consultation of data: Foundation, Footing, Column and 
Design. 

Spreadsheets are useful to consult data, copy foundation models or sort data. 

Foundation Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Automatically calculated. No 

Name Foundation name Single click 

Profile Corresponding stratigraphical profile defined in 
the Stratigraphical Profiles tab  

Double-click 

Concrete Material Concrete material for the footing, as defined in 
the Concrete Materials spreadsheet. 

Double-click 

Backfill material Backfill material placed above the footing. Double-click 

Slab 
Thickness 
Dd 

Slab thickness Single click 

Slab 
Position 
HDd 

Height between bottom of  footing and top of  
slab 

Single click 

The Footing Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Automatically calculated. No 

Name Name of  the foundation model. Single click 

Bx max or 
Actual Bx  

Design: Maximum dimension of  the footing in 
the global x direction. 
Verification: Actual dimension of  the footing in 
the global x direction. 

Double-click 
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Column Description Editing 

Bz max or 
Actual Bz 

Design: Maximum dimension of  the footing in 
the global z direction. 
Verification: Actual dimension of  the footing in 
the global z direction. 

Double-click 

Thickness 
Ds 

Footing thickness Single click 

The Column Spreadsheet 
This spreadsheet is part of both shallow and deep foundations spreadsheets.  

Group: Structural data 

Column Description Editing 

ID Automatically calculated. No 

Name Name of  the foundation model. Single click 

Dimension Wx  Column dimensions according to global x-axis. Single click 

Dimension Wz  Column dimensions according to global z-axis. Single click 

Height H  Height of  column measured from top of  
footing. 

Single click 

Ecx 
x Direction 

Eccentricity of  concrete column (calculated from 
centre of  footing) in the global x-direction. 

Single click 

Ecz 
z Direction 

Eccentricity of  concrete column (calculated from 
centre of  footing) in the global z-direction. 

Single click 

The Design Spreadsheet 
This spreadsheet includes parameters that are needed to design the footing 
dimensions and reinforcement.  

Group: Structural data 

Column Description Editing 

ID Automatically calculated. No 

Name Name of  the foundation model. Single click 

Specification Choose a shallow foundation specification for 
the design or verification of  this footing. 

Double-click 
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Column Description Editing 

Bearing Capacity 
Equation 

Choose the method used for the calculation of  
bearing capacity. Please refer to topics Fields of  
application for theoretical calculation models and 
Fields of  application for empirical calculation 
models. 

Double-click 

Adhesion 
Ca 

Soil/Footing adhesiveness (kPa). Single click 

Concrete Cover 
Top 

Specify the concrete cover at the top of  footing. Single click 

Concrete Cover 
Bottom 

Specify the concrete cover at the bottom of  
footing. 

Single click 

Concrete Cover 
Sides 

Specify the concrete cover around (sides) of  
footing. 

Single click 

Rebars 
Layout 

Choose a rebar layout: Favour Mx or Favour My. 
Refer to topic Rebar Layout  

Double-click 

Rebars 
x - Dir.  

Select rebars that will be placed along the footing 
x-global axis. 

Double-click 

Rebars 
z- Dir. 

Select rebars that will be placed along the footing 
z-global axis. 

Double-click 

See also 
Shallow Foundation Model dialog box  
Shallow Foundations spreadsheet 
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If you decide not using the Foundation Models Wizard, we recommend that 
you enter data through corresponding dialog boxes instead of spreadsheets 
because dialog boxes are more explicit and contains more fields than 
spreadsheets. To open the dialog box when the spreadsheet is open, select any 
cell in the Foundation spreadsheet (first one), right click, and choose function 
"Details". 

See also 
Foundation Modeling Wizard  
Calculation of Friction and Point Bearing Capacity  
Piles' Spring Supports  
Deep Foundation Models Dialog Box  
Deep Foundation Models spreadsheet 

Calculation of Friction and Point Bearing Capacity 
for Piles 
Ref: Manuel Canadien des fondations, clause 20.2.1.2 (3) 

Calculation of Friction Bearing Capacity 
Granular Soils 
The Beta method is always used with these types of soils. Consequently, the 
parameters Beta for driven and bored piles shall be defined and not equal to 
zero in the Granular Soils spreadsheet. If so, the friction bearing capacity of 
piles in contact with this type of soil will be equal to zero.  

Then, the compression/friction global resistance factor shall be specified in the 
Foundation tab of Project Configuration dialog box.  

Qsu =Sum (Beta * Sigma’ * Pile perimeter * delta L) per soil layer in contact 

Qsr = Phi compression/friction * Qu 

Where "delta L" is the thickness of the soil layer considered 

Note: The perimeter of a pile composed of a W shape is equal to (b+d)*2 

Cohesive Soils 
The Alpha method is always used with these types of soils. The soil cohesion is 
included in equations, so this parameter shall be different from zero in the 
Cohesive Soils spreadsheet.  

The soil cohesion must be less than 100 kPa, with respect to the Manuel 
Canadien des Fondations. 

 

Deep Foundation Models 
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1. Steel Piles: 

Alpha = 0.00005 * Cohesion ^2  - 0.0125 Cohesion  + 1.1339 - 0.3367 / 
Cohesion 

2. Concrete Piles: 

If cohesion > 25 kPa: 

Alpha = 0.00008 * Cohesion ^2  - 0.0201 * Cohesion  + 1.9008 - 11.111 / 
Cohesion 

If cohesion < 25 kPa: 

Alpha = 1.0 

Calculation of Point Bearing Capacity 
Values for Nt (driven and bored piles) shall be specified in the Granular Soils 
spreadsheet. Also, the global resistance factor for Compression/Point shall be 
specified in the Foundation tab of Project Configuration dialog box.  

Granular Soils 
Qpu = Nt * Sigma’ *At  

Qpr = Phi Compression/Point * Qpu 

If Nt values are not specified in the Granular Soils spreadsheet, the SPT 
method will be used. Thus, the value for N1-60 is required:  

Qpu = m*N1-60*At   

Where the value for "m" is given at page 324, Manuel Canadien des fondations 
(MCF). 

Cohesive Soils 
Qpu = Nt * Cohesion * At   

Where values for Nt is given at article 20.2.1.2 (4) (MCF) 
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Piles' Spring Supports 

 
In accordance with the Canadian Foundation Manual (page 347), the spring 
support stiffness Kx and Ky is determined as follows: 

Kx = Ky = Ks * d * dH (N/m) 

Where  

Ks = 67 cu / d (N/m³) for cohesive soils; 

Ks = nh z / d (N/m³) for granular soils. 

When many layers are composing the soil, a factored value for Ks is calculated, 
considering each layer of soil and its respective thickness. 

In current version 5.9, the projected area is considered for each direction, 
allowing the calculation of spring stiffness in the proper way: Kx will be related 
to "d" and Ky, to "b".  

See also 
The Piles tab (Deep Foundation Models) 
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Deep Foundation Models Dialog Box 
It is important that you enter data in the dialog box, because it contains more 
fields and it is much more explicit than columns included in the Pile 
Foundations spreadsheet. Spreadsheets are useful for printing, editing and 
sorting data. 

To open the Deep Foundation Models Dialog box, do as follows: 

• Create a stratigraphical profile (Structure / Stratigraphical Profiles). 

• Define a specification for a deep foundation (Structure / Specifications 
/ Deep Foundations). 

• Go to Structure / Foundation Models / Deep. 

• Insert a line, click in any cell, right click, and select the Details function in 
contextual menu.  

This dialog box includes the following tabs: Model Definition, Footing, 
Column, Piles and Piles Layout tabs.  

The three first tabs are identical to those described for Shallow Foundation 
Models.   
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The Piles Tab 

 

Field Description 

Characteristics  

Installation Type of  installation of  piles: Driven or bored 

Work Specify if  the piles are working in point, friction, or both 
point and friction.  

Piles Head Specify if  the pile head is fixed or unrestrained. 

Piles End Specify if  the pile end is fixed or unrestrained. 

Buckling length Unsupported length of  the pile expressed in % or fraction of  
total length. 



C H A P T E R  6  F O U N D A T I O N  D E S I G N  

6-50  CivilDesign Inc. Engineering Software 

Field Description 

Shape and Material  

Shape Choose a pile section by pressing the I beam icon. Expand the 
shape selection tree and double click to select one. 

Shape Material Click on the arrow and expand the Material selection tree. 
Double-click to select a material. 

End Area Area at the end of  the pile. This area is recalculated whether 
the section is filled or not 

HSS Shape  

HSS with 0.9t Check this box if  the chosen HSS has been manufactured 
according to grade ASTM A500. 

Filled Section Tick off  this box if  the tubular section is filled with concrete. 

Infilling Material Click on the arrow and select the concrete material that filled 
the tubular section. 

Effective stiffness  

Inertia strong axis  Specify the ratio of  effective inertia on the section strong axis 
for the structural verification in bending. 

Inertia weak axis Specify the ratio of  effective inertia on the section weak axis 
for the structural verification in bending. 

Torsion Specify the ratio of  effective stiffness for torsion/shear for 
the structural verification of  the section. 

Axial Specify the ratio of  effective axial stiffness for the structural 
verification of  the section in compression. 

Structural Design of  Pile 

Specification Click on the arrow and choose a specification for the 
verification of  the deep foundation model. To add or modify 
a specification, press the button […] located at the right of  
this field. It will open the Deep Foundation Specifications 
spreadsheet. 
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Piles Layout Tab 
The Piles Layout tab allows you to enter, visualize, and print the piles layout 
according to the coordinates entered in the spreadsheet.  

 
Use one of the three buttons to quickly define the piles layout coordinates. 
Each one is representing a particular piles layout and is calling up a dialog box. 
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Following input, visualize and print the piles layout that will be drawn in the 
dialog box, as the example shown below: 
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The spreadsheet includes the following data: 

Field Description 

ID Automatically calculated 

Coord. X, Y, and Z Pile coordinates, according to the convention described 
below.  

Beta angle Beta angle of  the pile section 

Lateral angle Lateral slope of  the pile, expressed in angle 

Vertical angle Vertical slope of  the pile, expressed in angle 

 

Deep Foundations Spreadsheet 
This spreadsheet, which is located in the Structure/Foundation Models 
menu, is divided into four tabs: Foundation, Footing, Column and Piles. 
The three first tabs are identical to those part of the shallow foundation models 
spreadsheet. 

Spreadsheets are useful to consult or sort data and to copy foundation models 
using the Duplicate function of contextual menu.  

Piles Spreadsheet 
Group: Structural data 

Column Description Editing 

ID Automatically calculated. No 

Name Foundation name Single click 

Specification Choose a specification for the verification of  the 
deep foundation. 

Double-click 

Shape Chosen shape for the pile. To modify this choice, 
double-click in this cell to open the Shape 
selection tree and double click to select a shape. 

Double-click 

Material 
Pile 

Chosen material for the pile.  Double-click 

Filled If  the shape is filled with concrete, choose 
option [ x ]. 

Double-click 
or Space bar 

Infilling Material Concrete material that fills the tubular section. Double-click 
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Column Description Editing 

End Area Area of  pile end. Single click 

Installation Type of  installation for the piles: Driven or 
Bored. 

Double-click 

Work Indicate the way the piles are working: in point 
bearing, friction bearing or both. 

Double-click 

Piles Cap Indicate the pile head end condition: fixed or 
unrestrained. 

Double-click 

Piles End Indicate the end conditions of  pile end: fixed or 
unrestrained. 

Double-click 

Buckling length Buckling length: Percentage or fraction of  pile 
length. 

Single click 

Effective inertia 
for bending 
strong axis 

Factor (or percentage) that indicates the effective 
inertia that must be considered for bending on 
the strong axis. A factor of  1.0 or percentage of  
100% means that there is no reduction. 

Single click 

Effective inertia 
for bending 
weak axis 

Factor (or percentage) that indicates the effective 
inertia that must be considered for bending on 
the weak axis. A factor of  1.0 or percentage of  
100% means that there is no reduction. 

Single click 

Effective stiffness 
for torsion/shear 

Factor (or percentage) that indicate the effective 
stiffness of  the pile that must be considered for 
torsion and shear. A factor of  1.0 or percentage 
of  100% means that there is no reduction. 

Single click 

Effective axial 
stiffness 

Factor (or percentage) that indicate the effective 
axial stiffness of  the pile that must be considered 
for compression and tension. A factor of  1.0 or 
percentage of  100% means that there is no 
reduction. 

Single click 

HSS 
t (design) 

Wall thickness that will be considered during 
analysis of  this HSS. 

Double-click 
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Assigning Foundation Models to Supports 
A foundation model can be assigned to one support or more. Generally, the 
same foundation model is assigned to supports that would transmit loads of 
similar magnitude to the foundation.  

To assign a foundation model to one support or more: 

• Activate the "Support" icon on Elements toolbar. 

• Double-click on a support or select many and click the Properties 
icon. Go to the Support tab of Node Characteristics dialog box. 

• In the "Foundation model" heading, select a foundation model among 
the drop-down list box or click the "Foundation" button to define one. 
(This button opens one of the Foundation Models dialog box.) 

• Click OK. 

 

Foundation Supports 
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Tributary Areas for Spring Supports 
Use this tool, which is located in Structure menu / Tools, to automatically 
calculate tributary areas in the x-, y- and z-direction, for spring supports that 
are associated to plate elements.   

Procedure: 

• Activate the Structure activation mode. 

• Select spring supports. 

• Go to Structure / Tools and select Calculation of Tributary Areas. 

Calculated areas will be written in the Support tab (Node Characteristics 
dialog box).   

N. B. For the Generation of Abutments, Piers & Retaining Walls module, 
spring support tributary areas are automatically calculated from the 
stratigraphical profile data and are indicated in the Support tab. 

Foundation Transformation 
The function Foundation Transformation is available in Structure/Tools 
menu and is only used with the Abutment, Pier & Retaining Wall module, for 
the moment. The function transforms a footing into plates and adds elastic 
supports. For pile foundation, the function transforms the pile into members 
and adds rigid links from pile heads to footing.  

• Rename your file to keep bearing capacity results. 

• Activate the Structure mode. 

• Activate the Support element on Elements toolbar. 

• Select the foundation central support. 

• Select the Foundation Transformation function. 

The following dialog box will appear on screen. VisualDesign indicates the 
bearing capacity that will be used for the calculation of spring supports. You 
can specify the maximum dimension of plates that will be composing the 
footing after the transformation.  

Procedure: 
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See also 
Abutments, Piers, and Retaining Walls Generation and Design  
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Analysis with soil-structure interaction 
The secant moduli K of soils is used to calculate footing settlements.  

To model the soil/structure interaction, select the option "Secant mod. K" as 
degrees of freedom for selected supports in the Support tab (Node 
Characteristics dialog box) and then, assign a foundation model to these 
supports. Please refer to the topic Secant modulus K for Foundation Supports.  

When the soil-structure interaction is considered, the program performs 
iterations until the results of the foundation settlement, the stresses in the 
structure and the reactions at the supports caused by the settlement converge.  

The process for calculating soil-structure interactions rarely requires more than 
five iterations. If more than five iterations are required, the solution cannot be 
optimized. The results, however, are valid since the calculated percentages for 
capacity are greater than 100%. 

Procedure: 

• Select all the supports of only some of them, and press the properties icon 
to call up the Support tab of Node Characteristics dialog box. Choose 
the option Secant modulus K for appropriate degrees of freedom.  

• Create a load case and select an Interaction type of load in the Loads 
Definition spreadsheet. 

• Go to the Load Combinations Generation Wizard. Select a code and 
generate ultimate and serviceability load combinations.  

• Run a static analysis. 

• Select a load combination on Activation toolbar and look at results in 
menu Results / Foundations.  

Secant Modulus K for Foundation Supports 
If you own the Foundation Design module, VisualDesign can automatically 
calculate the linear and torsional rigidity of spring supports. It is done using the 
properties of soils composing the stratigraphical profile, which is specified in a 
foundation model. Lateral and vertical displacements of the footing or slab can 
be obtained from these calculated values.  

The secant modulus must be selected as degrees of freedom for a support if 
soil/structure interaction needs to be considered.   

Soil/Structure Interaction 
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Procedure: 

• Define a shallow foundation model. 

• Select supports and press the Properties icon.  

• In the Support tab, choose option Secant mod. K as restraints for Rx, Ry, 
Rz, Mx, My, and/or Mz degrees of freedom. 

• Assign supports to foundation models. 

The linear and torsional rigidity of the support will be calculated and written in 
the shaded field next to each degree of freedom corresponding to Secant 
modulus K.  

  
See also 
Support's Degrees of Freedom  

Analysis without Soil-Structure Interaction 
Soil-structure interaction is not considered if the option "Secant Modulus K" is 
not assigned to support degrees of freedom.  
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Limit States Design 
The limit conditions calculation is used to design foundations. The limit 
conditions calculation uses a global bearing factor rather than a global safety 
factor. At limit conditions, a global resistance factor of 0.5 is equivalent to a 
safety factor of 3.0 when calculating allowable stresses. Global resistance 
factors must be specified in the Foundation tab of Project Configuration 
dialog box.  

A limit condition occurs at the point at which a structure ceases to fulfil the 
function for which it was designed. Limit conditions that affect safety are called 
ultimate limit conditions and they occur when the load bearing capacity of the 
structure is surpassed, resulting in reversal, slipping, rupture or fatigue. The 
service limit conditions pertain to the use for which the structure is designed 
and concern bending, vibrations, permanent deformations and cracking. 

See also 
Serviceability Limit State  
Definition of Load Combinations  

Serviceability Limit States 
Serviceability limit states pertain to the use for which the structure is designed 
and concern bending, vibrations, permanent deformations, and cracking. 
Service limit conditions are verified with specific load factors. 

Foundation Design Procedures 
Project Configuration 
• Configure the project foundation parameters in the Foundation tab of 

Project Configuration. 

Definition of Soils 
• Define the soils that you need for your project, in the soils spreadsheets 

(Soils / Common). Create personalized soils if needed, by inserting lines 
at the end of spreadsheets.  

Definition of Foundation Models 
• Use the Foundation Modeling Wizard. In addition to the foundation 

model, this wizard generates a stratigraphical profile and a specification that 
applies to this model.   

OR 

Analysis 
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• Define the stratigraphical profiles in the Stratigraphical Profiles dialog 
box Structure menu. Make sure that the depth under footings is sufficient 
to consider the soil plane of failure under them. 

• Define a foundation specification. 

• Define the foundation model in one of the Foundation Models dialog 
box (Structure menu). 

Supports 
• Assign foundation models to supports. 

Load Combinations 
• Define load combinations using the Load Combination Generator. The 

dead load of backfill over footings is automatically considered in dead load 
cases. 

Analysis 
• Run a static analysis or a design. 

Results 
• Go to Results / Foundations. 
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All results obtained during the analysis are stored. There are two ways to view 
these results: Graphically or through spreadsheets. Results spreadsheets are 
listed under Results/Foundations.  

Graphic View Options 

Spreadsheet Shallow Foundation Results 

Footing Reinforcement  

Piles Foundations Results  

Piles Reactions  

Note: Results must be analysed carefully to detect the slightest data entry error. 

See also 
The Foundation Design module  
Results tab of View Options  
Display the structural and geotechnical design load  

Display the Foundation Structural or Geotechnical 
Design Load 
• Activate the Design Results mode  and open the View Options dialog 

box.  

• Select the Limits tab and activate the "Legend" box. Then, select the 
Results tab and activate one option among the two available: "Structural 
Design Load" or "Geotechnical Design Load".  

• To modify the font style and text height, go back to the Limits tab and 
click the "Font" button.  

Shallow Foundations 
Structural Design Loads:  
• The displayed design load will be the maximum among those calculated for 

overturning, sliding, uplift, and shear.  

Geotechnical Design Loads:  
• The displayed design load will be the maximum among those calculated for 

shear, bending moment, and reinforcing bars in the footing. 

Foundation Results - General 
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Deep Foundations 
Structural Design Loads:  
• Piles: The displayed design load will be the maximum among those 

calculated for shear, bending moment & compression, and the strength of 
the steel shape. 

• Footing: N/a 

Geotechnical Design Loads:  
• Piles: The displayed design load will be the maximum among those 

calculated for point bearing, friction bearing, or both. 

• Footing: The displayed design load will be the maximum among those 
calculated for global design load, compression, or tension.  

See also 
Results tab of View Options  
The Limits tab  
The Results tab  
Display the Pressure and Capacity of Spring Supports  

Sign Convention of Forces in the Footing 
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See also 
Saf and Waf Factors  
Position of rebars in the footing  
Footing reinforcement spreadsheet  
Specification for Shallow Foundations  
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Shallow Foundation Results Spreadsheet 
Once that the static analysis is completed, open this spreadsheet and look at 
the calculated bearing capacity of the foundation, for each load combination. If 
it is insufficient, qr = 0. Increase the footing dimensions or add piles.  

To consult this spreadsheet, go to Results/Foundation / Footings. 

Group: Design Results 

Column Description Editing 

Model Name of  the shallow foundation model. No 

Support Support node associated with the foundation 
model 

No 

Load 
combination 

Analysed load combination  No 

Bx 
Bz 

Check: Current dimensions of  the footing 
Design: Calculated dimensions of  the footing 

No 

Bx eff 
Bz eff 

Effective dimension of  the footing relative to 
global x, and z-axis. 

No 

Bearing 
Capacity 
qr 

Factored bearing capacity of  soil under the 
footing. If  this value is zero, the bearing capacity 
is insufficient. Look also at Hmin, in the Footing 
Reinforcement spreadsheet. 

No 

Contact 
Pressure 
qf 

Pressure of  soil under the footing No 

Settlement 
dy 

Footing settlement. Settlements are automatically 
calculated for service load combinations if  
foundations supports are modeled using the 
secant modulus of  soil. Refer to Secant modulus 
of  soil  

No 

Rfx 
Rfy  
Rfz  

Reaction (ultimate or service) transmitted to the 
foundation, relative to the x, y and z-axis. 

No 

Mfx  
Mfy  
Mfz  

Bending moment (ultimate or service) 
transmitted to the foundation, relative to the x, y 
and z-axis. 

No 

Shallow Foundation Results 
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Column Description Editing 

Design load 
Bearing capacity 

Footing Design Load 
=(qr / qf)*100 

No 

Hrs (1) Geotechnical horizontal resistance of  footing in 
the soil near the footing/soil interface. 

No 

Hri (1) Geotechnical horizontal resistance of  footing at 
footing/soil interface. 

No 

Hf 
x-dir.  

Horizontal sliding force acting on the 
foundation, in the global x direction. 

No 

Hr 
x-dir. 

Resistance of  the foundation against sliding, in 
the global x direction. 

No 

Design load 
Sliding 
x-dir. 

Design Load of  footing considering sliding:  
= (ΣF horiz / ΣF vert. ) x 100 

No 

Hf 
z-dir. 

Horizontal sliding force acting on the 
foundation, in the global z direction. 

No 

Hr 
z-dir 

Resistance of  the foundation against sliding, in 
the global z direction. 

No 

Design load 
Sliding 
z-dir. 

Sliding Design Load of  footing:  
= (ΣF horiz/ΣF vert.) x 100 

No 

Eccentricity 
Ratio x-dir. 

This ratio is equal to the calculated eccentricity x 
over the allowed eccentricity x, according to 
chosen model (Foundation tab of  Project 
Configuration). 

No 

Eccentricity 
Ratio z-dir. 

This ratio is equal to the calculated eccentricity z 
over the allowed eccentricity z, according to 
chosen model. (Foundation tab of  Project 
Configuration) 

No 

Uplift ratio This ratio is equal to the factored uplift reaction 
of  support over the factored dead load of  
footing. 

No 

Settlement ratio Design load relative to allowable settlement: 
Settlement (%) = (allowable 
settlement/calculated settlement)*100 

No 

Result Result of  analysis: O.K., Eccentricity error, 
Settlement error, etc 

No 
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Note (1): Refer to clause 6.7.5 "Factored Horizontal Resistance" of 
CAN/CSA-S6-00 Standard and clause 11.4.9.1 of CAN/CSA-A23.3-95 
Standard. 

See also 
Foundation tab (Project Configuration)  
Display Structural and Geotechnical Design Load  

Footing Reinforcement Spreadsheet 
Open this spreadsheet when that static analysis is completed and look at 
calculated footing reinforcement. Some columns are editable (yellow ones). 
You are allowed to modify dimensions of rebars and rebars layout in the 
footing. When you edit yellow columns, reinforcement is automatically 
recalculated.  

Access the results of calculated reinforcement in the footing by selecting 
Results / Foundation / Reinforcement. 

Group: Design Results 

Column Description Editing 

ID Automatically calculated No 

Name Name of  the foundation model No 

Quantity Number of  footing of  this model No 

Bx 
By 
Bz 

Footing dimension according to global x- y, or z 
direction.  

No 

Hs Footing thickness, as specified by the user. No 

Hmin Minimum thickness of  footing for shear and 
punching shear. 

No 

Concrete Material  Footing material Double-click 

Steel  Material of  reinforcing bars. Double-click 

Rebars 
Layout 

Rebars layout in the footing to favour Mx or 
Mz, as specified by user in the Design tab. See 
Rebars Layout. 

Double-click 

Concrete Cover 
Minimum 

Minimum concrete cover for reinforcing bars in 
this footing. 

Single click 

Concrete Cover 
Sides 

Concrete cover at the sides of  footing. Single click 
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Column Description Editing 

Saf Amplification factor for forces. Default value = 
1.25. Refer to Saf  and Waf  Factors. 

Single click 

Waf Amplification factor for the effective width of  
the footing. Default value = 1.50. Refer to Saf  
and Waf  Factors 

Single click 

Rebars dimensions 
x-, y or z-dir. 

Selection of  Rebar in the specified direction. Single click 

No. Rebars 
x-y, or z dir. 

Calculated number of  rebar in the x, y and z 
direction. 

No 

Spacing Rebars 
c/c x-, y, or z dir.  

Centre to centre spacing of  rebar.  No 

ρ x , ρ y, ρ z  Percentage of  steel reinforcement in the 
specified directions. 

No 

Bar length 
x-, y-, or z-dir. 

Length of  reinforcement in the direction 
considered. 

No 

d 
x-, y-, or z- dir. 

Calculated depth from the top of  footing to the 
centre of  gravity of  reinforcement, in the x, y 
and z direction 

No 

Mfx  
Mfy  
Mfz  

Bending moment (ultimate or service) in the 
footing, according to the specified direction. 

No 

Mrx  
Mry 
Mrz 

Bending strength of  footing, according to the 
specified direction. 

No 

Qfx 
Qfy 
Qfz 

Shear force acting on footing, in the specified 
direction. 

No 

Qrx 
Qry 
Qrz 

Shear strength of  footing No 

vf Punching shear stress in the footing No 

vc   Punching shear strength of  footing No 

Structural 
Design Load 

Structural design load of  foundation according 
to the selected code (specification for shallow 
foundation).  

No 

Message   Result: OK, Qr < Qf, Mr < Mf, vc <vf. No 
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Column Description Editing 

Reinforcement Weight of  footing reinforcement (kg). No 

Concrete Volume of  concrete footings No 

 

Note  If the user modifies some data into the spreadsheet, VisualDesign™ will 
automatically recalculate new data. 

See also 
Sign Convention for Forces in the Footing  
Saf and Waf Factors  
Position of Rebars into the Footing  
Specifications for Shallow Foundations 
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Pile Foundation Results Spreadsheet 
Access the results of pile foundation design by selecting Results menu-
>Foundations ->Piles. 

Group: Foundation Design Results 

Column Description Editing 

Model Name of  deep foundation model. No 

Support Support node assigned to the foundation model No 

Load 
combination 

Analysed load combination No 

Length Length of  Piles  No 

Cr  Geotech. 
Group 

Geotechnical factored compression resistance of  
the pile group (kN). 

No 

Tr  Geotech. 
Group 

Geotechnical factored tension resistance of  the 
pile group (kN). 

No 

dy Settlement of  the group of  piles. No 

Rx, Ry, Rz Reaction (ultimate or service) transmitted to the 
foundation, relative to the x, y and z-axis. 

No 

Mx, My, Mz  Bending moment (ultimate or service) transmitted 
to the foundation, relative to the x, y and z-axis. 

No 

Geotechnical 
Design Load 
Compression 
% 

Design load in compression for the group of  pile 
(%): 
(Reaction of  the pile group / Compression 
strength of  the pile group) *100 

No 

Design Load 
Settlement 
% 

Percentage of  allowable settlement: 
Allowable settlement  =  (calculated settlement / 
allowable settlement) *100  

No 

Results Result of  analysis for the considered load 
combination. 

No 

Graphic Results for Piles 
Select a line in this spreadsheet, right click and select the function Details in 
the contextual menu.  

Deep Foundation Results 
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Graphic Results for Piles 
Select a line in the Pile Foundation Results spreadsheet, right click, and 
select the function Detail in contextual menu to have access to the following 
graphical results: 

Pile Ultimate Capacity relatively to its Depth 
Select a line in the spreadsheet, which corresponds to the support (pile 
foundation) that you want to look at, and press the button. The graph shows 
the pile capacity in point bearing, friction bearing, and both.  

Qbr = φcp * Qb 

Qb = nominal capacity in point bearing;  
φcp = global resistance factor for compression/point; 

Qsr = φcs * Qs 

Qs = nominal capacity in friction bearing 
φcs = global resistance factor for compression/friction; 

Qr : Qbr + Qsr 
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Pile Neutral Plane 
The location of neutral plane corresponds to the depth where negative lateral 
friction is equal to positive lateral friction. 

  
Qd represents the dead load distribution along the pile depth; 
Qr is the variation of the total pile capacity (Qbr + Qsr) with the depth of the 
pile. 

See also 
Pile Foundation Results  
Pile Forces and Reactions  
Display the Pressure and Capacity of Spring Supports  
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Pile Forces and Resistance Spreadsheet 
Access the results for the verification of piles foundation by selecting Results 
/ Foundations/Piles Reactions. 

Group: Design Results 

Column Description Editing 

Model Name of  the model of  foundation No 

Support Name of  the support node No 

Load 
combination 

Analysed load combination No 

Pile number Pile number No 

Nz max Maximum axial force in the pile No 

Nz min Minimum axial force in the pile No 

Mfy Bending moment concomitant with Nz, on weak 
axis. 

No 

Vfx Shear force concomitant with Nz, on weak axis. No 

x Lateral deflection of  pile according to local x-axis. No 

% x   Ratio of  pile deflection to allowable lateral 
deflection, according to local x-axis. 

No 

Mfx Bending moment concomitant with Nz, on strong 
axis. 

No 

Vfy Shear force concomitant with Nz, on strong axis. No 

y Lateral deflection of  pile according to local y-axis. No 

% y  Ratio of  pile deflection to allowable lateral 
deflection, according to local y-axis. 

No 

Soil Pressure 
x Dir.  

Soil pressure acting on the pile, according to local 
x-axis. 

No 

Kp sol 
x Dir. 

Passive soil pressure on pile, according to local x-
axis. 

No 

P / Kp 
x Dir. 

Soil pressure divided by the passive soil pressure, 
according to local x-axis. 

No 
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Column Description Editing 

Soil Pressure 
y Dir.  

Soil pressure acting on the pile, according to local 
y-axis 

No 

Kp sol 
y Dir. 

Passive soil pressure, according to local y-axis. No 

P / Kp 
y Dir. 

Soil pressure divided by the passive soil pressure, 
according to local y-axis. 

No 

Nr 
Structure 

Axial strength of  the pile No 

Mrx  
Structure 

Bending strength of  the pile on strong axis. No 

Vry  
Structure 

Shear strength of  the pile on strong axis. No 

Mry  
Structure 

Bending strength of  the pile on weak axis. No 

Vrx  
Structure 

Shear strength of  the pile on weak axis. No 

Structural 
Design load 

Structural design load of  the pile: 
(Critical force / pile strength)*100. A value greater 
than 100 means that the pile section is incorrect. 

No 

Geotechnical Resistance of  Pile  

Cr 
Geotechn. 

Compression strength of  the pile. No 

Tr 
Geotechn. 

Tension strength of  the pile. No 

Geotechn. 
Design load  
Compression 

Geotechnical design load of  pile, considering 
compression force.  

No 

Geotechn. 
Design load  
Tension 

Geotechnical design load of  pile, considering 
tension force. 

No 

See also 
Foundation Design Module  
Piles tab  
Piles Layout tab  
Specifications for Deep Foundations  
Display the Pressure and Capacity of Spring Supports  
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Pressure and Capacity of Spring Supports along 
Piles 
Once that a pile foundation analysis is done, you can display pressures acting 
on each spring support located along piles along with the capacity of spring 
supports.  

This option is available in the Results tab of View Options dialog box. Check 
the "Pressure and Capacity" box in the Supports section. A coloured legend will 
also appear to differentiate pressure diagram (orange) from the capacity 
diagram (blue). If you display numerical values, they will be the same colour as 
their respective diagram. The displayed values correspond to the envelope 
minimum and maximum forces. 
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